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What'fle You Got ThereJ
Your Mac's model name is painted on the front. For the System and
memory info, choose About This Macintosh from the II menu;
details in the first two chapters.

Your Mac model: _ _ _ _ _ _ _ __
Your System version: ________
How much memory it's got:

Finding a file
Each tile you create is represented by an icon and is usually stored
inside an electronic folder, which looks like a file folder on your
screen. Everyone sometimes misplaces a file. Here's what to do.
1. Choose Find from the File menu (or the

II menu).

2. Type a few letters of the missing file's name.
You don't have to type the whole name ... only enough to
distinguish it; type Wonk to find the file called Willy Wonka
Earnings. Capitalization doesn't matter.

Surfliflin9 the First Half Hour
You may only need this information at the very beginning of your
Mac career- but you'll really need it.

Turning on the Mac
Press the On button. For most Macs, it's either the big key on your
keyboard with a left-pointing triangle, or a rocker switch on the
back panel (Chapter 1).

3. Press the Return key, or click the Find button.
The Mac roots through your files. If it shows you a list of all
icons that match, click one (to see where it is) or double-click
(to open it).
If the Mac displays the first icon that matches your request, and
it's the wrong file, choose Find Again from the File menu. Keep
choosing Find Again until you find what you're looking for, or
until the Mac beeps, telling you that it's done searching.

Turning off the Mac

Renaming a file

1. If you've typed or drawn anything, make sure it's safely stored on
your disk by choosing Save from the File menu.

2. Type a new name; then press Return.

2. Choose Quit from the File menu.
3. From the Special menu, choose Shut Down. (Or choose •Shut
Down from your II menu, if it's there.)
Cleon Up Window

f.mpty Trash
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Crase Disk,..

Rest6rt

Recent Macs perform all three of these steps automatically, by the
way, when you simply press the power key- with a triangle - on
your keyboard.

1. Click an icon (once). Press Return.

A file's name can be up to 31 letters long. If you make a mistake,
backspace by pressing the Delete key.

To insert a floppy disk
1. Hold the disk with metal edge first, label side up.

2. Push the disk into the Mac's disk slot until it makes a chunk
sound.
You can protect a disk from erasure, by the way, by sliding the
small square tab in the corner of the disk so that you can see
through the hole.

Ejecting a disk
Drag the disk's icon onto the Trash can. Or click the disk icon
(once) and choose Put Away from the File menu.

Copying a file onto a disk

Troubleshootin9 Ke1J.strokes
(Chapter 18 has the detaifs)

Drag the icon (below left) onto the disk's icon (below right). and
let go.
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The Mac is frozen, but cursor moves: Press 00-0ption-Esc and
then click the Force Quit button. (Works about half the time.
Other times, read on.)
The Mac has crashed or locked up: Restart by holding
00-Control and then pressing the power key (the key with
the triangle).
All icons appear blank: As the Mac starts up, hold down
00-0ption. When asked to rebuild desktop, click OK.

Alternatively, you can drag the file into the disk's window, instead
of on top of the disk's icon.

A weird problem keeps recurring: As computer starts up, press
Shift until you read "Extensions Off." Only basic functions work
now (no faxing, no screen saver). but the Mac runs clean and
pure. See Chapter 18 to finish the troubleshooting; this trick at
least gets you into your Mac.
You're panicking: Call 800-SOS-APPL.
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Workin9 with Sef/eral Pro9rams
The Mac lets you run more than one program at once. If you keep
launching programs, eventua lly you'll be told you're out of
memory. Until then, here are some pointers.

Determining what programs are running
Put the cursor on the icon in the far upper right of your screen,
and hold down the mouse button.
The Application menu drops down, listing all the programs you've
launched. The frontmost one, the one you're working in, is
indicated by a check mark.
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They call this box a dialog box because the Mac is asking
questions it needs answered. Here are the elements of a typical
dialog box.

Hide Finder
Hide Others
Shom All

./ [J

What All These Little Controls Do:

Radio buttons

Finder

O Best

Print Quality:

@Norma l

O Draft

~ SimpleTeHt

Quitting programs to free up memory
1. Use your Application menu, as illustrated in the previous item, to
choose the program's name.

2. Choose Quit from the File menu.

Named after the pushbuttons on a car radio, where only one
can be pushed in at a time. Likewise, only one Mac radio button
can be selected at a time.

Checkboxes
181 Clean

Workin9 with Mac Windows
Opening or closing a window

Text fields
O From:

Every window was once an icon that you double-clicked to see
what was in side.
1. Double-click any icon to open its window.
2. To get rid of a window, click the close box in the upper-left corner.

ink cartridge before printing

Used to indicate whether an option is on or off. Click once to
place the X in the box; click again to remove the X (and turn off
the option).

D

To:
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You're supposed to type into these blanks. To move from one
blank to another, eithe r click with the mouse or press the Tab key.

Pop-up menus
PaperType:~I_P_l_a_in~~~~_...
_,I

Moving a window
Point to the window's striped title bar(where the name of the
window appears). Hold the mouse button down, and drag the
window into a new position .

When you see this, you're seeing a pop-up menu. Point to the
text, hold down the mouse button, and make a selection from the
mini-menu that drops down.

Buttons

Bringing concealed icons into view
Sometimes a window is too small to show you all the icons within it.
If that's the case, you'll see gray scroll bars along the bottom or
right side.
1. Point to one of the small arrows on the scroll bar, and press the
mouse button continuously (below, left).
Your view of the window slid es in the direction of the arrow,
showing you what's hidden beyond the edges (below, right).
.::.13~
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Every dialog box has a clearly marked button or two (usually OK
and Cancel) that make the box go away-yo ur escape route.
Cl ick DK (or Print, or Proceed, or whatever the button says ) to
proceed with the command you origi nally chose from the menu.
Click Canc el if you wantto back out of the dialog box, as thoug h
you'd never issued the command .
See the thick black outline around the Print button above? You
don't have to use the mouse to click that button; you can press
eithe r the Return or Enter key on your keyboard instead.

B0
_L'l ei

2. To make the window as large as necessary to view all the icons
(limited by scree n size). click the zoom box, as shown by the
cursor here:
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Includes advanced treatment of these topics:
+ Invoking the commencement of NC 120V electric power to the CPU unit
+Propelling the cursor-control module on a horizontal plane
+ Insertion and removal of magnetic-oxide data storage media

Look, we use the word Dummies on the cover with
affection and a twinkle in the eye. Still, we
understand if you're not thrilled about leaving a
book on your desk called Macs For Dummies.
We hear you. And we've got the perfect solution:
just rip off the real cover of the book! This phony
cover will be all thats left. Leave it on your desk in
plain sight, so everybody will know what a
computer whiz you are.
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Are youJnt!mid!;!~~and confused by computers? Do you ijnd
thaftr!;!ditional,m~f:lualsare overloaded with techni.caldetails
you'lt n~ver use?. .Yct.!Jr' friends and ~mily always .c'aH you to
fix simple problemsi}n;ttfleir PCs? Then me .. .For Dummies~
compUter boQJc.:S.f!ri~~ from .IOG Books Worldwide i~ for you•

tro

. . .For Dummies books are W..i.tten for th&;~i~strated computer users who know they

. :.
aren't really dumb but find that PC hardware,;:$i;>flWare, and indeed the unique vocabulary of·····
computing make them feel helpless. . . .ForDummif)S books use a lighthearted approach,
a down-to-earth style, and even cartoons and.humorous i~ons to diffuse computer novices'
fears and build their confidence. Lighthearteq but not lightweight, these books are a perfect
survival guide for anyone forced to use a coril~~er.

like my copy so much I told
friends; now they bought copies.,,
11
/

Irene C., Orwell Ohio

auick, concise, nontechnical
and humorous."
11

Jay A., Elburn, Illinois
Thanks, I needed this book. Now I
can sleep at night"
1

Robin E, British Columbia, Canada

Sll:~edte~ders

Already, hundreds of thtlusandsof
.agree. They have made •• •For D#lmmies b~~11te
#1 introductory level computer book seri~ a~cl.have
written asking for more. So, if you're lookb)g.for the
most fun and easy way to leamabout computers,
look to •• •For Dummies bookS to give you
.helping hand.
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About the Author
Ohio-bred David Pogue never touched a computer - nor wanted to - until
Apple Computer suckered him into it by selling Macs half-price at Yale, from
which he graduated summa cum laude in 1985. Since then, Pogue has merged his
two loves - the musical theatre and Macs - in every way he could dream up:
by writing manuals for music programs like Finale; by being the computerconsultant guy for Broadway musicals; by teaching Mac music seminars around
the country; and by becoming the Mac guru to every Broadway and Hollywood
creative-type he could get his hands on - Mia Farrow, Carly Simon, Mike
Nichols, Stephen Sondheim, Gary Oldman, and others.
In his other life, Pogue is a straight-ahead theatre musician, having conducted
11/2 Broadway shows (the second one flopped out of town), played piano for OffBroadway productions, and composed a number of small-time musicals (such
as his wedding). In his other life, he's a magician and novelist (having written
Hard Drive, a techno-thriller named a "notable book of the year" by the New
York Times).

And in his other other life, Pogue is a Contributing Editor for Macworld magazine. His column, The Desktop Critic, appears in the magazine each month.
Pogue's resume also boasts some real accomplishments, like winning the Ohio
spelling bee in seventh grade, being the only nonlawyer in three generations,
and getting a Viewer Mail letter read on David Letterman.
He lives in Stamford, Connecticut.
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Foreword

1:

is certainly no surprise to me that l was asked to write the Foreword for this
book. After all, l was David Pogue's first dummy. When we met nine years
ago, I was an aging composer, wearily putting quill pen to parchment, surrounded by mountains of erasers. The world of computers was as foreign to me
as the craters of the moon.

Then along came Mr. Pogue, fresh from Yale, who guided me patiently and
painlessly into the joyful world of Macintosh. He made it all seem so simple. And
the Mac, my new friend, was helpful as well, with little admonitions like, "Are
you sure you want to do this?" or apologies like, "I'm sorry I can't find this. H
you find it for me, I promise I'll remember where it is next time." I was soon
convinced that this machine really cared about me. In a short time, I became a
mouse maniac.
Since then, I have written the scores for five musicals, three films, and countless
letters of complaint to my congressmen on this wonderful contraption, thanks
to my two wise, kind friends, David and the Mac.
In this book, you'll find many reminders, explanations, and shortcuts. Macs For
Dummies will stay by me at my desk. After all, once a dummy ...

John Kander
John Kander, with lyricist Fred Ebb, has written the scores for Cabaret; Chicago;
Zorba; New York, New York; and the Tony award-winning musical Kiss of the

Spider Woman.

Introduction
A Formal Welcome to the 20th CenturlJ
Something has driven you to learning the computer -your friends, your job, or
fate. In any case, you couldn't have chosen a better time; technology and price
wars have made computers comprehensible, affordable, and almost fun. The
Macintosh is the primary example.
In 1984, the ad people called the Macintosh "the computer for the rest of us."
The implication was that other computers were hard to learn. Previous computers required you to learn jargon, have technical skill, and memorize dumb
keyboard codes. The Macintosh was as simple as a toaster - nothing to
assemble, nothing to install, no manual to puzzle through.
And sure enough, the first Mac pretty much fit that description. Its factorysealed case meant that you didn't have to install any parts (like you do on IBMstyle computers). The first Macintosh wasn't expandable. It was a complete,
self-contained unit. You unpacked it and plugged it in. Like a toaster.
But Apple Computer learned about a funny catch-22 in the computer business.
The people who influenced computer sales (like computer magazines and
consultants) liked the jargon, the keyboard codes, the messy circuit board stuff!
These were people who prided themselves on having mastered the convoluted,
dim-witted design of pre-Mac computers ... people who not only didn't appreciate the simplicity of the Macintosh but actually resented it. In reviews, editorials, and interviews, the Powers That Were kept saying that the Macintosh would
never survive unless Apple opened it up. Let people expand it, customize it,
juice it up, just like IBM owners had been required to do for years.
Alas, that movement pushed the Mac out of its "computer for the rest of us"
mold. Suddenly, there were more models. The computer weenies who ruled the
press started imposing all their terminology and tech-talk on this poor little
machine. Macintosh user groups sprang up - they're everywhere now where you'd hear talk like, "How can I accelerate my 25 MHz SE/30 to get a
decent frame rate out of QuickTime two-point-oh?" or "How much RAM do I
need for virtual memory on my 80-meg Quantum?"
The Mac wasn't a toaster anymore.
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WhlJ. a Book for Dummies?
Today, the Mac sometimes seems almost as intimidating as the computers it
was supposed to replace. The way the magazines and techno-nerds throw
jargon around, you'd think the Mac was the private property of the dweeby
intelligentsia all over again.
It's not. You hold in your hands a primal scream: "It's not as complicated as they
try to make it sound!" Really, truly, almost everything said by the computer
whizzes of the world is more complicated than it has to be. (Ever study psychology? A person who uses jargon where simple English would do is trying to
underscore the listener's ignorance.)
This book is designed to help you

I

Y' Translate the tech-talk into useful information
Y' Weed out the stuff you'll never need to know
Y' Navigate the hype when it comes to buying things
Y' Learn the Macintosh and get useful things done

By the way, of course you're not a dummy. Two pieces of evidence tell me so: for
one thing, you're learning the Mac, and for another, you're reading this book!
But I've taught hundreds of people how to use their Macs, and an awful lot of
them start out saying they feel like dummies when it comes to computers.
Society surrounds us with fast-talking teenagers who grew up learning English
from their Nintendo sets; no wonder the rest of us sometimes feel left out.
But you're no more a dummy for not knowing the Mac than you were before
you knew how to drive. Learning the Mac is like learning to drive: after a lesson
or two, you can go anywhere your heart desires.
So when we say Dummies, we're saying it with an affectionate wink. Still, if the
cover bothers you even a little - I'll admit it, you wouldn't be the first - please
rip it right off. The inner cover, we hope, will make you proud to have the book
laying out on your desk.

How to Use This Book
(Other Than as a Mousepad)
If you're starting from the very, very beginning, read this book from the end with Appendix A, where you can find out how to buy a Mac (and which one to
get) without getting scammed. It also contains an idiot-proof guide to setting up
your computer.

________________________ Introduction
Chapter 1 assumes that you do, in fact, have a Mac, and that it's been plugged
in. You'll find out how to tum it on and off, for starters. In 10 minutes (or 20 if
you're trying to watch TV simultaneously), you'll have mastered the raw basics
of driving your Mac.
Then there's something, if you'll forgive me, called Chapter 11/2. It's my attempt
to play down the technical nature of the topic - the difference between
memory and disks - by not devoting a full scary chapter to it.
Chapter 2's a Mac lesson for the absolute beginner: how to use the mouse
(and what a mouse is), how to use menus - that kind of thing. In Chapter 3,
you'll do some actual work, using actual software, solving an actual problem;
Chapter 4 follows with a word processing lesson that won't destroy your
self-esteem.
Once you've got your ideas typed into the computer, you'll want to print your
work; that's one of the Mac's strong suits. Chapter 5 lays bare the mysteries of
printing and using typefaces.
Chapter 6 is the all-important "Faking Your Way Through the Top Ten Programs," an indispensable guide for anybody who wants to look cool without
actually expending any effort. Chapter 7, on the best-selling Mac program
ClarisWorks, just got too darned big to fit into Chapter 6. And speaking of
software, Chapter 8 explains those icons inside the all-important System Folder
and attempts to answer man's primal question: "What is all that junk?" Before
you graduate from beginnerhood, this part of the book ends with Chapter 9,
"Screamingly Important Things Nobody Tells You." It reveals everything you
need to survive a day-to-day Mac existence - but that people expect you to
learn the hard way.
In Chapter 10, you find out how to fake your way onto America Online, the
Internet, and the Web, so you'll finally be able to, for example, find out the
cricket scores in Tanzania whenever the urge strikes you. By the time you get to
Chapter 11, you'll be ready to start sailing with a priceless potpourri of sizzling
shortcuts. Then, in Chapter 12, you get to read about all the expensive equipment you can plug into the Mac: modems, scanners, CD-ROM, and all that good
stuff. Finally, in Chapter 14, you'll see what this "multimedia" thing is all about,
in which the Mac talks, sings, plays movies, and teaches Spanish at the local
YMCA.
If you were clever enough to buy a Performa - a special breed of Macintosh

that comes with preinstalled software - then Chapter 15 has your name on it.
Likewise, for the peripatetic among us, PowerBook owners will thrill to the
insights of Chapter 16. And if you've bought a Power Mac, it requires special
care and feeding (Chapter 17).
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Good Machines," the mother of all troubleshooting sections. Read Chapter 19
when the stuff in this book is starting to seem old hat, and you're ready to push
off into the wider world of computing, and when you're willing to sink still more
money into your Mac - to upgrade it. (There is no Chapter 13, for the same
reason -whatever it may be - that there's no Floor 13 in office buildings.)
The book winds down with Appendix B, the Resource Resource (which has
contact info for a number of important Mac companies and organizations),
and Appendix C, the Techno-Babble Translation Guide. (You'd probably call it
a glossary.)

Macintosh conflentions
Macintosh conventions? Sure. They're called Macworld Expos, and there's one
in Boston and one in San Francisco each year.

Conflentions in this book
Oh, that kind of convention. First, I'm going to satisfy those beginners who have
a recessive geek gene in their DNA, those who actually want to learn more
about what's going on under the hood, with occasional sidebars on technoid
topics. They'll be clearly marked with titles like "Stuff you'll never need to
know." Unless you're actually interested, rest assured that you can live a rich
and rewarding life without ever reading a word.
Second, so that we'll be eligible for some of the more prestigious book-design
awards, I've marked some topics in the main text with these icons:
Nerdy stuff that's OK to skip but will fascinate the kind of people who read Tom
Clancy novels.

~ The Macintosh is the greatest computer on earth, but it's still a computer. Now
and then it does unexplainable stuff, which I'll explain.

The former Speaker of the House. Also a shortcut so you can show off.

Denotes an actual You-Try-It Experience. Hold the book open with a nearby
cinder block, put your hands on the computer, and do as I say.
:-ttHOLo

~r;~~ Indicates a deep glimpse into the psychology of Mac users: why people who
already know how to use the damn things, for example, love to intimidate
~
people who don't.

:: IJ

Wh1JaMac1
H there's one single atom of computer phobia in your bloodstream, but you

need a computer, get a Macintosh. Trust me. And trust the 22 million former
computerphobes who are now happily computing away on Macs.

A confirmation of IJ.OUr taste and intelli9ence
You've heard it a thousand times: the Macintosh is the most user-friendly
computer. But what does that mean? In concrete terms?
For one thing, you have a lot less to install and set up. When you buy an IBMtype computer, for example, you spend your first weekend hunched over an
open computer case filled with wiring. You squint at the manual that's filled
with techno-babble and get depressed that you, a well-educated, perfectly good
English speaker, can't understand the first thing it's saying. With a Macintosh, of
course, you basically just plug it in and press the On switch.
And another thing: you have a lot less to memorize when you use a Macintosh.
Because the commands are all listed on the screen, you don't have to remember that Control-Alt-Escape-semicolon is the Print command. In the IBM world,
of course, every single program has different commands in different places with
different keys you press to activate them. Out of 10,000 Macintosh programs,
there are probably five that don't have exactly the same major commands in
exactly the same places with exactly the same keyboard shortcuts.
There are a bunch of other reasons you've done the right thing to go for the
Mac - the screen looks .better, it's easy to expand, it's the easiest to learn, and
it has all kinds of built-in high-tech goodies, like sound, CD-ROM, and networking, that you'd have to pay extra for (and install) if you had any other computer.
Of course, the last reason that a Mac is superior is that it's superior; it entitles
you to gloat about owning the world's most hip, technologically evolved,
shrewd computer.
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Apple and obsolescence
Apple is the gigantic Silicon Valley computer company that started out as a
couple of grungy teenagers in a garage. Each time Apple introduces a new
Macintosh model, it's faster, more powerful, and less expensive than the model
you already bought. People love Apple for coming up with such great products but feel cheated at having paid so much for a suddenly outdated machine.
Feel whatever you want, of course. But if you're going to buy a computer, accept
the fact that your investment is going to devalue faster than real estate in Three
Mile Island.
Here's a promise: No matter how carefully you shop or how good a deal you get
on a Macintosh today, your model will be discontinued by Apple within a year.
(It'll still work just fine, and be more or less up-to-date, for about five years.)
Yeah, I know - it's a cruel, irritating fact, but it's a fact nonetheless.
With that quick and inevitable computer death looming, how can people psych
themselves into laying out $2,000 for a computer? Simple: They believe that in
those few short years, the computer will speed them up enough, and enhance
their productivity enough, to cover the costs easily.
That's the theory, anyway.

·.tfie 5th WMe ( . . . .·. •. e··· Rich Tennant
~

In this part ...

~ere are three general ways to learn how to work your

I

~ac. You can prevail upon the good graces of your local
computer dealer, who, having pocketed your money already,
would just as soon have you blow away. You can read the
manuals, which have about as much personality as a walnut.
Or you can read a book like this one. (Then again, no book
is quite like this one.)
Tough choice, huh?
In this part, you'll learn, as kindly and gently as possible,
what you need to know to get up and running on your Mac
system - and nothing else.

Chapter1

How to Turn On Your Mac
(And What to Do Next)
In This Chapter
fill>- How to turn your Mac on (and off)
fill>- Confronting weird new words like mouse and

menu

li!Si- Doing windows
f/i'> Mindlessly opening and closing folders

1:

you haven't bought a Mac yet, go immediately to Appendix A. Don't speak
to any salesperson until you've read it.

H you have bought a Mac, but it's sitting in cardboard boxes on your living-room
floor, read the second half of Appendix A, where you'll be gently guided through
the not-harrowing-at-all experience of plugging everything in.

At this moment, then, there should be a ready-to-roll Mac on your desk and a
look of fevered anticipation on your face.

Box Open. Now WhatJ
Switching the Mac on
In this very first lesson, you'll be asked to locate the On button. To keep life
interesting, Apple has decreed that This Switch Shall Be in a Different Place on
Every Different Mac Model. Fortunately, after you locate yours, it'll pretty much
stay in that spot for as long as you own your Mac.

]0
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You can find the power switch in five possible places. Here goes:
A keyboard button

Every Mac keyboard has this key in the upperright corner. It has a left-pointing triangle on it

On most of the world's Macs, this key turns the
machine on. If yours doesn't, you must have
one of the other on-switch locations.
Back-panel switch

Feel around on the ends of your Mac's back
panel. On many Macs, especially smallish or
inexpensive ones, there's a plastic rocker
switch back there.
If you look atthis switch, the On position is
marked by a straight line, and the Off position is
marked by a circle . Nobody can ever remember which is which. You may want to think of it
this way: the 0 stands for Off. (Of course, it also
stands for On . . . and they wonder why people
are intimidated by computers?)

Round front-panel button

A.few models whose model numbers begin
with a 6(6JO, 6100, 6115, a d so on) have a
round nub of an On/Off button on the front
panel, on the right side.

Back-panel pushbutton

Only PowerBook laptops have this button. If
your model number begins with a 1, you have
to flip open the back panel, which is a pain.
You'll then see the round, concave power
button. (If your PowerBook model number
begins with a 5, you turn it on with the trianglelabeled key on your keyboard.)

Keyboard pushbutton

PowerBook Duos only. It's the rubber capsuleshaped button on the keyboard. (An identical
button is on the back.)

Was your hunt for the elusive On Switch successful? Then turn the Mac on! You
should hear a ding or a chord, and after a few seconds, an image appears on the
screen.
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The startup slide show
If the computer does, in fact, have power, you're in for a treat: you get to

witness the Macintosh Startup Slide Show, revered by millions. First, you see a
quick glimpse of the smiling Macintosh. It looks like this:

(In the rare event that your smiling Macintosh looks like this -

- your monitor is upside-down.)
Next slide: the words "Welcome to Macintosh" (or "to Power Macintosh")
appear.
Next slide: if yours is a fairly recent model, you see the famous Mac OS logo,
looking like Picasso's portrait of a schizophrenic:
\

Mac OS
During this time, the bottom of your screen fills with little inch-tall pictures. In
Macintosh lingo, the term for "little inch-tall pictures" is icons. These particular
icons represent the different features of your Mac, each turning itself on and
preparing for action: one represents your CD-ROM drive, another's for your fax
software, and so on. Much, much, much more about these startup-item
doodads in Chapter 8.
At last, the gray or tinted full-screen pattern, called the desktop, appears.
Congratulations! You've arrived.
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If you saw anything else during the startup process - such as a blinking

question-mark icon, a strange error message, or thick black smoke -you've
just met your first computer problem. Proceed directly to Chapter 18, "When
Bad Things Happen to Good Machines." This problem and many others are
explained - and solved - for you there.

Your First Moments Alone To9ether
As any gadget lover can tell you, the most exciting period of appliance ownership comes at the very beginning. You're gonna love this stuff.

The bi9 turn-off
Before we get into 3-D color graphs, space-vehicle trajectories, and DNA
analysis, maybe you'd better learn how to turn the Mac off.
You can cut the power, of course. If your model has a back-panel rocker switch,
you could hit that. Otherwise, your Mac has a round, slotted, pea-sized power
button on the back.
But turning off the Mac by chopping off its power is a no-no, according to Apple
(although I've never heard of it hurting anything). The preferred method is to
use the Shut Down command; we'll get to that in a moment.

Mot1in9 the mouse
The mouse is the gray, soap-sized plastic box on the desk beside your keyboard. Having trouble visualizing it as a rodent? Think of the cord as its tail, and
(if it helps you) draw little eyeballs on the sloping side facing you.
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Now then, roll the mouse across the desk (or mouse pad), keeping the cord
pointed away from you. See how the arrow pointer moves across the screen?
For the rest of your life, you'll hear that pointer called the cursor. And for the
rest of your life, you'll hear moving the mouse called moving the mouse.
Try lifting the mouse off the desk and waving it around in midair like a remote
control. Nothing happens, right? The mouse only controls the cursor when it's
on a flat surface. (A ball on the bottom of the mouse detects movement and
moves the cursor accordingly.) That's a useful feature - it lets you pick up the
mouse when you run out of desk space, but the cursor will stay in place on the
screen. Only when you set the mouse down and begin to roll it again will the
cursor continue moving.
If you have a PowerBook, by the way, you don't have a mouse. Studies have

shown that rolling a gray, soap-sized plastic box across the thigh of the guy next
to you on the airplane can have, ergonomically and socially speaking, unpleasant results. Therefore, you've been given, instead, either a trackball (essentially
an upside-down mouse) or a trackpad. The principle is the same: roll your
fingers away from you, and the cursor moves up the screen. Instead of a square
mouse button, you have one or two jumbo buttons nestled against the ball or
pad. (If you've got two buttons, they're identical in function.)
I won't mention this distinction again, because if you're smart enough to have
bought a PowerBook, you're smart enough to translate future references to the
mouse into trackball or touchpad terms.

What's on the menu?
Let's try some real computing here. Move the cursor up to the white strip at the
top of the screen. It's called the menu bar, named after a delightful little pub in
Silicon Valley. Touch the arrow on the word Special.

' s

File

Edit

Uiew

Label

Special

Pointing to something on the screen in this way has a technical term: pointing.
(Think you're going to be able to handle this?)
Now put your index finger on the button on the mouse and press the button
down. Hold the button down. Don't let go.
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Special, as shown in the following figure. Keep holding down the button.

,.
Clean Up Window
Empty Trash
Eject Disk
Erase Disk •••

~E

Restart
Shut Down

Congratulations -you've learned how to click the mouse (by pressing the
button), and you've also learned to pull down a menu (the list of commands).
Try letting go of the mouse button; the menu disappears.

Shuttin9 down
Click the word Special (hereafter known as the Special menu) again. This time,
when the list of commands appears, keep the button pressed and roll the
mouse downward so that each successive command turns black. In Mac jargon,
you're dragging the mouse (moving with the button pressed). And when each
menu command turns black, it's said to be highlighted.
The only commands that don't get highlighted are the ones that are dimmed, or
"grayed out." They're dimmed because they don't make any sense at the
moment. For example, if no disk is in the floppy-disk drive, choosing Eject Disk
wouldn't make any sense (and it wouldn't work, either). So the Mac makes that
command gray, which means it's unavailable to you.
Roll the mouse all the way down to the words Shut Down so that they're
highlighted.
If you've had enough for one session, release the mouse button - the Mac

turns itself off completely. (Unless your particular model has a physical on/off
switch; in that case, the screen will now tell you to flip the switch off.)
Hey, you've only read a few pages, and already you can tum your Mac on and
off! Told you it was no harder than a toaster.
If your thirst for knowledge is unquenched, and you want to slog ahead with

this lesson, then don't let go of the button yet. Instead, slide the cursor off the
menu in any direction, and then let go of the mouse button. The menu snaps
back up like a window shade and nothing else happens. (A menu command only
gets activated when you release the mouse while the cursor is on a command.)
When you're ready to forge forth, read on.
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The Shut Down nobody knows
Depending on when you bought your Mac, you
may have a second, more convenient Shut Down
command. It's tucked away in a menu you may
not even have recognized as a menu - the
Apple logo atthe upper-left corner of the screen.
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File

Edit

Uiew

File Edit Uiew Label
Rbout This Macintosh ...

I§ RppleCD Rudio Player

0

Calculator
~Chooser
c;;;:i Control Panels

~ Find File
~ Jigsaw Puzzle
Key Caps
i;:J Note Pad

GJ
Click that logo (hereafter called the S menu);
hold the mouse button down; and check out the
last command. See if it's called• Shut Down.

~Scrapbook

~Stickies

'"] • Shut Down

If so, you have a relatively new Mac. My suggestion: get into the habit of using this Shut Down
command, the one in your Apple menu, rather
than the one in your Special menu. It's a long
story; trust me that you'll have fewer problems
using the one in your S menu.

Moflin9 thin9s around on the desktop
Take a look around the Mac screen. You've already encountered menus (those
words File, Edit, View, and so on at the top of the screen). Near the upper-right
corner of the screen, you see an icon (remember? - a small symbolic picture).
If your Mac is brand new, that icon is called Macintosh HD.
Icons represent everything in the Mac world. They all look different: one
represents a letter you wrote, another represents the Trash can, another
represents a floppy disk you've inserted. Here are some examples of icons you'll
probably be seeing before long:

You can move an icon by dragging it. Try this:
1. Point to the Trash icon.
2. Drag it to a new position (move the mouse while the button's down).

15

16

Part I: For the Absolute Mac Virgin _ _ _ _ _ _ _ _ _ _ _ _ _ __
Hey, this thing isn't so technical after all, right?
Other than the fact that there's a Trash can, nobody's really sure why they call
this "home-base" screen the desktop. It has another name, too: the Finder. It's
where you file all your work into little electronic on-screen file folders so you'll
be able to find them again later.
Used in a sentence, you might hear it like this: "Well, no wonder you don't see
the Trash can. You're not in the Finder!"

Icons, windows, and Macintosh SIJ.ntax
Point to the hard-disk icon (a rectangular box, probably called Macintosh HDfor Hard Disk) in the upper-right corner of the screen.

This particular icon represents the giant disk inside your Mac, known as the
hard drive or hard disk, that serves as your filing cabinet. It's where the computer stores all your work, all your files , and all your software.
So how do you see what's in your hard drive? Where do you get to see its table
of contents?
It turns out that any icon can be opened into a window, where you'll see every
item inside listed individually. The window has the same name as the icon
you opened.
Before we proceed, though, it's time for a lesson in Macintosh syntax. Fear not;
it's nothing like English syntax. In fact, everything you do on the Macintosh has
this format: noun-verb. Shakespeare it ain't, but it's sure easy to remember.
Let's try a noun-verb command, shall we?
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I. Click the hard-disk icon in the upper-right corner of the screen.

The icon should turn black, indicating that it's selected. Good job -you've
just identified the noun.
2. Move to the File menu and choose Open.

OON
. I

Print
*P
Close Window oow

001

Get Info
Sharing .• •
Duplicate
Make Alias
Put Away

~o

Find ...
Find Again

OOF
OOG

OOY

Page Setup ...
Print Desktop ...

You guessed it - Open is the verb. And, sure enough, your hard disk opens
into a window, where you can see its contents.

Macintosh HO
187 .8 MB in disk

4 items

~
~

System Folder

~

Simple Text

44 .1 MB available

LJ

Clar-isW'or-ks

Macintosh Basics

Did any of that make sense? In the world of Macintosh, you always specify what
you want to change (using the mouse), and then you use a menu command to
specify how you want it changed. You'll see this pattern over and over again:
select something on the screen and then apply a menu command to it.
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Look over the contents of your hard-drive window. See the following figure.
(Everybody's got different stuff, so what you see on your screen won't exactly
match these illustrations.) You can do all kinds of neat things to a window.
They're worth learning - you're going to run into windows everywhere after
you start working.
ZOOM BOX - Click here to
make the window large enough
to show all its contents.

CLOSE BOX - Click here to close
the window. It's the same as
choosing Close from the File menu.

TITLE BAR - Drag anywhere in this
striped area to move the entire window.

l

-

Macintosh HD
471.4 MB in disk

6 items

LJ

Applications

~

~

I

t--- VERTICAL SCROLL BAR- It's white,
indicating that you're seeing everything
in the window (top to bottom).

Simple Tex t

Sy stem Folde-r

_l

~

LJ

LJ

App le Ex tras

Macintosh Basics

~_::_

441 .8 MB av ail ab le

z

'{}
'..=-

:2:'.i

j_~ ~t--

SIZE BOX- Drag in any direction to
make the window bigger or smaller.

HORIZONTAL SCROLL BAR- It's gray,
indicating that you're not seei ng everything
in the window (there's something off to the
side). You can drag the little square from side
to side to adjust your view of the window.

Go ahead and try out some of the little boxes and scroll bars. Click them. Tug
on them. Open the window and close it again. No matter what you do, you can
never hurt the machine by doing "the wrong thing. "That's the wonderful thing
about the Macintosh: it's the Nerf appliance.
Now try this. Make sure your hard-drive window is open. See the System
Folder? Even if you don't, here's a quick way to find it: quickly type SY on your
keyboard.
Presto, the Mac finds the System Folder (which happens to be the first thing
that begins with those letters) and highlights it, in effect dropping it in front of
you, wagging its tail.

All SIJ.stems are fl.O
If nothing happened when you typed SY, your Mac's probably really old; it may
not be using the famous behind-the-scenes software known as System 7 or
System 7.5. Absorb the wisdom of Chapter 8 if you care what this means.
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However, it is worthwhile to know what version of this scrcalled "system
software," or "OS" (for operating system), your Mac uses. Fortunately, finding
out is easy.
Get a pencil.
Remember the S logo in the upper-left corner of the screen? As you may recall,
it's no ordinary logo. It's actually a menu, just like the ones you've already
experienced. Point your arrow cursor tip on the apple, hold the button down
continuously, and watch what happens.
As with any menu, a list drops down. This one, however, has an extremely
useful command. This command is so important that it's separated by a dotted
line from the mere mortal list items after it. It's About This Macintosh.

Slide the pointer down until About This Macintosh turns black, and then release
the mouse button. A window appears:
~

liiJ

About This Macintosh
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As the preceding figure indicates so subtly, this window reveals what version of
the System software you have. The version is either 6-point something or 7point something. (It may even be 7-point-something-point-something, indicating
that Apple uses a math even newer than New Math.)

In any case, the version is a number you'll need to know later in this book and
later in your life. Therefore, take this opportunity to write it onto your Cheat
Sheet (the yellow cardboard sheet inside the front cover). You'll find a little
blank for this information in the upper-left corner of your card, where it says
"Your System version."
(When you're finished with this little piece of homework, close the About This
Macintosh window by clicking the little square in the upper-left corner - the
Close box - to make it go away.)
The main question is: do you have System 7 (-point anything) or System 6
(-point anything)? The answer will make a big difference, both to your understanding of this book and to your ability to get dates at computer-club meetings.
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I'm going to assume that you're using System 7 (or 7-point-something). If your
Mac is really old, and you've got System 6, watch for special notes that refer to
the differences between the two systems.

Double-clickin9 in theorlJ. and practice
Anyway, moving on: try pressing the arrow keys on your keyboard - right, left,
up, down. The Mac highlights neighboring icons as you do so.
Suppose that you want to see what's in the System Folder. Of course, using your
newfound noun-verb method, you could (1) click the System Folder to select it,
and then (2) choose Open from the File menu.
But that's the sissy way. Try this power shortcut: point to the System Folder
icon so that the tip of the arrow cursor is squarely inside the picture of the
folder. Keeping the mouse still, click twice in rapid succession. With stunning
originality, the Committee for the Invention of Computer Terminology calls this
advanced computing technique double-clicking.
If all went well, your double-click opened a new window, showing you the
contents of the System Folder. (If it didn't work, you probably need to keep the

mouse still or double-click faster.)
Remember this juicy golden rule: Double-click means "open. "
In your Mac life, you'll be asked (or tempted) to click many an item on-screen:
buttons that say "OK"; tools that look like paintbrushes; all manner of multiplechoice buttons. In every one of these cases, you're supposed to click once.
Only when you want to open something do you double-click. Got it?

Multiple windows
Now you should have two windows open on the screen: the hard-disk window
and the System Folder window. (The System Folder window may be covering
the first one; they're like overlapping pieces of paper on a desk.)
Try this: Click the title bar of the System Folder window (just one click; remember that double-clicking is used exclusively for opening something). Drag the
title bar downward until you can see the hard-drive window behind it. See the
following figure.
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Macin tos h HO
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You can tell that this window is in
back because its title bar is white.
Just click anywhere in the
window to bring it to the front.
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--Take a stress-free moment to experiment with these two windows: click the
back one to bring it forward; then click the one that was in front to bring it to
the front again.
If you need any more help fooling around with these windows , the Macintosh

manual has a complete tutorial.

Usin<J a list fliew
There's one more aspect of windows that will probably make Type A personalities
wriggle with delight. Up 'til now, you've been viewing the contents of your disk
as a bunch of icons. Nice, but wouldn't it be neat to see things alphabetically?
I. Make sure the System Folder is the active window (the one in front; "A."
in the following figure).
We're going to use the System Folder because it's got a lot of stuff in it.
Next, you're going to use a menu. Remember how to choose a menu
command? Point to the menu's name and hold down the mouse button.
2. Locate the View menu at the top of the screen. From it, choose By Name
(''B." in the upcoming illustration).
Suddenly, the big icons are replaced by a neat alphabetical list of the
window's contents (upcoming figure, "C.").
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The easiest homework IJ.OU fle er/er had
1

To reinforce your budding mouse skills, here's a pathetically easy assignment.
Find the icon in your hard-drive window called either Macintosh Basics or
Mouse Practice. (If the icon isn't sitting there in your hard-drive window in
plain sight, try using the Find command, as described in Chapter 4. And if you
still can't turn it up, don't sweat. I'll try to hit most of the same points as we
go along.)
Macintosh Basics (or whatever it's called on your system) is a clever, animated
introduction to the Mac, and it shows you America's favorite computer skills
(the ones you just learned): pointing, clicking, and dragging.
Here's how you use the Macintosh Basics program:
1. Open the Macintosh Basics folder, if necessary, by pointing to it and
double-clicking.

2. Point to the little Macintosh Basics man and double-click that.
From there, just follow the instructions on the screen. Turn down the corner of
this page, and pick up here when you're ready to go on. By the time you finish,
you 'II have earned your MMA- Master of Mouse Activity.

_ _ _ _ _ _ _ _ Chapter 1: How to Turn On Your Mac (And What to Do Next)

Invasion of the little triangles
When you view a window's contents in a list,
each folder within the window is marked by a
tiny triangle. The triangle points to the right
You can open one of these folders-within-thefolder in the usual way, if you wish- by doubleclicking. But it's much more satisfying for neat
freaks to click the triangle instead. In the following figure, the before-and-after view of the Control Panels folder (inside the System Folder)
shows how much more organized you can be.

D

One more trick: See the words Size, Kind, and so
on (at the top of the window)? Click any of these
words. Instantly the Mac re-sorts everything in
the window, based on the word you clicked.
Example: Click Size, and you'll see the largest
files listed first.
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When you click the triangle, in other words,
your window contents look like an outline. The
contents of that subfolder are indented. To
"collapse," or close, the folder, click the downward-pointing triangle.
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Pit stop
Shut the Mac down now, if you want (by choosing the Shut Down command
from the Special menu - but you knew that). Chapter 11/2 is something of a
chalk-talk to help you understand what's really happening inside the computer's
puny brain.

Top Ten Similarities Between You
and Your Mac
Before you move boldly forward to the next chapter, ponder the following
frightening similarities between you and your computer.
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Part I: For the Absolute Mac Virgin - - - - - - - - - - - - - - 1. Both weigh between 5 and 15 pounds when first displayed in public.

2. Both have feet on the bottom.
3. Both have slots to provide adequate ventilation of the innards.
4. Both react to the movement of a nearby mouse.
5. Both sometimes crash when asked to do too much at once.
6. Both have a central button.
7. Both light up when turned on.
8. With considerable effort, both may be made to work with IBM computers.
9. Both may be connected to a phone line for days at a time.
10. Both have a built-in 1.4MB SuperDrive. (Well, OK, you probably don't, but
you don't want to be exactly like your computer, do you?)

Chapter 11/2

High-Tech Made Easy
In This Chapter
~

How disks and memory work
~ A floppy disk is neither floppy nor a disk. Discuss.
~ Making the distinction between floppy and hard disks
~ Why you'll never lose work to a computer glitch
~What

to remember about memory

How a Mac Works
I'm a little worried about sticking this chapter so close to the front of the book.
Plenty of people firmly believe that the Mac has a personality - that when
something goes wrong, the Mac is being cranky; and when a funny message
appears on the screen, the Mac is being friendly. Don't let the following discussion of cold, metal, impersonal circuitry ruin that image for you; the Mac does
have a personality, no matter what the wireheads say.
For the first time, you're going to have to roll up your brain's sleeves and chew
on some real, live computer jargon. Don't worry-you'll feel coolly professional and in control by the time it's over. And it's a short chapter. Only half a
chapter, really. That should make it easier to contemplate reading pages of
chalk-talk.

StoriniJ thin9s with flopplJ disks
Human beings, for the most part, store information in one of two places. Either
we retain something in our memory - or, if it's too much to remember, we write
it down on the back of an envelope.
Computers work pretty much the same way (except they're not quite as handy
with envelopes). They can either store what they know in their relatively peabrained memory, which I'll cover in a moment, or they can write it down. A
computer writes stuff down on computer disks.
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The most common kind of disk is the floppy disk. Ironically, the Mac's floppy
disks aren't floppy, and they're not disks. They're actually hard plastic squares,
31/2inches on a side.
Inside the protective hard shell, though, there's a circle of the same shiny
brown stuff that cassette tapes are made of. (I suppose that means a floppy
disk is really in there.) Anyway, instead of recording a James Taylor song or a
Bruce Willis movie, as audio or videotapes would do, the computer records
your documents: notes for your novel, your latest financial figures , or a fan
letter to Hootie & the Blowfish.

INSIDE A DISK

Protective liner

•

1 111ill

1

Sector
Track

Opening a disk's case reveals the
floppy disk it protects. What you
can't see is how the disk is divided
into concentric rings, or tracks,
containing sectors that store your
data and programs.

Floppy disks come in several capacities,
but even the largest one holds only about
1,000 pages' worth of data. That may seem
like a lot, but that's just text. Pictures, for
instance, take up much more space; that
same floppy disk can probably only hold
one or two color pictures. You can see,
then, that floppies aren't very handy for
storing lots of information.

Conceptualizin9
the hard disk
Every Mac made since 1987 has an even
better storage device built inside it - a
hard disk. The concept of a hard disk
confuses people because it's hidden inside
the Mac's case. Since you can't see it or
touch it, it's sort of conceptual - like
beta-carotene or God, I guess. But it's
there, spinning quietly away, and a hefty
chunk of your Mac's purchase price pays
for it.
Hard disks differ from floppy disks in a few
critical ways. A hard disk delivers information to the computer's brain about ten
times faster, holds about 500 times more,
and costs about 500 times as much.
(Floppies are dirt cheap.)
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Why all this talk of disks? Because a hard disk is where your life's work is going
to live when the computer is shut off. You will, like it or not, become intensely
interested in the overall health of your computer's hard disk.

Understandin9 memorlJ
. OK. Now we get to the good stuff: how a computer really works. I know you'd
just as soon not know what's going on in there, but this is mental broccoli: it's
good for you, and later in life, you'll be glad you were forced to digest it. If, at
this point, your brain is beginning to hemorrhage, skip this section and find
serenity in Chapter 2.
There's actually a significant difference between a Macs memory and your
memory (besides the fact that yours is probably much more interesting). When
the Mac is turned off at night, it forgets everything. It becomes a dumb, metaland-plastic doorstop. That's because a computer's memory, just like yours, is
kept alive by electrical impulses. When you tum off a Mac, the electricity stops.
Therefore, each time you turn on a Mac, it has to re-learn everything it ever
knew, including the fact that it's a computer, what kind of computer it is, how to
display text, how many days until your warranty expires, and so on. Now we
arrive at the purpose of those disks we've been droning on about; that's where
the computer's knowledge lives when the juice is off. Without a disk, the Mac is
like someone with a completely hollow skull (and we've all met that type). If
you're ever unlucky enough to experience a broken hard drive, you'll see how
exciting a Mac can be without any disks: it shows a completely gray screen with
a small blinking question mark in the middle. (I've met a few people like tha~ too.)
When you turn on the Mac, there's whirring and blinking. The hard disk inside
begins to spin. When it hits about 3,600 rpm, the Mac starts reading the hard
disk - it "plays" the disk like a record player. It finds out: "Hey, I'm a Mac! And
this is how I display text!" and so on. The Mac is reading the disk and copying
everything it reads into memory. (That's why the computer takes a minute or
so to start up each day.)
Memory is really neat. After something's in memory, it's instantaneously
available to the computer. The Mac no longer has to read the disk to learn
something. Memory is also expensive; it's really a bunch of complicated circuits
etched onto a piece of silicon the size of a piece of Trident.
Because it's expensive, most people's Macs have far less memory than disk
space. For example, even if your hard disk holds every issue of National Geographic ever published, you're probably only going to read one article at a time.
So the Mac reads "African Tribal Women: Pierced Noses in the Desert" from

27

28

Part I: For the Absolute Mac Virgin - - - - - - - - - - - - - - your hard disk, loads it into memory, and displays it on the screen. So it doesn't
matter that your Mac's memory doesn't hold as much as your entire hard disk;
the hard disk is used for long-term, permanent storage of lots of things, and
memory is used for temporary storage while you work on one thing at a time.

You often hear computer jocks talk about megs. Only rarely are they referring to
Meg Ryan and Meg Tilly. Meg is short for megabyte. So is the abbreviation MB.
(Mega = 1,000,000 and byte = an iota of information so small it can only specify a
single letter of the alphabet.)
What's highly confusing to most beginners is that memory (fast, expensive,
temporary) and hard-disk space (permanent, slower) are measured in the same
units: megabytes. A typical Mac has 8 or 16 megs of memory (silicon chips), but
250 or 500 megs of hard-disk space (spinning platters).
With this vital fact in mind, see if you can answer the following paradoxical
dinner party question:

"How many megs does your Macintosh have?"
The novice's answer: "Um ... say, have you tried those little cocktail weenies?"
The partly-initiated's reply: "I ... I think 250?"
The truly enlightened response: "What do you mean, how many megs? Are you
referring to memory or to hard-disk storage space? Here, have a cocktail weenie."

Understandin9 RAM
Let's add another term to your quickly growing nerd vocabulary list. It pains me
to teach you this word, because it's one of those really meaningless terms that
was invented purely to intimidate people. Trouble is, you're going to hear it a
lot. You may as well be prepared.
It's RAM. You pronounce it like the goat. RAM is memory. A typical Mac has 8 or
16 megs of RAM (in other words, of memory).
Incidentally, this might be a good time to find out how much RAM you have.
Here's how to find out.
Turn on your Mac.

_ _ _ _ _ _ _ _ _ _ _ _ _ _ _ Chapter 11/z: High-Tech Made Easy

Wljytftt~;~-··;·

f ···.·· '··
1·'.1 .i
Random AJ;lbrevi~~on ~o
pqsedly · .ds tor Random'

.·:Wtt~t'v

Remember the menu? The fr uit in the upper-left corner of the screen? Pull
down that menu as you did in Chapter 1. Once again, slide the pointer down
until About This Macintosh turns black, and then release the mouse button.
File

Edit

Uiew

Label

i

Calcul11tor
~Chooser
li?i!I Control P11nels

A window appears.
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"
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About This Macintosh

System Software

System Software 7 .5

~

~
4,~0K

©Apple Computer, Inc. 1983-1994
Largest Unused· Block:

4,058K

iit
'O
~

The number circled in the preceding illustration shows how much RAM your
Mac has. If you lop off everything after the comma (only mentally, please),
you're left with the number of megs of RAM. It's probably 4, 5, 8, or 16 megs.
Older Macs may have less; high-powered expensive ones may have more.
In any case, your Mac's RAM endowment is a statistic you'll enjoy reviewing
again and again. Therefore, take this opportunity to write this number, too, onto
your Cheat Sheet at the front of the book. There's a little blank for this information, nearby where you wrote your System-software version.
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Puttin11 it all to11ether
OK. Now that you know where a computer's information lives, let me take you
on a tour of the computer's guts. Let's get into our little imaginary Disney World
tram. Keep hands and feet inside the car at all times.
When· you turn on the Mac, as noted earlier, the hard disk spins, and the Mac
copies certain critical information into its memory. So far, the Mac only knows
that it's a computer. It doesn't know anything else that's stored on your hard
disk. It doesn't know about African Tribal Women, or your new screenplay, or
how much you owe on your credit card - yet.
To get any practical work done, you now have to transfer the article (or screenplay, or spreadsheet) into memory; in Macintosh terminology, you have to open
a file. In Chapter 2, you'll find out how easy and idiot-proof this is. Anyway, after
you open a file, it appears on the screen. (It's in memory now.)
While your document is on the screen, you can make changes to it. This, of
course, is why you bought a computer in the first place. You can delete a
sentence from your novel or move a steamy scene to a different chapter (the
term for this process is word processing). If you're working on your finances,
you can add a couple of zeros to your checking-account balance (the term for
this process is wishful thinking). All without any eraser crumbs or whiteout.
Perceptive readers (who haven't already gotten bored and gone off to watch
TV) will recognize that you're making all these changes to what's in memory.

The more you change the screenplay that's up on the screen, the more it's
different from that permanent copy that's still on your disk, safe and sound.
At this point, you're actually in a pretty precarious position. Remember that
memory is sustained by electricity. In other words, if your four-year-old mistakes the Mac's power cord for a handy suckable plaything and jerks it out of
the wall, then the electricity stops, the screen goes blank, and all the changes
you've made disappear forever. You're left with the original copy on the disk, of
course, but any work you've done on it vanishes, along with anything else in the
Mac's memory.
However, every Mac program has a simple command, called Save, that saves
your work back onto the hard disk. That is, the computer updates the original
copy that's still on the hard disk, and you're safe. Even if a sun storm wipes out
all power plants in the Northern Hemisphere and your Mac goes dark, your
novel or letter or spreadsheet is safe on the disk. Most people use the Save
command every five or ten minutes so that their work is always up to date and
preserved on the disk. (You'll learn how to use the Save command in Chapter 3.)

_ _ _ _ _ _ _ _ _ _ _ _ _ _ _ Chapter 11/z: High-Tech Made Easy

"I lost all mlJ Ulorkf11
So that you'll quit worrying about it, the precariousness of memory accounts
for the horror stories you sometimes hear from people who claim that they lost
their work to a computer. "I was on volume Y of the encyclopedia I've been
writing," they'll say, "and I lost all of it because of a computer glitch!"
Now you can cry crocodile tears and then skip back to your office with a smirk.
You know what happened. They probably worked for hours with some document on the screen but forgot to use the Save command. Then, when the
unthinkable happened - someone tripped on the power cord - sure enough,
all the changes they'd made got wiped out. A simple Save command would have
stored everything neatly on the hard disk.

Top Ten Differences Between Memoru
and a Hard Disk
May you never confuse memory with a hard disk again.
1. You usually buy memory two or four megs at a time. Hard disks come in
sizes like 200, 500, and 750 megs (and on up).
(Free bonus fact! If a hard drive's size reaches 1,000 megs, it gets a new
measurement name - its size is said to be one gigabyte. The abbreviation
for one gigabyte is lG. People also say "one gig, "which confuses the heck
out of jazz-club musicians.)
2. Memory comes as chips on a little minicircuit board. A hard disk is a big
box made of metal (and sometimes encased in plastic).
3. You can only install memory inside the computer (something you
usually hire a local guru to do). A hard disk may be either inside the Mac
(an internal drive) or a separate box you just plug into the back (an
external drive).
4. Memory delivers information to the Mac's brain almost instantly. The hard
disk sometimes seems to take forever.
5. Memory is sometimes called RAM. A hard disk has no abbreviation.
6. Not every Mac has a hard disk (about 11 people still use very old models
with nothing but floppy disks). But every Mac has memory.
7. When the Mac is reading information off a hard disk, a little light on the
computer's case may flicker on and off (on the front of most Macs, or on
the case of an external hard disk). You can't tell when the Mac is getting
information from RAM.
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8. As a very general rule, RAM costs about $25 per meg, and hard drive space
averages about 75 cents per meg.
9. Memory's contents disappear when you turn off the computer. A disk's
contents stay there until you deliberately throw them away.
10. To find out how much hard-disk space you have left, you look at the top of
a window on your desktop, as shown:
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But to see how much RAM you have left, you have to choose About This
Macintosh from your menu to get the window shown:
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The number where it says Largest Unused Block is roughly how much
RAM you're not using at the moment. Details are in Chapter 18.

Chapter2

Doing Windows, Getting Floppy
In This Chapter
Ii>- All about windows, folders, and icons
Iii>- Learning keyboard shortcuts
1!'i>- Working with floppy disks
1!'i>- Tips on using windows and floppy disks to raise your social status

8ecomin9 Manipulatitle
All of the clicking and dragging and window-shoving you learned in Chapter 1 is,
in fact, leading up to something useful.

Foldermania
I've said that your hard disk is like the world's biggest filing cabinet. It's where
you store all your stuff. But a filing cabinet without filing folders would be about
as convenient to handle as an egg without a shell.
The folders on the Mac screen don't occupy any space on your hard drive.
They're electronic fictions whose sole purpose is to help you organize your stuff.

Mr. Folder

The Mac provides an infinite supply of folders. Want a folder? Do this:
From the File menu, choose New Folder.

illlO
:)€p

Close Window :1€W
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Ooh, tricky, this machine! A new folder appears. Note that the Mac gracefully
proposes "untitled folder" as its name. (Gotta call it something, I suppose.)

Notice something else, though: the name is highlighted (black). Remember our
earlier lesson? Highlighted = selected = ready for you to do something. When
text is highlighted, the Mac is ready for you to replace it with anything you type.
In other words, you don't even have to backspace over the text. Just type away.
I. Type USA Folder. Press the Return key.

The Return key tells the Mac that your naming spurt is over.
Now, to see how folders work, create another one.
2. Choose New Folder from the File menu again.

Another new folder appears, once more waiting for a title.
3. Type Ohio. Press Return.

USA Folder
You're going to create one more empty folder. But by this time, your wrist is
probably weary from the forlorn trek back and forth to the File menu. Don't you
wish you could make a folder faster?
You can.

Ke1Jboard shortcuts
Pull down the File menu, but don't select any of the commands in it yet. See
those weird notations to the right of some commands?

_ _ _ _ _ _ _ _ _ _ _ _ _ Chapter 2: Doing Windows, Getting Floppy

Open
Print
8€P
Close Window 8€W
Get Info
Sh11ring •.•
Duplicate
M11ke Rli11s
Put Rw11y

8€1
8€0
OOM
OOY

Find ••.
Find Rg11in
P11ge Setup .•.
Print Window •..

Get used to 'em. They're keyboard shortcuts, and they appear in almost every
menu you'll ever see. Keyboard shortcuts let you select certain menu items
without using the mouse.
Some people love keyboard shortcuts, claiming that if you're in a hurry, pressing keys is faster than using the mouse. Other people hate keyboard shortcuts,
pointing out that using the mouse doesn't require any memorization. In either
case, here's how keyboard shortcuts work.
When you type on a typewriter, you press the Shift key to make a capital letter,
right? They call the Shift key a modifier key because it turns ordinary, wellbehaved citizen keys like 3 and 4 into madcap symbols like # and $. Welcome to
the world of computers, where everything is four times more complicated.
Instead of having only one modifier key, the Mac has four of them! Look down
next to your spacebar. There they are: in addition to the Shift key, one says
Option, one says Control, and another either says Command or has a little 88
symbol on it.
It's that little cloverleaf - the command key- whose symbol appears in the
File menu. Next to the New Folder command, you see88-N. That means:

1. While pressing the 88 key down, press the N key. Then release everything.
Barn! You've got yourself another folder.
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2. Type Michigan and press Return.
You've just named your third folder. So why have you been wasting a
perfectly good afternoon (or whatever it is in your time zone) making
empty folders? So you can pretend you're getting organized.
3. Drag the Ohio folder on top of the USA Folder.

Michigan

Make sure that the tip of the arrow actually hits the center of the USA
Folder so that the folder becomes highlighted. When it turns black, let go
of the Ohio folder - and watch it disappear into the USA Folder. (If your
aim wasn't good, you'll now see the Ohio folder sitting next to the USA
Folder; try the last step again.)
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4. Put the Michigan folder into the USA Folder in the same way - by
dragging it on top of the USA Folder.

As far as you know, though, those state folders have disappeared. How can
you trust me that they're now neatly filed away?
5. Double-click the USA Folder.

Yep. Opens right up into a window, and there are your two darling states,
nestled sweetly where they belong.
If you were to double-click one of the state folders, you'd open another
window. (Having a million windows open at once is nothing to be afraid of.
If you're a neatness freak, you might feel threatened, but closing them is
easy enough - remember the close box in the upper-left comer of each one?)

OK, so how do you get these inner folders out again? Do you have to drag
them individually? That would certainly be a bummer if you had all 50
folders in the USA Folder.
Tums out there are several ways to select more than one icon at a time.
6. Click above and to the left of the Ohio folder (Example I, next page).
Without releasing the mouse, drag down and to the right so that you
enclose both folders with a dotted rectangle (Examples 2 and 3).
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Release the mouse button when you've got both icons enclosed.
Now that you have several folders selected, you can move them en masse
to another location.
7. Drag the Ohio folder outside of the USA Folder window. The Michigan
folder goes along for the ride.

This was a somewhat unproductive exercise, of course, because we were only
working with empty folders. It gets much more exciting when you start working
with your own documents. All of these techniques work equally well with
folders and with documents.

How to trash somethin9
Here's one more icon-manipulation trick you'll probably find valuable.
I. Close the USA Folder by clicking its close box.

JI!
2 ~i?ms

usn folder
2 8 .9 MB in disk

2. Drag the folder on top of the Trash can in the lower-right corner of the
screen.

Don't let go until the Trash can actually turns black (when the tip of the arrow
cursor is upon it). When you do let go, notice how the Trash can bulges, a
subtle reinforcement of how important it thinksyour stuff is. Anyway, that's
how you throw things out on the Mac: just drag them on top of the Trash can.
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Bonus technique for extra credit
The method of selecting several icons by dragging a rectangle around them is fine if all the
icons are next to each other. But how would you
select only the icons that begin with the letter A
in this picture?

i1tlll
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The power-user's secret Click each icon while
pressing the Shift key. As long as you're pressing
Shift, you continually add additional, non-adjacent icons to the selection. (And if you Shift-click
one by accident, you can deselect it by Shiftclicking again. Try it!)
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You can't very well enclose each A by dragging
the mouse - you'd also get all the other icons
within the same rectangle.
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What's really hilarious is how hard they've made it to get rid of something. Just
putting something into the Trash doesn't actually get rid of it; technically,
you've really only put it into the Oblivion Waiting Room. It'll sit there forever, in
a bulging trash can. If you needed to rescue something, you could just doubleclick the Trash can to open its window; then you could drag whatever-it-was
right back onto the screen.
So if putting something into the Trash doesn't really delete it, how do you really
delete it? Choose Empty Trash from the Special menu.
Even then your stuff isn't really gone; you get a message like the one shown here:

The Trash contains 64 items, which use
4.3MB of disk space. Are you sure you
want to permanently remoue these items?
[ Cancel J (~J

Click OK, and your file is finally gone.
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Actually, don't tell anybody, but even after you've emptied the Trash, your file
still isn't really gone forever. Programs like Norton Utilities can unerase a file
that's been trashed, as long as you haven't used your Mac much since you
threw the away the file. That's useful to remember in case (1) you ever trash
something by mistake, or (2) you're a spy.
Now you can understand why you never hear Macintosh owners complain of
having thrown away some important document by accident - the Mac won't
let you get rid of anything without fighting your way through four layers of
warnings and red tape.
Pretty cool computer, huh?

Fun with Floppies
For our next trick, you're going to need a floppy disk. If you didn't buy a box of
blank disks with your Mac, you're going to need some eventually. Call up Mac
Connection and order some. They're cheap, and you'll have them by tomorrow
morning. (Phone number is in the Resource Resource at the back of the book.)

Hou/ to insert a flopplJ. disk
Take your first disk. Hold it flat. You're going to slip it into the Mac metal side
first, label side up.
Put the floppy disk into the disk drive slot, which is the thin horizontal slit on
the front of your Mac (or the side of your PowerBook). Keep pushing the disk in
until the Mac gulps it in with a satisfying kachunk.
If it's a brand new disk, or not a Mac disk, you'll probably see this message:

This disk is unreadable:
Do you want to initialize it?
([

Eject

J)

[Initialize J

Go ahead. Click Initialize. (If you're asked whether you want to make it
single-sided [the kind of disk that's way obsolete] or double-sided, select double-

sided - unless you're going to be sending this disk to someone who bought a
Mac in 1984 and immediately moved to Borneo.)
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Trash and System 6
If you're using System 6 (did you take the test
in Chapter 1 to find out?), the Trash can doesn't
sit there, bulging, until you Empty Trash. It gets

emptied automatically when you turn off the
Mac, and sometimes sooner.

You're then asked to name the disk; type a name, click OK, and then wait about
45 seconds while the Mac prepares the disk for its new life as your data receptacle.
If it's not a new disk - for example, if you're using one of the disks that came

with your Mac - the floppy-disk icon shows up on the right side, just beneath
your hard-disk icon:

To see what's on the disk, double-click the icon. As you've no doubt tired of
hearing repeated, a double-click on a disk icon opens its contents window.

A floppy factoid barely worth reading
You know how an audio cassette has that small
plastic tab, which you can pry out to prevent
your little sister from accidentally recording over
the tape?

progress); you can just slide the tab back and
forth. When you slide the tab so that you can see
through the hole, you've /ockedthe disk, and you
-can't erase it or trash any of its contents.

Well, a floppy has the same thing (a tab, not a
sister). In the corner of the disk, on the back,
there's a little square sliding tab. On a disk, you
don't actually have to pry out the tab (this is

When you slide the tab so that it covers the hole,
the disk is unlocked, and you can erase it, trash
it, or copy new stuff onto it
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Hou/ to coplJ. stuff onto a flopplJ. disk
You're about to learn how to copy stuff from your hard drive onto a floppy disk
(and vice versa). This is important stuff: In your lifetime, you'll do a lot of
copying from floppy disks to your hard drive (such as when you buy a new
program and want to put it on your hard drive). And if you're smart, you'll also
do a lot of copying onto floppies from your hard drive (such as when you make
a backup copy of all your work, in preparation for the inevitable day when your
hard disk calls in sick).
Here's how you copy stuff onto a floppy disk. We'll assume that you've already
inserted a floppy disk.
I. Double-click your hard-disk icon.
If its window was closed, it now opens. If the window was open but hidden
behind the floppy-disk window, the hard-disk window now pops to the front.

2. Drag the Ohio folder on top of the floppy-disk icon.

~

TeachText

If you already trashed your Ohio folder, no big deal. Choose New Folder
from the File menu (or press 38-N) to create a new folder. Drag that
folder instead.

The point is that, on a Macintosh, making a copy of something is as easy as
dragging it to the disk you want it copied onto. You can also drag something
into the disk's window (instead of onto its icon).

Hou/ to coplJ. somethin9 to IJ.OUr hard drille
Copying something from a floppy to your hard disk is equally easy. Open the
floppy-disk window (by double-clicking the floppy-disk icon). Then drag ·
whatever icons you want from the window onto the hard-disk icon (or into the
hard-disk window).
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For example, in the following illustration, two files are being copied from a
floppy disk - not just into the hard-disk window, but into a specific folder on the
hard disk:
Macintosh HD

LJ LJ

,... .,

App le- Ex tr as Applications
~

Si%xt !l. j

Disk
471 .S MB in disk

-1!1
41 .8 MB avai

You can make as many copies of a file as you want without ever experiencing a
loss of quality. You're digital now, kids. It's not like copying tapes, where each
copy of a copy is a little bit worse than the previous generation. The tenthousandth copy of your novel will be just as spicy as the first. (That makes
software companies nervous; some unscrupulous people make a regular habit
of making themselves free copies of their friends' expensive software.)

How to 9et the flopplJ. disk out a(/.ain
OK, so you've made a backup copy of your fourth-quarter report, or you've
just copied a new program onto your hard disk. Now what? How do you get the
disk out?
Well, you wouldn't be alone in guessing that you use the Eject Disk command in
the Special menu. But you'd be wrong. The Eject Disk command does spit out
the disk - but it leaves the disk's icon on the screen so that the Mac thinks
it's still available. The minute you try to go on with your work, the Mac will
start displaying messages demanding that you give the disk back to it.
Totally annoying.
A much better way to get rid of the disk is to select it (noun) and choose Put
Away (verb) from the File menu. That makes the disk pop out, and its image

disappears from the screen. (If you care, there's a keyboard shortcut for Put
Away: 3€-Y.)
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Dweebsr Corner: Alternative disk tips
Another way to remove a floppy disk is to drag
its icon to the Trash can! Yes, yes, I know it
looks like you're erasing the entire disk. It looks
that way to everyfirst-time Mac user. But you're
not-this action just pops out the disk.

not at the desktop/Finder.) Even less frequently
than that, you'll have a disk in the drive and the
Mac will be off. In that case, turn on the Mac
while pressing the mouse button down continuously until the Trash can appears.

Every now and then, you'll have a situation where
a disk won't come out of the drive. If the Mac is
still running, hold down the 3€ and Shift keys
together and press 1. (This works even if you're

And if that doesn't pop the disk out, straighten a
paper clip. Push it slowly but firmly into the tiny
pinhole to the right of the disk drive slot. That'll
shove the disk out.

Top Ten Window, Disk, and Trash Tips
Staggering through the basics of using your Mac unattended is one thing.
Shoving around those on-screen windows and icons with grace is quite another.
Master the following and then invite your friends over to watch some evening.
1. To rename an icon or disk, click carefully on its name. Wait for a second or
so, until a rectangle appears around the name. That's your cue to type
away, giving it a new name. Press Return when you're done.

&
It works a little differently in System 6. Just click an icon and start typing.
No rectangle, no waiting.
2. If you're looking at a windowful of file icons, you can select one by typing
the first couple of letters of its name.
3. Don't forget that you can look at a window's contents in a neat list (choose
"by Name" from the View menu). Once in a list view, when a folder is
highlighted, you can press 3€-~ to expand it (as though you'd clicked the
triangle to view its contents) and 3€-f- to collapse it again.
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4. Every time you choose Empty Trash from the Special menu, the Mac asks
you if you're absolutely sure. If you'd prefer the Mac to simply vaporize the
Trash contents without asking, select the Trash icon. Choose Get Info from
the File menu and click the "Warn before emptying" checkbox so that the
X disappears.
~

Trash Info

tm

Tm h

..,here : On the desktop
Contents: The Tr-ash is empty.

Modified : Thu , Oct 20 , 1994, 8 :16 PM

l~'W'arn

before

empt!j~

5. If you're trying to make a copy of a floppy disk, you'll find that the Mac can
only copy a little bit at a time. It winds up asking you to insert one disk,
then the other; one disk, then the other . . . until your wrists are swollen
and bleeding.
A better, faster idea: Copy the entire disk to your hard disk, eject the
floppy, insert the blank floppy, and then copy the stuff from the hard disk
to the new floppy. Using the hard disk as an intermediate holding tank in
this way eliminates the disk swapping. (Just trash the superfluous copy
from your hard disk when it's all over.)
6. If you have a very important document, you can prevent it from getting
thrown away by accident. Click its icon. Choose Get Info from the File
menu. Select the Locked checkbox.
Now, even if you put it in the Trash and try to empty the Trash, the Mac
will simply tell you that there's a locked item in the Trash, which it won't
get rid of.
7. You already know how to copy a file from one disk to another. You can
copy it on the same disk, too. Click the icon and choose Duplicate from the
File menu.
Or, while pressing the Option key, drag the icon onto a new window
or folder.
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8. Isn't it frustrating to open a window that's too small to show you all of its
contents?

5 items

170 MB in disk

Q

D
Saved Work 10/10/93

Of course, you could spend a weekend fussing with the scroll bars, trying
to crank the other icons into view. Or, using error-and-trial, you could drag
the lower-right handle (the resize box) to make the window bigger.
There's a much quicker solution. Click the zoom box in the upper-right
corner of the window. The Mac automatically makes the window exactly
large enough to show all of the icons.

F!"'
S1111ed Work Folder
!!ii Zoombox
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9. You don't have to be content to leave the Trash stranded way down there
at the bottom of your screen. You can move it anywhere you want, just by
dragging it.
That's especially handy if you're lucky enough to have one of those
screens the size of a Cineplex Odeon and don't feel like packing a week's
worth of supplies every time you want to make a Journey to the Trash
Corner.
10. You don't have to eject disks and clean up your windows before you shut
down the computer. The disks pop out automatically, and the windows will
be right where you left them the next time you turn on the Mac.

Chapter3

Actually Accomplishing Something
In This Chapter
~

What software is, for those who care

~

Copying and pasting
~Desk accessories and the fruit-shaped menu they're listed in
~ The pure, unalloyed joy of control panels

~e Mac is like a VCR. The disks you slide into the Mac are like the tapes you

~lip into your VCR. Without tapes (disks), the VCR (Mac) is worthless. But
with tapes (disks), your VCR (Mac) can take on any personality.

f

A VCR might let you watch a Western one night, home movies another, and a
60 Minutes expose about a corrupt Good Humor man another night. In the
same way, your Mac can be a typing instructor, a checkbook balancer, or a
movie-editing machine, depending on the software you buy. Each piece of
software - usually called a program, but sometimes known as an application is like a different GameBoy cartridge: It makes the Mac look, feel, and behave
differently. The average Mac user winds up using about six or seven different
programs regularly.

Obsolescence TheraplJ
Your relationship with a software company doesn't end when you buy the
program. First, the company provides a technical help staff for you to call when
things get rocky. Some firms are great about this relationship - it's a toll-free
number that's answered immediately by a smart, helpful, customer-oriented
technician. More often, though, sending out an SOS is a long-distance call ...
and a long-distance five- or ten-minute wait before somebody can help you. How
can you find out how good a company's help line is? By asking around and
reading the reviews in Macworld and MacUser magazines.
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Like the computers themselves, software applications are continually being
improved and enhanced by their manufacturers. Just as in owning a computer,
owning a software program isn't a one-time cash outlay; each time the software
company comes out with a new version of the program, you'll be offered the
chance to get it for a small "upgrade fee" of $25 or $99, for example.
You'd think people would get fed up with this endless treadmill of expenses and
just stick with the version they've got, refusing to upgrade to successive
versions. Some manage it. Most people, however, succumb to the fear that
somehow they'll be left behind by the march of technology, and wind up forking
over the upgrade fees once a year or so. Let your budget and sense of independence be your guide.

Credit Card Workout #2: 8u1J.in9 So~u/are
(Credit Card Workout #1, by the way, was buying the computer.)
If you bought a Performa model, you received a handsome bonus gift of software preinstalled on your hard disk. If not, until you go on another buying
spree, you won't be able to do much more than admire the Mac's contribution
to the decor.
Of course, every Mac comes with some software. For example, each Mac comes
with the System software (on white floppy disks or on a compact disc) that it
needs for its own internal use. It comes with some miniprograms, like the
Calculator and the Note Pad, called desk accessories. But none of this free
software will make you very productive on the day you set up your computer.
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Software, for the most part, is expensive. The most popular Mac word processing program, for example, is Microsoft Word, and the lowest price I've seen for it
is $300. If you plan to do number crunching, over 90 percent of Mac users use
the spreadsheet Microsoft Excel (another $300). Want a database for handling
order forms, tracking phone calls, and creating merged form letters? Check out
the fantastic FileMaker Pro (around $200).
There are lower-priced alternatives, of course. If you really want to do your
homework, read a few recent issues of Macworld and MacUser for some guidance. WordPerfect, for example, is an excellent, easy-to-use word processing
program, and it's only $130. It can even exchange files with Microsoft Word.
Unfortunately, you may feel a little bit left out with one of the underdog programs since almost all the talk, help, and articles will be about the big three
(Word, Excel, and FileMaker).
If you're on a budget and don't much care about being in the vanguard, you can
get a lot of power in the form of an integrated program like ClarisWorks -which
is the kind of program you get when you buy a Mac Performa. For the cost of a
single program, you get several programs mashed into one: word processor,
database, spreadsheet, drawing program, and so on. (See Chapter 7, "A Whole
Big Chapter on ClarisWorks.")

In any case, you definitely need a word processor. Most people could use an
address book program like InfoGenie and a calendar/reminder program like
Now Up-to-Date. And then there are graphics: if you want to draw or paint, read
Chapter 6 for some explanations and suggestions.

Where to 9et it
There are two places to buy software: via mail order and at a store. Unfortunately, as you'll quickly discover, today's computer stores generally offer a
pathetically small selection of Macintosh software. On the other hand, mailorder companies offer thousands of choices; give much bigger discounts; take
returns after you've opened the box; and don't charge sales tax. And, of course,
you don't have to fire up the old Volvo. You get your stuff delivered to your
door by the next day (the overnight shipping charge is usually $3 per order).
At the risk of sounding like a broken CD, I'm going to direct you to the Mac
magazines like Macworld and MacUser for more info on mail-order companies.
They're called things like Mac Connection, Mac Zone, and Mac Warehouse.
They all have toll-free phone numbers, and their catalogs and ads all appear in
every single issue of those magazines. (Their numbers also appear in Appendix
B, the Resource Resource.) Overnight mail-order companies like these are truly
one of the bright spots in the Mac world. You can call Mac Connection, for
example, until 3:30 a.m. and get your new programs by midmorning (seven
hours later). After being around them a while, you'll start to wish there were
overnight mail-order grocery stores, gas stations, and dentists.
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In the next chapter, you're going to do some word processing. That's what 90
percent of Mac users do the most of (when they're not hang gliding, housing the
homeless, and saving the environment, I mean). I have no way of knowing what
software, if any, you bought with your computer. Maybe you already have a
word processing program, maybe not. (Look over your pile of boxes. If there's
one that says Microsoft Word, WriteNow, WordPerfect, Nisus, or anything that
ends with -Works, then you have a word processor.) If you don't have a word
processor yet, call up a mail-order company and order one right now so you'll
be able to work with it tomorrow.
Until Federal Express delivers your new software, however, let me show you
some of the basic principles of the computer. To make sure you've got the same
thing on your screen that I do, we'll start off by using the built-in programs that
came with your Mac.

Vour flerlJ. first software
There are several menus across the top of the screen (remember these?). As
you get to know the Mac, you'll discover that their wording changes from
program to program. Right now, they say File, Edit, View, Label, and Special; in a
word processor they might say File, Edit, Font, Size, Format, and so on. The
menu names (and the commands listed in those menus) are tailored to the
function of the software.
There's one menu that's always on your screen, though: our friend the Apple
menu (the Sat the left edge of the menu bar). Among other things, this menu
provides immediate access to some useful miniprograms known as desk
accessories. Desk accessories are surefire, nonthreatening, and fun - perfect for
your first baby steps into the world of software.
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Desk Accessories
Let's start simple. Move your cursor up to the S menu and choose Calculator.
The Calculator pops up in a tiny window of its own.

The Calculator
Using the mouse, you can click the little calculator buttons. The Mac gives you
the correct mathematical answer, making you the owner of the world's biggest
pocket calculator.
What's neat is that you can also type the keys on your numeric keypad, the
block of number keys off to the right side of your keyboard. As you press these
real keys, you can watch the on-screen keys in the Calculator window get
punched accordingly. Try it out!
(Of course, a PowerBook doesn't have a numeric keypad. Still, the numbers on
the top row of regular alphabet keys works just as well.)
Take a moment to reinforce your love of windows: by dragging the title bar
(where it says "Calculator"), move the Calculator window into a new position. If
you were good and tired of looking at it, you could also make the Calculator go
away by clicking its close box (in the upper-left corner, like on all windows).
But don't close the Calculator just yet. Leave it open on the screen.

The Note Pad
Now go to the S menu again, and this time choose Note Pad. Instantly, the
world's most frill-free word processor appears on the screen.
You'll learn more about word processing in the next section. For now, we're just
going to do some informative goofing around. With the Note Pad open on your
screen, type a math problem, like this:
37+8+19*3-100
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It

Secrets of the • menu
The Calculator, along with other miniprograms
like the Note Pad, Key Caps, and so on (all in the
ti menu), is called a desk accessory. It's always
available to you, no matter what Mac activity
you're in.
In the olden days of System 6, the Apple menu
contained only desk accessories. They were
small, inexpensive, and cute. One of the special
features in System 7, however, is that you can
stick anything you want into that ti menu: fullfledged software applications, a disk icon, a
folder, a document you work on a lot, a sound,
and so on. (Some people wind up with very long
Apple menus.)

Want to know the secret of making your own ti
menu in System 7? Check it out Point to your
hard-drive icon in the upper-right corner of the
screen and double-click. Now double-click your
System Folder icon. Inside that, you'll find a folder
called Apple Menu Items. (Pretty cryptic, I know.)
Go ahead and drag any icon into this folder:
another folder, a letter, your word processing
program, whatever; instantly it appears in the
Apple menu for easy access.
(It's better still to put an alias of your icon in
there, but Chapter 8, where aliases are explained, is still miles away.)

(In the computer world, the asterisk* means "times," or multiply.) If you make
a mistake, press the big Delete key at the upper-right corner of your keyboard.
This means "Backspace."
Now, by dragging the Note Pad's title bar, move it so that you can see the
Calculator window, too.

You're going to use two programs at once, making them cooperate with each
other - one of the most remarkable features of the Mac.
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Selectin9 text
This is about to get interesting.
Using the mouse, position the pointer at the left side of your equation (below,
top). Press the button and drag, perfectly horizontally, to the right (middle).
Release the mouse when you've highlighted the entire equation (bottom).
137+8+19*3-100

I
You've just selected some text. Remember in Chapter 1 when you selected an
icon - and then used a menu command? Struggling, as always, to come up with
a decent analogy, I likened this select-then-operate sequence to building a nounverb sentence.
Well, it works just as well with text as it does with icons. You've now highlighted, or selected, some text. The Mac now knows what the noun is - what
it's supposed to pay attention to. All you have to do is select a verb from one of
the menus. And the verb du jour is Copy.

The comerstone of human endeatlor:
CoplJ. and Paste
Choose Copy from the Edit menu.

Undo

sgz

Cut

88H

Paste 88U
Clear

Thunder rolls, lightning flashes, the audience holds its breath ... and absolutely
nothing happens.
Behind the scenes, though, something awesomely useful occurred. The Mac
looked at the selected equation and memorized it, socking it away into an
invisible storage window called the Clipboard. The Clipboard is how you
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transfer stuff from one window into another and from one program into another.
(Some programs even have a Show Clipboard command, in which case I take
back the statement about the Clipboard being invisible.)
Now then. You can't see the Clipboard at this point, but in a powerful act of
faith, you put your trust in me and you believe that it contains the highlighted
material (the equation).

The Application menu
Do you see the tiny Note Pad icon at the right end of your menu bar? It's next to
that question mark thing.

This icon actually represents a menu - the Application menu, of course. It lists
all the programs you have running at once.
At this moment, you have three programs running at once: the Note Pad, the
Calculator, and the famous Finder (or desktop).
You multitasking maniac, you.
Choose Calculator from the Application menu.

Hide Note Pad
Hide Others
Show Rll

l!il Finder

_, IEJ Note Pad
The Calculator window comes to the front, and the icon in the upper-right
changes to look like a Calculator.
Those of you still awake will, of course, object to using the Application menu to
bring the Calculator forward. You remember all too plainly from Chapter 1 that
simply clicking in a window brings it to the front, which would have required
less muscular effort.
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Absolutely right! You may now advance to the semifinals. However, learning to
use the Application menu was a good exercise. There are going to be many
times in your life where the program that's in front covers up the entire screen.
So then how will you bring another program forward, big shot? That's right. You
won't be able to see any other windows, so you won't be able to click one to
make it active. You'll have to use the Application menu.
In any case, the Calculator is now the active application. (Active just means it's
in front.) Now then: Remember that intricate equation that's still on the Mac
Clipboard? Instead of having to type an equation into the Calculator by punching keys, let's just paste it in.
I. Press the Clear key on your Mac keyboard or click the C button on the
Calculator.

You just cleared the display. We wouldn't want your previous diddlings to
interfere with this tightly controlled experiment.
2. From the Edit menu, choose Paste. Watch the Calculator!
If you looked in time, you saw the number keys flashing like Las Vegas at

midnight. And with a triumphant modesty, the Mac displays the answer to your
math problem. (It should be 92.)

Did you get what just happened? You typed out a math problem in a word
processor (the Note Pad), copied it to the Clipboard, and pasted it into a numbercruncher (the Calculator). Much of the miracle of the Mac stems from its capability to mix and match information among multiple programs in this way.
It's a two-way street, too. You can paste this number back into the word processor.
I. From the Edit menu, choose Copy.

But wait! Something was already on the Clipboard. Where is the Mac
supposed to put this new copied info?
On the Clipboard, of course. And whatever was there before (your equation) gets nuked. The Clipboard contains exactly one thing at a time whatever you copied most recently.
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2. From the Application menu, choose Note Pad (or just click the
Note Pad window).

The Note Pad is now the active application.

3. Type this:

Dear son: You owe me $
Stop after the $ sign. Move the mouse up to the Edit menu.
4. From the Edit menu, choose Paste.

Bingo! The Mac pastes in the result from the Calculator (which it had ready
on the Clipboard).
Incidentally, whatever's on the Clipboard stays there until you copy
something new or until you turn off the machine. In other words, you can
paste it over and over again.
5. For a second time, choose Paste from the Edit menu.

Another 92 pops into the window.
Nil.te Pad

Dear son: Vou owe me $9292

By now, you're probably cradling your wrist, which no doubt aches from all
those trips to the menu. Although what you're about to learn is, technically
speaking, a power-user technique, it will save you all kinds of time and chiropractor bills.
You don't have to use the menu to issue a command like Copy or Paste. If
you wish, you can use a keyboard shortcut to do the same thing. You may
remember having used the 88 key in Chapter 2 to issue commands without
using the mouse.
And how are you supposed to remember which letter key corresponds to which
command? Well, usually it's mnemonic: 88 +P for Print, 88 +O for Open, and so
on. But you can cheat; try it right now. Pull down the Edit menu, but don't let go
of the mouse button.

Cut
OOH
Copy OOC
Paste OOU
Clear

_ _ _ _ _ _ _ _ _ _ _ _ Chapter3: Actually Accomplishing Something
There's your crib sheet, carefully listed down the right side of the menu. Note
that the keyboard shortcuts for all four of these important commands (Undo,
Cut, Copy, Paste) are adjacent on the keyboard: Z, X, C, V.
C is Copy. And V, right next to it, is Paste. Let go of the mouse button and let's
try it.
I. While holding down the 38 key, type a V.
Bingo! Another copy of the Clipboard stuff (92) appears in your Note Pad.
(In the future, I'll just refer to a keyboard shortcut like this as "98-V.")
2. Press 38-V again.
Yep, that kid's debt is really piling up. He now owes you $92,929,292.
But after all, he's your son. Why not just let him pay 10 percent down on the
amount he owes you? In other words, why not undo that last 92 pasting?
3. From the Edit menu, choose Undo.
The most recent thing you did - in this case, pasting the fourth 92 gets undone.
Rewriting history is addicting, ain't it?
Remember, though, that Undo only reverses your most recent action. Suppose
you (1) copy something, (2) paste it somewhere else, and then (3) type some
more. If you choose Undo, only the typing will be undone (step 3), not the
pasting (step 2).
There are some other DAs, too. (Like everything in the Mac world, it's cooler to
call something by its initials. DA= desk accessory.) Play around with (and look
up in your Macintosh owner's guide) the Puzzle, the Scrapbook, Key Caps, and
all that stuff.

Control Panels
There's one item in your Apple menu that isn't a DA. It says Control Panels, and
all it does is open up your Control Panels folder. And what exactly is your
Control Panels folder? Well, it's a folder that lives inside your System Folder. It
contains a bunch of icons, each of which controls some aspect of your Mac.
Choose Control Panels from the ti menu to make this window appear:
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Control Panels
26.7 MB in disk

32 items

11.3 MB available

~

l!i0
Color

Sound

Startup Disk

ii

Monitors

Memory

Mouse

_._

J~.t ~(

m

labels

Ffle Sharing Monitor

Views

Everybody's got a slightly different set of control panels, so your screen may
look different. In any case, I'll show you around one control panel; then you can
take it from there.
I. Quickly type SO on your keyboard.

Remember this handy trick? You can select one icon in a folder just
by typing the first couple of letters of its name. In this case, you get the
Sound icon.
( P.S. If you don't find a Sound icon, maybe you have one of the really new
models where it's called Monitors & Sound. In that case, of course, you'd
find it by quickly typing MO.)
2. Double-click Sound.
The Sound control-panel window opens. It looks like ... well, rather like a
control panel. These particular controls govern the sound your Mac makes
when it beeps at you.
To adjust the overall volume of your speaker (for games and
CD-ROMs, for example), choose Volumes from this menu.

Sound

r L~A_le_r_t_so_u_n_d_s_ _ _
""'.J······-······················································',

y

v'
Indigo
Quack
Simple Beep
Sosumi
Wild Eep

J==~ If your Mac came with a

'.::===:::::::::=;::::::".~=,K=:
:>
Alert l olume

Add ... _j"

l

Try clicking these different names
to hear each sound. This is how
you choose an "error beep" the sound the Mac uses to scold
you when you make a mistake.

Remoue ]

This slider controls the volume of
the error beep ... but not necessarily
the overall volume of your speaker.

microphone, you can click the Add
button to record new error-beep
sounds of your own.

_ _ _ _ _ _ _ _ _ _ _ Chapter3: Actually Accomplishing Something
All right - close the Sound window by clicking the close box in the upper-left
corner.
This weekend, find some time to fiddle around with the other controls in the
Control Panels folder; see the upcoming Top Ten list for suggestions.
OK, enough fooling around. Time to get some work done. (Fortunately, working
on the Mac is almost as much fun as goofing off.)

Top Ten Control Panel 6planations
Dozens of control panels are kicking around in your Control Panels folder
(which you can see for yourself by choosing Control Panels from the ti menu).
Here are a few national favorites. (A few of these only come with System 7.5point-something; consult your Cheat Sheet at the front of this book to see
whether you have it. And for much more detail about all that stuff in your
System Folder, see Chapter 8.)
1. Monitors - lets you switch your monitor to black and white or back to
color.
2. Mouse - controls how sensitive the pointer movement is.
3. Keyboard - lets you decide whether holding down a key should type its
letter repeatedly, like XXXXXXXXXXX, and how fast it repeats.
4. Date & Time - sets your Mac's clock. Usually, when you buy a Mac, it
comes set to California time. To change the clock, open Date & Time. (If
you don't have System 7.5, open General Controls instead.) From there,
just click the digits in the time display and type new numbers.
5. Map - tells what time it is anywhere in the world. Either click to specify
a location, or type the name of a major city or country and click the
Find button.
6. Views - lets you change the typeface, and type size, of all your icon
names on the desktop.
7. PC Exchange- lets your Mac use floppy disks from DOS-compatible/
_Windows computers (yuck).
8. WindowShade - has an on/off switch for the really neat WindowShade
feature, in which you can collapse a window that's in your way by doubleclicking the striped title bar.
9. PowerBook - for laptops. Controls how quickly your PowerBook turns
itself off to conserve battery power.
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10. Desktop Patterns - lets you choose a new backdrop design for your
desktop. The Kitties design is a particular favorite of macho computer
nerds everywhere.

(Desktop Patterns only comes with System 7.5 and later. If you have a
previous version of the System Folder, use the General Controls control
panel, which has a similar desktop-editing feature.)

The 5th Wave

11

B Rich Tennant

He must re a Macinl:o3h use-r-t:here·s a

wrrotwatcn icon e1-LC1led. on his retina.''

Chapter4

Word Processing 101
In This Chapter
li1;> How to forget all those typewriter lessons
Bl»- Copying and pasting
~

How to save your files so they're not lost forever

~You -yes,

you - the desktop publisher

L

et's not kid ourselves. Yeah, I know, you're gonna use your Macintosh to do
photo retouching, to conquer the Internet, to compose symphonies. But no
matter who you are, what you'll probably do the most of is good old word processing.
Anyway, just because everybody does it doesn't mean word processing isn't the
single most magical, amazing, time-saving invention since the TV dinner. Master
word processing, and you've essentially mastered your computer.

Your Veru First Bestseller
If you have a word processing program, install it onto your hard disk now, if you

haven't already done so. You'll find the instructions at the beginning of its
manual; see Chapter 9 for some hints on installing software.
Find the program's icon on your hard disk. It may be inside a folder, which
you can open by double-clicking. It may also be staring you in the face, in the
form of a big fat Launcher button (see the sidebar called "All about big fat
Launcher buttons").
In any case, after you find the word processing program icon, double-click it;
you'll be presented, after a moment, with a blank white screen. (If you have
ClarisWorks, the program starts by asking you what kind of work you want to
do; select Word Processing and click OK.)
If you don't have a word processor yet, you can use your discount word
processor, the Note Pad; choose its name from the ti menu.
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All about big fat Launcher buttons
If you have a Performa, or indeed any Mac that's
running System 7.5 (Cheat Sheet check!), then
you probably found something like this floating
on your desktop when you first turned it on:

Appleo Rtm0t•

Eric's: Solil•il"•

Accus

SMnp~

t'w'Ot"ld

This thing, the Launcher, is supposed to make
getting into your programs easier. Studies
showed that double-clicking an icon, as you've
been thus far instructed, was beyond the technical abilities of some people. Thus the Launcher
was born, where a single click on any icon
launches (opens) a program.
The rules for using the Launcher - which, on
some models, is called Software Highlights are simple:
1. To switch to another "page" (window-full)
of icons, click one of the wide text buttons

at the top of the window for example.

Applications,

2. If there's some program on the Launcher
window that you don't really use, you can
get rid of it. While pressing the Option key,
drag that sucker rightto the trash. (You aren't
trashing the actual program, wherever it may
actually reside on your computer. You're just
getting its icon off the Launcher window.)
3. If there's some program - or document, or
folder - whose icon isn't on the Launcher
window but should be, simply.drag its icon
into the Launcher window and release. A
copy of that icon appears automatically,
ready for subsequent one-click launching.
4. If you'd rather not have the Launcher window confronting you every morning at all,
choose Control Panels from the S menu.
O.ouble-click the control panel called General Controls. Click the option called "Show
Launcher at system startup" to turn it off.

Top three rules of word processin9
The first rules of typing on a computer are going to be tough to learn, especially
if you've been typing for years. But they're crucial. Here they be:
V'

Don't press the Return key at the end of each line. I'm dead serious here.
When you type your way to the end of a line, the next word will automatically jump down to the next line. If you press Return in the middle of a
sentence, you'll mess everything up.

V'

Put only one space after a period. From now on, everything you write will
come out looking like it was professionally published, instead of being
cranked out on some noisy Selectric with a bad ribbon. A quick glance at
any published book, magazine, or newspaper will make you realize that
the two-spaces-after-a-period thing is strictly for typewriters.

_________________ Chapter 4: Word Processing 101

See here?
There are two spaces after this sentence. It looks sort of wide.
There's only one space after this one. Looks pretty good.

Y" Don't use the L key to make the number I. All right, this one's not so

I

crucial to your future happiness. Still, your Mac, unlike the typewriter you .
grew up with, actually has a key dedicated to making the number 1. If you
use a lowercase L instead, the 1 will look funny, and your spelling checker
will choke on it every time.

The point of no returns
Why aren't you supposed to hit Return at the
end of each line?
First time in print! An actual example of the kind
of mess you can get into by pressing Return after
each line of text.
NotePod -

1\+Mi@ljp)ij~:·ulson
closed h1s eyes 11gclnst the

sti nging r titn.

lli!i

V

filil-

Note Pod -~
Struggling for his greneide,

Poulson
~ lo se<! hts eyes ogoinst the
st1nglng rain.

P"

kind of guy he is (left). But suppose you'd been
foolish enough to press Return after each line of
text; if you remove those three highlighted words,
the word Paulsonflops back to the left side of the
line, but the rest of the sentence stays where it
is, looking dumb (right).
On the other hand, if you hadn'tput Returns into
your text, you'd get the figure below, where everything looks peachy.
~~ NotePad 
St ruggltng for his grenade,
Peu\ son closed hi s eyes egelnst
the stinging retn.

N_

I

~

At left: the original passage. Suppose you decide to remove Paulson's title, "Chief Executive
Officer.'' since everybody already knows what

R
..,.,.....,...........,...,.....,,...
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blame you. After all, I'm telling you to do things that you were explicitly taught
not to do by that high-school typing teacher with the horn-rimmed glasses.

There are a few other rules, too, but breaking them isn't serious enough to get
you fired. So let's dig in. Make sure you have a blank piece of electronic typing
paper open in front of you - either a new, untitled word processing screen or
the Note Pad.

The excitement be9ins
You should see a short, blinking, vertical line at the beginning of the typing area.
They call this the insertion point. It shows you where the letters will appear
when you start to type.

!iil!!ll

Nole Pad

The screams of

~

l!I~

I

1

The flashing insertion
point gets pushed
along as you type.

to

ll

Type the upcoming passage. If you make a typo, press Delete, just like Backspace on a typewriter. Don't press Return when you get to the edge of the
window. Just keep typing, and the Mac will create a second line for you. Believe.
Believe.
The screams of the lions burst Rod's eardrums as the motorboat, out of
control, exploded through the froth.

See how the words automatically wrapped around to the second line? They call
this feature, with astonishing originality, word wrap.
But suppose, as your novel is going to press, you decide that this sleepy
passage really needs some spicing up. You decide to insert the word speeding
before the word motorboat.
Remember the blinking cursor - the insertion point? It's on the screen even
now, blinking calmly away at the end of the sentence. If you want to insert text,
you have to move the insertion point.

_________________ Chapter 4: Word Processing 101
You can move the insertion point in two ways. First, try pressing the arrow keys
on your keyboard. You can see that the up- and down-arrow keys move the
insertion point from line to line, and the right- and left-arrow keys move the
insertion point across the line. Practice moving the insertion point by pressing
the arrow keys.
If the passage you want to edit is far away, though (on another page, for ex-

ample), using the arrow keys to move the cursor is inefficient. Your fingers
would be bloody stumps by the time you finished . Instead, use the mouse:
1. Using the mouse, move the cursor (which, when it's near text, looks like
this
just before the word motorboat. Click the mouse.

I)

The I-beam changes to the insertion point.

The scree ms of the lions burst
od's eerdrums es the
j otorboet , out of control,
exploded through the froth.

0

This is as confusing as word processing ever gets - there are two little
cursors, right? There's the blinking insertion point, and there's this one I.
which is called an I-beam cursor.
In fact, the two little cursors are quite different. The blinking insertion
point is only a marker, not a pointer. It always shows you where the next
typing will appear. The I-beam, on the other hand, is how you move the
insertion point; when you click with the I-beam, you set down the insertion
point.
In other words, editing stuff you've already typed, on the Macintosh, is a
matter of click, then type.
2. Type the word speeding.

The insertion point does its deed, and the Mac makes room on the line for
the new word. A word or two probably got pushed onto the next line. Isn't
word wrap wondrous?
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Editin<J for the lin9uisticalllJ. blessed
So much for inserting text: you click the mouse (to show the Mac where) and
then type away. But what if you need to delete a bunch of text? What if you
decide to cut out the first half of our sample text?
Well, unless you typed the challenging excerpt with no errors, you already know
one way to erase text - by pressing the Delete key (which is called Backspace
on some keyboards). Delete takes out one letter at a time, just to the left of the
insertion point.
Deleting one letter at a time isn't much help in this situation, though. Suppose
you decide to take out the first part of the sentence. It wouldn't be horribly
efficient to backspace over the entire passage just so you could work on the
beginning.
No, instead you need a way to edit any part of your work, at any time, without
disturbing the stuff you want to leave. Once again, the Macintosh method,
noun-then-verb, saves the day. Try this:
I. Using the mouse, position the I-beam cursor at the beginning of the
sentence.

This takes a steady hand; stay calm.
2. Clickjust to the left of the first word and keep the mouse button pressed
down. Drag the I-beam cursor - perfectly horizontally, if possible - to
the end of the word as.
As you drag, the text gets highlighted, or selected. You've done this once

before, in your copy-and-paste lesson.

111..111111111..111..lmlllllllllll,he
speeding motorboat, out of control , expl oded through
the froth.

If you accidentally drag up or down into the next line of text, the highlight-

ing jumps to include a big chunk of that additional line. Don't panic;
without releasing the mouse button, simply move the cursor back onto the
original line you were selecting. This time, try to drag more horizontally.
If you're especially clever and forward-thinking, you'll have selected the blank
space after the word as, as well. Take a look at the previous illustration.

All right, in typical Mac syntax, you've just specified what you want to edit by
selecting it (and making it turn black to show it's selected). Now for the verb:

_ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ Chapter 4: Word Processing 101
1. Press the Delete key.
Barn! The selected text is gone. The sentence looks pretty odd, though,
since it doesn't begin with a capital letter.
2. Using the mouse, position the cursor just before (or after) the letter t that
begins the sentence. Drag the cursor sideways across the letter so that
it's highlighted.

~e speeding motorboat , out of control , expl oded
through the froth .

Here comes another ground rule of word processing. See how you've just
selected, or highlighted, the letter t? The idea here is to capitalize it. Of
course, using the methods for wiping out (and inserting) text that you
learned earlier, you could simply remove the t and type a T. But since
you've selected the t by dragging through it, replacing it is much easier:
3. Type a capital T.
The selected text gets replaced by the new stuff you type. That, in fact, is the
fourth ground rule: Selected text gets replaced by the new stuff you type. As your
Macintosh life proceeds, keep that handy fact in mind; it can save you a lot of
backspacing. In fact, you can select 40 pages of text so that it's all highlighted
and then type one single letter to replace all of it. Or you could select only one
letter but replace it with 40 pages of typing.
Take a moment now for some unsupervised free play. Try clicking anywhere in
the text (to plant the insertion point). Try dragging through some text: If you
drag perfectly horizontally, you select text just on one line (below left). If you
drag diagonally, you get everything between your cursor and the original click
(below right).
§liil=

Note Pod

Breethle ss ly, he plunged into
the icy, surging w eters. His
cold cut him to the co re .

Note Pod

Breethle ss ly, he plunged into
the icy, surging weters. His

I

Only when he sew th e sherks did
hi s pul se return t o
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You deselect (or, equally poetically, unhighlight) text by clicking the mouse.
Anywhere at all (within the typing area).
Here's about the most fabulous word processing shortcut ever devised: Try
pointing to a word and then double-clicking the mouse! You've easily selected
exactly that word without having to do any dragging.
As you experiment, do anything you want with any combination of drags, clicks,
double-clicks, and menu selections. It's nice to know - and you might want to
prepare a fine mahogany wall plaque to this effect - that nothing you do with
the mouse or keyboard can physically harm the computer. Oh, sure, it's possible
to erase a disk or wreck one of your documents or something, but none of that
requires a visit to a repair shop. You can't break the computer by playing
around.

· 'Aword: processit1l.~r.111e.;ette
.

.

YouRriow, ~ino!Af,that.Yollf mouse pointer looks
like this~ I '·:~hEjneverit's near text. And you
know, by now, that you use this cursor to click
wherevetyouwanttotype next

But suppose you:wal1t to add some words way
down the.page, likethis:
He s1Bred at the yawning expanse of
while paper. His hands trembled on
the keys. Swea1illg, he finally rolled
the paper through the ancrent
typewxiler and wrole:

.

insertiop,point cursor simply.jurnps bacltiipto
the en4qf what.you've already typed. ln its ornery way, the Mac enforces its own rule of\llO'it~
ing: No jumping ahead, bub.
· ··· ·· ·· .·

Of course, you can skip down the page if you
want some words to appear there. But you
have to typeyourwaydownthe page first. That'$
why God invented the Return key. Press it over
and over again until your little insertion-point
cursor Is blinking merrily away .at the bottoJl}:!ll ,
the page """': orwherever you tell it ~e go 7""' ati(ifc
'nowstart typi11g.
· · ·.
· .·· ···. ··
~

< ,'(,' ""

'<>

,

'/'

,
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Note P11d ~l!!i
He s1Bred at the yawning expanse of
{)' · ·
while paper. His hands trembled on
the keys. Swea1illg, he finally rolled
the paper through the ancrent
typewriler and wrole:

..(Return

fl~=~

Ret.u.r.n
Return
·.Return

You'l.1.discover pretty quickly that the Mac won't
let you •fYP~ there,Jherule is: You can click your
cursoranvwhEltei''.c;>rrthe page··that.alreadyhas
•• typing u ·, 8utit}ftl'o tr'{ to click down be/0111? in
,the · ~p~ce,~y()U're out of luck; the blin19ng

~
~
~
~
~
~
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Form and Format
For the rest of this lesson, you're going to need a real word processor. Sorry,
kids, the Note Pad will only get you so far in life. If you're really a cheapskate,
you can use the little freebie program called SimpleText for this lesson (it's on
your hard drive somewhere).
One of the most important differences between a typewriter and its replacement - the personal computer - is the sequence of events. When you use a
typewriter, you set up all the formatting characteristics before you type: the
margins, the tab stops, and (for typewriters with interchangeable type heads)
the type style.
But the whole point of a word processor is that you can change anything at any
time. Many people type the text of an entire letter (or proposal or memo) into
the Mac and then format it. When you use a typewriter, you might discover, after
typing the entire first page, that it's slightly too long to fit, and your signature
will have to sit awkwardly on a page by itself. With a Mac, you'd see the problem and nudge the text a little bit higher on the page to compensate.
Word processing has other great advantages: no crossouts; easy corrections
that involve no whiteout and no retyping; a permanent record of your correspondence that's electronic, not paper, so it's always easy to find; a selection of
striking typefaces - at any size; paste-in graphics; and so on. I think it's safe to
say that once you try processing words, you'll never look back.

The return of Return
With all the subtlety of a Mack truck, I've taught you that you're forbidden
to use the Return key at the end of a line. Still, that rectangular Return key on
your keyboard is important. You press Return at the end of a paragraph, and
only there.
To the computer, the Return key works just like a letter key- it inserts a Return
character into the text. It's just like rolling the paper in a typewriter forward by

one notch. Hit Return twice, and you leave a blank line.
The point of Return, then, is to move text higher or lower on the page. Check
this example, for instance.
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Dearest· Todd,qr
qr
J.have-never-loved-so-much-as-1-did-last.
night.-lmagine-myjoy·as-1-watched-you.
plunch-your-shiningscimitar· into-the·
greasy-flesh-of. !hat-that-hideous. thing·
from-the-deep.qr
qr
Unfortunately,. the-IRS-has-determinedthat-you-failed. to.file· returns-for. the-years
1982-1986 .. They-have-asked-that.I.notify.
you- of.qr

qr
Dearest. Todd,qr
qr
I-have-never-loved-so-much-as-I-did-last.
night.-Imagine-my-joy-as-1-watched-you·
plunch-your-shiningscimitar-into-the.
greasy-flesh-of. that-that-hideous. thin8
from. the-deep.qr
qr
Unfortunately,. the-IRS· has· determinedthat-you-failed- to-file- retums-for- the-yeare
1982-1986 .. They-have.asked-that-I-nolify·
you-of.qr

Return characters move text down on the page. So, if you want to move text up
on the page, drag through the blank space so that it's highlighted (above left);
of course, what you've really done is select the usually invisible Return characters. If you delete them, the text slides up the page (right).
Combine this knowledge with your advanced degree in Inserting Text (remember? you click to place the blinking insertion point and then type), and you can
see how you'd make more space between paragraphs or push all the text of a
letter down on the page.

Appealin9 characters
Another big-time difference between word processing and typing is all the great
character formatting you can do. You can make any piece of text bold, italic,
underlined, all of the above, and more. You also get a selection of great-looking
typefaces - only a few of which look like a typewriter. By combining all these
styles and fonts randomly, you can make any document look absolutely hideous.

l:sa1ij.that .Returns are usually invisible. How- • markifllJs; The cpmma~dr' ~-

e~~r/~~~ry.time you press the Return kewthe ·· lnvisiblesiin'Wo.rd/the" · · ·
•·· .. IYJac•a~l1.u;iffydoes plop down a symbol onto your 11;in ClarisWorks, you·ha
. ~cre:~n:.$ii'me thingwith the spacebar; Same . ences from theEdit'menu .
. ·w~h:thetab key.
Invisibles option. fo
You'l!ha~~to check your own word processor's something like this:
. ·
manualtqfind out the exact command, butvirtu·
•
"Alison-mygod,.not. that!. Anything. but· that!"'ll
ally.evefyword processor lets you see these
•
But-it-was.too-late ..She-had-already disappeared:'!!.•::: ..·
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Here's the scheme for changing some text to one of those character formats:
noun-verb. Sound familiar? Go for it:
I. Select some text by dragging through it.

Remember, you can select a single word by double-clicking it; to select a
bunch of text, drag the cursor through it so that it turns black. You've just
identified what you want to change.
Each word processor keeps its Bold, Italic, and Underline commands in its
own specially named menu; it may be called Font, or Style, or Format. Drag
your cursor through each menu name, reading the commands on each
menu as it drops down, until you see the character formats like bold and
italic.
2. From the Font menu (or Format menu, or whatever it's called in your
program), choose Bold.
Or Shadow or Outline or whatever. You've just specified how you want to
affect the selected text.
You can apply several of these formats to the same text, too, although you
won't win any awards for typographical excellence. Try changing the typeface,
also; the various fonts are called things like Chicago, Geneva, Times, and so on.
Changing fonts works the same way: Select text and then choose the font.
And sizes - same deal: Select some text and then choose a type size from your
word processor's menu. (Again, the name of the menu may vary. But for
specifics on Microsoft Word and ClarisWorks, see Chapters 6 and 7.) The font
sizes are measured in points, of which there are 72 per inch. Works out nicely,
too - a Mac monitor has 72 screen dots per inch, meaning that 12-point type on
the screen really is 12-point.
File
~Iii

Edit

Uiew

Insert
1o Point
11 Point
12 Point
18 Point

.,

36 Point

Before you know it, you'll have whipped your document into mighty handsome
shape.
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The efficiency zealot's guide to power typing
Because you can format text after you've typed it doesn't mean you have to. Most power-users get
used to the keyboard shortcuts for the common style changes, like bold and italic. They're pretty easy
to remember,: In nearly every word processing program, you get bold by pressing 88-8 and italic
with 88-1.
What's handy is that you can hit this key combo just before you type the word. For example, without
ever taking your hands off the keyboard, you could type the following:
He stared at the Delinquent Birds folder. No: it was not happening!

i

i

i

i

88-B

88-B

88-I

88-I

In other words, you hit 88-8 once to turn bold on for the next burst of typing, and 88-8 again to turn it
off - all without ever having to use a menu.

Gettin9 rid of the black
Text changes color as you drag across it, right? This is called highlighting.
A panicked phone call from a novice Mac owner recently alerted me to a
strange fact: nobody ever tells you how to make the text white again! It's not in
the manuals, it's not in the books, it's not in the menus.
To make text white again (unselected), click the mouse anywhere in the window.
Dr. O'Sullivan grinned as she
unwrapped the bandages from his
face. Flakes of dried blood crumbled
from his twisted. hideous

Just click anywhere ...

. .. to get rid of the highlighting.

There. I think I just made the world a better place.

Formattin9 para9raphs
Where type styles and sizes can be applied to any amount of text, even a single
letter, paragraph formatting affects a whole paragraph at once. Usually these
styles are easy to apply. To select a paragraph, you don't have to highlight all
the text in it. Instead, you can just click once, anywhere, within a paragraph to
plant the insertion point. Then, as before, choose the menu command that you
want to apply to that entire paragraph.
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This figure shows some of the different options every word processor provides
for paragraph formatting- left-justified, right-justified, fully justified, and
centered.
Her heart pounding, she looked toward the door. It swung
open with a creak. The stench hit her first-an acrid,
rotting swamp smell. She covered her mouth with the
blood-soaked handkerchief and stepped backward, her
naked back pressed hard against the fourposter.

Her heart pounding, she looked toward the door. It swung
open with a creak. The stench hit her first-an acrid, rotting
swamp smell. She covered her mouth with the blood-soaked
handkerchief and stepped backward, her naked back pressed
hard against the fourposter.

Her heart pounding, she looked toward the door. It swung
open with a creak. The stench hit her first-an acrid,
rotting swamp smell. She covered her mouth with the
blood-soaked handkerchief and stepped backward, her
naked back pressed hard against the fourposter.

Her heart pounding, she looked toward the door. It swung
open with a creak. The stench hit her first-an acrid,
rotting swamp smell. She covered her mouth with the
blood-soaked handkerchief and stepped backward, her
naked back pressed hard against the fourposter.

You can control paragraphs in other ways, too. Remember in high school when
you were supposed to turn in a 20-page paper, and you'd try to pad your muchtoo-short assignment by making it two-and-a-half spaced? Well, if you'd had a
Mac, you could have been much more sneaky about it. You can make your word
processed document single-spaced, double-spaced, quadruple-spaced, or any
itty-bitty fraction thereof. You can even control how tightly together the letters
are placed, making it easy to stretch or compress your writing into more or
fewer pages.
Take this opportunity to toy with your word processor. Go ahead, really muck
things up. Make it look like a ransom note with a million different type styles
and sizes. Then, when you've got a real masterpiece on the screen, read on.

Someone Satle Me!
(Workin9 with Documents)
It might terrify you - and it should - to find out that you've been working on
an imaginary document. It's only being preserved by a thin thread of streaming
electrical current. It doesn't exist yet, to be perfectly accurate, except in your
Mac's memory.
You may recall from the notes you took on Chapter 1 1/2 that memory is fleeting.
(Specifically, I mean computer memory, but if you find a more universal truth in
my words, interpret away.) In fact, the memory is wiped away when you turn
the Mac off - or when your coworker's trip over the power cord turns it off for
you. At that moment, anything that exists on the screen is gone forever.
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menu, and its keyboard shortcut is always 88-S.
When you save your work, the Mac transfers it from transient, fleeting, electronic memory onto the good, solid, permanent disk. There your work will
remain, safely saved. It will still be there tomorrow. It will still be there next
week. It will still be there ten years from now, when your computer is so
obsolete it's valuable again.
Therefore, let's try an experiment with your ransom note document on the
screen. From the File menu, choose Save.
Uh-0h. Something weird just happened: The Mac presented you with a box full
of options. It's called a dialog box, because the computer needs to have a little
chat with you before proceeding. (Depending on your version of the system
software - see your Cheat Sheet - it may say "Documents" at the top of
this window.)

loi USR folder ... I
D
D
CJ
CJ

RlilSkil
C111iforni11
Connecticut
H11w11ii

S11ue 11s:
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= H11rd Driue
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U

S11ue

B

C11ncel

What the Mac mainly wants to know is: "Under what name would you like me to
file this precious document, Massssster?"
And how do you know this? Because in the blank where it says "Save as," a
proposed title is highlighted (selected already). And what do you know about
highlighted text? Anything you start typing will instantly replace it.
The Mac, in its cute, limited way, is trying to tell you that it needs you to type a
title. Go ahead, do it: Type Ransom Note.
At this point, you could just click the Save button. The Mac would take everything in perilous, fleeting memory and transfer it to the staid, safe hard disk,
where it would remain until you're ready to work on it some more.
However, a bunch of other stuff lurks in this dialog box. Especially since this is
the Numero Uno source of confusion to beginners, I think a tour of the Save File
box is in order.

- - - - - - -- ---------Chapter 4: Word Processing 101

Nafli9atin9 the Salle File
(and Open File) box
You've already learned about the way your computer organizes files: with
folders and with folders in folders. Remember this little exercise, where you put
state-named folders inside the USA folder?

J

World
29.9 MB in disk

8 items

Elil

USR folder
29.9 MB in disk

4 items

o
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t--

Ll
CJ LJ
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'--

Connecticut
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Well, the point of all the complicated-looking stuff in the Save File box is a
miniature version of that same folder-filing system. Suppose you see this when
you're trying to save your file:

la USR folder ... I
D
D
D
D

Rlaska
California
Connecticut
Hawaii

Saue as:
Ransom Note

Look at the open-folder "menu" (in a rectangle above the list). It tells you that
you're viewing the contents of the USA folder. In other words, if you click the
Save button, you'll file your new Ransom Note document in the USA folder,
mixed in among the state folders.
But suppose you want to file the Ransom Note document in one of the state
folders. You already know how you open a folder - by double-clicking it - so
you'd point to Alaska, for example, and double-click.
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le Rlaska •I
D lnlmview
Cl Nome

i1t

Li Polili( s
D Popul<1Hon
D fl<l~ourc(l~
Saue as:

Now the open-folder "menu" above the list says Alaska, and you can see the
stuff inside the Alaska folder. Most of their names are dimmed because they're
all documents; the only things whose names are black in this dialog box are
folders. (The Mac wants to know where you want to put your new document.
Because you can't very well store one document inside another document, the
names are grayed out and unavailable, and only the folder names are black and
available.)
OK. So now you're viewing the contents of the Alaska folder. What if you change
your mind? What if you decide that the ransom note should really go in the
World folder - the one that contains the USA folder?
You must retrace your steps. That's what the little open folder menu is all about
(the open folder icon is in front of the word Alaska). They call this doohickey a
po,rup menu: it's a menu, but it's not at the top of the screen. The small black
triangle beside the name Alaska tells you: "Click me!"

Iesi Rlaska l;J
61 World
=Hard Driue
iii! Desktop

Sure enough, when you click the word Alaska (preceding figure, left), you see
the list of all the nested folders you had to travel through to get here (preceding figure, right). This is where things get a little weird: The list is upside-down
from the path you took!
In other words, if you were in the Finder instead of in this Save File dialog box,
you started at the Desktop level (gray background). You'd have double-clicked
the hard-disk icon to open its window. Then you'd have double-clicked the
World folder to open that, and the USA folder inside of that, and finally the
Alaska folder. If you look at the preceding menu picture, you'll see that, sure
enough, your entire folder path is listed. You can view the entire hierarchy of
folders - as long as you get used to the fact that the list is upside-down, and
the outer levels (the hard disk and the Desktop) are listed at the bottom.

_ _ _ _ __ ___________ Chapter4: Word Processing 101
Therefore, if you wanted to file the ransom note in the World folder (below, right),
you'd simply slide down the pop-up menu list and choose World (below, left).

la world ..-1
O Rfric11
o Rnt11rctic11
0 Rsi11
O Europe
O USR folder

Then, at long last, when you're viewing the contents of the folder you want to
save the file in, you can click the Save button.
For the purposes of following along with this exercise, double-click a folder any folder - to store your file in. And then click Save.
Your file gets snugly tucked away into the folder whose contents you're viewing.
Want proof, 0 Cynic? All you have to do is choose Finder from the Application
menu. Remember, the Application menu is the icon at the upper-right side of
the screen. It lists all the programs that are running at once.

Show Rll

./Ill Cl11risWorks
•

Word 5. 1

When you choose Finder, our friends the folders , windows, and Trash can pop
up. If you wanted to make sure your file really exists, and it really got put where
you wanted it, you could now double-click your way through folders until you
found it. In our example, your ransom note would be in the World folder:

6 items
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·- used for retrieving files you've already created. You need to know how to climb
up and down your folder tree, as you'll see in a moment, if you ever want to find
your files again.

Closin9 a file, with a si9h
You've created a ransom note. It's got all kinds of text and formatting. You've
saved it onto the disk so that it'll be there tomorrow. In a moment, you'll get a
chance to prove it to yourself.
Click the close box in the upper-left corner of the window. Once.

In the Mac's universal language of love, clicking the small square up there means
close the window, as you'll recall. If all went well, the window disappears.

How to find out what the heck IJ.OU 1re doin9
This gets sort of metaphysical. Hold on to your brain.
Just because you closed your document doesn't mean you've left the program. In
fact, if you pull down the Application menu at the right side of the screen, you'll
see that the word processing program is, in fact, still running. (It's the one with a
check mark beside it; your word processing program may be different.)

Hide Word 5
Hide Others
Show Rll

11

Finder
.,,..Words

You could bring the Finder to the front by choosing its name from the Application menu - without exiting the word processor. They both can be running at
the same time, but only one can be in front.
In fact, that's the amazing thing about the Mac. You can have a bunch of
programs all running at once. The more memory your Mac has, the more
programs you can run simultaneously.
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Worrywarts' corner
From the way I've described the terrifyingly delicate condition of a document that's on the
screen (that you haven't saved to disk yet) that is, precariously close to oblivion, kept alive
only by electric current - you might think that
closing a window is a dangerous act. After all,
what if you forgot to save some work? Wouldr.i't
closing the window mean losing that critical
memo?
·
Not really- if you try to close a document, the
Mac won't let you proceed until it asks you if
you're sure you want to lose all the work you've
done. It will say something like:

Saue changes before closing?

n

Yes

]I ~

[C ancel )

Click Yes if you do want to save your work. Click
No if you were only goofing around or showing
off your Mac to somebody and don't want to
preserve your labors.
Click Cancel if you change your mind completely
about closing the document and want to keep
working on it.

What gets confusing is that one program (say, your word processor) may be
active, but you'll think you're in the Finder. After all, you'll see your familiar
icons, Trash, folders, and so on. You have to understand that all of this is simply
shining through the emptiness left by your word processor, which has no
windows open at the moment. If a window were open, it would cover up the
desktop behind it.
Right now, for instance, I realize that it's hard for you to believe that you're
using a word processor, when there are no words on the screen. But you have
three clues as to what program you're using:
CLUE #1: The first command in the
Apple menu always identifies the
program you're in.

l

i

CLUE #2: The menu titles are
different in each progr~.

.-.m.-~Fi~le--=E~d~it----::-Ui~e-w---=-1-ns-e~rt:--:F~o-rm~a~t--=-Fo-n~tI

I

CLUE #3: The check mark in the
Application menu also
identifies the front program. ____..

Hide Word 5
Hide Others
Show Rll

{ti

Rlarm Clock
~ Finder

""<

Word 5

For the moment, I want you to stay in your word processing program.
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Gettin9 It All Back A9ain
OK. You've typed a ransom note. Using the Save command, you turned that
typing on your screen into an icon on your hard disk. Now it's time for a
concept break.

Those crazlJ. relationships: Parents and kids
Two kinds of files are lying on your hard disk right now: programs (sometimes
called applications) and documents. A program never changes; it's like a
Cuisinart on your kitchen counter, sitting there day after day. Documents are
what you create with a program - they're the coleslaw, crushed nuts, and
guacamole dip that come out of the Cuisinart. You pay money to buy a program.
Once you own it, you can create as many documents as you want, for free.

~

Word Proo-S-R™

Q

D
Memo

r;J)

Q

D
D
Leotter to Dad
Picnic

EJ

EJ

Menthol bean dip Poem for Am'ia

For example, you could use the Word Proc-S-R program (above top) to create all
the different word processing documents below it and thousands more like
them. If you love analogies as much as I do, you can think of the application as
the mommy and the documents as the kiddies.
Here's what their family relationships are like:
1. Double-dick the program icon when you want to open a brand new,
untitled, clean-slate document.

2. Double-click a document icon to open that document.

Unbeknownst to you, double-clicking a document simultaneously opens
the program you used to create the document.
Double-click a
document to
open it ...

i

Q

D

Memo

~

t ...

Word Proo-S-R™

and the Mac automatically
launches the corresponding program
that gave it birth, even if it's buried
in a folder somewhere.
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This may seem unimpressive to you. But in the dark days of DOS and other
scary pre-Macintosh computers, there was no such automatic programlaunching. You'd have to know what program you used to create the
document, launch it first, and then retrieve a document. And even then,
you'd have to remember what you named it, exactly, and type that name
precisely on the screen.

Fetch: How to retrietle a document
Let's return to our increasingly fruitful exercise with the ransom note, shall we?
Let's pretend it's tomorrow. Yawn, stretch, fluff your hair (if any). You find out
that the person you've kidnapped actually comes from a wealthy Rhode Island
family, and so you can demand much more ransom money. Fortunately, you
created your ransom note on the Mac, so you don't have to retype anything;
you can just change the amount you're demanding and print it out again.
But if you've been following the steps in this chapter, then there's no document
on the screen. You're still in your word processing program, though (or should
be; look for the check mark in the Application menu). So how do you get your
ransom note file back?
Like this:

1. Choose Open from the Fde menu.
A dialog box appears. You probably remember dialog boxes - in fact, you
probably remember this one. It looks just like the Save dialog box, where
you were asked to give your document a title. This one, navigationally
speaking, works exactly the same way.
Use this pop-up menu to see what
Double-click a folder this folder is inside of.
folder to see
whafs in it.
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You can tell thatth1s 1s a document because its icon isn't
a folder. You can open it by double-clicking its name.

'---'
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Unfortunately for my efforts to make this as instructional as possible, if
you've been following these steps, your ransom note is staring you in the
face right now. It's in whichever folder you saved it into. The Mac is nice
that way - it remembers the most recent folder you stashed something
in and shows you that location the next time you try to save or open
something.
If you want to emerge from this experience a better person, pretend you

can't find your ransom note. Pull down the pop-up menu and jump to your
hard-disk level:
5l World
,

I

I

iii Desktop

Now the display changes to show you the contents of your hard disk:
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Cancel
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And from here, you know how to get back into the World folder, don't you?
Correct - double-click the World folder, and you're right back where you
started.
2. Double-click the ransom note.

This is what you've been working up to all this time. The ransom note
appears on your screen in its entirety. Now, at last, you can edit it to your
heart's content.

Safle Me A9ain!
To continue this experiment, make some changes to your document. Once
again, you have to worry about the fact that your precious work only exists in a
fragile world of bouncing electrons. Once again, turning the Mac off right now
means you'll lose the new work you've done. (The original ransom note,
without changes, is still safe on your disk.)

- - - - - - - - - - - - - - - - Chapter4: Word Processing 101

Therefore, you have to use that trusty Save command each time you make
changes that are worth keeping. (For you desk potatoes out there, remember
that 88-S is the keyboard shortcut, which saves you an exhausting trip to the
menu.) The Save dialog box will not appear on the screen each time you use the
Save command (like it did the first time). Only the very first time you save a
document does the Mac ask for a title (and a folder location).
As mentioned in Chapter 11/2, you've probably heard horror stories about
people who've lost hours of work when some glitch made their computers
crash. Well, usually it's their own darned fault for ignoring the two most important rules of computing:

Rule I. Save your work often.
Rule 2. See Rule I.
"Often" may mean every five minutes. It may mean after every paragraph. The
point is to do it a lot. Get to know that 88-S shortcut, and type it reflexively after
every tiny burst of inspiration.
Ever notice how you can control the weather? If you haul around an umbrella all
day, it won't rain. If you forget the umbrella, it's Noah's flood.
It's precisely the same with computers. If you save your work often, you'll
wonder why you bother; nothing will ever go wrong. The day- no, the minute
.- you forget to save something you've typed, you'll get something called a system
crash and lose your entire document into the electronic ether.

~
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Leamin9 to be a l{uitter
Now you know how to start a new document, edit it, save it onto the disk,
reopen it later, and save your additional changes. You know how to launch
(open, or run) a program - by double-clicking its icon or by choosing its name
from the S menu. You've discovered that you can have more than one program
open at once, which can be handy when you need to copy numbers from the
Note Pad and paste them into the Calculator (for example).
But now you have to learn to get out of a program when you're finished for the
day. It's not terribly difficult:
Choose Quit from the File menu.

If the word processor was the only program you were running, then you return
to the Finder. If you were running some other programs, then you just drop
down into the next program. It's as though the programs are stacked on top of
each other; take away the top one, and you drop into the next one down.

The other most important rule of computin9
Duty compels me to keep this chapter going just long enough to preach one
other famous word of advice to you: Back up.
To back up, or to make a backup, means to make a safety copy of your work.
When you're in the Finder, the documents you've worked on appear as icons on
the hard disk. Your hard disk is like a giant-sized floppy disk. Like any of us,
these disks occasionally have bad hair days, go through moody spells, or die.
On days like those, you'll wish you had made a copy of the stuff on the hard
disk, so your life won't grind to a halt while the hard disk is being repaired.
Remember the cruel gods that make the computer crash when you don't save
your work frequently? Those same deities have equal powers over your hard
disk, and an equal taste for irony. That is, if you don't back up, your hard disk
will certainly croak. On the other hand, if you back up your work at the end of
every day or every week, nothing will ever go wrong with your hard disk, and
you'll mumble to yourself that you're wasting your time.
Life's just like that.

When What Was Found Is Now Lost
OK. You've practiced saving and retrieving files. You've dog-eared critical pages of
this chapter - heck, you've tom out all the pages and taped them to the walls
around you. Yet still it happens: you can't find some file you were working on.

_ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ Chapter 4: Word Processing 101
This is nothing to be ashamed of! Thousands of people lose files every day. But
through the intervention of caring self-help groups, they often go on to lead
productive, "normal" lives.
Here's what to do: sit up straight, think positive thoughts, and press 3€-F. (Or do
it the long way: choose Find File from your el menu.)
On the screen, you see the Find File box: your personal electronic butler who's
prepared to spend the next few seconds rummaging through the attics, garages,
and basement of your Mac.

Type a few letters of the missing file's name. (Capitals don't matter, but spaces
do!) Then click the Find button (or press Return).
What happens next depends on what version of the System Folder you have.
(In theory, you wrote it on your Cheat Sheet while reading Chapter 1.)

SIJ.stem 7.5-point-somethin9
If you have System 7.5-point-something, a new window appears, listing every-

thing on your hard drive whose name contains what you looked for. At this
point, you can perform any of the following stunts:
Double-click a file to open it. You can also drag it someplace - onto the desktop, maybe,
or even directly to the Trash. To open the window a file's in, click the icon and press 31:-E.
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This area shows you where the file is, no matter how many folders deep it's buried.
You can double-c lic k any of these folders, too, to open it.
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The idiot-proof guide to backing up
Put a blank floppy disk in the disk drive. (If it's a
brand new disk, you'll oe asked to initialize it
[prepare it for use by a Mac]; do it.)
Now selectthe icons of the documents you want
to back up. Drag them; together or one by one,
onto the floppy disk icon. If the floppy fills up,
insert another one and continue. Label the floppy
disks Backup (and note the date). Keep them
away from magnets and telephones.

=19

If this starts to get tedious, buy a backup program, which essentially backs up automatically.
DiskFit, Redux, and Retrospect are some popular
backup programs. If you have a Performa, you
already own a backup program, you lucky dog,
called Apple Backup (although it doesn't let you
specify what files to back up - it copies your
entire hard drive).
And if your stuff is too big or bulky to fit only a
paltry floppy or two, see Chapter 12 for suggestions for more stuff to buy and plug into your Mac.

M11cin t osh HD

5 items

170 .2 MB in disk

o

Hy perCard 2 .1 Play er

o

Programs

Macintosh Basics

~

Sy stem Folder

When you're finished playing with the Find File thing, choose Quit from its File
menu (or press 3€-Q).

SIJ.stem 7. 1 or earlier
If you have an earlier System version, the Mac will simply present you with the

first matching file by highlighting its icon, wherever it may be:
l§!i"= u11rlou s 11qu11tlc l i fe _iii]
3 items

482 .6 MB in disk

30.6 MB av

-····

rs

mollusk cycle

¢J_

~

crustacean cycle

tzy
j ¢1'i

_________________ Chapter 4: Word Processing 101
If this file isn't the one you were looking for, choose Find Again from the File
menu (or press 38-G). The Mac will scavenge once again and show you the next
matching file. If that's not the one, press 38-G again ... and so on until you finally

locate, or don't locate, whatever you're looking for.

Top Ten Word Processin9 Tips
1. Select a word by double-clicking - and then, if you keep the mouse down

on the second click and drag sideways, you select additional text in
complete one-word increments. (For some reason, this doesn't work in
ClarisWorks.)
2. Never, never, never line up text using the spacebar. It may have worked in
the typewriter days, but not anymore. For example, you may get things
lined up like this on the screen:

1963

1992

Born

Elee te d President Graduated college

2001

Power tips for finding files
When you're searching your computer for some missing file, you don't necessarily need to remember
its name. You can also find it just by remembering when you wrote it, how big it is, and so on.
The trick is the pop-up menus. By choosing from these little menus, you can build basic English
sentences to identify what it is you're trying to find. For example, if you were looking for a document
called "Mother-in-Law letter," you'd choose Name from the first pop-up menu, contains from the
second, and you'd type, say, Mother-in-Law into the blank, as shown in the top row below.
Then, by clicking the More Choices button repeatedly, you could set up more and more criteria,
narrowing down the search. Here are some examples:

(OK, there isn't really a "tone" option. But wouldn't it be cool?)
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Yet, sure as death or taxes, you'll get this when you print:
1963
Born

1992
E lee te d President

2001
Graduated college

So instead of using spaces to line up columns, use tab stops instead. Learn
how your word processor does tabs and use 'em!
3. You can select all the text in your document at once by using the Select All
command (to change the font for the whole thing, for example). Its
keyboard equivalent is almost always 3C-A.
4. Aesthetics Rule of Thumb: Don't use more than two fonts within a document. (Bold, italic, and normal versions of a font only count as one.) Talk
about ransom notes!
5. Don't use underlining for emphasis. You're a typesetter now, babe. You've
got italics! Underlining is a cop-out for typewriter people.
6. The box in the scroll bar at the right side of the window tells you, at a
glance, where you are in your document:
The position of
the box in the
scroll bar tells
you whether you
are at the
beginning ...

0

0

0

... in the middle ...

-0

-0

. . . or the end of
your document. -0

By dragging that box, you can jump anywhere in the document.
You can move around in two other ways:

Click inthe gray part to
jump one screenfu/
up or down.

Click (or hold down)
the arrows to scroll
one line at a time.

7. You've already learned how to copy some text to the Clipboard, ready to
paste into another place. Another useful technique is to cut text to the
Clipboard. Cut (in your Edit menu) works just like Copy, except it snips the
selected text out of the original document. Then click somewhere else in
your masterpiece and choose Paste from the Edit menu. (Cut-and-paste is
how you move text from one place to another.)

- - - - - - - - - - - - - - - - Chapter4: Word Processing 101
8. It's considered uncouth to use "straight quotes" and 'straight apostrophes.'
They hearken back to the days of yore (the days of your typewriter, that
is). Instead, use "curly double quotes" and 'curly single quotes' like these.
(See the difference?)
You can produce curly double quotes by pressing Option-[ (left bracket)
and Shift-Option-] (right bracket) for the left and right ones, respectively.
The single quotes (or apostrophes) are Option-] and Shift-Option-], for the
left and right single quotes, respectively.
But good heavens - who can remember all that? That's why every word
processor I've ever heard of (like ClarisWorks or Word) has an automatic
curly quote feature, which is a much better solution.
9. If there's an element you want to appear at the top of every page, like the
page number, or the date, or The Mister Rogers Story, Part VIL· The Early
Years, don't try to type it onto each page. Not only is that a waste of effort,
but the minute you add or delete text from somewhere else, this top-of-thepage information will become middle-of-the-page information.
Instead, use your word processor's running header feature - it's a little
window into which you can type whatever you want. The program automatically displays this info at the top of each page, no matter how much
text you add or take away. (There's also such a thing as a running footer,
which appears at the bottom of the page, as well as a running politician,
which you want to avoid at all costs.)
10. You know how to select one word (double-click it). You know how to select
a line (drag horizontally). You know how to select a block of text (drag
diagonally through it). By now, you're probably about to reach SelectionMethod Overload.
But none of those techniques will help when you want to select a lot of
text. What if you want to change the font size for ten pages' worth? Don't
tell me you're going to sit there dragging the cursor through 117 screens
of text.
Instead, try this two-part tip. First, click at the beginning of the stuff you
want to highlight so that the insertion point is blinking there.
Now scroll to the end of what you want to highlight. Hold down the Shift
key with one hand, and click the mouse with the other. Magically, everything between your original click and your Shift-click gets highlighted!
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1. Click . ..
2eus 'N' Me

;JX•
~

Iii!

•• I ••• 1 • • • I • •• 2 • •• I• •• 3 •••I••~

pdysseus looked darkly down upon the clinging
ma:nseIV8l\t. It You!"' he cried, wielding his
thunderbolt. "It is .wcroho hath defied me!"
Morton looked up, clinging.
"It was not my idea, I smar it!" he cried . "Your tax
guy made me do it!"
The brov of the great Greek overlord furromd into
a mighty V. "My l.U" t'"l{f!" he bellomd. His voice
echoed across the plains and rattled in the dell.

Morton nodded. "He indica11ld that you're used to
deducting the mortgage in11lrestonyourMt.
Olympus home, and applying it tovard the vacation
cabana in Cancun: he said, gaining courege. "He
said I must never mention that vacation-home
deductions mre eliminated in the Tax Reform Act
of 425 B.C ., or you'd start casting thunderbol13."

r-• 1-- 2. Shift-click ...
If

~Ii

3.. . .and everything in
between gets selected.

Chapters

AQuiet Talk about
Printers, Printing, and Fonts
In This Chapter
I> What the different kinds of printers are and how much they cost
I> How to hook up and start printing
I> More than you ever wanted to know about Postscript and TrueType (and other words
with no spaces in the middle)
~Why printouts sometimes look horrible

J

hope you're seated for this chapter. In fact, I hope you're leaning way back
with your feet up and a daiquiri in your hand.

There's no greater source of confusion and irritation for the beginning Mac user
than understanding printers and fonts, and how to get the best of the latter
from the former. After dropping $1,000 on a laser printer, some people still get
jaggedy, irregular type in their printouts. Others aren't able to print at all they get error messages. And still others have been printing their correspondence for years, in happy ignorance, using the Chicago font - the heavy black
type style that's used in the Mac menus.
It's time to make some sense of it all. If possible.

Credit Card Workout #3: A Printer Primer
Printers come in all kinds of configurations and prices. You can spend next to
nothing and get a "dot-matrix" printer whose printouts are so jagged that they
look like Dante's Inferno written in Braille. Or you can spend a thousand clams
or so and get a laser printer whose printouts look like they were typeset.
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The lma9eWriter-saurus
This honorable dinosaur is called a dot-matrix printer because it prints by firing
little pins against a ribbon that strikes the paper. The resulting collection of
dots forms the letters.
The lmageWriter is slow and so noisy that
people used to buy mufflers for them. The
print quality isn't anything to write home
about (and it's only barely good enough for
letters home.) About the only thing
lmageWriters are any good for is printing onto
multiple-page forms (like Fed Ex labels).

ImageWriter
StyleWriter
LaserWriter
The StuleWriter
Yes, Virginia, there is a high-quality printer that won't bleed you dry: the Apple
StyleWriter. Its quality almost matches a laser printer's. It's very small, very
lightweight, and almost silent. You can feed all kinds of nonliving things through
it: tagboard, envelopes, sheet metal, whatever. And it costs less than $300. Each
successive model has had better print quality: first the StyleWriter, then the
StyleWriter II, the StyleWriter 2400, and so on.

_________ Chapter 5: A Quiet Talk about Printers, Printing, and Fonts
So what's the catch? Well, both the StyleWriter and its
popular $300 rival, the Hewlett-Packard DeskWriter, are
inkjet printers. They create a printed image by spraying a
mist of ink. Therefore, the printing isn't laser-crisp if your
stationery is even slightly absorbent. Note, too, that
inkjet-printed pages smear if they ever get the least bit
damp, making them poor candidates for use during
yacht races.
Still, the StyleWriter is so compact, quiet, and inexpensive that it's hard to
resist. It prints grays (such as photographs) beautifully, too.

Laser printers
If you can afford to pay something like $900 for a printer, some real magic awaits

you: PostScript Laser printers. Don't worry about the word PostScript for now.
Just look for the word PostScript in the printer's description, as though it's
some kind of seal of approval.
A PostScript printer, like most of Apple's LaserWriter models, can print any text,
in any style, at any size, and at any angle, and everything looks terrific.
PostScript laser printers can also print phenomenal-looking graphics, like all
the diagrams in Macintosh magazines and the weather maps in USA Today.
They're quick, quiet, and hassle-free; most can print envelopes, mailing labels,
and paper up to legal-size (but not tagboard).
Remember the old saying, "The power of the press is limited to those who have
one"? Well, the combination of a Mac and a laser printer is what put the Mac on
the map because it turns anybody into a self-publisher. If you can afford a
PostScript printer, get it. If you're a small-time operation - a home business, for
example - get the cheapest Postscript laser printer you can find. Almost all
laser printers between $800 and $1,400 have exactly the same quality printouts.
Incidentally: if you plan to print mainly text (not fancy graphics or 3-D logos),
you may save money by buying a non-PostScript laser printer.

Color printers
There is such a thing as a color printer for your Mac. Unfortunately, you can
have only two of the following: reasonable cost, reasonable speed, and photographic-looking printouts.
For example, there are several inexpensive inkjet printers - the StyleWriter
2400, some of the DeskWriter models, the Epson Stylus, and so on. They cost
around $400, but the printouts look somewhat grainy - well, grainier than
actual photographs.
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If you want printouts that look like actual photographs, you need a dye-sublimation printer that uses color ink on shiny paper, just like real photos - no problem,
they're only about $10,000. Actually, some dye-sub printers aren't so bad; the
FotoFun, for example, is only $400. But its maximum page size is four by six inches,
it takes several minutes per page, and the paper it needs costs $1 per sheet.

Even so, a color printer can be a fun, handy machine. Just be warned that it will
be slow, the color ink cartridges run out quickly, and, of course, you have to
have something colorful to print.

How to Print
I'm going to assume that you've happily purchased a printer. If it's already
hooked up, and you've made some successful printouts already, fast-forward to
the end of this section.

Plu99in9 in a 'Writer
If you bought an ImageWriter, StyleWriter, or other 'Writer, a cable (printer-toMac) probably came with the printer. It's a no-brainer to connect them; there's
only one possible place to plug the cable into the printer. The other end goes
into the back of the Mac; there's a little round jack with a printer icon. (Be
careful not to plug it into the nearly identical jack next to it, which is marked
with a telephone icon.)

Of course, you also need to plug your new appliance into the wall.

Plu99in9 in a laser printer
If you bought a laser printer, believe it or not, you probably did not get a cable
with it. Like anything precious in the computer jungle, it'll take some bushwhacking through the technical underbrush to get at the explanation.

When Apple invented the LaserWriter - the very first PostScript laser printer they charitably recognized that not every company could afford a $7,000 printer
to sit beside each desk. They had a great idea, though: Invent a system where
several Macs could all plug into the same printer.
Ladies and gentlemen, I hereby introduce you to the word network.

_ _ _ _ _ _ _ _ _ Chapter 5: A Quiet Talk about Printers, Printing, and Fonts
The connectors that attach these Macs to a single shared printer are generally
called PhoneNet connectors. (There are actually many brands, but PhoneNet is
by far the most famous brand. Sometimes, .not quite accurately, people call them
LocalTalk connectors. No matter what you call 'em, they're the same connectors you use to hook Macs up to each other - but that's a topic for the sequel.)
What's great about PhoneNet-type connectors is that you string ordinary
telephone wire between them. If you decide to move your printer into the next
room, no big deal - just buy a longer piece of phone wire from Radio Shack.

A PhoneNet connector

A piece of phone wire

Plug one PhoneNet connector into the back of the printer and the other into
your Mac's printer jack. Then connect the connectors with a piece of phone wire.

The Chooser: Where Mac meets printer
The hardest part of printing on a Mac comes at the very beginning - an
unfortunate fact for the novice who simply wants to get going. You have to take
this step no matter what brand or kind of printer you've just connected, or you
won't be able to print a thing.
When you first plug a printer into the Mac, it's not smart enough to notice that
it's got a new friend; you have to tell it. Therefore, after the Mac is connected to
the printer, turn on both machines. Now choose Chooser from the ti menu. You
should see something like this:
Chooser

-Iii

~

AppleShare

JI,

~
~

Image Writer

Laser'W'r lter

l aserWriter 8

SttJ leWriter 1200

m

p£,

GlobalFax

8

~

Sty le'w'riter I/ ti

fo

Appl eTalk

@ Activ e
0 Inacti ve

7.5
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Your screen may look different, of course. The icons that appear in the left half
of the window depend upon which printer drivers are in your System Folder. A
printer driver is a little piece of software that teaches the Mac how to communicate with a specific printer. Its name and its icon match the printer itself, as you
can tell, sort of, from the preceding figure.
If you see a printer driver icon in the Chooser window that matches your

printer, you're in luck! Click it.
If you have a laser printer, click your model's icon. If you don't see your specific

model named, try the LaserWriter 8 icon. Either way, if your printer is turned
on, you should see its actual name show up in the right side of the Chooser
window, as shown here:
f§(ij

Chooser

~

~

Select a Pos ts cript Printer:

~

-0

Globa!Fax

AppleShare

.L

~

Laset""'Writer

If, on the other hand, you have a StyleWriter, you'll see a choice of jacks, as
shown in the following illustration. If you plugged your StyleWriter into the

printer jack as instructed earlier, click (obviously) the printer icon.
If you plugged your Style Writer into the printer jack of the Mac ...
Iii

L

Chooser

~

~

~

AppleShar-e

Globalfax

Image Writer

~

LaserWriter

~

StyleWriter 1200

Laser'w'rlter 8

Connect to:

r:.

L

-0

% <Serial Port >

~

a

ti
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MWMll
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~

=:::::::,,.

Q Actl ve
lzyN AppleTa lk @
Inacti ve
'-...

~

7.5

... be sure "AppleTalk" is set to Inactive.

_________ Chapter 5: A Quiet Talk about Printers, Printing, and Fonts
Good going! Everything's coming up roses. If the names of several printers show
up on the right, then you're either part of an office network with several
printers, or you're an unexpectedly wealthy individual. Congratulations. Click
the one you want to print on.
If you don't see your printer's icon (or any icons) in the left half of the Chooser
window, somebody's taken them off your Mac. No matter - re-install all these
icons by running the Installer on your original white System-software disks (or
the startup compact disc). Now you can repeat this Chooser business, and
everything should go fine.
If things still aren't going well - for example, if you click the driver icon, but
your printer's name doesn't show up in the right side of the window - then see
Chapter 17.

Anyway, once you click a printer driver icon, a couple of things happen. If
you're selecting a laser printer, you may be told to tum on AppleTalk. AppleTalk
is the networking feature, in which your Mac constantly sends little messages
out that telephone wire to see if any other Mac is trying to strike up a conversation - remember that if you have a laser printer, you're supposedly part of a
network even if just one Mac is attached to it. So make sure the little AppleTalk
setting (in the lower-right corner of the dialog box) is Active if you have a laser
printer. Conversely, make sure AppleTalk is inactive if you have a StyleWriter
plugged into your Mac's printer jack.
When you close the Chooser, you get a soon-to-be-annoying alert message:

You haue changed your current
printer. Please choose "Page
Setup ... " in all of the open
applications.

(~)

It tells you (as if you didn't know) that you've just changed to a new printer. Just
ignore it and click OK.
You've just introduced the Mac to its new printer. All of this is a one-time
operation, by the way. Unless you have to switch printers or something, you'll
never have to touch the Chooser again.
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&ck9round printiniJ.
In the Dark Ages of the 1980s, when you printed something, the printer's soul
took over your Mac's body. You couldn't type, you couldn't work, you couldn't
do anything but stare at the sign on the screen that said "Now printing." It was a
dark and stormy era, a time of wild and rampant coffee breaks. Only when the
paper came out of the printer were you allowed to use your computer again.
Since then, some clever engineer at Apple figured out how to allow background
printing. When you use this handy feature, the Mac sends all the printing
information, at a million miles per hour, into a file on your hard disk. It then
immediately returns its attention to you and your personal needs.
Then, quietly, behind the scenes, the Mac shoots a little bit of that file to your
printer at a time. It all happens during the microseconds between your keystrokes and mouse clicks, making it seem as though the Mac is printing in the
background. In time, the printer receives all the information it needs to print, the
paper comes gliding out, and you've been able to keep working the whole time.
~ t'LAt-t.
~

_

In practice, there are a few chilly background printing realities to consider. First,
a document takes much longer to print in the background than it would if the
.- Mac devoted all of its brain power to printing. Similarly, making your Mac
concentrate on two things at once also bogs down what you're doing; while
something's being printed in the background, you can outtype your word
processor, windows seem to take longer to open, and so on.

~

Turning the Background Printing feature on and off is easy. Select Chooser from
the menu. In the lower-right side of the box, you'll see the On/Off buttons. Go
for it.
I mention this tidbit so that you'll remember it when you're in a serious hurry
for a printout. When it's 1:55 p.m. and the meeting is at 2:00. Or you're leaving
the house anyway and want to make sure your printout is ready when you get
back. In all of these cases, it would be wise to tum off background printing to
ensure that you get your printout as fast as possible.

A~er all that:

How IJ.OU actuall1J. print

OK. Suppose that your printer is finally plugged in and, via the Chooser, has
been introduced to the Mac. The moment has arrived: you'd actually like to
print the thing.
Choose Print from the File menu. This dialog box appears; it looks different
depending on your printer, but the one pictured below is typical of what you
see if you have a laser printer:
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Printer: "Silentwriter 95"
Copies:l•I

Pages:®All

e.1.1

([ Print

J]

QFrom:O To:O

( cancel )

,.. Paper Source.......................·-·-·····-···········································-······ ,.oestlnation........,
Cassette
..,, Ii ®Printer

[ Options ]

I®All O First from: I
!

l

fie11rninim1rn11n:I

C<is~elle

..,.11

I
!orne

;

Help

L.............................._............

For 95 percent of your life's printouts, you'll completely ignore the choices in
this box and simply click the Print button.
For the other 5 percent of the time, the main thing you do in this dialog box is
tell the Mac which pages of your document you want it to print. If you just want
page 1, type a 1 into both the From and To boxes. If you want page 2 to the end,
type 2 into the From box and leave the To box empty.
Specify how many copies you want by clicking and typing a number in the
Copies box.

Now would be a good time, I suppose, to mention what the Tab key does in
dialog boxes. Suppose you want to print two copies of page 3. Instead of using
the mouse to click in each number box on the screen, you can just press Tab to
jump from box to box.
Therefore, you'd just type 2 (in the Copies box); press Tab, type 3 (in the From
box); press Tab, type 3 again (in the To box). And the mouse just sits there
gathering dust.
Tab
Tab
Return

Pages: QAll
r·P aper Sou rce·-·····----······-·-··········-·-·······-··-·--·---1 ["Destination.....,
O First from: I Cassette
..,, I! ! ®Printer

i ® All
.

Remaining from:

I

Ca%ette

..,,

Ii
i

L-···-·····..............................................................................................................,,,)

Io me

[ Options J
Help

!. . . . . . . . . . . . . . . . . . . . . . . ..!

Anyway, after you're done filling out the options in this box, you can either click
the Print button or press the Return key. (Pressing Return is always the same as
clicking the outlined button.) The Mac should whir for a moment, and pretty
soon the printout will come slithering out of your printer.
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This handy shortcut - using the Tab key to move around the blanks, and
pressing the Return key to "click" the OK or Print button - works in any Mac
dialog box. In fact, any time you ever see a button with a fat black outline, as
shown in the following montage of classic dialog boxes, you can press the
Return key instead of using the mouse.
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Cancelin9 printin9
If you want to interrupt the printing process, 3€-period does the trick - that is,

while pressing the 3€ key, type a period. Several times, actually. Even then, your
printer will take a moment (or page) or two to respond to you.

A Guide to Ja99ed Printouts
This is really going to be "A Guide to Avoiding Jagged Printouts," but we needed
an attention-grabbing heading.
Well, no; actually, this is really going to be "A Guide to Fonts." But in this day
and age, there's virtually no reason for anyone to know about font technology
except to prevent jagged printouts.
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Special FX with QuickDraw GX
Do you have System 7.5? Check your Cheat
Sheet, where (if you read Chapter 1) you wrote
down this information.

If you double-click one of these printer icons,
you see a list of the files waiting to be printed on
that printer.

Anyway, one of System 7.5's fancy new features
is called QuickDraw GX. The initials stand, as
you can probably imagine, for nothing at all.

GX has a million other new features, too. For
example, a lot of high-falutin' typography is built
into GX- glitzy new type-twisting features that
happen automatically as you type. Here are some
examples:

Good old QD GX is actually a pretty ingenious
piece of software, even though (a) it takes up a
huge chunk of your Mac's memory, (b) it doesn't
get installed automatically when you install
System 7.5 (you have to run a special GX installer), and (c) most of its features don'twork yet.
Someday, GX will supposedly revolutionize
Macintosh printing, typefaces, color, screen display, and more. Today, the only way it might make
a dent in your destiny is with desktop printer
icons. For people with more than one printer available, this is a great feature. Instead of slogging
off to the Chooser to specify a printer, you just
drag the icon of whatever you've typed on top of
an icon that represents a printer, as shown here.

Automatic correct-looking
fractions!

Automatic swashes!

l

"Put h ofthatfish back in the
wats."
I
\ '
1

Automatic fancy
initials!

Automatic letter-pair
tightening (kerning)!

These and other magical GX technologies require special, smartened-up GX fonts. (You'll be
reading about fonts shortly.) But the GX magic
also requires special, smartened-up GX programs, such as word processors. Unfortunately,
it may be a long time before software companies
update their stuff to make it GX-compatible.
Until they do, and typographic utopia arrives,
the only advantage you gain by installing
QuickDraw GX is that desktop-printer business.
(And besides, the modem-adventurous among
us can get thatfeature without installing GXby fetching, off America Online, the Apple program called Desktop Printing extension; see
Chapter 10.)
In general, therefore, QuickDraw GX is an excellent thing notto install.

But listen: if your printouts look great, you're done. Outta here. Finito. Go on to
the next chapter. This section gets a little dense, and it's only here if you need it
or, God forbid, if you want to know what's going on behind the scenes.
You see, to understand why lettering sometimes prints out jaggedly, you must
suffer through a description of the three different font formats that may lurk
inside your Mac.
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Font format 1: Bitmapped fonts
When the Mac first appeared, every typeface (which Apple calls a font) was
formed of dots in a particular arrangement. It was a "map" of dots, if you will
(and even if you won't). It was therefore called a bitmapped font. (So why don't
they call it a dotmap?You kidding? That'd be too easy to understand.)
These fonts were named after cities; New York, Geneva, Athens, and so on. They
had the exact same quality (resolution) as the Mac screen: 72 tiny square dots
per inch. (To make sure as many people as possible are left in the dark, everybody abbreviates "dots per inch" as dpi.)
Bitmapped fonts have two drawbacks. First, 72 dots per inch may sound, at
first, like a plethora of dots ... dots aplenty ... a veritable dotfest. But believe it
or not, 72 dpi is still too coarse to produce smooth printouts. You can still see
the chunky square dots that compose each letter.
Second, if you think about it, you'll realize that a bitmapped font can only be
printed clearly at a single size - the size at which its designer arranged the
dots to look good. True, each bitmapped font usually comes in a selection of
different sizes, each painstakingly mapped to screen dots - usually 10-point,
12-point, 14-point, 18-point, and 24-point sizes. But if you try to select
inbetween type size, you get pretty gross-looking results.

an

For example, 12- and 24-point below looks fine, but no 17-point New York font
bitmap comes with your Mac, as evidenced by the chunky example in the middle:
New York at 12-point size

New York at 1 ?-poi:nt size

New York at 24-point size
Therefore, if you're getting crummy-looking text in your printouts, the first
possibility is that you've used a bitmapped font in your document. (And if it
looks really wretched, you're probably using it at a non-predesigned point size.)
Fortunately, there aren't many bitmapped fonts left alive today; London, Venice,
Los Angeles, and Espy are about the only ones anyone runs into anymore.
Change the font to a non-city-named font, and read on.

Font format 2: PostScript fonts
The world changed when Apple created the LaserWriter printer. Its resolution
was 300 dots per inch - over four times sharper than the first Mac printer, the
ImageWriter.
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The main thing about the LaserWriter, though, was the new technology called
PostScript that was built into it. They call Postscript a "page description
language." All you really need to know about PostScript is that
Y' A PostScript laser printer means the end of jaggies. It can create extremely

sharp, clear printouts that look published.
Y' To print sharp text on a Postscript laser printer, you have to use special
fonts. (They're called, of course, PostScript fonts.)
Y' PostScript fonts can be printed at any size or angle - no matter how big,

small, or absurdly stretched -with equal clarity.
PostScript fonts, unlike bitmapped ones, don't print text by specifying the

placement of each dot on the page (below, left). Instead, the Mac thinks of each
letter in a Postscript font as a hollow outline (below, right). The printer fills in
that outline with solid black. Since a PostScript printer thinks of fonts by their
shapes, it's simple to tell the printer "Make this bigger"; it just multiplies the
outline-shape by a point size number you specify. Printouts of 12-point, 35.8point, and 128-point type all look equally sharp on a PostScript printer.

••••••
••••••
••••
••••••
••••
••••
••••••••
•••
••••
•••••••••
••••••
••
•••••••
•••••••
•

As a result - and unfortunately- each PostScript font has two parts. There's a
regular bitmapped font, with all the usual problems of ugliness-at-strange-sizes,
for use on the screen. (It's sometimes, therefore, called a screen font.) And
there's a separate file, called a printer font, that you put in your Fonts Folder or
System Folder, which stores all those outline shapes.

The printer fonts have the same names as the screen fonts, with the last letters
lopped off. In your word processor's Font menu, you might see Palatino
Roman - but in your System Folder, in the Fonts folder, there'll be a
printer-font file called PalatRom.
For each type family, like Futura, you need a whole rat's nest of printer-font files
in your System Folder: one each for bold, italic, bold italic, and so on. In the
following figure, you can see a suitcase icon (which contains the screen fonts)
and its associated printer fonts:
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N Helvetica Narrow

;]]
HelveNar Helv&NarBol HelveNarBolObl HelveNarObl

Anyway, this is all leading up to explaining a second (and more common) cause
of jagged type. If you've used Postscript fonts in the document you're printing,
and they're not looking terrific in the printout, then the appropriate printer-font
file is missing or in the wrong place (that is, not in the System Folder or the
Fonts folder).
"And where," I can almost hear you asking, "am I supposed to get this piece of
font that you claim I'm missing?"
"Well," you can almost hear me replying, "no Postscript fonts come with your
Mac! So if you have a Postscript font, either you or somebody else bought it (or,
um, copied it from somebody) and installed it on your Mac." Therefore, seek the
missing printer-font file on the original font disk.

Font format 3: True TIJ.Pe fonts
Fortunately, unless you're a graphic designer, you probably don't have any
bitmapped or PostScript fonts. As a result, you probably don't have any of the
corresponding Excedrin headaches.
Instead, your Mac came equipped with only one kind of font, an idiot-proof,
jaggy-free, self-smoothing kind of font that looks great on any printer at any size.
It's TrueType. It has all the advantages of Postscript fonts (smooth type at any
size). Yet it eliminates the problems of the PostScript scheme. Instead of having
two separate files - one for the printer and one for the screen - TrueType
fonts are self-contained. Likewise, instead of cluttering up your life with a
separate font for each style variation (bold, italic, and so on), all the styles in a
TrueType font are built into that one font suitcase file.

ID 1in9 a Font
So there are three kinds of fonts: bitmapped, Postscript, and TrueType. In your
quest to understand what you've got on your computer, and to straighten out
whatever jagged-printout problems you might be having, here's your own
personal Guide to Font Identification.
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Open your System Folder. If you have a Fonts folder, open it; if not, double-dick
the System file itself. Either way, you should see your fonts arranged before you;
the nine fonts that come with every Mac are as shown here:
Fonts
9items

~

Chicago

644.9 MB in disk

~
~

Courier

m
Geneva

~
~

He1ntica

512.2 MB available

~
Monaco

~~
New York

mm~
Symbol
Times

Palatino

Now then: to find out what kind of font one is, double-click a suitcase icon. If
you now choose By Icon from the View menu, you'll see TrueType fonts displayed with this special icon (see all those little Xs?):
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If, on the other hand, you don't see any icons with multiple /\s, you know it isn't

a TrueType font. Therefore, you're dealing with either a bitmapped or
Postscript font:
Iii

Iii]

Esf!.!1.. Sans

Ll2items

rd]
Espy Sans 10

645.4 MB in disk

511.7 MB available

~

rd]

tzy

Espy Sans 12

<>I

1¢11

And therefore, if that Fonts folder (or possibly your Extensions folder) doesn't
contain a bunch of correspondent abbreviated-name printer fonts, this font will
print jaggedly, like it or not.

But what about Zapf Din9bats]
There are 35 exceptions to that generalization - the 35 type styles built into
your laser printer. These fonts don't need printer files in your System Folder.
Here's the list:

Times Roman
Times Bold
Times Italic
Times Bold Italic

New Century Schoolbook
Roman
New Century Schoolbook
Bold
New Century Schoolbook
Italic

Avant Garde Roman
Avant Garde Demi
Avant Garde Italic
Avant Garde Demi Italic

New Century Schoolbook
Bold Italic

Bookman Roman
Bookman Demi
Bookman Italic

Palatino Roman
Palatino Bold
Palatino Italic
Palatino Bold Italic

Bookman Demi Italic

Helvetica Roman

Helvetica Bold
Helvetica Oblique
Helvetica Bold Oblique

Helvetica Narrow Roman
Helvetica Narrow Bold
Helvetica Narrow Oblique
Helvetica Narrow Bold Oblique
Zapf Chancery
Llj/µ~oA.

Courier
Courier
Courier
Courier

Roman
Bold
Italic
Bold Italic

(Symbol)

*O* +**00

(Zapf Dingbats)

(Although Oblique and Demi may sound like part of a sleazy trapeze act, they
are in fact the trendy words for Italic and Bold, respectively.)
I realize that your brain is probably imploding at this point, but the upshot is
simple: If you discover, in your Fonts folder, any of the typefaces shown above,
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like Zapf Chancery or Avant Garde, breathe easy. They may well be Postscript
fonts, but you don't need those little printer-font files in your Fonts folder they're built right into the laser printer.
One more word of advice, ye lucky laser-printer user: Nobody's ever gone to
hell for this, but it's a good idea not to let the TrueType and PostScript versions
of the same font coexist on your system. Make a decision to go with the TrueType
version or the Postscript version, and stand by it - and remove the duplicate.

A Veritable Font-u-copia
So where do you get additional fonts? The universal response to that kind of
question is, of course, buy them.
Those on a budget, however, can still get tons of great fonts. Call up your local
user group and pay about $5 for a disk full of new fonts. Or if you have a modem
(as described in Chapter 10), you can dial up America Online or another online
service and help yourself to as many fonts as your typographical taste buds can
tolerate.

Hou/ to install a font in SIJ.stem

7

Quit all your programs (if you're running any) before trying this.
Drag the font-file icon on top of the System Folder icon. That goes for both
printer-font files and screen font files, if it's a PostScript font you're installing.
(Do not drag them into the open System Folder window. Do not drag them to
the Trash can. Do not collect $200.)

8*'1~&
..........
You'll see a message alerting you that the Mac is going to install the font for
you. Just smile, wave, and click OK.

Hou/ to remofle a font
First of all, remind yourself what system-software version you've got. (Did you
write it on this book's Cheat Sheet, as instructed in Chapter 1?)
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The only sidebar about user groups
Just in case the term "user group" caught you
by surprise, here's the lowdown.
There are hundreds of these things Macintosh User Groups, or MUGs. They're called
things like LAMUG, NYMUG, and THUG (for the
LA, NY, and The Hudson organizations, respectively). Each is a teeming hotbed of Mac enthu.siasts of all different levels. They usually meet

monthly, crank out a newsletter a month, and
charge low annual dues. Each is also a dandy
place to get your questions answered, your purchases previewed, and your social cravings
slaked.

To find out which group is closest to you and
your Mac, call Apple's user-group hot line,

800-538-9696.

If you have System 7.1 or later, open your System Folder and then open the
Fonts folder therein. (If you've got any earlier version of System 7, open the
System Folder and then double-click the System file icon itself.)
In any case, you'll now see a list of your fonts in a window:
§Iii!

Fonts

2 4 items

LI
LI

464 . 1 MB in disk

Chicago

Courier

[] Espi Sans 1 0

LJ Fluent laser Fonts
LI Geneva
LI Helvetica
LI Monaco
LJ MS LineDr aw
LJ MT Ex tra
LJ New York
LI Palatino (Postscript)
Ll Symbol

To see what a font looks like, double-click its suitcase icon. You'll get a window
showing the individual font sizes, like Times 10 and Times 18; double-click one.
Alittle window opens, displaying a line from classical literature, displayed in
the font you're investigating.
To remove a font, just drag it - or its entire suitcase - out of the window.
Put it onto the desktop. Or put it into some other folder - or right into the
Trash can.
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Top Ten Free Fun Font Factoids
1. Every Mac comes installed with Times, Helvetica, Courier (which looks
like an electric typewriter), Symbol (a bunch of Greek symbols), New
York, Palatino, Chicago (the font used for menu names), Geneva (the font
used for icon names in the Finder), and Monaco (a monospaced font,
where every letter is exactly the same width; Monaco looks ugly on-screen
but looks OK when printed). The Mac won't let you remove the last three;
it uses them for various things on the screen.

2. Some of the bitmapped fonts that come with the Mac correspond to
Postscript fonts. New York is pretty much like Times; Geneva is sort of like
Helvetica; and Monaco is a lot like Courier (they're both monospaced).
3. Ten font families are built into most Postscript laser printers. They are, as
you'll recall, Times, Helvetica, Helvetica Narrow, Avant Garde, Palatino, Bookman, New Century Schoolbook, Symbol, Zapf Chancery, and Zapf Dingbats.
Any PostScript font that doesn't appear on this list has to be downloaded
(transferred) to the printer each time you turn on the printer and try to
print. As such, they're called downloadable fonts. That's why their printerfont files have to sit in your System Folder, where the Mac will know where
to find them. Downloadable fonts impact your life in several ways. First,
you have to buy them. Second, documents that use downloadable fonts
take more time to print; the Mac has to teach the printer what each
character looks like.
Third, if you use several downloadable fonts in a document, it may not
print at all. The printer's memory will get filled up with font information
even before the Mac starts to send the document. The result: The printer
keeps saying "Wait, wait, I'm not ready yet ... " to the Mac, and the Mac
keeps saying "Ready? Ready? Here it comes ... ," until you get disgusted
and flip one of them off. (Marriage counseling. for computer equipment is
not yet available outside California.)
The solution, of course, is to reformat your document using the built-in
fonts (Times, Helvetica, and so on) instead of downloadable ones - or to
install more memory into your printer. (You'll find more nitty-gritty on this
topic in Chapter 17.)
4. Choose Page Setup from the File menu. The Page Setup dialog box has a
handful of very useful options - what paper size you plan to use, for
example, or how much you want your document enlarged or reduced. In
the upper-right corner, though, is a nifty Options button (if you have a
laser printer). Click it. Up comes a dialog box:

[l3

LHerWriterOptlons

D Flip Horizontal
D Flip Uertlcal

1.1.1

~

r.:=:::;,

~

0 lnuert Image
D Precision Bitmap Rllgnment (4% reduction)
D Larger Print Area (Fewer Downloadable Fonts)
D Unlimited Downlo8dable Fonts In a Document
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To get a little preview of each option, click the appropriate checkbox and
watch the helpful Dogcow illustrate the effect on your printout.
Most noteworthy, though, is the item called Larger Print Area. The average
laser printer can only print to within 1/2 inch of the page edge. Select Larger
Print Area, though, and you gain 1/4 inch all the way around - a very useful
gain for graphics, music, page layout, and other kinds of printing.
5. Suppose that you select some text and make it bold. Then you try to print,
but the text keeps coming out as nonbold on the printed page.
The problem is that some PostScript typefaces, notably Zapf Chancery,
don't have a bold version. (Zapf Chancery doesn't even have an italic style
since it's already sort of italic.)
6. Adobe's Postscript typefaces each include a complete bitmapped screen
font for each type style - bold, italic, and so on. Unfortunately, each style
name appears in your Font menu prefaced by an initial: "I Times Italic, B
Times Bold, BI Times Bold Italic," and so on.
Who came up with this dumb idea, I can't tell you. But I do know that your
font menu lists fonts alphabetically. The result is that each typeface's style
variations aren't listed together - they're scattered all over the damed
menu, as shown in the left figure below. Your only chance of getting things
into shape is to buy a utility program that combines them into family
groups on your menu, with the style variations listed in a submenu (right):

Auant Garde
B Ruant Garde Demi
B Bookman Demi
B New Century Schlbk Bold
B Palatino Bold
Bl Auant Garde DemiOblique
Bl Bookman Demi Italic
Bl New Century Schlbk Boldlt
BI Palatino Bold Italic
Bookman
Chicago
Courier
Geneua
Heluetica
I Auant Garde BookOblique
I Bookman Lightl talic
N Heluetica Narrow
NB Heluetica Narrow Bold
NBI Heluetica Narrow BoldObl
New Century Schlbk
New York
NI Heluetica Narrow Oblique
.,.,Palatino
Symbol
Times
Zapf Chancery
Zapf Din bats

Ruant Garde
Bookman
Chicago
Courier
Futura
Geneua
Heluetica
Heluetica Condensed
Heluetica Narrow
Monaco
New Century Schlbk
New York
Symbol
Times
Zapf Chancery
Zapf Dingbats

••
•
••
• .,
Bold
Bold Italic
Italic
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One such utility is WYSIWYG Menus, part of the Now Utilities package (see
Appendix B, the Resource Resource).
7. In ClarisWorks and some other word processing programs, you can
actually see the names of the fonts in your font menu in those typefaces,
like this:
Arial
Arial MT Condensed Light
Mal Narro11U
A rial Rounded MT Bokj
Avant Garde
l!Guhllw•H

Badoni MT 111ara BoJd
Book Antiqua
Bookman
Boolanan Old Style
Bookman Old Style Bold

You can get this feature a few other ways, all of which involve spending
some money. Suitcase II, Now Utilities, and MenuFonts are a few programs
that add this feature to any program you own.
8. When you first buy your laser printer, you may have noticed (and sworn
at) the fact that it spits out a "startup page" every time you turn it on. This
startup page contains a host of extremely unimportant information, like
the number of pages you've printed in the printer's lifetime (including the
useless startup page in your hand). Meanwhile, the Brazilian rain forests
keep getting smaller.
You can tell the printer not to waste that paper and ink, if you want. Use
the little program, called either (a) Apple Printer Utility, (b) LaserWriter
Utility, or (c) LaserWriter Font Utility. It's on the disks that came with your
Mac, and may also be on your hard drive in a folder called Apple Extras.
Double-click this Utility program's icon, and choose Start Page Options
from the Utilities menu. Click Off, and savor the fact that you made the
world a better place for your grandchildren.
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and sans serif (SANNZ sair-iff).
A serif is the little protruding line built onto the edges of the letters in
certain typefaces. In the serif font pictured in the top example here, I've
drawn little circles around some of the serifs:

Te~if ~erifs

Sans-serif
A sans serif font, on the other hand, has no little protuberances, as you can
see by their absence in the little square (in the lower example above). Tunes,
Palatino, and the font you're reading are all serif fonts. Helvetica, Geneva,
and the headlines in most newspapers are sans serif fonts. And that information, plus 32¢, will buy you a first-class postage stamp in the United States.
10. This one's techy, but it's good.
When the Mac prints, it matches the placement of each word exactly
according to its position on the screen. Trouble is, the Mac's screen
resolution isn't that good- it's only 72 dots per inch instead of 300 or 600
dpi (the usual for printers). As a result, you sometimes get weird spacing
between words, especially between boldface words (see the bottom-left
printout below).
The solution: when you print, turn on the Fractional Character Widths
feature. This makes words look a little bit cramped on the screen (top-right
in the figure below) but makes your printouts look awesomely professional
(bottom right).
Fractional Widths OFF
On the screen:

Bull"ViDkle"s Little Secret

In the printout:

Bullwinkle's Little Secret

Fractional Widths ON

Bullwinkle's Little Secret

So how do you find this magical feature? In WordPerfect and Word 5, it's in
the Page Setup box (File menu). In Word 6, it's in the Options box (Tools
menu); click the Print tab. In ClarisWorks, it's one of the Preferences (Edit
menu). Try keeping it off when you're typing and on when you print.

In this part . . .
rther you've faithfully plowed through the personality-

_

f;.1~nriching material so far, nursing your inner child (the
one that always wanted to use a computer), and are now
ready for more , ..
. . . or you've just skipped over a lot of stuff to get here.
Either way, you won't be disappointed: the mind-blowing
Faking Your Way Through the Top Ten Programs will be your
survival guide for maintaining status in the office, and More
Stuff to Buy and Plug In will help you unleash your Mac's
potential (and unload your wallet).

Chapter&

Faking Your Way Through the Top
Ten Programs
Jn This Chapter
~

Faking your way through word/page processing programs like Word, PageMaker, and
QuarkXPress

~Faking your way through

famous number/data crunchers like Excel, Quicken,

and FileMaker
II>- Faking your way through graphics programs like ClarisWorks, MacDraw, and Canvas

~is chapter is a survival guide for stranded-on-a-desert-island, filling-in-for-

' ~r.-Big, my-son's-at-school-but-I-need-to-print-out-something, the-computerjust-arrived-but-the-board-meeting-is-in-two-hours, in-a-computer-store-to-trysomething-but-don't-know-how-it-works situations.
Macintosh users are notorious for not reading their software manuals. They're
actually belligerently proud of the fact that they never read manuals. Of course,
two years down the line, one user will look at another user's techniques and
intone, astounded, "I never knew it could do that!'
You're welcome to join this cult of instant gratification, with this chapter as
your guide - but at least read the manual for your word processor (or whatever program you spend the most time in).

ClarisWorks (Motled to Neu! Address)
You know how the phone company has run out of phone numbers in each area
code, so they're frantically sitting around a table somewhere making up weird
new area codes like 007 and 456? That's what happened here. The ClarisWorks
section just got so damed big - because there's so much you can do with this
program - that it had to get moved into a new chapter. Its own chapter, in fact,
which follows this one.
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Drawin9 Pro9rams (ClarisDrauJ,
ClarisWorks, & Co.)
MacDraw, ClarisDraw, Canvas, SuperPaint, all drafting programs, and the
Drawing window in ClarisWorks all work essentially alike. They're called
drawing programs. As much as that sounds like they'd be the same things as
painting programs, they're not.

Paint tis. draw
Painting programs create art called bitmapped graphics. When you lay
down some "paint," it's stored as a bunch of dots. You can erase them, but
you can't change the original shape you painted - a circle, say, or a letter of
the alphabet - because the Mac no longer thinks of them as a circle or a letter.
It just thinks of them as a bunch of painted little dots. The advantage: You have
control over each individual dot, and you have dot-manipulation tools like the
Spray Can. In the next figure, note (1) the speckled effect, and (2) the fact that
you can drag a chunk of circle out of the original collection of dots:

Drawing programs, on the other hand, create object-oriented graphics. When
you draw a circle, the Mac doesn't store it as a map of black dots. It remembers
that you drew a circle of a fixed shading and size. That means that you could
never speckle it, and you could certainly never erase (or remove) a chunk of it.
But the advantage of drawing programs is that, later, you can return to that
circle and move it by dragging it. Or you can overlap another object on top of
it - and later change your mind. Or you can change a circle's shading long after
you drew it. Or, as shown in the next figure, you can tug a circle's handles to
stretch it.

Drawing programs tend to print out with much sharper quality than
painting programs.
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Drawin9 concepts
The palette in all of these drawing programs contains the same basic tools.
These tools are incredibly common. They even crop up in non-art programs, like
databases (FileMaker), word processors (Word), and spreadsheets (Excel).
Here's the Reader's Digest condensed version:
Text Tool: Lets you add type to your
artwork. You can edit this text later.

Arrow Tool: Selects objects, grabs their
handles for stretching.

Hand (or Grabber): Slides the drawing
around on your screen, giving access
to offscreen areas.
Rounded Rectangle Tool: Creates
rectangles with rounded corners.

OD

Rectangle Tool: Creates rectangles-or,
with shift pressed, creates squares.

Line Tool: Draws straight lines-or, with
Shift pressed, draws perfectly horizontal
or vertical (or 45-degree) lines.

'0

Ellipse Tool: Creates ovals-or, with
Shift pressed, creates circles.

er '

Polygon Tool: Creates multisided shapes;
click at each corner, and double-click
to finish the shape.

Arc Tool-Draws a quarter-circle.

Each program has a few goodies of its own, too, but these basics are
always included.
To draw something, click the tool (and release the button), move to a blank part
of the screen where you want to place the object, hold down the mouse button,
and drag. When you let go, you'll see the new line or shape enclosed by small,
black, square handles. Using the Arrow Tool, you can drag these handles to
stretch or resize the object you just drew. Or click in the middle of it to drag the
object to a new location.
Or just click an object to make its handles show. After handles appear - letting
you know that the object is selected -you can use the menus to change the
object's appearance. For example, suppose you draw a thin line (below, left).
While it's selected, you can choose a new line thickness (below, middle) from
the line thickness palette (every program has one). The result: The same line
has a different thickness (below, right).
Hairline

-•-

---

vi---

-
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Using the palette of colors (or of patterns), you can change the color (or
pattern) that fills the inside of a shape the same way: select and then apply.
Actually, you'll generally find two different pop-up controls: one for the outside
of a shape, and another for the inside. In the picture below, from a ClarisWorkstype program, you can see these two separate sets of controls. The top row,
marked by the little pouring-paint-button icon, has three pop-up buttons that
control the inside of the selected rectangle (the three buttons change the color,
pattern, and gradient [shifting-color fill], respectively). The bottom row, marked
by the pen icon, has three pop-up buttons that control the outline of the
rectangle (the color, pattern, and line thickness, respectively).

The power of Shi~
When you press the Shift key while you draw something, the Mac constrains the
movement of your mouse to flat or symmetrical movements. For instance, press
Shift when you draw a line, and the line will be perfectly horizontal, vertical, or
45-degree diagonal. Press Shift while you draw a rectangle, and it will be a
perfect square. And so on.

A great time-saver for frequent pattern changers
The rule for modifying lines, squares, and circles
you've made in a drawing program is simple:
select then apply. (You've read this before, I
believe.) To make a rectangle black, you click it
(select it) and then choose a color from a pop-up
palette. Select, then apply.

All the ovals have the
same fill-in pattern.

Here's a powerful shortcut If you use a menu or
palette to make a setting before you draw something, while no object is selected, you specify the
settings forthe next objects you draw. This illustration should make all clear.

••

But choose some ... and all new ovals
settings while no
start life with the
oval is selected . . . new settings.

________ Chapter 6: Faking Your Way Through the Top Ten Programs

SelectiniJ. and 1J.roupin1J, multiple objects
In the Finder, after you click one icon, you can select additional icons by Shiftclicking them (that is, clicking them while pressing the Shift key). In a word
processor, if you have selected a word, you can extend the selection by Shiftclicking some place later in the paragraph.
Yes, indeed, Mr. Watson, there is a pattern here. This Shift-click-to-extend-aselection deal is a common Mac technique. Same thing in drawing programs:
click to select one object, Shift-click to select others.
After you've got a bunch of objects selected, you can group them - combine
them into a single new object - using (what else?) the Group command. You
can even group groups. You may want to group objects in this way just to make
sure their alignment to each other doesn't get disturbed.
Handiest yet, you can ungroup a group, or even ungroup a grouped group of
groups. (I'll give you a moment to work on that.) Drawing programs ungroup
objects in the same order in which they were grouped. So imagine that you
group objects A and B together, and then group object C to the first group. The
first time you use the Ungroup command, you'll wind up with the A/B group and
the C object loose; apply Ungroup a second time to split up A and B.

Text FX
One of the nicest things about drawing programs is that text is text, and text it
remains. Text in a painting program, on the other hand, turns into a text-shaped
collection of painted dots instantly. You can't edit the text or change the font or
correct a typo, once you're done typing. And the printout looks exactly as
jagged as it does on the screen:

A Green Onion
In a drawing program, though, because the Mac still thinks of text as text (and
not dots), it prints out at full text sharpness on a laser printer or StyleWriter:

A Green Onion
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Furthermore, in a drawing program, each piece of text remains editable inside
its little boundary rectangle. You can change the font or the size of the text or
the dimensions of this rectangle at any time. For example, if you notice a typo
(below, top), just click the text object with the appropriate text tool selected,
click the problem text, and edit away (below, bottom):

Carefull typeing
· 1c.;.re1u1

:ou.n,{,· r

After you create a text block, you can paste it into a word processor and drag
those little comer boxes. The word processor thinks it's just a plain old graphic
and proceeds to squish it any way you like. The result is fantastic text effects
you couldn't create in a word processor alone:

AGreen Onion
Beyond these concepts, a drawing program really doesn't require a degree in
rocket science. I now release you to your creative juices.

Paintin9 Pro9rams (Photoshop,
ClarisWorks A9ain)
There are about a dozen of these programs, many of which end with the word
Paint. Some examples are Super-, Ultra-, and PixelPaint; Kid Pix; HyperCard;
SuperCard; plus pro-level programs like Photoshop, Painter, Dabbler, and Color
It. (Those expensive ones can even be used to retouch photos.) ClarisWorks
even has a painting window. Most painting programs work alike - only the frills
differ from program to program.
They're called painting programs because they produce bitmapped artwork.
(For a discussion of what that means, see the introduction to the Drawing
Programs section.) Printouts from bitmapped programs tend to be a little bit
jagged, since the Mac is reproducing the Mac screen when it prints out.
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There's not much mystical hidden knowledge to be unearthed in paint programs. Once you've used a tool, you've pretty much mastered it for life. Here,
then, is a typical Tool palette. You click a tool (and release), move the cursor to
the page, and then drag across your white screen. With this guide - and the allimportant Undo command in the Edit menu - you're well on your way to the
world's toniest art galleries.
i!D!iiii!ii!:ii:iiii
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Mart(uee and Lasso
These tools don't create any marks on the artwork. Instead, they're selection
tools. They draw a dotted, shimmering line as you drag the mouse; you're
creating an enclosure. Anything within the enclosure - the selected area - will
be affected by your next move. For example, you can click within the selection
to drag that chunk into a new position. Or press the Delete key to erase it.
You can also apply special effects to the selected region, such as Invert
(which swaps white areas for black, and vice versa) and, in some programs,
Blur or Sharpen.
The Marquee and Lasso differ in two important ways. The Marquee always
creates rectangular selected areas, including whatever white space is inside the
rectangle. In the following illustration, you can see that when you drag a
rectangular selection on top of a dark object (left), the white part of the
selection remains opaque (right):

-~

121

]22

Part II: Increasing Your Coolness Quotient ______________
The Lasso, on the other hand, requires you to draw a circle all the way around
the image you're trying to select. When you let go of the mouse, the dotted line
snaps like a rubber band inward, enclosing only black regions of your artwork
(below, left). Therefore, when the selected part is dragged on top of a dark
object, the latter shows through the former (below, right):

Pencil
The Pencil is pretty tame. Drag across the white area to draw a one-dotthick line.
There's only one trick to it. If you begin your line by clicking in a dark spot, the
line you draw will be white, even if you cross over into a white area.

Text Tool
Not much to this one: click in a blank area and start typing. While you're typing,
you can press Delete (or Backspace) to fix a typo; in some programs, you can
even use the mouse to drag through stretches of text for editing. But beware!
The instant you click the mouse outside of the text box, your text freezes into a
noneditable clump of dots (yes, a bitmap).
In most programs, you can double-click the Text Tool icon to set the font and
size for your type (before you do the typing). Obviously, after you click the
mouse outside the text box (and freeze the text into a bitmap), it's too late to
change type characteristics. You have to delete the whole thing if you want to
change it.
Of course, bitmaps have some advantages; after selecting one with the Lasso
or Marquee, you can apply any transformation commands to it (found, if
your program offers them, in a menu): Stretch, Distort, Slant, whatever. See the
next illustration:
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SpralJ. can
Painting at its finest. Drag the Spray can across the painting area to create a fine
mist of dots, just like an airbrush or spray paint can. Dawdle over an area to
make it darker; hurry across the screen for a lighter mist. The color (or pattern)
of the spray is whatever color (or pattern) you've selected from the color (or
pattern) pop-up menu. For post-pubescent thrills, try drawing a subway car and
then spray paint your name across it.

Eraser
Pretty basic. Drag across dark areas to erase them. Don't forget to zoom in
(enlarge the screen image, using the Magnifying glass) for detail work. For more
mature thrills, draw your ex-spouse on the screen and then erase his/her head.

Line Tool
Choose a line thickness (there's usually a pop-up menu for this purpose) before
you draw. Then drag to create a straight line. If you want a perfectly horizontal,
vertical, or 45-degree line, press Shift while you drag. Some programs also let
you specify the line's color or pattern.

Rectan9le1 Ellipse, Pol1J.9on1 Arc
These shape tools pretty much work alike: drag diagonally to produce the
shape. (The Polygon Tool works differently- click once for each comer point
of your multisided shape; then double-click to finish the shape.)
In any case, you can usually control both the color (or pattern) of the interior of
the shape as well as that of the outline of the shape by using pop-up color (or
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pattern) menus; see "Drawing Programs," earlier in this chapter, for an example.
The Line Thickness pop-up menu governs the thickness of the outline. As
before, the Shift key is the great constrainer: press it to create a perfect square
(with the Rectangle Tool), circle (with the Ellipse Tool), and so on.

Hand 9rahher
Depending on the size of your monitor, you may not be able to see your entire
artistic masterpiece at once. You can always use the scroll bars to slide your
image up or down on your screen. But the Hand grabber is much more direct just drag in the direction you want to shift the painting.

Click this tool; then click the painting to zoom in and/or enlarge the display for
detail work. Of course, you're not actually making anything bigger (in terms of
its printout); you're really just magnifying the screen image to get more control
over those pesky dots. Keep zooming in until you get an idea of how those little
dots make up your painting. You can use the Pencil to click the dots either black
or white.
To zoom out again or return to normal size, you usually press Option while
clicking the painting.

Microso~ Word 5.

1

Q: Where does an 800-pound gorilla sit?

A: Anywhere it wants.
Refer to this age-old discourse the next time somebody asks you why Microsoft
Word, a program with numerous flaws and irritations, is the best-selling
Macintosh program of all time. Microsoft is a gargantuan software company in
Washington state. They sell so much software that the founder/owner (Bill
Gates) is the youngest multibillionaire in history. Probably because of
Microsoft's huge presence in the IBM-PC world, it's the 800-pound gorilla in the
Mac world, too.
Of course, Microsoft Word 5 isn't bad. In fact, it's got some truly wonderful
features, one of which is that almost everybody uses it. That means that when
you send your file to friends, you usually don't have to worry whether or not
they've got the software needed to read it.
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Anyway, you've already absorbed most of the basics of word processing (in
Chapter 4). Word has a few fancy features worth learning, though (and does
some basic features in interesting ways).
Incidentally: if you're stuck with using Microsoft Word 6 (-point-anything), keep
reading; this first section covers only version 5 (-point-anything).

Views
To start a new document, double-click the Word icon. You arrive at a blank
screen. Go ahead and start typing your Oscar-winning screenplay. Use the usual
word processing techniques (Delete to backspace, drag through text to select
it, use the Edit menu to copy and paste, and so on) to whip it into shape.
You'll discover, though, that your piece of paper appears to be endless, as
though it's delivered on a never-ending roll of Bounty. That's because you're in
Normal view, where you never see a page end. (The end of a page is symbolized
by a thin dotted line, but you sort of have to watch for it.) In Normal view, you
don't get to see page-related elements like page numbers, either. They're hidden
until you go to another view.
If you want to see a more accurate display of what you'll get when you print,

choose Page Layout from the View menu. Things start to bog down in Page
Layout view - that is, it takes longer to scroll around and visit different corners
of your document. But you clearly see where each page ends, and you get to see
things like page numbers and multiple columns.

For Posner, it was just another dismembered thumb, quivering
where it had fallen on the operating-room floor. He grabbed the
Tupperware and a spatula·and stepped toward it.
Dr. Green knew better. "Martin, no!.l'he shrieked, grabbing for the
.45 in its shoulder harness.
Posner looked up suddenly, but it was too late. The glistening slime

The page margin Previous Page &
Next Page buttons

Bottom edge
of the page
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There's also an Outline view, which is pretty bizarre. I'll let you cuddle up to the
manual for that one.
Finally, there's Print Preview, an absolutely vital and useful view. (Just to make
sure the program isn't too easy to use, they've put the Print Preview command
in the File menu, not the View menu with the others.) In Print Preview you get
to see the entire page - in fact, two side-by-side pages - no matter what size
monitor you have.

To chan9e the mar9ins
Print Preview also provides the easiest way to adjust the margins. Just drag the
small black handles; remember that you're adjusting the margins for all the
pages when you do this.
Se ction 3

;!"'•-- '"'"""'"•••·-•-.. "4..., ...

I I

Drag these black handles (and the others
like them) to adjust the margins. ..

- .o·

T

... and then click the gray
background to see the changes.

To return to Normal view from Print Preview, click Close.

The unbearable li9htness of inter(ace
In their efforts to make Word user-friendlier, Word's designers went, methinks, a
tad overboard in the visual-interface department. When you launch Word for
the first time, you get not one, not two, but ten different strips of icons and
buttons! I mean, come on.
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You could spot this cancer growing even in versions 5.0 and 5.1. Look at this
picture and tell me that you'd know how to work this program on your first
time at bat:
Tool bar
Ribbon

Ruler~b[:=:;~4:=;=::R=~~:'.:~~~;:::'.~~

Page 1

Normal

I'll do what I can to clear this up. I'll take each strip of cryptic controls and

decipher them for you.
But let me make this clear: here I am, a Board-Certified Power User, and I have
most of these things hidden. Oh, yes, it's true: you don't have to have these
things cluttering up your screen. As we go, I'll mention how you can nuke each
of these examples of graphic-interface-run-amok. Thousands of people have all
of these icon strips turned off. Without these strips, using Word is almost
exactly like using a typewriter, and that's 100 percent OK.

The Toolbar
The Toolbar is a bunch of icon buttons, each of which does exactly the same
thing as one of the menu commands. For example, if you click the very first
button on the Toolbar, you get a new, blank, empty document. It's exactly the
same as choosing New from the File menu.
Here's what the buttons do. (If you have a big screen, you'll see a few additional
buttons.)
Turn highlighted paragraphs
into a bulleted list
Open an existing
document
Print an Change
Print Copy Undo
envelope
case Tool bar menu

Open new Save Cut Paste Indent margin/ Check
document changes
unindent margin spelling
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Hyou're the kind of person who enjoys dismantling the car and then reassembling it from memory, you can, if you wish, rearrange the buttons, or create a
different set, using the Customize command on the Toolbar menu (the Toolbar
menu is shown in the figure above).
H, however, your main objective is to have as long and happy a life as possible,
you may wish to do away with the Toolbar entirely. There are three degrees of
non-Toolbar presence. First, you can rotate the Toolbar 90 degrees, so that
instead of taking up a valuable hall-inch across the top of your screen, it's
running down the side. To do this, pull down the Toolbar button/menu (as
pictured above), and choose Left.
Second, you can get rid of the Toolbar just for today. To do this, choose Toolbar
from the View menu.
Finally, you can request that you never again be tormented with the existence of
these enigmatic icons. From the Tools menu, choose Preferences. Scroll down
until you see Toolbar. Click the icon. At long last, deselect the View Toolbar
checkbox. You shan't see the Toolbar again.

The Ribbon: Quick word formattin9
When you're in Normal or Page Layout view editing text, two information strips
are across the top of the window. The Ribbon is the top one; the Ruler is below
it. (H you don't see these strips, somebody must have hidden them. Choose
their names from the View menu.)
For the most part, the Ribbon controls character formatting: the size of type, the
style (bold or italic), and the font. To do formatting, you first have to select
some text you've already typed - by dragging through it. Of course, you can
also make some of these settings just before you begin to type.
Click the up-triangle for superscript
and down-triangle for subscript.

Click this triangle to
choose a font for the
selected text.

The currently
selected font
and size are
displayed here.

Click this triangle
to choose a point
size for the
selected text.

Click here if you want normally
invisible symbols (like a
paragraph mark or space) to
show on the screen.

Click this thingie to
open up a drawing
window, where you
can rotate text and
draw shapes.

These three icons
control how many
columns of text on the
page: 1, 2, or 3. (You
won't see the effect
in Normal view.)
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If you ask me, the most useful settings are the B, I, and U buttons in the middle
(for Bold, Italic, and Underline). You can glance at them and know immediately
what formatting your next typing will have.

The font and size controls (at the left side) are useful, too, once you figure out
that you have to click on the downward-pointing triangle to change the setting.

The Ruler: f!uiclt paraiJ.raph formattiniJ.
Below the Ribbon is the Ruler. These icons make changes to an entire paragraph at a time - and remember, a "paragraph" is anything you've typed that
ends with a Return. Before you can use the ruler, you must first select the

paragraphs you want to change!
Nine out of ten novices surveyed find this concept hard to get used to. If
you want to indent one paragraph, just click anywhere in it so that the
insertion point is blinking within it, and then use the Ruler's margin control.
If you want to change your entire document, like making it double-spaced, start
by selecting everything (use the Select All command in the Edit menu), and then
use the Ruler.
If you want to affect several paragraphs but not the whole memo, drag through
them and then use the Ruler.

The point is to remember the Macintosh mantra: Select, then apply. Select, then
apply....
Click one of these 3 icons to make
the selected paragraphs singlespaced, one-and-a-half, or
double-spaced, respectively.
Click this triangle to
choose a Style for the
selected paragraphs.

Click one of these 4 icons
to make the paragraph
left-aligned, centered,
right-aligned, or fully
justified.

These are 5 ''tab wells." Click for a
left, centered, right, decimal, or
vertical-rule tab; then click it into
place on the ruler to make a tab stop.
These 3 icons help you
formattable margins, if you
use Word's Table feature.

The first icon means no blank Drag the triangle
lines between paragraphs;
to change the
the second icon means Open right margin, just
spacing (an automatic blank for the selected
line between paragraphs).
paragraphs.

Drag the top half of this marker to set the first-line indent for the
paragraph; drag the lower half to set the overall left margin.
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Be careful on the strip
And here you thought we'd finished talking about all Word's strips. No
such luck.
Word's most hazardous feature, as far as you, Most Honorable Newcomer, are
concerned, is its selection bar. This is a very, very skinny invisible stripe up the
left side of the window. You'll know when your cursor has inadvertently wandered in there because your arrow pointer will suddenly start pointing to the
right instead of left. (This narrow vertical slice is in every version of Word.)
You may find this impossible to believe, but Word's left-margin strip was not, in
fact, designed out of pure foaming malice toward new Mac users. It's actually
supposed to make editing your work easier by providing some text-selecting
shortcuts. Here are a few favorites.
Shortcut 1: Select one line of text by
clicking in the selection strip.

Lisa choked back the sobs as the explosions
shook the earth around her.
"Harry ... oh. my poor Harry," she moaned.
How could it have 1;1nned? A moment

MPRim!IPlfiiGll

ptli@Miiiirpl

of sweet-smelling roses. 1ben, within seconds,
the pulverizing blows of the hammering bomb
shattered her world.

Shortcut 2: To select a paragraph
instantly, double-click in the selection
strip. (Or triple-click anywhere inside
a paragraph.)
Shortcut 3: To select the entire
document, triple-click in the selection
strip. (Do this when you wantto
change the font for the entire memo,
for example.)

t;d!lfJRt•"UW
"Harry ... oh, my poor Harry," she moaned.

Liso choked b;.ck the sobs a.s the e:-: · losions
shook the e•nih o.ro•.md her. • • • • • • • •
"'H;:i.rr!l· .. oh. rny poor H::s.rry;'' she rnl"~1ned.
Hov·l could it h:i.~_;re h:i.ppened? /:.~ nion-1ent
::s.go she·' ct v·ra.lked into the I.:i.b V·rith a.n ::i.rrnlo:i.d
of sv·rret-sn1elling ioses. TI1en. v·rithin seconds .
the pulw1izing bkw·1s of the h•;.mrne1ing bo1nb
sho.tteied her world.

Mot/in9 text hlJ dra99in9 it
One of the coolest features in Word (version 5 and later) is "drag-and-drop" text
manipulation. You can highlight some text and simply drag it into a new
position without doing the tawdry cut-and-paste routine.
For example, in the following sentence, you select the word miserable by
double-clicking it. Then point the cursor at the highlighted portion, and drag it
carefully into a new position and let go. The result is shown here:
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The

ICGlilevenl

was a

~atastrophe.

·····---~ ~

The event was a

I Qilie

a tastrop he

(If the drag-and-drop deal doesn't work, some vandal probably turned this
feature off. Choose Preferences from the Tools menu and turn it back on.)

This isn't, by the way, the same as the capitalized feature called Macintosh
Drag-and-Drop. For the scoop on that, see Chapter 8 (Clipping Extension).

Pa9e numbers, headers, date-stampin9
Suppose you want something to appear at the top (or bottom) of every single
page (like TOP SECRET: Destroy this document after Xeroxing). Go to Normal
view. From the View menu, choose Header (or Footer for the bottom of the
page). A new window opens. Anything you type in here will conveniently appear
at the top of every page.
;;Iii
~.

Nouel:Header

1!21

0

[ Same As PrelliOUS )

A Q- Tip for Elissa

If you click the little page number icon, Word will put a page number (at the

insertion point) on every page. Click the middle icon, which is supposed to
look like a calendar, to pop the date into this header. And click the clock to
insert the time. Go ahead and use all the normal formatting controls - fonts,
sizes, styles - to touch up the header text. If you want to see how your page
looks, choose Page Layout from the View menu.

Checkin9 IJ.OUr spellin9
Click at the beginning of the document. Choose Spelling from the Tools menu. A
dialog box appears, in which Word will display each spelling error it finds; click
Suggest to see some guesses as to what word you intended. Double-dick one to
replace the misspelled word in the document. If Word keeps questioning the
spelling of a perfectly OK word - like your name - click the Add button to
teach the word to Word.
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If none of this happens, and you get some kind of message telling you that the

Spelling command isn't installed, then, by gum, the Spelling command isn't
installed. (When you first install Word, you're given the choice of which
features to include. Thesaurus, Grammar, Hyphenation, and the drawing
module are some of the others available. You can install them later, as long as
you have the original Word floppy disks.)

Hou/ to kill the summarlJ box
One of the most irritating aspects of Word 5 and 5.1 is that stupid Summary
Information box that comes up every darned time you save a document. (You
don't mind if I vent a little, do you?)
Before you put your fist through the screen, try this. Choose Preferences from
the Tools menu. Click the third icon, the one that says Open and Save.
In the main window, click Prompt for Summary Info to deselect it. That's it!

Hou/ to kill superfluous commands
While I'm going with my flow of hostility, may I point out how many menu
commands Word has that nobody ever uses? TOC Entry? Link Options? Revert
to Style? Let's be real here.
Fortunately, you don't have to live with them. See "How to kill superfluous
commands" in the Word 6 section, next.

Microso~ Word 6
Word 6 takes half an hour to install onto your Mac. This single program takes up
24MB of your hard drive. On a Mac of typical speed, Word 6 takes almost a
minute just to start up when you double-click it. Do not attempt to use this
program on anything but a Power Mac. The screen is so filled with toolbars and
buttons that your typing area is only about three inches tall.
Most people I know took one look at Word 6 and beat a hasty retreat to the
prior version.
Quite a number of people, however, actually work for a living; in many cases,
they actually work for companies. And quite a number of those have decided
that everyone must use Word 6. In sympathy for those forced to use this
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behemoth software, then, may I offer the following survival techniques.
Most of them have to do with getting rid of all of Word 6's unnecessary
baggage in the hopes of turning it from a multinational bureaucracy back
into a word processor.

Stuff in common with Word 5
Some things haven't changed in Word 6, and the exquisitely worded descriptions of those features in the previous section should shine as brightly as ever.
In particular, the sections called "Views," "Be careful on the strip," "To change
the margins," "Moving text by dragging it," "Page numbers, headers, datestamping," and "Checking your spelling" should be particularly enlightening to
you, the Word 6 user.

Killin9 the "Choose a template 11 box
One of Word 6's most annoying tics is that, whenever you want a new document, it presents you with a stupid list window offering you a choice of such
preformatted layouts as Thesis, Weekly Time Sheet, and Brochures 1 and 2.
Well, that's terrific - too bad for the 98 percent of us who just want to type up a
gosh-damed letter.
Fortunately, I've figured out a way to eliminate this annoying obstacle to getting
on with your work day. Instead of choosing New from the File menu, just press
88-N ... instant blank document.

Where1s the Font menu?
There isn't one. Whenever you want to change the font, size, or style of your
text, you're supposed to use the toolbar shown here:

Click the middle little down-pointing triangle; you'll see what Microsoft calls the
Font menu drop down, from which you may select a font.
If this toolbar isn't visible on your screen, choose Toolbars from the View menu
and make sure there's an X in the box next to Formatting.
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Killin9 the too/bars
For some reason, Microsoft has gone toolbar crazy. This is what Word 6 looks
like if you're not careful:

If this screenful of unidentified icon-buttons leaves you not enough room to
type in, choose Toolbars from the View menu. Click the little checkboxes to get
rid of the Xs. You should probably leave the Formatting one around, though, as
explained in the previous section.

Sin9le-spaced or double?
Classic example of why Word 6 is a big drag: there's no longer any easy way to
change your document from single-spaced to double-spaced. (In Word 5, you
may recall, a single button on the ruler sufficed.)
Anyway, here's what you have to do. Highlight the paragraphs you want to
change (or just choose Select All from the Edit menu). From the Format menu,
choose Paragraph; click the "tab" where it says Indents and Spacing.
See the little box where it says Line Spacing: Single? Click there for a little popup menu of choices like Single, Double, and so on. Choose the one you want.
Did these programmers once work for the Department of Motor Vehicles,
or what?
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Raul power: St1Jle sheets (Word 5, too J
In this book, you see the same kinds of styles used over and over again. For
example, this paragraph has specific margins and type characteristics, but
the subhead ("Raw power: Style sheets (Word 5, too)") looks different. Yet I
didn't have to reset all those margins and type styles for every appearance of a
subhead. I just used styles.
You can read the manual for the full spiel on styles. But here's the easy way to
do it.
Type some text. Format the heck out of it. Fiddle with the indents (those little
markers on the ruler at the top of your screen - if it isn't there, choose Ruler
from the View menu). Change the type style. Make it double-spaced or whatever. Adjust the tab stops.
Finally, when it's good and ready, click the Style Name box. In Word 5, it's at the
left side of the Ruler; in Word 6, it's on the Formatting toolbar. Give this formatting a style name. Go ahead, just type it. Call it Subhead.

111 IPalatino
Then press Return.
(In Word 5, you'll be asked to confirm that you want to create a new Style.
Click OK.)
Now the next time you need to format a paragraph this way, don't bother doing
all that formatting. Just plop the insertion point anywhere in the paragraph;
then, using the small black triangle to the right of the Style name box (on the
Formatting toolbar or the Word 5 Ruler), choose Subhead. You've just changed
all the formatting characteristics at once. (To switch back to the normal,
unformatted style, choose Normal from that same Style menu.)
Now here's the beauty part. Let's say you've got 12,029 subheads in your
document. (No wonder your editors say you're long-winded.) And now you
decide that you want to change the font. For all 12,029 of them.
Fortunately, doing so is incredibly easy, because you assigned all the subheads
to one style. Just triple-click one subhead to select it. (Triple-clicking highlights
the entire paragraph.) Change the font (or make any other changes you want
to make).
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G/0{1n/ Tftemwnuclear Politics (or Dummies
Think the President makes it l ook easy? You can, loo, once you know
the way! The humor makes it all easy to take.

Genetic Engineering for Dummies
Amino actds are your ammo for thi s engaging fun-to-read
1

guidebook to the wonders of gene splicing and chromosomal
tempering .

Magnetic-Resonance Imaging for Dummies
A lightheert<d look et the fast - emerging world of MRI scans and
postdigital arthroscopy.

Now, using the Style pop-up menu (that old black triangle again), choose the
same Style name - Subhead.

u··d,,,
Normal

Word will ask you what you're doing. Click "Redefine the style based on selection" and then click OK.

Global Thermonuclear Po/mes for Dummies
Think the President makes it l ook easy? You can, too , once you know
the wa y! The humor makes it er easy to take.

Genetic Engineel'ing (or Dummies
/\mi no acids are your ammo for this engagi ng fun-to- read
1

guidebook to the wonders of gene spli cing and chromosomal
tampering .

Magnetic-Resonance lmtUJing for Dummies
A lighthearted look at the fast-emerging wo rld of MRI scans and
postdigital arthroscopy.

In the blink of an eye, all 12,029 occurrences ofthis style change!

How to kill superfluous commands
Unless you're trying to crank out the next Sears catalog on your Performa or
something, chances are good you won't be needing indexing, auto-hyphenation,
and other abstruse options in Word.
Removing a command you never use is incredibly easy. While pressing 00 and
Option together, press the minus (hyphen) key. Your cursor turns into a big fat
minus sign! Handle your mouse with care, now - it's a loaded weapon. Any
menu command you touch will disappear from the menu!
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Here's a partial listing of the commands I nuked from my Word 6 menus.
Depending on how far you intend to let Word take you, you may want to
augment this list (or leave some of these alone):
~

File menu: Save All, Templates, Summary Info

~

Edit menu: Paste Special, Go To, Publishing, Links, Object

~

View menu: Annotations, Footnotes

~

Insert menu: Annotation, Field, Form Field, Caption, Cross-Reference,
Index And Tables, Frame, Object, Database

~

Format menu: Drop Cap, Heading Numbering, Style Gallery, Frame,
Drawing Object

~

Tools menu: Mail Merge, Protect Document, Revisions, Macro

~

Table menu: almost everything

And, by the way, you're not removing these commands from the program you're simply removing them from the menu listings. If you ever want to restore
Word's menus to their original condition, choose Customize from the Tools
menu. Click Menus. Click Reset All.
(In Word 5, choose Commands from the Tools menu. Click the Reset button in
the lower-right comer of the window that appears.)

Quicken
Here it is, kids - one of the best designed, best known, best loved programs on
the planet. Microsoft never could have come up with this one.
Quicken, of course, is the ultimate checkbook program. Of course, calling
Quicken a checkbook program is slightly understating the case, like calling
AT&T a phone company or calling O.J. Simpson a former football player. As
you'll discover, Quicken can really be the cornerstone of your entire bank
account, credit card, tax, investment, and otherwise-financial empire.

The Cate9or1J concept
Quicken makes you choose Categories before you do anything else. When it's
time to do your taxes; when you want to see where your money's going; when
you want to plan ahead for next year; in all of these cases, Quicken can show
you a snapshot of your current financial status, organized, as always, by
category. It's a great system.
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You're free to make up your own categories, of course. But when you launch
Quicken for the first time, the program offers you two standard sets: Home and
Business. Pick one as a starter set, depending on how you're going to be using
Quicken, to get past the opening screen or two.
When you arrive at this screen, grab your bank-account statement.
Set Up Recount
- Account

Type -------·----------------~

O Liability

® Bank
Use for checkng, savings, or money
market accounts .

Use for items you ove , such as a loan
or mortgage .

Q Cash

Q Portfolio

Use for cash 1r ansactions or petty cash.

Use for brokerage accounts , stocks,
or bonds.

Q Asset

Q Mutual

Use for valuable assets such as your home.

0

Fund

Use- for a single mutual fund .

Credit Card
Use for any credit card account.

Acco unt Name:
Desc ripti on:
(o ptional)

J

L

[:::::::=====--~]
Notes

J

[ Cancel

[ Create

J

Fill in what you want to call this account. Money-Grubbing Corporate
Bank Vermin is fine, except that it won't fit. Savings or Checking is a more
common title.

The re9ister
At last you're permitted to see the Face of Quicken: the register window.
Type in the opening balance - in other words, the
ending amount on your last bank statement. ·
-Iii

CitiBank Check:

DATE

DESCRIPTION

NUMBER
CATEGORY

2/ 18
1994
2/ 18
1994

(

Record

I

R~ster
PAYMENT

Ooeni nQ Balance
[Citi Bank Check!L

[ Restore J

111]
DEPOSIT

.(

!.,,............

,

,

B LANCE

0

MEMO

iiiiJ
~

w j~

Current Balance:

0 00

,_

-

1~

$0.00

~
Iii
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Type in the date and final amount of your last bank statement, as shown in the
preceding figure.
This register window may look like any normal Mac window, but that's like
saying that jalapeii.o looks like any normal salad component. There are a
thousand handi-features™ to make typing in information fast and easy. To wit:
1'

Change the date by pressing the + and - keys on your keyboard.
~

CitiBonk Check: I
NUMBER

DATE

DE SCRIPTION
CATEGORY

I

MEMO

Openi ng Balance
[Citi Bank Check1J:

11201

[ 1990

Most of The Quicken Experience involves recording money you've spent
and money you've made. The first stage of each typing binge is to set the
date. Just click there, and then make the date advance or retreat by using +
and - ; the longer you hold down the key, the faster the number changes.
Neater yet - after you've clicked the Date blank, you can also type t for
today's date, m or h for the beginning or ending date of the month, or y or r
for the beginning or ending date of the year. Isn't that adorable?
1'

Press Tab to jump from column to column.
CitiBonk Check: ReJl.!ster
DATE

NUMBER
CATEGORY

1..!_!120
' - 1994
1 2~~8

1~

j_

-z.
--;-

Record

./

DEPOSIT

BALAHCE

{)-

MEMO

QpeninQ Balance
(Citi Bank Chee ...
Monthly Paycheck

13 45

~~

::i:;;:

Tab!

II

PAYMENT

DESCRIPTION

.2...

Tab!
) [ Restore

J

iiiimJ

Cu r rent Balance :
Ending Balance:

t£:i

$5 ,000 .00
$5 ,000 .00 Iii

Press Shift-Tab to jump backwards through the blanks. You can get by for
months without ever needing the mouse.
1'

Don't bother tabbing to the cents place; just hit the decimal. When you're
typing in a dollar amount, leave off the $ sign and just type a decimal point
(period) in the usual place. Quicken's smart enough to put the dollars and
cents on opposite sides of the dividing line.
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~

If Quicken recognizes something you're typing, it'll finish the phrase for
you. You do not have to type Metropolitan light, Power, and Water Authority
of Northern California every time you cut a check for utilities. By the time
you've typed Metrop, Quicken will have filled in the rest of the payee for

you (assuming you've ever typed it before).
If Quicken guesses wrong, just keep typing. Quicken will remove its guess.
~

After entering a transaction, press Return. Quicken sets you up with a
new blank line, ready to receive the next scrap from your envelope of
receipts. Oh, yeah - it also does all the math for you and updates the
bottom line at the bottom of the window.

Just another $10,000 dalJ.
Now that you've got your register set up, the rest of Quicken is simplicity itself.
Suppose you made a bank deposit today - your weekly paycheck plus the first
installment from a lottery you won.
~

Saui'!.!l.s:

DATE

DESCRIPTION

NUMBER

J_

CATEGORY

2/3
1994
12 /5
1994
12/30
1994
2/ 18
1994

~

Record

PAYMENT

Pl umber
Paycheck and Lottery ,. 1

I Restore

./

DEPOSIT

BALANCE

MEMO

Tra nsfer
[Pri vilege Ckng]
Groceries

,

Iii

R~ster

1,697 71

66,911 65

100 00

66, 8 11 65

160 00

66,651 65
10000 4~

I
J

§
~

Current Balance :
Ending Balance:

$66,9 1 1 .65 ~
$66 ,651.65 Iii

Click in the bottom row of the ledger, which is blank. (There's always one blank
line at the bottom of the register. If you don't see it, maybe you need to scroll
down using the scroll bar at the right side.) Use the + and - keys, naturally, to
adjust the date (or type t for today).
Tab.
Then type a description of today's event - in this case, Paycheck and lottery #1.
Tab.
Now type in the total amount of your bank deposit, paycheck plus prize money.
If this weren't a dual-source deposit, you'd be done - but you're not. Here's
where it gets really neat.
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See the little Split icons at the middle bottom of the window? Click the right
side. A stack of sub-blanks appears, in which you can break down your total
transaction amount, as shown here:
~

Sauings:
NUMBER

OATE

R~ster
PAYMENT

DESCRIPTION

,

DEPOSIT

BALANCE

MEMO

When you
click the
Splits icon,
this sub-list
appears.

(

2 /18
1994

Paycheck and Lottery '"1
CATEGORY

MEMO

1

i nc1 udes year- end onu3

"""

::r

AMOUNT

0 49 0
10 , 000 00

t[

1

10,000J49

IQI
Rec~ d ]

I Restore

J

1~Liii

Current Balance:
Ending Balance:

$66,9 11 .
$66 ,651 .

The category must be on the
The Memo can be
Category list- generic classes anything you want.
like Tax, Auto, Insurance, etc.

You've got to choose a category for this part of the split. For the paycheck, no
sweat - it would be Salary. If you type the letters Sa, Quicken will recognize
where you're headed, and it will fill in the rest of the word. (Alternatively, you
can press 3€-L, for list, to see Quicken's complete list of categories. You can
double-click anything on that list to make it fill in the Category blank here.)
Tab.
Then type in, for the paycheck, a memo. Anything you want. Or nothing. Tab.
Now enter the amount of the paycheck. In this case, you work as a tollbooth
operator for a remote and impoverished township in a debt-ridden South
American country, so you only make 49¢ per week. Type .49. Tab.

Creatin9 a neu/ cate9or1J.
Now you're supposed to enter the category for your lottery money. Yet oddly
enough, Quicken doesn't come with a Lottery Winnings category. You're going
to have to make it up.
Suppose you decide to call this category Prizes. Type that, then press Tab and Quicken will tell you that you've colored outside of the lines.
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Can't find category 'Prizes '. Would you like
to select from the list, or set it up?

Cancel

J (( Set Up JJ [ Sel°ect

Fortunately, Quicken also offers you the easy way out. Click Set Up. Now you
can create your new financial category.
Set Up Cate ori es

Category:
Descripti on:
(optional)

ILottery winnings

,- Type -----~

[

@Income

,

l___Q__E'.' ~:ri:•___________J
[ Cancel

J

[81 Tax- re Iated
Create

I

When coming up with a name for your new category, think general. Think tax
time. Don't create a category called Beige leatherette camera case, that one
with the tassels. Instead, the IRS would probably be content to see Equipment
or something.
In the case of the lottery winnings, be sure to specify the Type - Income - and
that, God knows, it's Tax-related. In other words, this little baby is definitely
going to find a place on your 1040 form. Groceries, on the other hand, will not.
Click Create. You return to your entry, where Prizes is now accepted as a legit
category name. Tab over to the Memo blank, type something like First installment, and you're done. Quicken has already entered $10,000 into the Amount
blank to make the split amounts match the grand total.
To close up the Split window, click the left side of the Split icon (or press 31:-E).

More TlJpical Examples
Another great candidate for the Split window: credit-card payments. Suppose
you write a check to pay this month's credit-card bill. (Most people have a
separate Checking account, which you can create by choosing New Account
from the File menu.)
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Choose Write Checks from the Activities menu. You get this representation of
America's most recognized piece of paper:

~

'i)

PAYTOIHE
DATE
ORDEROF _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ $ _ _ __

ADDRESS

'
..................................................... ........................................
MEMO
CATEGORY

Record

[ Restore

I

~

Current Balance:

$66,9 11 .65

Start typing the payee's name. As you know by now, if Quicken recognizes the
name, the program will complete the typing for you. Tab. Type in the amount.
This time when you press Tab, you get to see one of the slickest features ever. If
you typed in $453.45, Quicken writes out, in longhand English, Four hundred fiftythree and 45/100 on the second line.
Tab your way into the Address box and type the mailing address (press Return
after each line, not Tab). Then Tab to the Memo blank and type your account
number. And now (egg roll, please)- choose Memorize from the Edit menu.
From now on, when you start to make a check out to Citib, Quicken will fill in
the payee name and the address and the account number!
sa11in s: Write Checks
PAY TO THE
ORDER OF Citibank

VISA

453.45

........................ ...... J
MEMO

41 2 8 8239 335 4973

CATEGORY

Record

[Restore

I

~

Current Balance:

$66,9 11.65
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Before you hit Return (or click Record), it's a good idea to note what this creditcard payment covers. Just as you did before, click the right side of the Split icon,
bottom center.

The Cate9orlJ. palJ.off
The point of all this categorizing, of course, comes at year-end (or any other
occasion where a financial snapshot is required). Quicken does some amazing
number crunching.
At tax time, for example, choose Personal Finance from the Reports menu.
Double-click, say, Summary. Plug in the year's starting and ending dates;
instantly you've got a detailed breakdown to hand your tax guy (or yourself, as
the case may be). The graphs are equally impressive (choose Graphs from the
Reports menu).
_(if

Summar Report

Qulck2oom Graph

Fri.by, Fdrury 18, 1994
Douli Tn.a1 - All Aeeo...is

Asset Comparison
% of T olal As• els

SUlllD18IY Report
111193 TMoq-l. 2118194

Utrn3Cat~rory

2118194

lull:q

W:om.t
Action.Phzt
Casino incom.t
CousUling
Ftts
b.ttl'!St..(

lnltrut-s

•

1111

Trump Pleza

%40.0 2
33.36
22.98
2.69
0.95
0.0 1
$298,612.30

D M811aPortfolio
D Sa\oings
Ill Trump Tower
l:fl Checking
O Pri\oilegeCkng
Total

January 19 9i
963.51
102,954 .21
6,035.75
29 1.45
63.M
2,094.44

Reconcilin9 for the non-accountant
Yeah, Quicken's great, it's fast and easy, it's dirt cheap to buy, etc., etc. But none
of that puts it in the Hall of Greats. No, the real plum is the reconciling feature.
You're entitled not to believe me, but you'll actually come to look forward to
curling up with Quicken and your bank statement each month.
Like many of us out in America Land, there was a time when I, too, occasionally
failed to compare my checkbook with the bank statement each month. But
trusting the bank's computers can be dangerous; they do make mistakes. In my
six years of using Quicken, I've caught my bank with its computerized hands in
my tiller twice - $45 the first time, $200 the second!
Anyway, here's how reconciling works. With your bank statement in front of
you, choose Reconcile from the Activities menu. Fill in the closing balance from
the bank statement; fill in any interest your money earned, too, as well as any
finance charges those filthy usurers charged you.
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Sa11in s: Reconcile Startup
Enter the follovi ng information from your bank statement:
Previo us Balance:

I

9, 983.39 1

Nev Balance:
If you enter a se rvi ce charge or interest, Quicken will add it to your account.
Date
Amount
Category
Service Charge:
2/ 18/9 41
Inte rest Earned:

I
I 2/ 18/941

[ Cancel

I

12.5411 nterest -s

U

OK

,

Click OK. Now the fun begins.
Read down the transactions listed on your bank statement. Each time you find
one that matches a listing in Quicken's Reconcile window, click it in the Reconcile window, so that a check mark appears. Keep going until you've accounted
for everything on the statement.
~liil

Sa11i~s:

Type
Date
Amount
-140 . 00 ii'
1/ 9 /94 W/0
-1 , 463 . 70
1/25 /94 W/ 0
./
-6 ,406 . 52
1/25/94 W/0
-2 , 000 . 00
1/29/94 W/0
- 1,697 . 71
2/3/94 W/0
./
-8,000 . 00
11
/30
/
94
W
/
0
./
- 2 10.00
12/ 1/94 W/0
12/ 1/94 W/0
-5, ooo oo 1r~
12/2/94 W/O
./
12/5/94 W/ 0
Check off items that appear on your statement.
Double click on a transaction fo edit it.

Reconcile

Num

-~~~ ~~ ~

Items you have marted cleared
11 Checks, Debits

-17 ,692.41
14, 123 .26

4 Deposits , Credits

Di ffe re nee this statement: -89 . 98

[

Cancel

I I[

OK

ii

If the statement has extra items
The most common problem you'll find is that the bank lists some deposit or
payment that Quicken doesn't know about. This is most likely what's known in
the biz as Operator Error - although, as I've noted, once in a blue moon, you'll
catch a genuine bank mistake.
If you note discrepancies as you go, use one of these two techniques:
i ' Double-click any transaction listed in Quicken's Reconcile window. You'll

be teleported directly to the Register entry for that item, so you can read
the description and try to get more information. For example, if you have
two different entries for "New co-op in St. Thomas," then odds are pretty
good you entered it twice. Unless you truly did buy two, delete one of
them (use Delete Transaction in the Edit menu).
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I

Y' Pull the Register window to the front. If you discover transactions on

the statement that you forgot to plug into Quicken during the month, go
ahead and type them in now. Then return to the Reconcile window and
click them off.

What's supposed to happen is that the line called Difference This Statement
winds up to be zero (see the previous illustration). If it does, click OK and bask
in the warm sunny feeling of Quicken's little congratulatory message.
If the Difference This Statement doesn't come out to zero, you can either squirm
for another 20 minutes trying to find out why your computer doesn't match the
bank's, or you can take the fatalistic approach and click the OK button.

In that event, Quicken will create a new entry in your register called, ahem,
Balance Adjustment. Try, try not to think of it as shouting "This is where you
screwed up, you numerically incompetent clod!" every time you look at it for the
rest of your life.
In my experience, by the way, the temptation to simply accept the discrepancy
is much greater when it's in your favor.

How Quicken Inc. makes monelJ
OK, it's not really called Quicken Inc., it's called Intuit. Anyway, you may wonder
why they charge so little (about $35) for such a great program.
(c;

~

;=

~

VLA/.t
~

Ever hear the old adage: "If you want to make money, give away the razor, and

.~ sell a lot of blades"? That's Intuit's philosophy, says I. They make their money
on the preprinted Quicken checks you can get for your laser or nonlaser printer.

These checks are incredibly handy. Since Quicken prints the checks itself, the
information for that check is automatically recorded in your register. In other
words, it's impossible for you to forget to log a check, or for the amount to be
wrong in the register, and so on. (You can, of course, still write checks by hand,
but you have to remember to enter them into Quicken.) You can use your own
Mac graphics programs to dress up the return-address portion any way you
like, too, such as adding a little cartoon of a sobbing man with empty pockets.
Despite the profound handiness of Quicken's checks, they are expensive. The
CheckFree service, in which you use your modem to pay checks automatically,
is an even more expensive frill that can't possibly pay for itself in postage
savings. On the other hand, after you've been slapped with a couple of $50 late
fees for this or that, CheckFree might start to seem like a good deal after all.
Most time-saving of all, though, is Quicken's electronic ties to the banks themselves (version 6 and later). There's generally no cost, and it's a glorious feeling
to issue all your checks directly from Quicken; to have the bank automatically
reconcile your Quicken file (via modem); and so on.
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Pa9eMaker
The idea of page-layout software is amazingly simple. You see a blank page. You
dump different kinds of page elements onto it: text, graphics, straight lines,
photos, whatever. Then you drag them around like tiles on the page until
they're in an attractive arrangement. This, kids, is page layout. Without a single
union laborer being paid $180 per hour to paste waxed paper strips onto
dummy pages (which is how they used to do page layout), you can publish and
distribute your very own Neighborhood Anarchist Weekly- you can become a
"desktop publisher." And since the Macintosh brought this fun new pastime into
people's homes and offices, every magazine, brochure, newsletter, flyer, and
newspaper from USA Today to Time is designed this way.

Startin9 a new document
Double-click the PageMaker icon. You get a dialog box that asks what size paper
you want to use: Letter (8 1/2-inch x 11-inch), Legal (8 1/2-inch x 14-inch), or
Tabloid (11-inch x 17-inch), which is what the National Enquirer uses.

The Master Pa9es
Some elements of your publication are probably going to appear on every page:
the logo, the page number, the issue date. Instead of making you retype Bathroom Fixture Journal at the top of every page, you can just type it once, on the
Master Pages. To get to the Master Pages, you click the little dog-eared page
icons in the far lower left of the window:
~Iii

'
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'
11:

p:

j!:

'

~
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~
~
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I, ~

Untitled
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Now you see two blank pages - the Right and Left Master Pages (if your
document has facing pages), whose image lurks behind every individual page of
your publication. This is where the logo, the page number (which you create
using the Text Tool by holding down 38-0ption and typing a P), the chapter
head, or whatever goes.
When you're done working with the Master Pages, click one of the individual
page icons (each corresponds to a page of your document) to return to onepage-at-a-time editing.

Addin9 text
Ideally, you're supposed to write the articles for your newsletter (or whatever)
in a word processor like Word. Then go to PageMaker and choose Place from
the File menu. A list box appears; find your word-processed article, double-dick
it, and finally click the mouse (or drag to create a rectangle) on the appropriate
starting page. The article spills onto the page, stretching from margin to margin
(or filling the rectangle). Now, by grabbing the corner handles, you can resize or
reshape the article's layout on the page (following figure, left):

1······································ ......,

II
I

~. . . . . ~I

You can also shorten the article's length by dragging the little window shade
handle at the bottom, as in the preceding figure, right.
Of course, if you're thinking that an article needs shortening, window-shading it
into a shorter box is only wishful thinking. All you've done is to place less of the
article on the page - the rest of it is chopped off but needs to go someplace.
To specify where the rest of the article should go (as in, "continued on page
C4"), 38-click the "windowshade handle" at the bottom of the text block. The
cursor turns into a "loaded text" icon, telling you that the program is ready to
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pour the remainder of the article wherever your little heart desires. If you click
someplace, PageMaker will dump the remainder of the article from margin to
margin. If you drag to create a rectangle, the article will only fill that rectangle,
as shown here.

Cl
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·········································'

The neatest part of fl.owing text from box to box like this is that if you later have
to cut some material from the beginning of the article, the text will flow, snakelike, through every text box it's been poured into. You'll never lose a single
precious word.
If you could use some guidance in drawing text boxes, place your pointer in the
ruler at the side (or top) of the screen and drag onto the page. A thin "guide"
line comes with the pointer, which you can drag into position. (Hint: for
consistent pages, place some guides on the Master Pages, so they'll be in the
same place on every page.) These guides don't print; they're simply straight
edges to help you align things, as you can see in the example below.
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TweakintJ. to perfection
You can zoom in or out by using the Page menu commands and change the text
style by selecting text (with the Text Tool, which looks like an A) and applying
fonts, styles, and other attributes using the Type menu. For heavy-duty text
editing, you'll want to use the built-in word processor, the Story Editor (choose
Edit Story from the Edit menu).
Add straight lines, boxes, and other graphic accents using the appropriate tools
on the PageMaker Tool palette; the Element menu controls line thickness. You
can either paste in graphics or import them using the Place command in the
File menu.
Just remember that the Pointer Tool is what you need to draw, move, resize,
delete, shorten, and lengthen text blocks. But you need the Text Tool to do
everything that pertains to type, including changing fonts, sizes, styles, line
spacing, and so on.
After you become a power-user publishing mogul (God forbid), you may
· appreciate the Styles palette, which gives you a list of predefined paragraph and
text formatting attributes. (See the description of Word to get an idea of why
these are useful and how to use them.)
And if you're using PageMaker 5.0 or later, you'll get a kick out of the Control
Palette, a veritable carbon copy of the QuarkXPress Measurements Palette
(read on!).

QuarkXPress·
QuarkXPress is PageMaker's rival. Both have ardent supporters. (In fact, if
you're ever on a blind date with a Mac person, it's a sure conversation starter:
"So which do you like - Quark or PageMaker?'') The differences are getting
smaller and smaller, as each company comes out with an update that duplicates
the features of the other.
Anyway, this is not the book to solve the great debate. This is the book to help
you muddle through a few basic tasks when they're thrown at you.
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The basics
Quark (for some reason, everybody refers to this program by
the name of its company) does
pretty much the same thing as
PageMaker, but the methods are
different. The Tool palette looks
like this:

Item Tool
Content Tool
Rotation Tool
Zoom Tool

&

Text Box Tool
Rectangular Picture Box Tool
Rounded-Corner Rectangular Picture Box Tool
Oval Picture Box Tool
Polygon Picture Box Tool
Orthogonal Line Tool
LineTool
Linking Tool

~.'~

Unlinking Tool

[Al

!XI
00
®
(;&I

+
'.

The rules of thumb: Use the Item Tool to delete, move, and copy boxes (text and
picture boxes), but use the Content Tool to resize or edit the text and pictures
themselves. You can actually leave the Content Tool selected all the time since
it's what you use for typing, editing, adjusting text box comer handles, cropping
pictures, and so on - and whenever you need to move something, press the 88
key and drag. (The 88 key switches you temporarily to the Item Tool.)
To create a document, double-click the QuarkXPress icon and then choose New
from the File menu. A dialog box appears, where you specify the page size and
margins you want; then click OK.
To import some text, click the Text Box Tool and draw a rectangle. (You can't
paste or import text or graphics in Quark without first drawing a box to contain
it.) Quark switches back to the Content Tool automatically; from the File menu,
choose Get Text and select the word processing document you want to import.
It appears in the selected text box automatically. As in PageMaker, you can now
edit the text, drag the text box's comers to adjust its dimensions, and so on.
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LinkiniJ. to pa9e Ct,
Quark's method of breaking a story up into separate text boxes requires the use
of its Linking Tool. First, make sure you've actually drawn both text boxes on
the screen, using the Text Block Tool. Now click the Linking Tool. Click the first
text box and then the second text box - that's all there is to it. The text now
flows freely from one to the other, even if you edit the text in either box.
What's especially useful about this method of linking is that you can prelink text
boxes that you've drawn on a Master Page. If you produce a newsletter, for
example, that has roughly the same layout month after month, you could design
an empty template containing ready-to-go, prelinked, empty text boxes. When
those lazy-slob writers are finally ready to tum in their stories, one Get Text
command suffices to pour an article into your waiting Quark layout, and all
flowing happens instantly.

Quark's Document Layout palette shows a thumbnail view of all pages in your
document, including any Master Pages. (You can have up to 127 different
Master Pages, in case each section of your magazine has different common
background elements.)
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Master page icons

This Document Layout palette serves a number of useful functions:
Y'6

Double-click a page icon to make the document window jump to that page.

Y'6

Drag a page icon into a new position to rearrange your pages.

Y'6

Drag a Master page icon onto a Document page icon to change its background (master) elements.

Y'6

Double-click a Master page icon to edit that Master page.

Y'6

Drag a blank page (top left of the palette) or a Master page icon in between
two existing Document page icons to insert a new page.

The Document Layout window does a bunch of other stuff, but this should get
you started, and you can always use the QuarkXPress Help feature to read up
on the other features.

Measurement Palette
Choose Measurement Palette from the View menu to see this useful little
floating window full of precise numerical controls over the selected object. Click
any of these numbers to change them. Try changing the angle for a text box it's fun!

Excel
Excel is the best-selling Macintosh spreadsheet program. Well, "best-selling" is
about the understatement of the decade. (A recent Excel ad headline said, "99
out of 100 spreadsheet users use Excel. What are we doing wrong?")
If you're not familiar with a spreadsheet, get psyched - even if you only use 1

percent of its features, Excel can really be a godsend. It's for math, finances ,
figuring out which of two mortgage plans is more favorable in the long run,
charting the growth of your basement gambling operation, and other numbercrunchy stuff.
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Startin9 up
Double-click the Excel icon. A blank spreadsheet appears on your screen. It's a
bunch of rows and columns, like a ledger book. The columns have letters, and
the rows are numbered. Each little rectangular cell is called, well, a cell. It's
referred to by its letter and number: Al, for example.
To type a number into a cell, click the cell with the mouse and begin typing.
Note that unless you have version 5 or later, you don't do your typing (and
editing) in the cell itself; all the action is in the editing strip at the top of the
window. When you're done typing or editing, press Enter.

Formattin9 numbers and tert
As you enter numbers, don't bother to format them with dollar signs, decimal
points, and aJl that jazz. Formatting can be applied later. For instance, you could
enter the following numbers, each of which has a different number of decimal
places:

· t · · · · · · · · " " "·~·~Nf~"l""

" T." ". ·" " " "·~·~;.s~.~~l""..
·· ·~· · ·· · · ········· · · ·· · ·· · · ····· ··· ····r

Now drag vertically through them with the pointer.

546';

::::::i i '

...
...

....
:

:

...

By now you can probably say it in your sleep: In the world of Mac, you select
something first and then act on it . . . Select, then apply. .. . After the numbers
are selected, you can format them all with dollar amounts in one fell swoop. See
the little tiny pop-up menu at the upper-left corner of the screen? Choose
Currency from this list.
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Instantly, Excel formats all the selected numbers as dollar amounts. Note how it
adds zeros (or rounds off excess decimal places) as necessary.

Spreadin9 the sheet
Now it gets good. If you've been fooling around so far, erase everything you've
done. Drag the cursor diagonally through whatever you've typed and then
choose Clear from the Edit menu. We're gonna start you off fresh-like.
Click in cell B3 (that's column B, row 3; a spreadsheet is like a good game of
Battleship). Type in 1963.
To jump into the next cell to the right, press Tab. Or press the right-arrow key.
(You move to the left by pressing Shift-Tab, or the left-arrow key.) In any case,
enter 1973. Repeat until you've filled in the years as shown in the next figure.
You move down a row by pressing Return or the down-arrow key. Shift-Return
moves you up a row, and so does the up-arrow key. (There's a certain twisted
logic to this, isn't there?)
You can also jump to any cell by clicking in it, of course. Now then: Go wild.
With these navigational commands under your belt, type in the text and
numbers as shown in the figure. (Frankly, it doesn't make any difference what
numbers you type. I made them all up anyway.)
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Want to make the top row boldface, as shown in the preceding figure? Drag the
cursor through the years. Now click the 8 button in the ribbon at the top of
the screen.
a

Format

Data

Optio

ii ~ Cilll llltiJrill
i353

If you haven't guessed, B means Bold, and I means italic. (And I mean italic!)

Creatin9 automaticall1J. calculatin9 cells
Here comes the juicy part. Click in the Totals row, under the 1963 column of
numbers. Click the funny I: button on the ribbon. It's the Sum button, and it's
some button.
In the formula bar at the top of the screen, you'll see that Excel has entered
"=SUM(83:88)."
In English, the program is trying to say: "The number I'll enter into the cell you
clicked (Total) is going to be the sum of ... well, I suppose you mean the
numbers directly above the cell you clicked- cells 83 down to 88." Isn't it
smart to guess what you mean?

Well, smart, but not quite smart enough - because you don 't want the number
1963 included in the total! So you can override Excel's guess by showing it
which numbers you do want totaled .. . by dragging through them. Try it. While
the dotted-line rectangle is still twinkling, drag vertically through the four cells
below 1963. Then press Enter.
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Neat, huh? Excel automatically totals the four numbers you selected. But that's
only the half of it. Now click one of the cells below the 1963 heading- and
change the number. That's right, type a totally different number. (And press
Enter when you're done typing. You always have to press Enter to tell Excel
you're done working in a cell.) Voila - the total changed automatically!
This is the origin of the phrase "What-if scenario." You can sit here all day,
fiddling with the numbers in the 1963 column. As soon as you change a number
and press Enter, the total will update itself. That's why it's so easy to compute a
mortgage at 10 percent for five years and see if it's better than one at 8 percent
for seven years (or whatever).

Fill ri9ht, feel ri9ht
Now then. You have three other columns to contend with. Do you have to redo
business each time? Nope. You've already explained to Excel how the
Total row should work: it should add up the four numbers above it, not including the year at the top of the column.
the~

So just take that magic total cell (B9 in the preceding picture) and copy it into
the three cells to its right. Excel is smart enough to add up the right numbers in
each column (no, it won't put the 1963 total into each cell).
Of course, you could use the regular Copy and Paste commands - but that's
too tedious. Use the Fill Right command instead. Drag through the Totals row,
starting with the 1963 total and extending through the three other years'
total cells.
..........................................................

==:1~------· ·
Then, from the Edit menu, choose Fill Right (or press 3€-R). Bingo! Excel intelligently copies the formula from the first cell into the other cells, totaling each
column automatically. You may as well know that there's also a Fill Down
command, used when you want to copy a formula to a series of cells below the
one that contains it.
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From here to infinitlJ
Using the standard math symbols(+,-, / for division, and * for multiplication),
you can build much more complicated auto-calculating cells than the simple
SUM function described above. For example, you can use nested parentheses
and the whole works. To make a cell calculate how many hours there are in ten
years, for example, you'd click on it. Then, in the formula bar at the top of the
screen, you'd type =(24 *365)*10 and press Enter. The formula always has to
begin with the equal sign, but otherwise your equations can be as complicated
as you want.
You can have formula cells that work with numbers from other formula cells,
too - in the example above, you could create a Grand Total cell that would
sum up the 1963, 1973, 1983, and 1993 totals automatically. There are even a few
dozen more complex formula elements - financial, statistical, math, and time
functions - listed in the Paste Function command (Edit menu), if you're into
that kinky stuff.

Makin9 a chart
There are a zillion options for charting, too, but here's the quick-anddirty approach.
Drag through the table you created earlier - just the data part, not the totals in
the bottom row. After this section is highlighted, click the Chart Wizard button
on the ribbon, as shown here:
·
t

Formula

Format

Data

Options

Macro

Window

G

Now the cursor turns into a skinny little crosshair. Excel is waiting for you to
show it where, and how big, to make the chart. Drag diagonally across the
screen, either below the numbers (if your screen is big enough) or - what the
heck - right on top of them. When you let go, a charming little chart pops up.
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(If a charming little dialog box appears instead, click the » button.) Doubleclick the chart and then double-click an individual bar to adjust the colors and
styles used in the chart.

l
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Excel also has outlining, drawing tools, macros, a database function, and
probably a convenient toaster-oven ... but this was supposed to be a crash
course. If you want those frills, you'll have to actually put your nose in
the manual.

FileMaker Pro
FileMaker is the king, queen, and princess of database programs. A database is
just what it sounds like: a base of data - a pile of it, if you will - that you can
view in a million different ways. It's perfect for lists, CD collections, invoices,
catalogs, and so on.
Stop me if you've heard this one. Suppose you have a mailing list, and you want
to know how many people in zip code 44122 have last names beginning with M.
Or you have a list of 2,000 books and want to sort them by author's name or
print a list only showing hardcover volumes, or find out the publisher of a book
of which you know only one word of the title. For all these tasks, a database is
the way to go.
The really far-out feature of FileMaker is that you can set up several different
views of the information. Suppose you have a mailing list for a party. You could
set up your Data Entry view with great big 18-point bold type, which makes it
easier for you to type in those names without your glasses. You'd also want a
Mailing Label layout, though, which neatly arranges the addresses side-by-side
across the page, in a much smaller type size, so that you can print and mail the
invitations. Yet a third layout could be the Name-Tag view; it would place only
the person's name (and not the address) in a cute font, preceded by the words
"Hello! My name is." Using these different layouts - of the same information really lets you put the data to work without having to do any retyping.
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Step 1: Startin9 a file
Double-click the FileMaker icon. A dialog box appears, where you're either
supposed to open an existing data file or create a new one; click New. In the
next dialog box, type a name for your file and click New again.

la FileMaker ..-1
~ ClilriS Help System
151 FlleMilker Billloon Help
1!51 FileMaker Pro
[51 FileMilker Pro Help
J'OS lilbels
!51 Mililing Lilbels

J:!

(
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ii

new flle named:

l'jed

[ Desktop

l9J

CrHte

=PogueBook

II

New

D

Cancel

jRddresses

Before you know it, a really complex-looking dialog box appears. Brace yourself
for a couple more terms.
As you design your database, you'll be creating two units of information. First of
all, there are the individual blanks: the name, the zip code, and the state. These
are called fields. (The International Council of Nerds evidently felt that calling
them blanks wouldn't have confused people enough.)
A set of fields constitutes one record. A record might be a complete name-streetcity-state-zip set for a mailing list; if there are three people's addresses, there
are three records in the database. Still with us?
OK then. In the dialog box now staring you in the face, you're being asked to
create the fields (the blanks). First type the name of the field; it might be First
Name or Last Name or Street or Account Number or Date or Eyebrow Thickness
or whatever. Now tell FileMaker what kind of data is going to be in this blank, as
shown in the following table.
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If you select this data type. ..

Then this happens. ..

Text

You can enter any kind of typed data.

Number

FileMaker won't let you type letters of the
alphabet- only digits.

Date, lime

FileMaker only accepts dates or times in
any format.

Picture

You can't type anything into this field, but
you can paste a picture.

Calculation

You can't paste or type anything. FileMaker
fills in this field automatically by performing
math on other fields, like adding the
Amount and Tax fields.

Summary

You can't paste or type anything. FileMaker
fills in this field automatically by performing
math on other fields, like adding them,
counting them, or giving you a running
total.

For each field you'll want on the screen, then, type a name and select a data
type, and click Create. Repeat for the other fields. (If you want FileMaker to
automatically enter data, like today's date, then click Options just after creating
a field.)
Anyway, after you're done defining every blank you'll want to use, click Done.
You've just finished step 1.

Step 2: Data entrlJ
At this point, you can start typing away to input data. The rules are simple: It's
just like a word processor, so you use the Delete key to backspace over a typo,
cut, copy, and paste selected text, and so on. To advance to the next field, press
Tab. To jump back to the previous field, press Shift-Tab. To create a new, blank
record (for a new person's address, say), choose New Record from the Edit
menu. (Again, for a complete illustrated tour of this process, see the
ClarisWorks chapter coming up.)
As you create more records, the little open book icon at the upper left will

indicate that it has more and more "pages," each of which is a record. This little
diagram shows the four ways you can navigate your pile of data.
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Click the top page to see the previous record
Drag the bookmark to scroll through the records
'----=....,-Click the bottom page to see the next record

~~~'

Cl ick here to type in a record's number

Unsorttd

If your goal, in reading this section, is to perform the joyous task of entering
data, this mo,y be all the info you'll need. Put down this book and get busy. If, on

the other hand, you want to create a database of your own, or if you're supposed to modify an existing database, you may want to learn step 3.

Step 3: Desi9nin9 a lalJOUt
When you first create a new FileMaker file and define some fields, the program
creates a simple default arrangement of the blanks so that you can type in some
data. The default arrangement looks like this:
Mallin

g

jLayout •1

List

I

Records :
1

But suppose you want those same fields arranged in a more mailing-labelish
layout, like this:
Mailin

List

!Anita Break

Reconts :

To accomplish this, you must enter the Layout Zone. Choose Layout from the
Select menu (or, in version 3, the Mode menu). You enter a view that looks a lot
like MacDraw (or any other drawing program). And, in fact, all the tools (line,
rectangle, blah blah blah) work exactly as they do in a drawing program (see
"Drawing programs" at the beginning of this chapter).
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A calculated maneuver
If you created a Calculation field, a dialog box

will appear as soon as you click Create. In this
box, you can build the equation you want
FileMaker to use. The equation usually involves
other fields - which are listed at the upper

left-combined with the+, -, I (divided by), and*
(times) symbols. For example, if you're crazy
enough to live in New York City, you would define
the Sales Tax field as Purchase Amount* 1.0825
(8.25 percent is the sales tax rate).

So click the Arrow Tool. Drag the fields around (make sure you can tell the
difference between a field and its label, which you may or may not want to
appear on the screen). Or click a field and then change its type style from the
Format menu.
Since you can have as many different arrangements of your information
as you want, use this pop-up menu to select the Layout you want to edit.
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These are field labels. They don't
have to appear in a layout if you
don't want them to.

These boxes represent the fields
themselves. To resize one, click and
then drag a corner handle. To move
one, drag it by its center.

If you want to see more than one record at a time (when you're in data entry

mode), drag the little Body tag upward until it's just below your fields, and
choose View as List from the Select menu. (If you're using FileMaker Pro 3, you
have to choose Browse from the Mode menu before you can use the View as
List command.)
Remember, too, that you can delete a field from a particular layout. For example,
if you're creating "Hello! My name is" stickers, you certainly don't need each
person's phone number to appear on his or her badge (unless it's that kind of
party). So you can delete the phone number field from the layout; you do not
lose any data you've typed in. The phone number field still exists - just not in
this layout. Using the New Layout command in the Edit (or Mode) menu, you
can create another layout .. . and another . .. and so on, until you've had your
fill of data rearrangement.
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When you're finished designing layouts, return to data entry mode by choosing
Browse from the Select (or Mode) menu.

Findin9
Once you've got some data typed in, you can manipulate it in all kinds of fun
and exciting ways. Choose Find from the Select (or Mode) menu to get what
appears to be a blank layout. Type what you're looking for into the appropriate
blanks. For example, if you're trying to find everybody who lives in zip code
90210, you'd fill out the Find dialog box this way:
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Then click the Find button. After about one second, you'll be returned to
Browse (data entry) view, where you'll see the results of your search. This is
important - FileMaker is hiding the records that didn 't match your search
requirements. You haven't lost them; they're just out of sight until you choose
Find All from the Select menu. You can prove this to yourself by consulting the
little book at the left side of the screen. It will say "Records: 194, Found: 22."
That means FileMaker still knows there are 194 addresses in your mailing list,
but only 22 have zip code 90210 (and they're all attractive teenage models on a
major TV show).

Sortin9
To sort your records, choose Sort from the Select (or Mode) menu. FileMaker
needs to know how you want to sort your records: by first name, zip code, nose
length, or what? On the left side, you see a list of all the fields in your database;
just double-click the one by which you want to sort.
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j Cun·ent File ( 'l isting'?
First Name
Last Name

·I
Ii!

Street

Sor-t Order-

*
* First Name

(Clear Rll)

-Ifs

Last Name

•••

(»Mo ue»)

City

State
Zip Code

lo
.ii @
11• Q
1.1 Q

D

((

Sort

)J

(

Un sort

(

Done

l
l

~
D

Include s ummary fi elds

Ascending ord.:r
D"'1"sc.;>nding eirder

Custom order based on valuJ? list
Overridi field's lan9uagec for sort

I <.No Lisb: Defino:d> ...

IEnglish

,,

...

(If you want to sort by last name and then sort by first name within each
common last name, double-click First Name.) Finally, click Sort.

Sorting is the one major drag with FileMaker, by the way. As you're about to
discover, FileMaker doesn't keep your stuff in the sorted order! Every time you
add a record or search for something, all your records jump back into the order
in which you first entered them! You have to use the Sort command over again
every time you want things sorted again.

Other steps
FileMaker can do a million other cool things. For example, it can look up a piece
of info (like a phone number) from another FileMaker file and copy it into the
appropriate place in this file. In fact, version 3 is, as they say, relational. Instead
of just looking up a piece of information from another file, you can actually put
particular fields in more than one FileMaker file - change somebody's phone
number on his order blank, and your mailing-list file is automatically updated.
Really neat; really complicated.
FileMaker also has a powerful Scripts command, which performs a series of
steps automatically. In other words, you can make the program find all names
added since last week, sort them by last name, switch to the Mailing Label
layout, and print them - all with a single command from the Scripts menu.
These rarefied pleasures are not, however, for the unenlightened. Grab whichever is closest - the manual or your resident computer guru person.
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Top Ten Pro9rams That Aren't in the Top Ten
For your shopping pleasure and entertainment: a double handful of neat
programs that are often discussed at techno-savvy cocktail parties. ("Hi there,
baby. Want to come up and see my FreeHand printouts?")
Plug alert: If these additional programs interest you, then so might MORE Macs
For Dummies; its "Faking Your Way through Ten More Programs" covers many
of them.
I. FreeHand or Illustrator. Primo, powerful, professional, pricey Postscript

graphics programs. Be prepared to read the manual.
2. Photoshop. MacPaint on steroids. A stunning, pro-level photo painting
program, capable of fantastic transparency effects or undetectably
painting your in-laws right out of the family portrait.
3. Now Up-To-Date. A sensational calendar program: type your appointments
onto the appropriate squares. Up-To-Date can then remind you of them;
show your To Do list; and print out gorgeous daily, weekly, or monthly
agendas.
4. PowerPoint. It's called presentation software. Lets you quickly and easily
assemble slide shows - graphs, bullet charts, colorful diagrams - with a
choice of many rich, unified color schemes. Print the slides onto slides or
transparencies, or use the Mac itself to give a slide show.
5. Persuasion. Like PowerPoint, but even bigger and more powerful and more
complicated.
6. Kid Pix. Mind-blowing, colorful, audio-equipped version of a painting
program. Designed for kids but equally addictive for adults. The drippy
paintbrush runs, the eraser makes scritch-scratch sounds, and when you
want to start over, the Dynamite Tool blows up your artwork. About $30.
7. Myst. Reason enough to buy a CD-ROM player (which you need for this CD
anyway). A spectacular visual treat, and a darned addictive wordless
mystery.
8. Netscape Navigator. You use this program to cruise the famous World Wide
Web, as you'll discover in Chapter 10.
9. InfoGenie. A sizzlingly fast Rolodex program. Can pull up one person's card
out of 2,000 in less than half a second. Can even dial the phone if you have
a modem. Easier to use than a hairbrush. If you'll want to do much printing, you may prefer the more feature-laden (but much slower) Now
Contact or TouchBase. They print out your address books in a billion
different formats.
10. Premiere. For high-horsepower color Macs. This is the program for making
your own digital QuickTime movies right on the screen. And what's
QuickTime? Like the man said: digital movies right on the screen. See
Chapter 12.

Chapter7

AWhole Big Chapter
on ClarisWorks
~Tooling

around in the world's most multitalented software
~ Nonchalantly combining text, graphics, and database information
~ Going beyond the call of duty: slide shows, mailing labels, and company

rarisWorks is Swiss Army Knife software. Just look at all you get, even if you

\_,~on't know what they are yet: a word processor, a database, and a spreadsheet. Now how much would you pay? But wait: you also get a graphics program that can even serve as a basic page-layout system. And if you order now,
you even get a little communications program (to use if you own a modem - a
phone hookup for your Mac).

All of these modules are neatly bundled into a single integrated program. You
can write a letter and put a graphic in it; or design a flyer that has a little
spreadsheet in it; and so on. This section will be worth reading even if you don't
own this particular software, because ClarisWorks works exactly like most
other Mac programs.

Launchin9 ClarisWorks
Double-click the ClarisWorks icon.
After the Claris logo disappears, you're asked to decide what you want to
accomplish. Because you'll face this decision every time you use this program,
a rundown may be in order here.
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New Document

----··

4i on1wing
..di Painting
II Spre11dsheet

~ Dat11base
~ Communications
Create a new word processing document using preconfigured options .

D Use Assistant or Stationery

( Cancel

J ([

OK

JJ

Word Processing: You know what a word processing document is: something
you type. A memo, a novel, a ransom note.
Drawing: This is ClarisWorks's version of MacDraw (see "Drawing programs" in

the previous chapter). In this kind of document, you toy around with lines,
shapes, and colors to produce logos, maps, Hangman diagrams, and other
important visuals.
Painting: This is ClarisWorks's painting window (see "Painting programs" in the
previous chapter). Painting is another way of making graphics. But unlike the
Drawing mode, where you can only create distinct circles, lines, and squares,
the Painting tools let you create shading, freeform spatters, and much more
textured artwork.
Spreadsheet: A computerized ledger sheet, almost exactly like Excel (also in the
previous chapter). Crunches numbers: calculates your car's mileage per gallon,
your bank account, how much of the phone bill your teenage daughter owes,
that kind of thing.
Database: An electronic index-card file, very much like FileMaker (see the

previous chapter). You type in your lists - household expenditures; record
collections; subscriber list to Regis & Kathie Lee! magazine - and the program
sorts them, prints them, finds certain pieces of info instantly, and so on.
Communications: You need this kind of program if you want to use your
modem for dialing up (1) local "electronic bulletin boards," (2) a pay-by-thehour information service like CompuServe, or (3) your local school's computer
system. (You don't use this program to dial up America Online or the Internet.
See Chapter 10.)

To make Claris Works strut its stuff, I'll show you how to create a thank-you
letter. But not just any thank-you letter - this is going to be the world's most
beautiful and personalized form letter. You're going to merge a list of addresses
into a piece of mail, creating what appear to be individually composed letters;
thus, the technoid term for what you're about to do is mail merge.
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Yeah, yeah, I hear ya: form letters aren't exactly what you bought a computer to
do. Follow along anyway; this exercise will take you through most of ClarisWorks,
and you'll brush up against some features that will be useful to you.

Your first database
Suppose you just got married. You were showered with lovely gifts. And now it's
your task to write a charming thank-you note to each of your gift givers. You'll
begin by typing a list of the gift givers. The ideal software for organizing this
kind of information is a database.
Therefore, double-click the Database button.

New Document -

A Word Processing
4i Drawing
..di Painting
ii Spreadshee t

I

[·

lh·}

,;;, JlilliD •

~ Communications

Ji

Create a new database document.

D Use Assistant

or Stationery

[ Cancel

J ([

OK

JJ

Don't be alarmed. The screen that now appears may look complicated, but it's
actually not so bad - it simply wants to know what blanks you'll be wanting to
fill in for each person in your list (name, address, gift type, and so on).
Define Database fields
Field Type

Field Name

Field Name
[

create

I

"--------~

Modify

Field Type iTeHt ... 1
Delete

Enter the name of a new field and sel ect the type of data it w ill hold fr om
the Field Type popup menu .

(

Opti on s ...

((

Done

l
l)
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You're about to type names for these blanks (which the program calls fields). As
always, if you make a typo, just press the Delete key to backspace over it. Here
we go:
I. Type First Name. Press the Return key.

Pressing Return is the same as clicking the Create button.
2. Type Last Name. Press Return.
3. Type Address. Press Return.
See how you're building a list?
4. Type Gift. Press Return.
5. Type Adjective. Press Return.
In this blank, you'll eventually type a word that describes the glorious
present this person gave you.
6. Finally, type Part of House. (You'll see why in a moment). Press Return.
Your masterpiece should look something like this:

Field Name
First Name
Lost Name
Rd dress

Field Type
Te Ht
Te Ht
Te Ht
TeHt
Te Ht

Gift
Rdjectiue
I

IQ

I

l-0

I
Create

Field Type ITeHt
Delete

•I

("'[""o""p""u""on""s""
•."".~JJ

Select Options to change thls field's attributes, or change its name
and/or field type and press Modify.

Done

7. Click the Done button in the lower-right comer.
The dialog box goes away.
When you see what you've created, things should make a little bit more sense.
You've just created the blanks (oh, all right, fields) to be filled in for each person
in your list.
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first Name
Last Name
Address
Gill

Adjective
Part of

[
[
[
L
L
L

&ta entrlJ. time
This is important: To fill in the fields of a database (like this one), just type
normally. To advance from one field to the next - from "First Name" to "Last
Name," for example - press the Tab key. Do not press the Return key, as every
instinct in your body will be screaming to do. You'll discover why in a moment.
(You can also move to a new field by clicking in it, but the Tab key is quicker.)
So here goes:
I. Make sure you can see a dotted-line rectangle for each field, like the
ones in the preceding figure. If not, press the Tab key.

The little blinking cursor should be in the "First Name" blank. (If it's not,
click there.)

2. Type Josephine. Press the Tab key to jump to the "Last Name" field.
First Name
Last Name

posephine

==============i

:;:I

Address

Gill

3. Type F1ombebe. (See "Accent heaven" on the next page to see how you
make those cool little accents.) Again, press Tab.
Now you're in the Address blank.

4. Type 200 West 15th Street. Ready to find out what the Return key does?
Go ahead: Now press Return. Note that you don't advance to the next
blank; instead, the program thoughtfully makes this box bigger, so there's
room for another line of address.
first Name
Last Name
Address

Gill
Adjective
Part of

posephine
jFlombebe
1200 West 15th Street
New York, NY 10010
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Accent heaven
Ah, mais oui, mon ami. C'estvrai, c'est
la vie, c'est le resume.
I know what you're thinking: What a
smooth, sophisticated guy to be able.
to speak French like that! Thank you.
But you're also thinking: How did he
get those cool accent marks? Very
easily- and you, having been smart
enough to choose a Mac over all its
inferior competitors, can do it, too.
The Mac has a ton of these special characters.
Look at your keyboard - I bet you don't see ©,
or™, or•, or¢, or any other useful symbols Mac
peaple use all the time. That's because they're
hidden. The secret that unlocks them is ... the
Option key.
It works like the Shift key: while pressing Option,
you type a key. Here are some popular ones:

To get this. . . Press Option and type this ...
©

g

TM

2

So that's where all those little critters live I
Anyway, there's one more wrinkle to all this. A
few symbols, called diacritical marks (that's not
a computer term, it's a proofreading one, I think)
can be placed over any letter. They include the
markings over this ii, this e, this and so fOrth.
Since the Mac doesn't know ahead of time which
vowel you're going to type, creating these marks
is a two-step process:

e,

1. While pressing Option, type the key as
shown here:

To get this. . . Press Option and type this . ..

e

c

u

4
n
£

3

•

8

®

t

t

Anyway, the Mac has dozens of these things.
What's nice to know is that you have a complete
built-in cheat sheet that shows their locations on
the keyboard. It's the Key Caps desk accessory,
which is in your ti menu.
Open it up and take a look. Now try i:>ressing the
Option key.

When you do this, nothing will happen." In
other words, no marking appears on the
screen - until you do step 2.
2. Type the letter you wantto appear under the
diacritical marking.
Only now does the entire thing - letter and
marking - appear on the screen. So if you think
about it, typing the six-letter word resume requires eight keystrokes. est formidable, ca!

c·
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If you ever hit Return by mistake, intending to jump to the next blank (but

just making this blank bigger), press the Delete key.
5. Go ahead and type New York, NY 10010. Then press Tab.
And don't worry that the second line of the address immediately gets
hidden. The information you typed is still there.
6. Type acrylic sofa cover (and press Tab); practical (and press Tab); living
room (and stop).
You've just filled in the information for your first gift sender. So that this won't
take all day, let's pretend that it was what they call an intimate wedding, and
you only received gifts from three people.
But let's see, we need a new set of fields, don't we? Come to think of it, wouldn't
life be sweeter if there were a computer term for "set of fields"? By gumbo, there
is! A set of fields is called a record.
I wouldn't bother with that term if it didn't crop up in the next set of instructions.
I. From the Edit menu, choose New Record.

2. A new record ("set of fieldsj appears, and you're ready to type the
second person's information. Type anything you want, or copy the
example below, but remember to press Tab at the end of each piece of
information.
(Oh, and if you want a second line for the address, press Return. Make up a
town and state; you're a creative soul.)

First Name
Last Name
Address

Gilt
Adjective
Part of

~pi:"in=nie=============i

~tiJ!~ay"==;==========
~2 Pocono La.
~ir conditioner wl remote

~lh~igh~-t~ec~h==========
~~e~d~ro~om"'--~~~~~~~~~

3. Once again, choose New Record from the Edit menu. Type a third set of
information, perhaps along these lines:
First Name

IS uzie

Last Name
Address

11 Doormouse Ave.

Gilt
Adjective
Part of

~==========~

~IKh~io~u~~=r=:':==========i
i=IH:ar=ley~=========~
i=jex='=p=en=si=ve=========~

~ga~ra~g~e~~~~~~~~~--'
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Fabulous! You're really cooking now.
4. As a final wise step, choose Save from the Fiie menu. Type Gift List as the
name of your database.

Ia

ClarlsWorks •

I
~

D

ll!~!Ul t--11~

Cl Sample Documents
Cl Tutorial

Saue Rs:
lc1arisWorks

=Cabinet
(

!:jl~C1

J

[ Desktop ]

H Saue l
•I

Cancel

IGift List
5. Click Save to preserve your database on the hard disk.
You've just created your first database. Having gone through the tedium of
typing in each little scrap of information the way the Mac wants it, you can now
perform some stunts with it that'd make your grandparents' jaws drop. You can
ask the Mac to show you only the names of your friends whose last names
begin with Z. Or only those who live in Texas. Or only those whose gifts you've
categorized as fabulous.
For instructions on finding, showing these lists, and sorting your database, read
the section on FileMaker in Chapter 6.

Formin9 the form letter
Next, you're going to write the thank-you note. At each place where you want to
use somebody's name (or other gift-related information), you'll ask ClarisWorks
to slap in the appropriate info.
I. Choose New from the File menu.
Once again, you're asked to choose the kind of document you want.
2. Double-click Word Processing.
Now you get a sparkling new sheet of electronic typing paper.
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This area
represents
the margins of
the page. Yo u
can't type
here.

Iii
_!_

iiiil

Untitled I (WP)

J2

J1

0

l3

...L

11; J

[~~l ~l ~I ~

14

_J_

j_6

~

- ~EJEI !Dim! 1· !

Ii
~

lDefault

I'""

_.,
~

Do your typi ng
here. Press
the Delete
key to fix a
typo.

_.. r
]

I
i
I

i
!

I
I

!£0 · 1!i.Olii11!1i::'lTi~

- --~lllllfl .

.

ff

A_

~

__[9~

Incidentally, if you have a smallish-screen Mac, you probably don't want all
that margin area eating up your screen. You can hide it easily enough:
choose Document from the Format menu. A dialog box appears; click the
Show Margins checkbox to deselect it. And then click OK. Now your whole
screen is filled with typeable area.

Avoiding the ClarisWorks Excedrin headache
At this moment, you can do anything you'd do to
a highlighted Macintosh object. You can also
use the Edit menu to cut, copy, duplicate, or
delete this record.

If God uses software, it's probably ClarisWorks.
That's how wonderful it is.
However, using ClarisWorks does have its frustrations. Here's one of them. It's called the black
record syndrome.
If you accidentally click one of your records in
the area shown in the figure below, it turns black.
You've actually now selected a record.
·

If you've selected this thing by accident, however, your main instinct will probably be to get rid
of the black highlighting. There's only one way to
do that click in a field (the blank where you'd
type in information).

First Name
Last Name

Addrn~

If you click or
drag in here .. .---;,;,.::-=-111-

Gilt
Adjective

Put or

Gift list (08)
I Bob
I Smith
1 207 O<:ean Drive
: Glass thi ng
1 Shiny
1 Coif% table

~

Gift list (DB)

~

~-· --------~
-

. . . you highlightthe

entire record.

1:1
;

""'"~"

tu :i tNnme

fl

i11t!o

Addre s9.

11

G ill

11

Ad1•c t1v e
Prut of

•
>

1r1L•11

th t !

I 111
1

rt--t•l I
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Now then - on with the form letter. You'll start the letter with the address,
of course. Yet the address will be different on each letter! This is where
mail-merging is handy:

3. From the Hie menu, choose Mail Merge.
When the little window appears, you'll see your database name, "Gift List,"
prominently displayed.

4. Double-click Gift List to tell ClarisWorks that it's the database you want
to work with.
Now a strange-looking window appears:

r~~~~;;;:s

I

OSbo~Fl•ld Data

O

G;ft

Adjective
Part of House

[

Insert Field

-0

l

.

··~j5-,,,-i-tc-h~D-at-ab-a-se, ..--..I

I

Print Merge...

I

In the scrolling list you see the field names from your database. Here's how
it works:

5. Point to First Name and double-click.
See what happened? The program popped a placeholder for the First
Name right into your letter. When you print, instead of «First Name», it
will say Josephine.

6. Type a space. In the Mail Merge window, point to Last Name and
double-click. Press Return to begin a new line of the address; then point
to the Mail Merge window again and double-click Address.

,~<,F=irs
~t~N~
am
_e
_>_
> «~Las~
t~
Na_m_e_
»__,
1

!«

Add

ress »

J

Field Names
first Name
Last Name

Gift

I

Jt.

l~e~_g_! Database ;

{}

l .,.
g.;.;,
iif-.
t l;;;
is;.;t~--.11

Fl
l'~ I

DST 1'1•1d Daja

::::c:;~:use qy I Svitch
Database ... )
9
lns~rt Field~ r
P~ inj ~erg-~--- .
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Before you continue typing, you may want to drag the little Mail Merge
window off to the right of your screen as best you can. (To move the
window, dr:ag its title bar.) You're going to want to see both it and your
typing simultaneously.
7. Press Return a couple of times. Type Dear, followed by a space.
8. Point to the words First Name in the Mail Merge window, as you did a
moment ago. Double-click. Type a comma.
Your letter should look something like this:

<First Name» «Last Name»
<Address»
Dear «First Name»,

9. This is where it gets good. Press Return a couple of times. Type I nearly
cried when I unwrapped the incredible, followed by a space.
I 0. Double-click the word Gift in the Mail Merge window.
11. Continue typing: you gave me for my wedding. It is far and away the most
(and now double-click Adjective in the Mail Merge window) gift I will

ever receive.

i«First
. Name» «Last Name»
r<Address»

!;
!Dear «First Name»,

i
!

nearly cried when I unwrap~ed the incredible «Gift» you gave me for my wedding. It
11s Farand away the most«AdJectlve»g11t I will ever receive.
;
11

Are you getting the hang of this? At each place where you want
ClarisWorks to substitute a piece of information from your Gift List
database, you insert a little «placeholder».
To see the last field name, Part of House, you may have to use the Mail
Merge window's scroll bar. Then finish the letter as follows:
12. Type It will look sensational in the (double-click Part of House in the Mail
Merge window) of our new home.
13. Press the Return key twice and finish up like this: I had to write this

personal note to you and you alone, so you'd know how much I treasure your
gift above all the others. Love, Marge.
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<First Name» «Last Name»
<Address»
Dear «First Name»,
I nearly cried when I unwrapped the incred ible «G ilt» yo u gave me for my wedding. It
is far and away the most «Adjective»g ilt I will ever receive.
It will look sensational in the «Part of House»of our new home.
I had to write this personal note to you and you alone, so you'd know how much I
easure your gilt above all the others.
Love, Marge.

Emily Post would go instantly bald in horror if she thought you were about to
send out a letter that says Dear First Name. But through the miracle of computers, when these letters are printed, it'll be impossible to tell that each one
wasn't typed separately.
Save from the File menu. Type Thank-you letter, and click Save.

The 9raphics zone: Desi9nin9 a letterhead
You can read a lot more about graphics programs in the previous chapter. But
just to show you how you can tie everything together, let's whip up a quick
letterhead in the Graphics module.
Choose New from the File menu. Our friend, the New Document dialog box,
appears. This time you should double-click the Drawing button.
New Document

A

Word Processing

~,t. I '

..di Painting
II Spreadsheet

II:

l!"1l Database

ClarisWorks shows you its drawing window. The grid of dotted lines is there to
give things a nice architectural look; it won't appear in the finished printout.
See the tool icons on the left side of your screen? They're pretty much covered
in the section on MacDraw, in the preceding chapter. Now then:
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1. Click the text tool - it looks like a letter A - and release the mouse
button. Move your cursor onto the drawing area, and drag across the
screen, as shown here.
Untitled 6 (OR) _ _

Ii

~·

•
. . . . . . . • Click the TextTool.
.... . .... ..... . .... . . .

• Then click about here, and drag to here. •

Y\
2. Use the Font menu; choose Times. Use the Size menu; choose 24 Point.
3. Type three spaces and then a long dash. (fo make a long dash, hold
down the Shift and Option keys, and type a hyphen.) Type A Very
Personal Note. Type another long dash and then three more spaces.

-A Very Personal Note-

4. Press the Enter key so that handles appear around your text. Using the
Alignment submenu of the Format menu, choose Center.
5. Fmally, you'll add that elegant white-lettering-against-black look that
shows up on so many corporate annual reports. At the left side of your
screen, there's a set of odd-looking icons. Fmd the one immediately
below the tiny pouring paint can icon, as shown by the arrow in this
illustration (left):

•••EJoo·
••••••
••o••••••
••EJ••••••
••o••••••
••rn:i•••••
• •D lllllliillD• • •
l!'ll• DD ~ D l!l• EJ

DDDDDDllOD
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This icon is actually a pop-out palette. Click the icon, but keep the mouse
button pressed so that the palette appears (previous figure, right). Drag
carefully to the right until the pointer is on the solid black square, as
shown at right (previous figure). Release the mouse.
You've just used the Fill palette to color in the entire text block with black.
Which is just great, except that now the text is a solid black rectangle! To
fix the problem, you need to make the text white.
6. From the Text Color submenu of the Format menu, choose White. Ta-<la!

:

- A Very Personal Note-

:

You used a ClarisWorks Graphics window to make manipulating your text
easier. Of course, while you're in the graphics mode, you could actually do
some graphics ... you could use any of the other drawing tools to dress up
your logo. You could draw a box around this letterhead. You could rotate the
whole thing 90 degrees. You could make all kinds of insane diagonal stripes
across it.
Keep those creative possibilities in mind when it comes time to design your
real letterhead.

For control freaks only: The View buttons
Before you leave the drawing window, cast
your eyes upon the lower-left' corner of the
screen. There you'll find this odd-looking array
of controls:
Hide palette
Pop-up menu Splitthe screen

l

L

[ 1oo ' l!:.10..1:11~.r 1m

/ ~

::.r ::'fJifl

Zoom in; Zoom out
As you can tell, ClarisWorks makes blowing up
your work extremely easy. (Obviously I mean
magnifying it; destroying it is up to you.) A quick
click on either of those little mountain buttons

makes the artwork smaller or larger. Or jump
directly to a more convenient degree of magnification by using the percentage pop-up menu
(where it says 100 in the figure to the left). You're
not changing the actual printed size - only
how it's displayed on the screen.
If you're on a small-screen Mac, you can hide
that inch-wide strip of tools at the left side of the
window by clicking the palette-hiding button,
as shown in the figure. Finally, you can see two
widely separated parts of the drawing simultaneously by dragging the fat, little black strip,
indicated by the words "Split the screen" in the
figure, to the right. Now you've got two distinct
panes of your masterpiece, which you can
scroll independently.
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The retum of CoplJ. and Paste
All that remains is for you to slap this letterhead into your mail-merge letter.
I. From the Edit menu, choose Copy.

2. Now you have to return to your word processing document. Here's a
quick way to pull it to the front: From the Window menu, choose ThankYou Letter (WP).
(WP stands for Word Processing document, DB stands for Database, DR
stands for Drawing, and PT stands for Painting.)
Your letter springs to the fore.
3. From the Format menu, choose Insert Header.
(A header is an area at the top of every page, above whatever text you've
typed. In this case, it looks like an empty text area.)
4. From the Edit menu, choose Paste.

Et voilii . .. your graphic pops neatly into the header.
You've actually done it: combined a database, a word processor, and a drawing
program in a single project! For a real kick, click the Print Merge button. It's on
the little floating mail merge window-ette that should still be on the screen.
Watch how the program automatically replaces actual names for the « placeholders» on the screen.

Field N.imes
Last Name
Address

Gift
Adjective
P.art of House {}

I

lnse,-t Field

( Svitch Database ... J

J

Other Cool Stuff ClarisWorks Does
A little paint
If you've been following along, you haven't yet tried the Painting window. By
this time, I trust you know how to get there: choose New from the File menu and
then double-click the Painting button.
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Suddenly, you're in a pixel-blitzing wonderland, where you can create all kinds
of "painted" artwork. As you discovered when reading Chapter 6, this kind of
artwork has pros and cons. The pro is that you can change the color of every
single dot on the screen (instead of just drawing circles, lines, and rectangles ,
which is all you can do in the Drawing window). The con is that you can't move
or resize something in a painting after you've laid down the "paint" (which you
can do in the Drawing window).

A little slide show
One of the strangest and most delicious things people do with a Macintosh
is make slide shows. These can be self-running (a new "slide" every four
seconds, say). They can be controlled by you (a new slide every time you
click the mouse button). Most of all, they can be really impressive-looking to
your friends .
You're in for another Macs For Dummies Bargain-Hunter's Paradise, by the way.
Plenty of businesspeople spring $300 to buy a program that does nothing but
slide shows. (They have a $300 word for it, too: "presentation software.") You,
of course, get one in ClarisWorks at no extra charge.
If you have ClarisWorks 4, making a slide show is particularly easy, because you

can use the idiot-proof Assistant feature. Choose New from the File menu; select
"Use Assistant or Stationery"; double-click the Assistant called Presentation.
Now ClarisWorks asks you a series of questions, such as what kind of message
you want to present, what style of slide background you want, and so on:

Select how you want to show the presentation. Then choose
the background style to suit your message and audience.
Pre sent using:

IComputer Screen ..,. I
Background Style:
Busic presentation style !tFun style for kids
Post modern style

..f

A solid, professional look, good for us e in a corporate or bus iness env ironment

Progress

[ Can cel ) [ Begin )

~ l~I
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When you're finished answering, you've got a terrific-looking slide show on the
screen. Use the scroll bars to move among the slides, changing the (forgive the
term) dummy text on each slide to say what you want it to say.

Other assistants
While we're on the topic of Assistants - a feature of ClarisWorks 3 or 4 remember that Claris Works ·beats the pants off most other programs when it
comes to creating certificates, press releases, address books, to-do lists, and so
on. The key, after choosing New from the File menu, is to select the "Use
Assistant or Stationery" checkbox, as shown here:

New Document

~

..

~Home Finance

4i Border

4J Certificate R
4i Certificate B

~ Checkbook and Ledger

-o.

TMs Assistant will help you create a name and addrE'ss database .

~Use

Rssistant or Stationery

[ Cancel

([

OK

]J

Experiment with the pop-up menu at the top of this screen; some of the most
useful ready-made documents (which they call stationery) are hiding in here.

That's not all there is
The only parts of Claris Works we've left unexplored are the spreadsheet (which
I couldn't figure out how to tie in to a thank-you letter) and the Communications
module. Spreadsheets are covered under Excel in Chapter 6. And if you have a
modem and want to learn about the Communications program, then the little
extra Claris Works manual does a nice job of explaining how to make your phone
line a highway to the world of information. Or, if it's worth spending some bucks
on, buy MORE Macs For Dummies, where the whole world of modem-dialing is
covered with astonishing clarity, brilliance, and modesty.
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Mailing labels made easy
ClarisWorks does many things well. But one of
its most useful features is printing mailing
labels - a hated and difficult process in the
olden days.
To make them, begin by visiting an office-supply
store to buy the sticky labels themselves. Avery,
the galactic leader in mailing-label manufacturing, makes them .in seven trillion sizes; the most
common for addressing envelopes, however, is
called model 5160, which gives you 30 peel-off
labels per sheet.
If you don't already have a database into which
you've entered your names and addresses, the
simplest route to successful mailing labels in
ClarisWerks 4 is this:
1. Fromthe File menu, choose New. Select the
"Use Assistant or Stationery" checkbox.

2. Double-click the Names and Addresses
item.
3. Type in your names and addresses - remember, the Tab key moves you from blank
to blank, and the New Record command ·
(Edit menu) adds a new record for the
next person.
4. When you're ready to print labels, choose
"Avery 5160,5260,5660" from the Layoutmenu.
5. From the File menu, choose Page Setup;
click Options; turn on "Larger Print Area";
click OK; click OK.
Put some sheets of labels into your printer, and
print away! (Actually, do a test print on a plain
piece of paper, so you don't waste labels in
case something's not quite right.)

Chapters

System Folder: Trash Barge
of the Macintosh
In This Chapter
&!'>-What the System Folder is for
&!'>-Just enough verbiage on System 7.5
&!'>-

What junk you can throw out of your System Folder

~ere it sits. Only one folder on your hard drive looks like it -

or acts like it.

I ;~.s the System Folder, which holds software that the Mac needs for itself.

Every Mac has a System Folder. (Correction: every functioning Mac has one.)
Yours probably looks like any other folder, except that it's called System Folder
and its icon has a tiny Mac Plus drawn in the middle:

System Folder

You, the former novice, need to know about this vital folder for three important
reasons.
First, someday you, like millions of Mac users before you, will attempt to
double-click one of the icons inside the System Folder. With gentle, earnest
curiosity, you will shyly move your pointer onto something; with a soft, trusting
gesture, you'll click your mouse button twice; and with sarcastic venom, the
Mac, your former friend, will reward you with nothing but a meaningless error
message.
You get this message because much of the stuff in the System Folder isn't for
you! It's information for the Mac, by the Mac. Information - notes it takes - to
serve you, its master. Most of the stuff in the System Folder is for the system
(which explains why Apple hides it away in a folder to begin with).
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The second reason you'll be glad you learned about the System Folder is this:
you got a brand new computer. It's clean, it's fresh, it's empty. You know for a
fact that you haven't put much of anything into it. And yet, one day you open up
your System Folder to discover that it's absolutely crawling with files, overrun
with zillions of little icons you've never seen before, teeming like so many
roaches under the floorboards.
You're perfectly entitled to exclaim, "Jeez, what is all this stuff?!" And, before
having read Chapter 11/2, you might also have exclaimed, like many Mac
beginners before you: "For the love o' Mike, all those files are gonna use up all
my memory!"
~ \>LA/Jlt

'*' _

I=

~

~

Naturally, you now realize the foolishness of this comment. Data resting

.~ comfortably on your hard drive doesn't use up any memory. It does, however,
take up disk space.

Since disk space, for most of us, is also limited, I'm going to show you exactly
how much of the System Folder clutter you can safely throw away.
Finally, you should know about the System Folder because it's the nerve center
of your whole Mac ... the heart ... the brain ... the headquarters. A Mac
without a System Folder is like a car without an engine. A house without a roof.
Groundhog Day without Bill Murray.

Battle of the Svstems
Back in Chapter 1, I hinted that your Mac may or may not be outfitted with a
special feature called System 7. And instead of explaining what that meant, I
muttered something along the lines of, 'Tell you later." Before we get busy with
our System Folder Trash-fest, we need to get this explanation over with.
You know how General Motors comes out with a new model of each of its cars
every year? Apple does the same thing: It keeps making minor changes to its
computers, trying to make them better (and provide more incentive to buy
them).
In 1991, Apple came out with a newer version of the System Folder contents,
called System 7. (It replaced the older version, which, with stunning originality,
was called System 6.)
System 7 has lots of terrific features, especially for the beginning Mac user.
Every Mac sold since early 1991 is equipped with System 7. You'd only have
System 6 if you bought your Mac used, or you've had it for a long time.
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It's easy to tell which System you have. In Chapter 1, you were supposed to
have written down this information on this book's Cheat Sheet; but here's a
quick cheat. Look in the upper-right comer of the screen. Do you see this
icon (1)? If so, you have System 7-point-something. Otherwise: System 6.
And if the upper-right of your screen contains a more mod-looking question
mark - like this ~ - then you have the even more trendy System 7.5. More on
that later, too.

Names and Numbers
When people say "System 7," they're not being terribly specific. Apple keeps
making little changes to System 7. Each time, they rename the thing by changing
the digits after the decimal point. First it was called System 7.0. Then they made
a few touch-ups and called it System 7.0.1. They then made some more improvements and dubbed the result System 7.1. .. and then added more goodies and
called it System 7.5. (If you can believe this, there was actually even something
called System 7 Pro. What'd they do, run out of decimal points?)
When I was your age, we were taught: one decimal point per number. Anyway, if
you ignore the additional decimals, you can pretty much figure out which
System version is more recent. For example, 7.01 is, technically, a smaller
number than 7.1, so it's therefore earlier.
Then there's the issue of P. Some system versions have the letter P after them:
System 7.lP, for example. That means you have a Performa Mac. More about
Performas in Chapter 15.
Finally, there's x. You'll sometimes hear computer people say that something
won't work if you have System 7.x. That's shorthand. It means "System 7.0,
System 7.0.1, System 7.1, or System 7-point-anything." As opposed, naturally, to
System 6.x.

As you'll recall from Chapter 1, there's a quick way to find out what you've got.
Go to the S menu. Choose About This Macintosh. A window appears. The
upper-right comer tells what system version you have.

What's the diff: 7 fls. 7.0.1and7.1
Versions 7.0 and 7.0.1 aren't appreciably different. The one feature System 7.1
added was a folder called Fonts inside the System Folder. You know all about
fonts if you read Chapter 5. Anyway, the Fonts folder makes it much easier for
font freaks to add and remove new typefaces to the Mac.
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What's the diff: 7 fls. 7.5
Apple's 1994 incarnation of the System Folder added 50 new features and takes
up a lot more disk space. In addition to all of the features listed above for
System 7, you also get:
"' Step-by-step instructions (Apple Guide). Lurking in that ,Z J menu at the
top right of your screen is a fascinating source of advice that's geared
especially toward You, the Novice. It's called Macintosh Guide.
Choose it from the i rJ menu to see an index of topics on Mac essentials.
These include questions, tasks (like printing and using disks), and
definitions.
All you have to do is follow the steps described in the little help window.
When you've completed each step, you click the right-arrow button on the
screen to see the next step.

1. Click a topic area :
v How do I

Reviewing the Basks

Working with Programs
Files
Disks
Using DOS Files & Disks
Printing & Font s
Networks & Telecommunications

display colors or grays?
change the highlight color or gray?

change the color of window borders?

change the colors In t he Label menu?

Setting Options

change t he background pattern?
v Why can't I

Sound

display color on the screen?
v Definitions

~--···••l(; I
Monitors

background pattern

Memory

control panel

-0-

DK

When you're supposed to use the mouse, a big fat red ghostly magic
marker draws a circle around whatever you're supposed to manipulate.
Big fat red magic marker

s

File

Edit

Uie

How do I change the color of an icon?

Do Thi• Open th e Label m enu and choose th e color
(an d label) you want.
The label a ppear s w h en item s a r e d isplayed in
a list view, such as View by Na m e or View by
Label.
You're done. For a tip, click t he right arrow.

_ _ _ _ _ _ _ _ _ Chapter 8: System Folder: Trash Barge of the Macintosh
And if you ever get confused by even these patient instructions, you can
click the "Huh?" button for an even more basic explanation. It's all pretty
wonderful.
More of life's institutions should have "Huh?" buttons.
VJ" Submenus in the Apple menu. Now you can open a particular control

panel without even opening the Control Panels folder. Any folder listed in
the ti menu has submenus that list its contents.

a

About Microsoft Word ...

J

Iii

PowerBook Display
Rfter Dark 3.D
Rpple Menu Options

Calculator
~Chooser

"' FaH Center
I/
I

I

llli

~ Find File
113 Image Grabber'"

Iii Key Caps

~ Memory
l;slJ Note Pad
• QuickDEH'" 11
~ Recent Applications
fQ!I Recent Documents
~ Recent Seruers
ml Scrapbook
Stickies

<JI

~

~
~

Control Strip -If
CopyDoubler
Desktop Patterns
File Sharing Monitor
Flash-It 3.0.2
General Controls
Keyboard
Label Secrets
Labels
Map
Memory
Monitors
Network

VJ" Roll-up windows. Just when you'd gotten used to thinking of menus as
behaving like window shades, now windows snap up like window shades.

Just double-click a title bar to unclutter your screen. Double-click the
floating menu bar - all that remains - to re-expand the window.
Before:

After:

Scrapbook
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""" Stickies and Hnd Hie. The two most useful desk accessories ever born
(read "In your Apple Menu Items folder," coming up later in the chapter).
""" QuickDraw GX and PowerTalk. Chapter 5 contains the very few words
that need to be said about the pretty-much-useless QuickDraw GX.
PowerTalk is similarly complex, memory-hungry, and useless for the
average person who doesn't work at NASA.

What's the diff: 7.5 tis. 7.5-Point-1, 2, or 3
These successive versions of System 7.5 don't have very many meaningful
differences. System 7.5.1 added the ability to tum off your Mac by pressing the
power key on the keyboard; System 7.5.2 works on only a few models (the
PowerBook 5300 and certain Power Macs) but otherwise adds no new features.
And System 7.5.3 just makes Power Macs slightly faster and more reliable.
If everything is working fine for you, I wouldn't worry about how many decimal
points your particular Mac has. If you do care about such things, though, here's
my not-very-urgent advice: If you have System 7.5-point-anything, upgrade to

System 7.5.3. You can get the upgrade software for free from America Online or
the Internet (the Web address for Apple is http://www.apple.com, if you're that
advanced). Set aside a rainy Saturday afternoon for the project of getting and
installing the update software.

SIJ.stem-Folder Trash-0-Rama
Who else would be utterly mad enough to say the following in public? Half the
stuff in your System Folder is worthless. It's designed for power users, or people
in big corporate networks, or superweenie jet-propulsion scientists and their
Mensa-qualifying eight-year-old offspring. Meanwhile, these files are taking up
room on your hard drive.
Do it right now: double-click your System Folder to open it. (Of course, your
System Folder is in your main hard-drive window. Double-click your hard-drive
icon first, if need be.) Now click the zoom box, the tiny square in the top-right
comer of the System Folder window, so you can see as much of the System
Folder contents as possible. As a matter of fact, move your mouse up to the
View menu and choose "by Name." That should put everything into a neat list.
Just look at all that junk! You sure as heck didn't put it there - what's it doing
there?
Here's a wonderful, glorious, worth-the-price-of-the-book-right-there list of
everything in your typical System Folder, item by item. I'll tell you which of
these things you can safely trash.
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~- ~s tem Folder
22 items

187 .9 MB in disk

Aldus

t> CJ

Apple Menu Items

Installer Temp

D

Control Panels
Dia 1- tn Data
Extensions

D

Finder

PowerTalk Data

~

Cl Preferences

~

CJ PrintMonitor Documents

D Scrapbook File
D Shiva Help
<$
t> CJ
t> 0

CJ

Shiv a Modems
Shutdown Items
Startup Items
Sy stem

_n_

+ l illllJ.

~

~

~

~

9~6K

4K
2,940K
16K
17,624K
448K

t> 0 Fonts
l> CJ Launcher Items
D MacTCP DNR
D Note Pad FilE'
l> CJ

100K
6,608K

Clipboard

D

l> CJ

44 MB av

Size Kin

Name

t> 0
t> 0
l> Cl

_!SJ

1,896K

zero K
20K
SK

Don't have a cow about throwing things away,
either. This is not like cleaning your attic, where
if you toss that box of your drawings from
elementary school, you've wounded your inner
child forever. No, this stuff you can always get
back again if you need it. It's all on the white
System disks (or the silvery system-software
CD-ROM disc) that came with your Mac. (If
you're a Performa or PowerBook owner, you
probably didn't get System disks; you're
supposed to make your own backup of the
System Folder.)

36K
14,472K

zero K
484K
100K
28K

zero K
4K
3 ,320K

~

By the way, you may not find every one of these
files listed in your System Folder; about half of
them are tweaky little bonus features that only
come with System 7.5 or later. Likewise, you
may find files in your System Folder that aren 't
listed here (especially if your Mac isn't new).

]It li!J

In IJOUr Apple Menu Items folder
Let's start off with the stuff in the Apple Menu Items folder, which is, alphabetically speaking, the first thing in your System Folder. You'll recall, of course, that
anything in this folder also appears in the S menu at the left side of your screen.
This is really a two-for-one discussion: each Apple menu item is also a desk
accessory like the ones you worked with in Chapter 3. So now you'll get to find
out what exactly those things in your S menu are . . . acquire a deep and abiding appreciation of their importance and value ... and then throw them away.
Alarm Clock - Try choosing it from your S menu right now, if you have it.
You'll see that it's a tiny clock. You can leave it open on your screen all day, and
always know exactly how much time you're wasting. With some difficulty, you
can also use it to set an alarm that goes off at a certain time of day. (Some
alarm. All it does is beep once and make your S menu icon start flashing.)

You can probably trash the Alarm Clock and never miss it. It's not even included
anymore in System 7.5. As the song says, does anybody ever really know what
time it is?
AppleCD Audio Player - It has Play, Stop, and Rewind controls for playing
regular music compact discs on your Apple CD-ROM player. If you don't have an
Apple CD-ROM player, this does you no good whatsoever.
Battery - This DA shows you how much juice is left in your battery. Toss it
unless you have a PowerBook.
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Calculator, Note Pad - You already know about these desk accessories (see
Chapter 3). Leave them for now.
Chooser - You definitely need this, as you found out in Chapter 5.
Control Panels - This folder is simply a shortcut (an alias) to opening your
real Control Panels folder. More on aliases and control panels to come.
Find Hie - (System 7.5 and later) A turbocharged file-finding feature. Worth its
weight in the precious metal of your choice. Just type in what you're looking for,
and the Mac finds it ... fast. (See the end of Chapter 4 for a complete demonstration.)
Type what you're looking for here.
Use th is pop-up menu to specify what
disks or folders you want to search.

Use this pop-up menu to specify what kind of info
you're looking for (the file's name, date, etc.).
Guard this desk accessory with your life; even when you grow up to be a great
big computer whiz, you will still forget where you stored a file now and then.
(The Find command in the File menu, by the way, brings up the exact same
feature.)
Key Caps -Another desk accessory. It helps you find out which combinations
of keys you're supposed to press when you want to type wacky symbols like ¢
or¥ or© (see details in Chapter 5).
Puzzle, Jigsaw Puzzle - Highly silly desk accessories whose Novelty-Wear-Off
Quotient is about five minutes. Upon reaching the sixth minute, trash it. (Jigsaw
Puzzle comes with System 7.5.)
Scrapbook - This desk accessory is worth keeping. Using Copy and Paste, you
can put pictures, sounds, or blocks of text into it for use later. For example, after
you spend three weekends designing an absolutely gorgeous logo for yourself,
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paste it into the Scrapbook. Thereafter, whenever you need that logo again,
open the Scrapbook and copy it, so that it'll be ready to paste into your memo
or package design.
Stickies- (System 7.5 and later) How did we live before Stickies? Sheer, purest
genius. Stickies are electronic Post-It notes. That's all. Just choose New Note
from the File menu, jot down what you want, and maybe pick a new pastel hue
from the Color menu.

s

File

Edit

Note

Color
WELCOME TO STICK IES !

Stickies lets you write notes (like
these) and stick t hem to your screen.
You can use Stickies to jot quick notes,

to write reminders, or to store
frequently used text . Your notes are

visible whenever the Stickies program
is active .

When you try to close Stickies (by choosing Quit from the File menu), you'll be
asked nicely if you want the Stickies to reappear each time you turn on the Mac.
Say yes, and you'll never forget another dog-grooming appointment.
•Shut Down - (System 7.5 and later) The same as the usual Shut Down
command. Why a duplicate here in the Apple menu? So that you can get to it
without having to quit whatever program you're using at the time. Saves a step
when dinner's ready.

Jn IJOUr Control Panels folder
Control Panels is another folder inside your System Folder. As you read in
Chapter 3, a control panel is a tiny miniprogram that changes some aspect of
the Mac's behavior.
Apple CD Speed Switch - Slows down your CD-ROM drive to accommodate a
very few ancient discs. If you have AppleCD Audio Player under your ti menu,
you don't need this at all.
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Apple Menu Options- (System 7.5 or later) This is the little gizmo that
provides the submenus in your Apple menu, as described earlier in "What's the
diff: 7 vs. 7.5." Also creates, in your Apple menu, folders that track the last
bunch of documents and programs you used, which is handy.
AppleTalk - Useful only if you're on a network and on a "PCI" Power Mac; part
of Open Transport described later.
At Ease Setup - This control panel lets you choose which icons you want on
your big fat At Ease tablecloth. (See Chapter 15 to find out what At Ease is.) If
you use At Ease, take note: you need this control panel if you ever want to tum
At Ease off!
-ATM™ - The first half of Adobe Type Manager (see Chapter 5). It didn't come
with the Mac until System 7.5, but an awful lot of people have it anyway.
Auto Power On/Off- Works only with a few Mac models, such as certain
Power Macs. Makes them tum off by themselves at a specified time. Try doubleclicking this; if you get an error message, throw it out.
AutoRemounter- One of many doodads that's only good for connecting Macs
together - in this case, a PowerBook and a regular Mac. (It automatically
reconnects the two whenever you wake a sleeping PowerBook.) If you have
neither PowerBook nor network, send it Trashward.
Brightness- This control panel doesn't even do anything except on a Mac
Classic or Classic II. If you have any other model, send it to the Trash.
Button or Button Disabler- For LC or Performa 500-something models only.
This one disables the volume and brightness buttons on the front panels of
those 500-series models (presumably to prevent tampering in school situations). If you have any other model, trash it.
Cache Switch - This little software switch has two settings: Compatible and
Faster. It only works on a few models - some Quadra and Centris models -:and even then, only slightly. (Compatible mode makes your Mac run slower but
with fewer problems using really old programs.)
CloseView - Magnifies the screen if you have trouble seeing. Switch it on or off
by pressing 88-0ption-O. The area of enlargement follows around your little
pointer, which takes some getting used to. This control panel also lets you make
your screen white-writing-on-black, instead of the reverse. If neither of those
visual options interests you, out it goes.
Color - It's used on color or grayscale Macs to choose what shade you want
to use when you highlight some text. (Talk about obscure.) See Chapter 11
for details.
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D
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D

Purple
Yellow
Green

:mnmm

•

•

ned
Pink
D Blue
D Groy
•
Black & White
•Other ...

CJ

Highlight color:

ImmI
Window color:

Ia

....

Standard

,

ColorSync System Profile - For people who work in the color publishing
business. For scanners, expensive color printers, and so on.
Control Sbip- Originally for PowerBook; beginning with System 7.5.3, compatible with any Mac. Produces the nifty floating Control Strip, which gives you
one-click access to several control-panel-type options. On the PowerBook, for
example, it looks like this:
File
AppleTalk Sharing

Power
Savings

Speaker
Volume

~~~~~'F.'l11"11

End tab
Battery
Level

Hard-Drive Sleep
Spinning

Hide Entire
Strip

Anyway, this control panel simply makes the Control Strip appear or disappear.
CPU Energy Saver - Turns off the Mac after you haven't used it for, say, half an
hour to save electricity. Only works on Macs that shut off completely when you
choose Shut Down from the menu. So if you have an LC, the 6100, Performa
6115, or a similar push-button-power-switch model, out this goes.
Date & Time - Lets you set the Mac's clock and date. There's even a Daylight
Savings Time checkbox (but you have to remember to turn it on and off each
season). Also controls whether or not the time appears at the top of your screen.
Desktop Pattern - (System 7.5 or later) Very simple: lets you choose a fancier
backdrop pattern for your computer. Lists various textures, fabrics, and, well,
kitties. See the end of Chapter 3.
Easy Access - For people who have difficulty using a mouse or typing with
both hands. If you're coordinated and two-handed, throw this thing away.
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Express Modem - The only models that have this control panel are those with
a built-in Apple fax modem (or the so-called GeoPort Adapter): a PowerBook,
Power Macintosh, or AV model, for example. If you're having trouble sending
faxes or using your modem, make sure this switch is set to the Express Modem
setting, not the External Modem setting.
Extensions Manager - Comes with System 7.5 or later. Here's how it works. As
the Mac is starting up, press and hold your spacebar. Suddenly, you'll be shown
a list of everything listed in this chapter - all the control panels and extensions.
By clicking their names, you can decide which of them you'd like to use during
the work session that's about to begin.

[ All Off

J [

[More ... ]

All On
[ Options ...

J

File Sharing Monitor - Another of the slew of control panels that have to do
with networking (connecting Macs together by wire). If you have no plans to
plug your Mac into somebody else's, throw this away.
General Controls -A useful control panel. Set your cursor-blinking speed, and
so on. In System 7.5, lets you create a Documents folder to collect every new file
you make, just as on a Performa. Details in Chapter 15.
Keyboard - Use this control panel to change how a key behaves when you
keep it pressed. Does a held-down key start repeating like thisssssssssss? And
how fast?
Many first-time Mac users fare better if they turn the repeating-key feature off.
That way, if a book happens to lean on the spacebar while you're on the phone
for 20 minutes, you won't hang up to find 536 pages of blank space in the letter
you were working on.
If you couldn't care less, throw this one away.
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Labels - See your Label menu? (In the Finder, it's up there: File, Edit, View,
Label, Special.) Labels are a way to categorize your files. You just highlight an
icon and choose a label from the Label menu (such as "In Progress'). It's a
wonderful, ingenious, fascinating concept. Almost nobody uses it.
Use this control panel, Labels, to change what the Label menu says (instead of
Essential, Hot, In Progress, you can change them to say Late, Past Deadline,
Hopeless, or whatever). If you don't use labels, which is probably the case,
chuck this.
Launcher- You only have this if you have a Performa Mac or System 7.5. You

can throw it away, but only if you want to de-Performatize your Mac. See
Chapter 15 for an explanation.
Macintosh Easy Open Setup - If there's one thing that frustrates novices and
old Mac salts alike, it's seeing that infernal "Application not found" message
when you double-click an icon. With this control panel installed, when you
double-click an icon, you don't get an error message -you get a dialog box
that lists the programs you own that can open the mystery file.

The document named "TeHt doc" was not created
with the application program "Scriptable TeHt
Editor".
To open the document, select an alternate
program, with or without translation:
~ Scriptable Te Ht Editor

~ SimpleTeHt
•Microsoft Word

D Show only recommended choices
[ Cancel J

Open

MacLink Plus Setup - Designed primarily to open IBM files when you doubleclick them, translating them into a Macintosh format. If you don't work with
files from a DOS computer, out this goes, along with everything else in your
System Folder called MacLink.
MacTCP - Lets you configure your Mac for connections to the Internet. If
you're not on a network and don't use the Internet, throw this out. See Chapter
10 for more on the Internet.
Map - This control panel is primarily useful for people who do business with
different geographical locations. You type a major city's name and click Find,
and the Map shows you where that city is. It also tells you how far away it is,
and what the time difference is.

~'------

198

Part II: Increasing Your Coolness Quotient _ _ _ _ _ _ _ _ _ _ _ __
Memory-As the French say, Ne trashez pas! You'll need this one. Details on
memory, and Memory, in Chapter 18.
Monitors - If you have a color screen, you use this control panel to switch it
between color and black and white.
And why, you may well ask, would you ever want your Mac world in black and
white after you've gone to all the trouble and expense of buying a color Mac?
Easy-when you set your monitor to black and white, it's faster. Much faster.
Things like opening windows and scrolling through a document happen about
three times quicker in black and white. (They're just not as pretty doing it.)
Monitors & Sound -A combination of two other existing control panels,
Monitors and Sound (duh). Evidently somebody at Apple thought there were
too many control panels and thought some ought to be combined.
Mouse - This control panel adjusts how far the cursor moves on the screen
relative to how you move the mouse. You may be surprised that moving the
mouse one inch does not move the cursor one inch on the screen. In fact, the
distance the arrow moves depends on the speed of your mouse motion.
Try this: move the mouse very slowly across three inches of desk space. The
arrow moves three inches. But now jerk the mouse across the same three
inches. Now the cursor flies across your entire monitor!
Anyway, the Mouse control panel lets you adjust how much of this speedexaggeration you'll get when you move the mouse. It also lets you decide how
fast two clicks must be to be treated as a double-click. .
My advice: set the Mouse Tracking to one of the Fast settings, and the doubleclick speed in the middle. Then throw this control panel away.
Network - Yet another control panel used only for networking. In fact, even if
you have a network, you can toss this; it's used to switch between different
kinds of networks, such as Ethernet and LocalTalk (whatever they are).
Numbers - For non-Americans. Lets you change the way the Mac punctuates
numbers. For example, the French use periods in large numbers instead of
commas. You'd say, "Bonjour! You owe moi $1.000.000, Monsieur."
If you're satisfied with the American way of doing things, throw this away.

Open Transport anything- Useful only if you're on a network (or the
Internet), and you're using a Mac that has so-called PC/ slots (you'd probably
remember having read that term on the box somewhere). This super-techie
collection of System folder-lint includes Open Tpt AppleTalk Library, OpenTpt
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Internet Library, Open Transport Library, and many more favorites (many of
which are in your Extensions folder). If you're not on a network or on the
Internet, throw away the whole mess.
PC Exchange - Lets you shove IBM-computer disks into your Mac. If you only
work with Macs, send this baby Trashward.
PC Setup - Useful only if you paid an extra $400 for your Mac to get a so-called
DOS Compatibility Card, meaning you can run DOS or Windows programs on
your Mac. Use this control panel to change a bunch of weird-looking options
only a DOS person could understand.
PowerBook (or Portable), PowerBook Display- The first one controls how 1.-l _ ,.... .
quickly your laptop Mac goes to "sleep" to conserve battery juice. The secondlfVVI l/
governs what happens when you plug an external monitor into your laptop.
Naturally, if you don't have a PowerBook, it's Trash Time for both. (See Chapter
16 for more on PowerBooks.)
PowerBook Setup - Lets you schedule a time for your PowerBook to wake up
by itself. Why? You tell me.
~ii

~

•

PowerBook Setup
72

SCSI Disk Mode
ID:

01 02

@3

Autom11Uc Wake-Up
D W•k•-VP ~t: 5:30PM

04 Os 06
6/ 4/94
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Power Macintosh Card - Did you upgrade your older Mac by installing a
"Power Mac upgrade card"? (Consult your MasterCard statements.) This
control panel lets you tum it on or off. If you didn't buy any such thing, this
control panel can hit the road.
PowerTalk Setup, PowerTalk-anything- Unless somebody in your office
specifically told you to leave this, I'd discard this slow, memory-hogging,
extremely complicated networking software.
Screen - For models with built-in screens only (such as Performa 400- or 500somethings). Lets you adjust the screen picture, since those Macs have no
monitor knobs. Useless for all other models.
Serial Switch - This thing only works on one Mac: the Ilfx, which was last on
the market in about the Jurassic Period. It's an on/off switch that may make
MIDI musical gear work better on that model.
Sharing Setup, Users & Groups - More control panels used only for networking. Throw them away unless you want to connect to other Macs.

Sound -A keeper. It lets you adjust the volume of your speaker. It also lets you
choose from among several equally uncouth sound effects for use as your error beep
(what the Mac does when you make a mistake); see Chapter 11 for a quick tour.
Sounds & Displays - Essentially the same as "Monitors & Sound" (see that),
but harder to figure out.
Speech - Extremely cool - lets your Mac read, out loud, what you have typed.
Details in Chapter 14. Also: on Power Macs and Quadra AV models, lets the Mac
take spoken commands. Again, Chapter 14.

Startup Disk- You'd use this if you had more than one hard drive connected to
your Mac. You have one hard drive inside the Mac. Some people purchase
another one, or a removable-cartridge thing, that plugs into the back. Startup
Disk lets you choose which hard drive's System Folder you want to run the
show when you next tum on the computer. If the hard drive in your Mac is your
only hard drive, toss Startup Disk.
Text - (System 7.5 or later) Mister Pointless. Would let you choose a language
software kit other than English for your computer - if you had any installed.
You don't. Throw this away.
Trackpad - Worthless unless you have a PowerBook 190, 500-, or 5000something. On those laptops, this works just like the Mouse control panel
(described earlier) ... except, of course, it adjusts the Trackpad sensitivity, not
the mouse's.
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Users & Groups - Yet another one used only for networking. Otherwise, out
she goes.
Views - My grandfather's 106 and sharp as a tack. When I showed him my
PowerBook last Thanksgiving, he had absolutely no problem using it. But there
was one thing that bothered him: the icons' names were too small to read.
So I opened up the Views control panel, typed a new point size as shown in the
following figure, and handed the Mac back to him. He loved it.
He did remind me, however, that when he was growing up, they didn't even
have electricity.
Uiews
HO Futurn Heauy ... ...

j

llEJ6

D Always snap to 9rid

Control Panels

37 items

124.2 MB in disk

~

Key oar</

!

I!

Network

WmdowShade - (System 7.5 or later) This is the gadget that turns on or off
that collapsible-window syndrome described earlier, where you double-click a
window's title to hide the window (except for the title bar). You don't really
need it except to turn the feature on and off.

201

202

Part II: Increasing Your Coolness Quotient _____________

In IJ.OUr Ertensions folder
An extension is a little program that runs automatically when you turn on the
Mac. It usually adds some little feature to your Mac that you want available at
all times: a screen saver, for example, that automatically blanks your screen
after a few minutes of inactivity on your part.
Abaton Interfax, GV Platinum••. - In some modem programs, like America
Online, you're supposed to tell the software what kind of modem you own. You
choose your model from a really long list. For every corresponding modem
name, a file sits here in your Extensions folder.
You should feel absolutely great about taking 30 minutes right now to throw
away every modem-model file except the one you actually own. You'll save
RAM, hard-disk space, and time when you launch your modem programs.
(Other examples of these modem documents: anything beginning with the
words Zoom, Prometheus, Hayes, Global Village, Practical Peripherals, and so on.)
Apple CD-ROM, Foreign File Access, anything-Access - Why does Apple's CDROM player need so many little extensions? Heaven knows. All I know is that
you should toss these if you don't have a CD-ROM.
Apple Guide, Video Guide, anything-Guide - Remember that System 7.5
feature called Apple Guide, in which you're given step-by-step on-screen
instructions for doing something? These are the files that contain all the
instructions. If you use the Apple Guide feature, leave these here. If you don't,
you can save a lot of disk space by tossing anything with the word Guide in it.
AppleScript, Finder Scripting Extension, anything-Script -All components of
a very technical System 7.5 feature for the kind of person who wouldn't be
caught dead reading this book. However, even if you don't use these yourself,
some of System 7.5's best features depend on these extensions, so I'd leave
them in place.
AppleShare, File Sharing Extension, Network Extension, Sharing Setup,
Network, Users & Groups, Fiie Sharing Monitor, EtherTalk Phase 2, Mac TCP
Token Ring, Mac TCP DNR, TokenTalk Phase 2 (for the Token Ring card), and
TokenTalk Prep - Still more doodads for networking Macs together. If you're
not on a network, out they go.
A/ROSE - There's a good joke in here somewhere - something about A/ROSE
by any other name - but, alas, this extension is useless. Jettison pronto.
Assistant Toolbox - Only for PowerBooks. Lets you control certain functions
from the keyboard: 38-Shift-zero puts your laptop to sleep, and 38-Shift-Controlzero makes your hard drive stop spinning. This extension works with the
PowerBook File Assistant file-synching program, provided with recent
PowerBooks and System 7.5. In general, it's for power-geeks only.
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AudioV'1Sion Extension - Look at your monitor. Does it have speakers built
into either side? If not, you don't have the Apple AudioVision monitor, and you
can safely send this icon to the great Trash can in the sky.
Basic Color Monitor - This extension lets your Mac work with this one
specific low-cost Apple monitor model. If you have any other kind of screen, get
rid of this.

Caps Lock - Only for PowerBooks. Because the Caps Lock key on certain
models doesn't light up or stay down when you press it, this little extension
puts an up-arrow symbol on your menu bar when Caps Lock is engaged. That
way, you know when you're about to inadvertently type 46 pages in all caps.

Oipping Extension - (A System 7.5-or-later item) This is the magic software
responsible for a nifty feature called Macintosh Drag & Drop. Here's how it
works: Open your Note Pad from the S menu. Type something. Drag across
what you've typed to highlight it.
Now stick your pointer right into the middle of the highlighted area. Drag it
sideways clear out of the window and onto the desktop.
And presto: you've just created a clipping file - a little icon on your desktop
that contains whatever you dragged there! You could actually drag this little
clipping icon back into a Note Pad or SimpleText or Scrapbook window to put it
there. It's like Copy and Paste: The Next Generation.
While you're playing with Drag & Drop, note that it also works within a window.
That is, if you're writing your thesis in the Note Pad (heaven help you), you can
drag highlighted phrases around within the Note Pad window to move them
from one paragraph to another.
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Color Picker - The Color Picker is that dialog box that shows a big color
wheel, allowing you to choose a particular color. It appears, for example, when
you're in the Labels control panel and you click a label color to change it. This
extension adds a More Choices button to that dialog box, allowing you to
choose some super-techie options. Trash it.
Color SW anything - Software to make your Color StyleWriter printer work. If
you dont have one, throw these away.
·
ColorSync - For color publishers only. I'd toss it.
DAL - It's for hooking up to gigantic humming mainframes in Houston. Nobody
uses it. Toss it.
Display Enabler - This extension is for multisync monitors only (see Appendix
A). It adds, to your Monitors control panel, the ability to enlarge or reduce the
screen picture, allowing you to see less or more "real estate" at once.
Drag and Drop- For System 7.1 variants only. Gives you the Macintosh Drag &
Drop feature described in "Clipping Extension"; unnecessary in System 7.5.
EM Extension - Another piece of Extensions Manager, described under "In
your Control Panels folder," earlier in this chapter.
External CD Sound - Exclusively for 5200-models with an external CD-ROM
drive. Fixes a bug in which you couldn't hear, through your built-in speakers,
sound from music CDs.
Fax Extension, GeoPort Extension, Shared Library Manager, Fax Sender Believe it or not, you need all this crud just to run your GeoPort Adapter. That's
the strange-looking box, which is supposed to act like a fax/modem, that may
hang off the back of a Power Macintosh or AV model.
Finder Help - Leave this one alone. It's where the Mac stores the information
you get when you use Balloon Help.
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Fmd File Extension - Comes with System 7.5 or later. You want it; trust me. It's
responsible for bringing uµ that wonderful new Find File feature described near
the beginning of this endless chapter.
Graphics Accelerator - Makes your Mac repaint the screen faster. Works only
on Power Macs with "PCI slots."
Ilcifllsi Monitors, PowerBook Monitors, anything-Monitors - Talk about
trivial. These extensions add a couple of technical monitor-configuration
options that you can't even see unless you open your Monitors control panel
and click the Options button. Throw these away except the one that describes
your Mac model.
LaserWriter, StyleWriter, anything-Writer - Recognize these names? They're
various printers made by Apple. You only need one of them - the one that
matches your printer. You should definitely throw away all the others. (More on
printers in Chapter 5.)
MacinTalk Pro - Included with System 7.5 and later: lets your Mac speak text
you've typed. See Chapter 14.
Microsoft Dialog library, Microsoft OLE Extension, Microsoft-anything - You
poor thing! Somebody is making you use Microsoft programs, maybe even
Microsoft Office. Unfortunately, you're stuck with all of this System folder crud
if you hope to make those programs work.
Mailbox Extension - Yet another piece of the hated PowerTalk networking
thing. See "PowerTalk Setup, PowerTalk-anything" earlier in this chapter.
My Speech Macros - Imagine you have a Power Mac. Imagine you're a programmer. Imagine you've been creating new commands for the Power Mac's
speech-recognition feature. This is where you put them. Isn't imagination fun?
ObjectSupporillb, AppleScript lib, anything-Uh - For Power Macintosh only;
some kind of deep-seated, high-tech data-sharing technology you're not suppose to know about. Leave these alone.
Open Transport-anything- See "Open Transport anything" under "Control
Panels" earlier in this chapter.
PowerTalk Extension, PowerTalk Manager, and so on - Uh-oh. Somehow you
wound up with System 7.5's big, slow, complicated PowerTalk networking and
e-mail software on your Mac. Unless you work in an office where some full-time
nerd is dedicated to making this system operate, I'd trash this and all its related
files: Catalogs Extension; Mailbox Extension; Serial Tool; PowerTalk Guide;
and soon.
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In~::==--::::er contains one little file for each individual
printer model. Open this folder and discard the icons for any printers you
don't use.

PrintMonitor - Definitely leave this. It's actually a program, not an extension,
and it's the genie that grants you the miracle of background printing, a concept
you probably don't understand unless you've read Chapter 5.
Printer Share - Lets you share one StyleWriter among several networked

Macs. No network? Toss this baby.
RAM Doubler -A neat program from Connectix that tricks your Mac into

thinking that it has more memory (RAM) than it actually does. Since you or
someone you love probably paid good money for this, don't throw it away. Read
up on RAM Doubler in Chapter 18.
QuickDraw GX - The memory-grabbing On switch for QuickDraw GX, a
System 7.5-or-later feature described in Chapter 5. I think you're better off
without it.
QuickTime, QuickTime Power Plug, QuickTime-anything - You need these

little jobbers if you plan to use (or are using) digital movies on the Mac. You
know, little flicks that play inside a Triscuit-sized window right on your screen,
complete with sound (see Chapter 14). The QuickTime extension (and accompanying files) make those movies possible; many CD-ROM discs require this
item. If you're not a Hollywood wannabe, and don't use CD-ROMs, then save
yourself the memory and disk space and send this one to the cutting room
floor.
Record Button Extension - This one works with that bizarr-0 Apple keyboard,
the one that splits in half down the middle for ergonomic comfort. This item
makes the Record button (on that keyboard) turn on your Mac's sound recording (if the Sound control panel is open). Pretty useless.
SCSI Manager 4.3 - Nothing but trouble. Unless you already know what it

does, and have purchased all the necessary equipment, out she goes.
/

Serial (Built-in)- Still more Open Transport crud (see "Open Transport-

anything'').
Shortcuts - Another piece of Macintosh Guide (see "Apple Guide" at the

beginning of this extensions listing).
Sound Manager - This extension brings to your Mac an improved package of

sound recording-and-playback features. The most-immediate changes to your
Mac are a new, glassier Simple Beep alert sound; and a new Sound control panel
(see "Sound," earlier in this chapter).
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Any number of installations introduce the Sound Manager to your System
Folder: one of the hardware System updates, System 7 Pro, System 7.5, and
soon.
SR Monitor and System Speech Rules - For speech recognition, that interesting
Power Mac feature described in Chapter 14. If you aren't regularly talking to
your Mac - besides just swearing - out these go.
System AV and Video Startup - Exclusively for those lucky Mac owners of
models that can make QuickTime digital movies from your home camcorder
footage.
Thread Manager - Unnecessary in System 7.5 or later; actually, unnecessary
everywhere. Lets certain programs (of which very few exist) perform one
task - like initializing a floppy disk - while you continue to work on something else.
WorldScript Power Adapter - Lets your Power Macintosh use WorldScript
Language Kits, if you've bought any. You haven't; ditch this.

In IJOUr Fonts folder
You only have a Fonts folder if you're using System 7.1 or later. Actually, you
probably shouldn't throw away anything in it. See Chapter 5 again for a detailed
explanation of what all this junk is.

In IJOUr Launcher Items folder
You only have a Launcher Items folder if your Mac has Performa in its name (or
if you're running System 7.5). And the purpose of this folder is to let you specify
what jumbo icons you want to appear in your Launcher window, the Performa's
program-launching bay. See Chapter 15 for the gory details.

In IJOUr Preferences folder
The Preferences folder is filled with information, and none of it's for you.
Every single file in this folder was put there by another piece of software. Let's
say you change a setting in your word processor: you always want it to make
your typing double-spaced, let's say. Well, where do you suppose the computer
stores your new setting? It jots it down in a preferences file. And this prefs file
lives - wild guess - in the Preferences folder.
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Prefs files are famous for frustrating beginners. Because they're for use by your
programs, and not by you, virtually every one of them gives you a rude error
message if you try to double-dick it. You simply can't open a Prefs file; only
your software can.
You really can only do one good thing with the Preferences files: throw them
away. That is, throw away any that belong to programs you no longer use.

In the Speakable Items folder
There's no possible way you'll find this folder in your System Folder, except
under one circumstance: you have a Power Macintosh, a four-digit Performa, or
a model with AV in its name (such as Centris 660AV or Quadra 840AV).
If you're using your Mac's speech-recognition feature -you know, where you
talk to your Mac ("Computer: open MacWrite") -you can "teach" your Mac to
recognize the names of certain files or folders by putting them, or aliases of
them, into this folder.

Loose in the S1Jstem Folder
Clipboard - Every time you use the Cut or Copy command in a program, the
Mac, according to what you read earlier, socks the selected material away on an
invisible Clipboard. Well, guess what: it's not actually invisible. Technically
speaking, that info you copied has to be put somewhere. This is where: in the
Clipboard file.

Little-known fact: you can double-click the Clipboard file to open a window that
shows the last thing you cut or copied. (Another little-known fact: the last
swallow of a can of soda is 69 percent saliva.)
Extensions (Disabled) - This explanation is tricky and techie, but I'll do my
best. Remember Extensions Manager, described under "Control panels" earlier in
this chapter? It lets you tum extensions or control panels on and off. Well, now
you know how it works. When you click some extension's name to switch it off for
the day, Extensions Manager doesn't delete that extension; behind the scenes, it
just moves it into this Extensions (Disabled) folder. When the Mac next starts up,
it only "loads" the extensions that are in the actual Extensions folder.

To tum that particular extension on again, you can, of course, use Extensions
Manager again - but you could also move the file manually back into the
regular Extensions folder. (By the way, other, similar programs, like Conflict
Catcher and Now Startup Manager, work the same way.)
And if you tum off a control panel, sure enough, it winds up in a folder called
Control Panels (Disabled).
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Fmder - This is the most important program on your Mac. Without it, a
System Folder is just a folder, and your Mac can't operate. The Finder file is
responsible for creating your basic desktop: the Trash, your disk icon, windows, and so on.
System - This is also the most important file on your Mac. It contains all kinds
of other info necessary for the computer to run: your sounds, for example; your
fonts (in systems before 7.1); and reams and reams of instructions for the
computer's own use. Without a System file, the Mac won't even turn on.
System Enabler- This, too, is the most important file on the Mac. Like the
System and the Finder, without this file, your Mac can't even tum on. However,
not every Mac has one of these. If you have one, don't touch it.
PrlntMonitor Documents - PrintMonitor, as you read in Chapter 5, has to do
with background printing. After you use the Print command but before the paper
actually starts coming out of the printer, the Mac stores the printout-to-be in
this folder. You can trash this folder if you want, but it'll reappear every time
you tum on the Mac.
Scrapbook file, Note Pad file - When you paste something into the Scrapbook
or Note Pad desk accessories, behind the scenes, the Mac actually stores it in
these files.
Startup Items, Shutdown Items - Fascinating, Captain. Anything you put into
the Startup Items folder (a program, a document, a sound, a folder) gets opened
with a mysterious automatic double-click whenever you tum on the Mac. If you
don't do anything but word process, for example, drag the icon of your word
processor into this folder. Thereafter, every time you power up for the day, your
word processing program will be on the screen awaiting your brilliance.
Starting in System 7.5, you also have a Shutdown Items folder. Same deal,
except anything in here gets run automatically when you Shut Down the computer. Automatic-backup programs come to mind. A sound that says "Th-th-thth-th-that's all, folks!" also comes to mind.
-ATM 68020/030 -Another component of Adobe Type Manager (see
Chapter 5). Leave it here.

Top Ten Other T1J.pical Pieces
of SIJ.stem Folder Crud
Unless your Macintosh is brand new, you've probably got a bunch of other
System Folder clutter I haven't mentioned. Usually, it's stuff that you (or your
guru-friend) purchased and installed.
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Remember, the vast majority of this stuff doesn't eat up any of your memory; it's
only occupying disk space. Still, if some piece of unidentified System Folder
crud really bugs you, you can always try moving it out of the System Folder for
a week or so, long enough to see if your Mac still works without it.
1. Adobe or Aldus -A folder full of stuff for programs made by Adobe
(formerly Aldus), such as PageMaker or FreeHand.

2. Claris -A folder full of stuff used by Claris Corporation programs
(ClarisWorks, FileMaker, and so on). Contains supporting junk like spellingdictionary files, translator files (so you can open Word files with
ClarisWorks, for example), and the like.
3. CEToolbox - A component of any program from a company called CE
Software (DiskTop, QuicKeys, QuickMail, & Co).
4. Suitcase:__ A font-management program that lets you "turn on" or "turn
off" sets of fonts very easily.
5. GlobalFax or Teleport or PowerPort or Express Modem or FaxStf - The
software that controls your modem and fax features.
6. After Dark Files -After Dark is the famous automatic screen dimmer that
features the famous Flying Toasters and Fish. This folder holds all of its
different modules.
7. 32-bit Enabler (or Mode32)-These are memory-related add-ons. You
need one or the other if your Mac has more than 8MB of memory and it's a
Mac II, Ilx, Hex, or SE-30. At this point, you probably don't know or care
about memory; if you want to find out more, see Chapter 18.
8. PrintMonitor Documents - Remember Background Printing from Chapter
5? That's when the Mac saves your printouts as temporary files on your
hard drive when you use the Print command; it then feeds those temporary files to your printer when it gets time, so that you can, in the meantime, get back to work.
Well, this folder is where those printouts-to-be wait around before they're
actually sent to the printer.
9. At Ease Items - The storage folder for aliases of everything you choose to
list on your At Ease screen. See Chapter 15 for more about At Ease.
10. HelvNar, PalatRom... - These weird abbreviated-name icons are printerfont files. If you have System 7.1 or later, they belong in your Fonts folder
instead; maybe they didn't get moved when you upgraded your System
version. No harm done; it's only clutter.

Chapter9

Screamingly Important Things
Nobody Tells You
In This Chapter
fil>-A really important thing you wouldn't have been told otherwise
Iii>- And another thing
Iii>- And another thing
Iii>- And another thing

J

t's amazing anybody can use computers at all, really. You're sold a computer,
you're handed a manual written by people who read Popular Semiconductor,
and you're kicked out of the nest.

Think about every important lesson you've learned in life. You learned how to
be careful in relationships only after having your heart broken. You learned
about con artists only after being swindled. You learned to drive more carefully
only after your first accident.
It's the same way with computers. Sure, you'll learn sooner or later; but most
people have to learn everything the hard way. You get to sit back in your La-ZBoy and read about it.

It Doesn't Need to Be Repaired.
Even if something funny's going on with your Mac, the machine itself is probably fine.
Most beginners, though, immediately suspect the circuitry. I understand the
instinct. I mean, when VCRs, lawnmowers, or electric razors go on the fritz,
you're right -you need a repair shop. But a computer's different; it has
software. When your Mac starts behaving oddly, it's probably a software
problem, not a mechanical one. That means you can fix it yourself, for free.
Almost always.
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In Chapter 18, you'll discover the steps you can take to restore your Mac's
software to health. Until then, just remember: these machines are built like
rocks and almost never"break."
(PowerBooks are another story. You would be, too, if you were hauled around
in a briefcase.)

Don't 8ulJ Version 1.0 of An1Jthin9.

@)

This principle isn't just true of software or Macs; it's true of cars and houses
and medicines, too. The rationale is simple: if it's brand new, there's no way all
the bugs and kinks have been ironed out.
Even if the software company's 20 paid testers can't find any problems, it's
amazing what happens when 100,000 ordinary folks start banging away. Problems crop up from nowhere, hidden bugs emerge, and the "early adopters"
(people who bought the 1.0 version) pay the price.
The software company rushes to correct the problems, and it releases a new
version called something like 1.01. That's the version you should buy.

You Can Leafle Windows Open.
You don't need to close all your windows before you turn off the computer.
Leave 'em open when you're done for the day! They'll be waiting and ready
when you start up tomorrow. You save effort on both ends.

Press Option to Fax.
If your Mac has a fax/modem, you're in for a delicious treat. Faxes sent by a Mac
come out looking twice as crisp and clean when they're received by a real fax
machine. And sending faxes couldn't be more convenient for you - no printout
to throw away, no paper involved at all. Your Mac sends the thing directly to
another fax machine's brain.

Connecting a phone line to your fax/modem (or the phone jack on your
PowerBook) is the easy part. Now you have to figure out how to send what you
want to send. Sure, you could read the manual - but who's got the time?

________ Chapter 9: Screamingly Important Things Nobody Tells You
Here's what you do. Begin by typing (or opening) whatever it is you want to fax.
Usually, this means a letter you've written in your word processor. Make sure
it's in front of you on the screen.
Now take a look at your File menu, and note where it says Print. Got it?
OK, let go of the mouse now. With one hand, press and hold down the Option
key on your keyboard. With the other, go back up to the File menu and look at
the word Print. If your fax/modem is like most, that word Print has now changed
to say Fax/
Edit Uiew lnser
New
HN
Open ...
HO
Close
HW
Silue
HS
SilUe Rs ...
-Ofl

Edit Uiew lnser
New
HN
Open ...
HO
Close
HW
SilUe
HS
SilUe Rs ...
-Ofl

Print Preulew ... H"'CI

FilH Preuiew ...

Normal

H"'CI

With Option key

If you choose the Fax command, you'll be shown some kind of address book,
where you can type in your friend's fax number; you'll also see a button called
something like Send, which will get the fax merrily transmitting away.

Now then. If your menu doesn't change to say Fax when you press the Option
key, then maybe you don't have one of the standard modem brands. Try looking
at the menu again while pressing the Shift and Control keys together. (That's the
key combo if you have an Apple modem.) Or try it again pressing the 88 key.
If none of those combinations works, then something else is afoot. Maybe you
don't have the fax/modem software installed; rustle up the original disks and
install it. Maybe you have that one-in-ten fax/modem brand that doesn't have
the Fax-menu feature at all.

The point, though, is that you should not have to open up the Chooser every
time you want to send a fax! I'm afraid that thousands of people aren't aware of
the Option-key (or Shift/Control-key) shortcut. They still open the Chooser in
the ti menu, switch to the Fax icon, send the fax, open the Chooser again,
switch back to their printer - a colossal waste of time and effort.
Remember, the computer is supposed to save you time.
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Submenus Are about Horizontalness.
A submenu is a minimenu that springs out of a regular menu, like this:

Rb out ClarisWorks ...
•

Arter Dark 3.0

!

liiii!I RppleCD Rudio Player

Apple Menu Options

II Calculator
Color
I"!!
Keyboard
•i,_iliclhololslerll!llllllllllllli=l-;La~b;e~ls!.._~-+DlskTop
Find File
~ Jigsaw Puzzle
Key Caps
Note Pad
filill Recent Applications
~ Recent Documents
lil!i!I Recent Seruers
Ill Scrapbook
•

Iii

11

~

~

Map
Monitors
Network
NowSaue
PowerKey
QuicKeys™
Users It Groups
Uiews

~

Getting one of these things to work is only slightly easier than tying your shoes
with one hand.
The trick is patience. And horizontalness. Slide down to the main menu command (it's Control Panels in the preceding figure), and then pause. Now slide
directly to the right onto the submenu; if you try to take a shortcut diagonally,
the whole submenu will disappear, and you'll have to start over.
Once you're squarely (and horizontally) onto the submenu, now you can move
up or down to the command you really want.
A lot of work, I know, but it's the price we pay for progress.

A '~sit'' File Has to Be &panded.
Suppose, just for a moment, that you become a real Macintosh ace. You start
using a modem to dial up the outside world. You visit America Online or a local
electronic bulletin board system. You see something worth getting ... maybe a
program called FreeMoneyMaker 2.0. So you download it (transfer it to your
own Mac).

FreeMone11Maker .sit
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But now you double-click the icon you got. And it says, "Application not found."
You've just been bit by the .sit bug.
A .sit file is one that's been compressed into a compact form, for use on modem
services, using a program called Stufflt. The point is, of course, to make the file
smaller so it'll cost less to download or transfer to your Mac. America Online is
supposed to unstuff .sit files automatically when you sign off. (It leaves the ".sit"
file behind, though, so look for both the ".sit" and the expanded version when
you're done using America Online.)
If, however, you somehow wind up with an unexpanded .sit file, you need to get
your paws on a program that can expand it. There are millions of 'em. They're
called things like UnStufflt, Stufflt Expander, DropUnStuff, and, of course, Stufflt;
many of them cost nothing.
And where do you get such a program? From wherever fine public utilities are
vended: from those very same modem services, of course, or from a local Mac
user group.
Fine print: You may occasionally see files that end with .cpt (created with
Compact Pro), .dd (created with DiskDoubler), and .sea.
That last one - a .sea file - is especially likable. It's a self-expanding archive,
which means that it expands when you double-click it. You don't need Stufflt or
any other program to decompress it and start making FreeMoney.

An11 New Pro9ram Must Be Installed.
Another real-life situation:
You buy a new program. Let's say it's After Dark: The Oprah Win/Tey Collection.
You admire the handsome disks, turning the cool plastic squares over and over
in your hand until you get really bored.
At last you decide you want to install the software and start seeing talk-show
characters parading across your screen. You manage to insert the disk correctly
(metal side first, label side up). And then you stare dumbly at the screen, not
knowing what to do next, and definitely not seeing any signs of Oprah.
Today's store-bought programs are much too complicated for the typical
college-educated American to install correctly, having a multitude of files that
must all be carefully deposited in specific places on your hard drive to work.
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Therefore, the vast majority of them come equipped with some kind of automatic Installer. In other words, when you shove the disk into your Mac, you'll
usually see something like one of these:

LJ

Installation File-s

·- = . Install Disk 1
1K available

;J'i

-=:J

ReadMe First!!!.1 .0.1

I'm sure you get the point you're looking for the word Installer somewhere on
your screen. Double-dick whatever says Installer. (The exception, of course, is
the Microsoft programs as shown above; Microsoft never does things the
Macintosh way.)
From here on, you're on autopilot. The program will show you a few welcoming
messages, explain what's about to happen, and maybe list what's about to be
dumped onto your hard drive. Just keep smiling and clicking OK buttons until
it's over. Along the way, you'll be asked to shove in any additional disks; just do
what you're told. Keep Disk 1 handy, though. For some idiotic reason, you
always have to re-insert Disk 1 when all the other disks are finished .

Do the Shi~·KelJ Trick before lnstallin9.
One more thing about installing. Unless you find that computer headaches
make life more interesting, do this. Before you install any new program, restart
your Mac. As it's starting up again, hold down the Shift key until you read
"Extensions off" on your screen.
You've just disabled any anti-virus programs or other startup programs that
give most software Installers fits.
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''Read Me First" ="l9nore Me First. 11
In the picture you saw a page or so ago, you may have noted that, along with an
Installer, almost every program comes with a little icon that says Read Me First,
ReadMe, Lisez s 'ii vous plait, or something.
Most of the time, if you double-click this item, you'll be shown a screenful of fine
print pertaining to the program you're about to install. Example: "Part 45. If you
have a Performa 3100/23 with 45 MHz acceleration and no Shift key, and you've
previously installed a 32-bit Addressing software, note that your screen saver
may take two seconds longer to appear."
The point is that it's usually pretty trivial stuff. And it's usually pretty technical
stuff. The software company is basically warning you about bugs you may be
about to encounter.
So skim the material, but do not sweat it if you have no clue what they're talking
about. Nobody else can understand programmers, either.

Most Stuff You Buu You'll Net/er Use A(/.ain.
This happens to be a proven fact. The vast majority of programs bought by
computer fans wind up on the shelf, unused.
I guess that's perfectly understandable; after all, we retire old sweaters, appliances, and unlabeled jars in the refrigerator. Why not software?
Because it's darned expensive, that's why. Therefore, read the magazine reviews
before you buy something; at $300 a pop, programs aren't sweaters. Also, buy
software from places (such as a mail-order joints) that will let you return it.
They're insane to give you that opportunity. You may as well take advantage of it.

Don't Worru about Viruses.
There has never been a Mac virus that destroys files.
Read it again.
Oh, there have been viruses, all right. They've made Macs beep or burp or
display quirky little messages. But there's never been one that wrecked
anybody's files, let alone hurt the machine itself.
A virus can't physically hurt the machine, actually. A virus is a piece of software.
Erase the disk it's on, and it's history.
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In Chapter 11, you'll read about anti-virus programs you can get. Fine. But if
you're going to worry about owning a computer, there are much worthier
worries: carpal tunnel syndrome, planned obsolescence, and Kid Pix-playing
four-year-olds, for example.

Etle11J. Piece of Et[uipment Needs So~ware
in Your S1J.stem Folder.
Your Mac is a regular little Ellis Island. It greets every piece of incoming add-on .
equipment with open little silicon arms. You can attach all kinds of things to it:
printers, CD-ROM players, scanners, modems, musical instruments, or anything
else described in Chapter 12.
When it comes to understanding and troubieshooting your Mac, though, here's
a key piece of news: every single hardware item you add requires a corresponding software program. Think of it as the paperwork for newcomers.
These little programs, called drivers, translate between the Mac and whatever
equipment you're attaching. They usually hang out in the folder called Extensions (inside your System Folder). If you look right now, you'll see one for your
printer and probably a bunch for other printers. If you have a CD-ROM, scanner,
modem, or whatever, you'll find corresponding files somewhere on your Mac
for them, too.
Now you know the technical reason you can't just unhook your printer, attach it
to my Mac, and expect it to work, without copying over that little driver file.
(Another technical reason: I live in Connecticut.)

Error Messa9es Are Useless.
Every so often a representative of the United States Postal Service drops by
bearing huge sacks of mail from readers around the world. Sure as spring
follows winter, most of them ask the same question:
"What does 'Bad F-Une Instruction (Error Type-93)' mean?"
It means: "Does not compute."
Of course you know that. After all, you only got that message when something
terribly wrong went down, and your cursor froze on the screen, and a loud
electrostatic buzzing filled the room. What you really want to know is whether
that "Bad F-Line, Error of Type -93" can help you figure out what happened.
And the answer is no. Oh, sure, they publish lists of these codes. But no
kidding: they are totally unhelpful. Here are some examples:
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Error code

Message

,Meaning

-1

qErr

queue element not found during deletion

-2
-3

vTypErr

invalid queue element

corErr

core routine number out of range

-4

unimpErr

unimplemented core routine

OK? Now do you believe me?
As an Apple programmer once explained it, it's like finding a car smashed into a
tree with its tires still spinning. All you can say for sure is that something went
wrong. But you have no idea what led up to the crash. Maybe the guy was
drunk, or distracted, or asleep. You'll never know.

Same thing with your Mac. The machine knows that something happened, but
it's way too late to tell you what. Restart it and get back to business. If the
problem recurs, read Chapter 18.

The More Popular It Is, the Cheaper and
Better It Is.
Bummed out because your expensive music program is buggy? Frustrated
when your medical-office software acts up?
Unfortunately, Economics 101 rears its ugliest head when it comes to
Macintosh programs. If your interests are specialized - music, medicine, hair
replacement - the pickings will be slimmer, more expensive, and less polished
than general-interest stuff. For example, there aren't many bugs in ClarisWorks
or WordPerfect; because so many people buy them (and because general
software is a very competitive area), the companies have had the time to work
out the wrinkles.

IBMs Are Not Cheaper.
Two kinds of personal computers are on earth: Macintosh and IBM-compatible.
(Dell, Compaq, Gateway, Packard-Bell ... they're all IBM-compatible, also
known as PCs, DOS, or Windows.) Each kind has its following, which
vehemently defends its own beliefs and purchases.
Incredibly, you still hear this one argument today: "l bought an IBM," some poor
slob will tell you, "because Macs are more expensive."
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First of all, it's simply not true. Look at the newspaper these days. A Power
Macintosh model actually costs substantially less than an IBM compatible of the
same speed (if there are any IBMs of the same speed).
But the real kicker is that when you compare sticker prices, you're comparing
(you'll forgive me) Apples and oranges. Because an IBM-type computer doesn't
come with as much stuff!
For example, a Mac has built-in sound circuitry, so you can play games and
CD-ROM discs right out of the box; on a PC, you have to buy a $150 "sound
card" and figure out how to install it. On a Mac, you can buy a piece of phone
wire and connect several computers together (networking). You'd have to buy
"networking cards" if you had an IBM. On a Mac, if you get a new hard drive or a
scanner, you just attach it to the back and it works. On a PC, you'd have to buy
an "interface card" and spend a weekend installing and configuring it!
Then there's the little matter of "down time" - the weekend hours PC-clone
owners spend puzzling over the weird and unexpected things their computers
do. There's simply less to go wrong on a Macintosh.
Finally, nobody ever considers the value of your time. Almost everybody
concedes that the Mac is easier to learn and easier to use. You get stuff done in
less time. Doesn't that <;ount for something?

America Online Han9s Up on Et1er1J.bod1J..
It's not just you. If you use your modem to dial into America Online in the peak
hours of the evening, you're competing with six million other people trying to
dial in. There just isn't enough space at the trough. You may get bumped off
your connection, or you may not be able to dial in at all.
One thing's for sure: if you wait a little while - or a long while - and try again,
you'll have much better luck.

Ma9azines Are of/er Et1er1J.one's Head.
It's true: the major Mac magazines, Macworld and MacUser, simply drip these
days with articles about 32-bit addressing and TCP/IP protocols. You don't get
'em; I don't get 'em. This despite the fact that the huge majority of Mac users are
beginners! Are the editors crazy?
Nope; they do it on purpose. Magazines survive on advertising income. The
more ads they sell, the fatter the magazine. (Interesting stat: the Mac magazines, exactly like other magazines from Time to log Cabin Living, are rigidly
controlled at 60 percent ads, 40 percent articles.)
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To be a happy, healthy, thriving publication, therefore, the computer mags want
to appeal to advertisers. So they're written to appeal to people who buy a lot of
stuff, which will attract advertisers.
Well, who do you think buys the most stuff? Guess what: it's not Stella the
student or Harry the home-office guy or Nancy the novice. It's Carl the corporate super-nerd. This guy doesn't buy one or two programs; he buys 500 copies
at a time, to outfit his entire company.
That's who the advertisers drool for; that's who the magazines write for; and
that's why there are so many ridiculously high-tech articles about things most

people couldn't care less about.
On the other hand, there's always at least a couple of articles that are useful to
us. Furthermore, while most beginner-oriented Mac magazines have quietly
croaked (because of- guess what? - not enough advertising), at least one of
them is usually still struggling along. At this moment, the Mac Home Journal is
alive and publishing, and not one of its articles is too technical.

1-800-SOS-APPL Is Worth Its Wait.

@)

You do have that number Magic-Markered on your wall, don't you? It's the tollfree Apple help line. Twelve hours a day, a crack staff is at the other end who's
willing to help you out of any crisis.
Unfortunately, they're also willing to help out 22 million other Mac users. As a
result, before a live operator answers your call, you sometimes have to wait
until the cows come home, make dinner, and get ready for bed.
But what do you care? It's toll-free, right? When you finally get live people on
the phone, odds are high that they'll solve your problem. If your Mac is genuinely on the fritz, they'll schedule a repair; and if it's within a year since you
bought your Mac, the repair is free. (If it's a PowerBook, they'll send you a
shipping box; ship it to themselves overnight; repair the thing; and overnight it
back to you, all for free. If it's any other Mac, they'll send somebody to your
house to fix the Mac.)

Click the Label instead of the Button.
Here's a wonderful shortcut. Whenever you're presented with a set of options,
they usually look something like this:
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Checkboxes
D Rhinoplasty
D Liposuction
D Rugmentation

Radio buttons
Rnesthetic
OLocal
®General
QNone

You're allowed to choose as many checkboxes as you want; a little X appears in
each one when you click it. Like the pop-out buttons on a car radio, however,
only one of the round ones - called radio buttons - can be selected at a time.
Anyway, your instinct is probably to click the little square or the little circle
button to make your selection. But it's far quicker to sloppily slash away with
your mouse at the label of a button instead of the tiny square or circle itself.
Click the words, and the button gets clicked.
Click anywhere on the words
Rnesthetic
OLocal
®General
ONone

You Can't Rename or Trash a Window.
Computer experts, if you stop to think about it, are about the worst people to
write computer books. Most of 'em have forgotten all about what it feels like at
the beginning.
I recently went over to rescue a friend. He claimed that his new Mac was "a
piece of worthless junk." When I visited his apartment, I saw why he thought so.
He had been trying to throw away files by moving them to the Trash. Nothing
wrong with that, right?
But he hadn't been dragging their icons to the Trash - he had been dragging
their open windows! There, in the lower-right corner of his monitor, were 35
open windows, all piled up as close as they could get to the Trash can.
And you know what? That was a perfectly reasonable action on his part. Why
shouldn't you be able to throw away a window?
Well, anyway, you get the point: you can't throw away a window. You can't
rename it, either. You have to close the window and then rename (or trash) the
icon that represents it.

':-,:,;:.;·:<';...:,"·):::.,·.'<··'"' ',/

Piflll

~-ardff
N~'Jc·,.,
/·'
•. N~rdill;\'oli . .
The Sth Wave

In this part ...

T:iere
comes a time in everyone's life when just turning
I ~he computer on and off no longer brings the surge

of excitement it once did. Now it's time to maneuver this
baby to the autobahn, open 'er up, and see what she
can do.

That's why the next four chapters move beyond the
desperate, what-am-I-doing? basics and show you some of
the more rarified talents of your machine.

Chapter10

Faking Your Way onto America
Online and the Internet

A

modem is a little $100 to $300 box whose mission in life is to let your
computer call another computer over the telephone lines. It follows, then,
that the bigger the other computer, the more fun you're likely to have.
Somebody came up with an ingenious concept. Get a really huge computer. Buy
thousands of modems and phone lines. Fill the computer with tons of really great
information. Charge a few dollars per hour for the privilege of accessing all this
stuff. Make a mint.
This, then, is the principle of an online service.
Or hey, how about this: connect all the computers on earth by the phone lines,
so they can all visit each other.
This, then, is the principle of the Internet.
Before you begin this adventure, though, a grave warning: these services are
every bit as addictive as heroin, crack, or the O.J. trial, but even more dangerous. As you explore this endless, yawning new world, filled with surprises at
every turn, you're likely to lose track of things - time, sleep, and your family,
for example. Take it slow, take it in small chunks, and use these services always
in moderation.
Also note that these things - modems, the Internet, and so on -weren't
designed by Apple. They existed long before the Macintosh. As a result, it's all
quite a bit more complicated and awkward than everyday Mac activities. I just
wanted to warn you.
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First, the Modem
If you don't already have a modem, the rule is simple: the more you pay, the

faster the modem.
Most people these days buy modems called "14.4" or "28.8," referring to the
speed ratings (in kilobits per second, if you must know). But if you're only
interested in sending or receiving electronic mail (as opposed, say, to looking at
great works of art via the Internet), you can buy a 9600-bps modem and save a
lot of money. As always, my suggestion is to buy it mail order, from, for example,
Mac Connection. (Appendix B has the number.)
When the Mac makes a call, it dials the phone many times faster than, say, a
teenage daughter, but ties up the phone line just as effectively. When your Mac
is using the modem, nobody else can use the phone.
Therefore, you need to figure out how you're going to plug in your modem:

I

~

Share a single line with the modem. Most modems have a built-in Y
jack - that is, two little jacks where you can plug in a telephone wire.
You plug the modem into the wall, and plug the phone into the modem.
Now you can use the telephone normally whenever you aren't using the
modem, and vice versa.
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Y6 Installing a second phone line. This is clearly the power-user's method:

give the modem a phone line unto itself.
Pros: (1) Your main family phone number is no longer tied up every time
you try to dial up the latest sports scores using your modem. (2) You can
talk to a human on one phone line while you're modeming on the other. (3)
If you're in an office with one of those weird PBX or Merlin-type multiline
telephone systems, you have to install a new, separate jack for the modem
anyway.

Cons: (1) This option is expensive; (2) it involves calling up the phone
company, which is about as much fun as eating sand; and (3) you run a
greater risk of becoming a serious modem nerd.

America Online
America Online, the largest online service, is about the best thing you can do
with a modem. It's simple to use, it's relatively cheap, and it's got so much to do
that it makes Disney World look like a garage sale.

Houl to 9et it
Pick up the phone and call 800-827-6364. Read a magazine while you wait for
somebody human to answer. Tell them you want the free starter disk. Read
several dozen magazines while you wait for the disk to arrive in the mail.
This disk entitles you to play with America Online for ten hours, free. If you
don't like it, you cancel, and everything's fine. If you do like it, they'll charge you
$10 per month. For that money, you can connect to America Online for a total of
five hours each month. (Additional hours beyond five are $2.50 each.)
This disk, not coincidentally, contains the software you need to dial up America
Online. Fortunately, they've worked out a clever scheme that lets you, as one
of 90 percent of Americans living vaguely near metropolitan centers, make a
local call to America Online. Somehow, this system carries your call all the
way to Virginia for free. (That's where the actual gigantic America Online
computers live.)

How to connect to it
To install the America Online program (if it isn't already on your hard drive),
insert the floppy disk, double-dick the Installer, and follow directions.
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America Online folder. Inside this folder is the America Online program whose
icon you double-click to get started.
~!iil-.flmeriu Online u2.6 Folder
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The first time you do so, you'll be guided through a series of setup steps
automatically. Along the way, you'll be asked
""" For your name and address
"""For a credit card number (heh-heh)
""" To choose a local "access number" from a list (and a backup number)these are the local phone numbers your Mac will dial each time you want
to connect with America Online
""" To make up a "screen name" and a password
Don't freak out about the credit-card number, by the way. If you cancel before
you've used up your IO free hours, your credit card will never be touched. (Be
sure you do cancel, though, by calling up that 800 number and reading a
magazine until they answer.)
The screen name can be IO letters long, but you can't use punctuation. You can
use a variation of your name (A Lincoln, MTMoore, Mr Rourke, etc.) or some
clever CB radio-type handle (FoxyBabe, Ski Jock, NoLifeGuy). Do understand,
however, that America Online has over six million members, and each of them
(including you) can choose up to five different screen names, one for each
family member. In other words, you can pretty much bet that names like Ellen,
Hotshot, and Mac Guy were used up some time in the Mesozoic Era.
The program will make you keep trying until you come up with a name that
hasn't been used before.
When all of this setup information is complete, your modem will begin screaming and making a hideous racket, and you'll see an America Online logo screen
that says things like "Checking Password."
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What all the screaming is about
When you use your modem for the first time,
you'll hear it begin shrieking and making all manner of high-pitched staticky sounds. Resist the
impulse to rip the thing from the wall and stomp
on it; it's supposed to make those sounds.

In order to send this information quickly, the modem essentially yodels. It sings a high note and a
low note, then high, then low, incredibly fast.
High notes mean a 1, and low notes mean a 0.
That's what all the shrieking is about

A computer, as you probably know, thinks in
streams of ones and zeroes. The information your
modem sends, therefore, looks something like
1001011101010101010- not much use to you, I
realize, but which could actually mean the word
"Fruitcake" to the receiving computer.

This also explains where the word modem
comes from, by the way: ·it's a contraction of
modulate, which means "yodel," and demodulate, which means "translate yodeling."

Your modem is dialing the local phone number; the local phone number is
relaying the call to the long-distance network; the long-distance network is
sending the call to Virginia; the computers there are answering the phone and
looking you up; your password is being checked to make sure you're not some
high-school hoodlum trying to break into your account; and, finally, if everything goes well, you're brought to this screen:

You also get to hear a recording of the famous Mr. Cheerful, the man who says
"Welcome!" as though you're just the person he's been waiting for all day. If
you've got e-mail waiting, he also says "You've got mail!" which he's really
happy about. (To read the mail, click the "You have mail" icon. If you don't have
any mail waiting, you'll just see an empty-envelope icon.)
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Explorin<J blJ. icon
America Online, you'll quickly discover, is a collection of hundreds of individual
screens, each of which represents a different service or company. Each day,
four of them (one of which is always News) are advertised on this welcome
screen. To jump directly to the advertised feature, you click the corresponding
icon. (In this case, one click suffices.)
The broader America Online table of contents, however, appears when you
click the Main Menu button at the bottom of the opening screen. The following
figure lists a few of the services that hide behind each of the eight primary icon
buttons.

Each of these buttons takes you to yet another screen, where you can visit
related services, as follows:
I. Headlines and news articles - sports, weather, entertainment, and so on

2. Stocks (check quotes, actually buy and sell, mutual-fund stats, and so on),
investing advice, tax information
3. Dozens of special-interest areas, based on religion, gender, hobbies, race,
sexual orientation, age, disabilities, and so on
4. News, help, and advice about computers, plus software to download
5. Advice, information, and reservation-making for travel, vacations, and
plane trips
6. An electronic mall: you can buy books, flowers, steaks, computers,
records, cards, and everything else
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7. Gateway to those "chat rooms," as described later
8. The electronic editions of dozens of newspapers and magazines: Entertainment Weekly, Consumer Reports, Macworld, and so on
9. TV and radio listings, reviews of books/movies/plays/TV shows, theater
listings, fan clubs, and so on
10. Dozens of resources for teachers, students, reference hunters

11. Dictionary, encyclopedia, telephone listings
12. See "The Internet (Yikes)," later in this chapter
13. Unbelievable quantity of sports information: current scores, statistics,
magazines, game leagues, and so on
14. Disney, Nickelodeon, video-game stuff, hobbies, tons of other carefully
screened material

Here's an example of how America Online can have a meaningful impact on
your actual daily life. Suppose you accidentally bump some floppy-hat-wearing
woman at the grocery store while reaching for a can of Spam Lite. She shoots
you a look and growls, "Screw you, flatworm."
Flatworm? Befuddled, you go home and dial up America Online. At the main

screen, you click Main Menu. At the Departments screen, you click Reference. In
the following window, you click Compton's Encyclopedia.
At the next screen, you're offered several choices, such as "How to use the
Encyclopedia" and "Search Encyclopedia Entries." You double-click the latter
option; you type flatworm, press Return, and presto! There's your definition: "a
primitive, broad, flat-bodied invertebrate covered with tiny hairlike structures."
Aren't computers wonderful?

Nafli9atin9 hlJ. ke1J.ulord
If you poked around enough, clicking icons and opening screen after screen,
you'd eventually uncover everything America Online has to offer. In the meantime, however, you'd run up your America Online bill, develop mouse elbow,
and watch four Presidential administrations pass.

A much faster navigational feature is AOL's keyword feature. Choose Keyword
from the Go To menu. (Shortcut: press 88-K) You get this box:
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Type the name of your destination into the blank and press Return. You're
teleported directly to that service.

A few of v.our faflorite thin9s
Here are a few typical AOL services, along with their keywords. Arm yourself
with this list so that you make the most of your free ten-hour trial.

Keyword

Service

What It ls

Access

Local Access Numbers

A list of local phone numbers for dialing
into America Online. Use this before
you go on a trip to another city!

Arts

Broadway shows

After using keyword Arts, click
Zeitgeist, click List Topics, and then
scroll down until you see Broadway
Musicals. Tons of messages about
what's new and upcoming in the
theater.

Atlantic

Atlantic Monthly magazine

The complete text of this month's issue,
plus contact with the editors

Beginners

America Online Beginners

An area for first-time America Online
users: help, directions, hints

Billing

Accounts & Billing

Your current billing info, disputes, and
so on

Classifieds

Classified ads

Just like the ads in a newspaper"- but
free

CSLIVE

Tech Help Live

On-the-spot communications with a
real human being of whom you can ask
questions about America Online

Encyclopedia Compton's Encyclopedia

As discussed earlier
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Keyword

Service

What his

Flowers

Flower Shop

Order flowers electronically

Geographic

National Geographic

The complete text of this month's issue,·
plus contact with the editors and
downloadable maps of the world

Homework

Academic Assistance
Center

A place for students to get live,
interactive help with homework and
research

Jobs

Jobs Listings Database

Like the Help Wanted ads of a paper

Macgame

Macintosh Games Forum

Files, messages, and discussions of
Mac games

Macworld

Macworld magazine

News, reviews, and articles from the
current issue of Macworld. Another
great place to ask questions.

Mall

The Mall

A whole mess of mail-order catalogs,
from which you can order online

MC News

San Jose Mercury News

The complete text of today's issue, plus
contact with the editors

MGR

Macintosh Graphics

Files, messages, and discussions about
art and graphics on the Mac

MMS

Macintosh Music Forum

Files, messages, and discussions of
Mac music and sound programs and
equipment

MOS

Macintosh Operating
Systems

A bunch of Macintosh gurus who can
answer virtually any question about the
Mac, troubleshooting, and so on

News

Latest news

Shows you a list of headlines. Doubleclick the one you want to read.

NPR

National Public Radio

Schedules, discussions with the hosts

Performa

Performa Center

Files, messages, and discussions of the
Performa line of Macintosh computers

PCFN

Financial Network

Financial advice, news, and an actual
online discount broker (buy & sell
stocks)

Sabre

American Airlines

Look up plane schedules (for all
airlines), make reservations, and buy
tickets. Complicated to use, but
interesting.
(continued)
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Keyword

Service

What his

Sports

Sportslink

Latest sports scores in every pro sport,
plus Olympic coverage (in appropriate
years) and the text of USA Today's
sports section

Star Trek

Star Trek

Star Trek

Stocks

Stock price report

Check the current price of any stock.
This feature even calculates your
current portfolio value and shows
whether you're up or down.

Traveler

Travel Forum

Advice and info abouttraveling the US
and elsewhere: passport info, travel
guides, horror stories

Furthermore, you can jump to any of the 100 Macintosh software and hardware
companies who have their own screens ("forums") online. The name of the
company is the keyword. Examples: Aladdin, Connectix, Now, Claris, Global
Village, Quark, Radius, WordPerfect, and so on.

''Now downloadin9 art .. . 11
This would probably be the time to mention the most universally loathed
"feature" of America Online - one that zaps beginners more than anyone else.
You're on America Online, you're exploring, you find something interesting you
want to see, you click the icon button, and - barn! -you get this:
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The &planation
America Online, Inc. continually improves its offerings, adding services you
couldn't get last week. And now you, foolish thing, have just attempted to enter
one of these new services: Kumquats Today, Dentists Online, whatever. As you
can see from the illustration above, the new service's screen is essentially blank
when you first get there; your Mac doesn't know about any of the new fancy
graphics that lie in store.
~ t'LA/-t

~

;:
~

So the AOL computers think they're doing you a favor: they send you the
~ missing pieces of art. This art might consist of little icon buttons, or a fancy
logo, or some big background image that fills the whole screen. You have no
choice but to sit there for two or three minutes until all those pieces of artwork
have been transmitted to your Mac.

The Good News
Fortunately, once your Mac has received all this artwork, it's got it forever; the
next time you visit that particular service, you won't have to wait at all. Only the
first time you visit something do you have to wait for the downloaded pictures.

Your Rer1en9e
If you are at all technically inclined, and are getting fed up with all that waiting,

you can fight back. Get the little program called ArtValve. Its sole purpose in life
is to let you prevent that art from getting sent to you; when it's in action, it
substitutes a boring generic AOL logo in each spot where a fancy button would
normally appear. Whenever you decide you want the art for some service, you
can switch ArtValve off.
For instructions on getting ArtValve - or any shareware program - from AOL,
see "How to find - and get - free software," later in this chapter.

The e-mail connection
Naturally, one of the best things about America Online is the e-mail - mainly
the sheer, adrenaline-gushing joy of getting some.
To send a message to somebody, choose Compose Mail from the Mail menu (or
press 88-M). Type their screen name, a subject, and your message in the
appropriate blanks. When you're done typing, just press Enter (or click the
Send Now button).
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If you want to send a file from your
hard drive, click here. You'll be able to
choose the file you want to send.

To send this message to more than
one person, put the additional
names here, separated by commas.

Press Tab to jump from blank to blank.
Untitled 1

Subj:
Attach Fil£>

.A-.
~

~M_a_il-+----------------D Return Receipt

File:
Is this right? Did I do it right? Did I? Did I?

Send l ater

~

S nd Now

'

Help

Click here to send your
mail (or press Enter).

You can use different fonts and sizes! Simply highlight
something you've typed, then use the Edit menu.

If you need to look up somebody's screen name, choose Search Member

Directory from the Members menu.
And to read your new mail, just choose Read New Mail from the Mail menu.
(Incidentally, once you've read something, it hangs around in your Check Mail
You've Read command - in the Mail menu - for about two more weeks, then
disappears forever.)

Toein9 the partlJ. line
By far the most mind-blowing aspect of America Online is, of course, the chat
rooms. In a chat room you'll find up to 23 people, chatting away (by typing).
The nutty thing is that everybody's talking at once, so the conversation threads
overlap, and hilarious results sometimes ensue:
Weinstein:

What does "Performa" MEAN, anyway?

Kiwi:

Well, since we're discussing computer terms, maybe
someone can tell me what's this Scuzzy thing in my Mac? My
friend Pauline told me it's a type of screen saver.
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The King:

I totally disagree, Uhura. Spock never said he had a sister.

SammyG:

It's the plural of Performus. From the ancient Latin - "Perf"
meaning "to sell a machine" and "Ormus," meaning "without
knowledge."

Weinstein:

Actually, it's SCSI, Kiwi. And no, it's not a screen saver.

Uhura:

How about the one where Bones falls in love with that
woman, but it turns out, in fact, that she's really a salt
creature ... ?

The King:

Was it salt? I thought it had something to do with antimatter
pods.

ClassAct:

Actually, there was an interesting editorial in the New York
Times about this. Anybody catch it?

Weinstein:

Don't get the Times. Are you a New Yorker, ClassAct?

ClassAct:

Born in Flushing. Bred in Massapequa. About economics,
Kiwi.

Uhura:

Antimatter can't exist in pod form. It was a salt creature.

Weinstein:

Unbelievable! My first wife's entire family lives in
Massapequa!

Nonetheless, the chat rooms are an unusual social opportunity: for the first
time, you can be the total belle of the ball (or stud of the studio), the wittiest,
charmingest, best-liked person -without so much as combing your hair.
To get there, choose Lobby from the Go To menu (or click People Connection
on the main "table-of-contents" screen). If you click the Rooms button, you'll
discover that dozens of parties are transpiring simultaneously, each founded
upon a different topic. Double-click a room's name to go there.
_Iii

Public Rooms
Members

23
23
23
23
23
23
23
23
23
23
Go

Double-click Room Name

~

Hew Member Lounge
Hews Room
Over Forty
Red Dragon Inn
Romance Connection

Sports
Starf lee t Academy
Starf leet Boot Camp
Tarot
Teen Chat

J I Who's Here?

J

I

More

' I Member Rooms )
I Priuate Room )
I
Help
~: I Feedback J

f'
!<..'

J

~

J

237

238

Part Ill: Toward a New, Nerdier You _ _ _ _ _ _ _ _ _ _ _ _ _ __

Things to know before entering the Party Zone
If it's your first time in a chat room, you may
be nonplused by the gross excesses of punctuation that seem to go on there. Every five
minutes, it seems that somebody types {{{{{{{{
Jennifer!!!}}}}}}}} or ****BabyBonesl****

You may also see a colon festival now and then.
Somebody might say ":::::quaking in fear::::::."
Don't ask where that designation came from, but
it indicates some kind of action - the writer
claims to be doing whatever is written there.

Actually, there's nothing wrong with these Finally, you sometimes see a crudely typed
peoples' keyboards. The braces are the arrow pointing to the left, like this:
cyberspace equivalent of hugging the enclosed
FrogMan: < ----------- has no life
person; the asterisks are kisses. That's how
you greet friends who enter the room - online, · This, naturally, indicatesthatthis person is pointanyway.
ing to himself.

Talkin9 behind their backs
What makes the live chats even more fun is that you can whisper directly into
the ear of anybody there - and nobody else can hear you.
This kind of behind-the-scenes direct communication is called an Instant
Message. To send one, choose Send Instant Message from the Members menu
(or press 3€-1). You get a box like this:
Jij-

lnst11nt Mess11 e

Nllme:

Iii

I LobsterGuy

Can you believe this bozo? He's hitting on all the women here!
Let's both gang up on him and make fun of his spelling.

Send

I

Ru11il11ble?

II

As soon as you type your whispered message and click Send (or press Enter),
the window disappears from your screen - and reappears on the recipient's
screen! That person can then whisper back to you.

Meanwhile, somebody else in the room may have been Instant-Messaging you:
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~= lnst11nt Messl!!l_e from Fr~gi

==@Iii§

Frogi: Hey, do you know if LobsterGuy is e men ore
wo men? I wes thinking of eski ng her out, but 1'm not sure
of t he gender .

iil:

Respond

As you try to maintain your presence in the main window and keep your end of
all these whispered conversations in their little windows, the hilarity builds.
Nothing - nothing - makes a better typist out of you than the AOL chat rooms.

free so~ware

How to find- and 9et -

Of course, for many people, the best part of America Online is the free software.
Heck, for many people, that's the only part of America Online.
Here's how it works:
I. From the Go To menu, choose Search Software Libraries.
A window appears like the following one.
2. Type the name of the file (or kind of file) you're looking for.
3. Press Return (or click List Matching Files).
In a moment, you're shown a complete listing of all files in America Online's
data banks that match your search criteria. Keep in mind that roughly 90,000 files
hang out on those computers in Virginia, so choose your search words with care.
You can, of course, restrict your search by using the little checkboxes. Here, for
example, is how you'd find a picture of Santa to use as clip art in a Christmas
card you're designing:
M11clntosh Softw11re

Li st files made available during: (C li ck one)
® All d11tes
0 P11st month

0

P11st week

Li st files only in these categories: (Click on one or more)
0
0
O
0

Beginners
DTP
G11mes
Hyperc11rd

0

Rll C11tegories

o

Business

0
0
0
0

€'tlef&p-e.

r11phics
llS'

·

ound

Communications
Education
H11rdware
Utilities

Li st files with these w ords reflecting my interest: (O ptional )

I San ta Claus

~_s_u_b_m_it_11_F_il_e_~J E List

M11tching Files )

[

Get Help & Info

±'ii
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When you click List Matching Files, you get a list of all 200 Santa Claus pictures.
If you think one sounds good, double-click its name to read a description. If it
still sounds good, click Download Now. Your modem will begin the task of
downloading (transferring) the picture file to your hard drive.
Other fun things to download: sounds (you double-click its icon to play it);
games (there are some great ones!); and utilities (for making your Mac easier
and more efficient). Remember that list of Santa Clauses? Look at the numbers
in the DLs column. That column shows the Popularity Quotient for each of
these files - the higher the number, the more people have downloaded the file.
In this example, the Christmas Time Clip Art file is definitely the hit of the
seasonal art world.

--

Category
Graphics
GIF
Startup Ho I i day
MacPaint
MacPa int
MacPa int
Mac Pa int
MacPaint
MacPaint
MacPaint
MacPaint
MacPaint

=

File li~f

1 J.

Title
Sant a CIaus 68.W PI CT
1
He Wants WHAT?? GIF
Classic Sa nta StartupScree n (r
Santa CI i p Art PN TG
Christ mas CI i p art PN TG
Christ mas Ti me CI i p Art PIC
Santa Claus x 8-Christmas
Boy Playing Santa (PN TGJ
Santa Claus PNTG
Christmas Art.sit (PN TG)
Santa Claus Postage Stamp \
_l
· Rad Sant a PNTG
Items 1-19 of 19 matching entries.

"'U""G""et""F""il""e""o""es""c""ri""pt""io""n""'U

I

Us1

!'-l(!rH

filf>s

I

DLs
Up loader
,,
207 \1BRose
54
osephB41
279
FL MacArt
592
I i ch Wa Id
647
UMPYJOHN
1478 I EROC IDUS
431
f FL MacArt
59
ac Bear
77
ser5059
428
aura Ross
286
Rich Wa ld
125
Lo st Art
'

J

V

[~"""G--,
et~H~e-lp_
&_l_
nf_o_lli

Can't open IJ.OUr downloaded 9oodies?
The first word out of the mouths of beginning downloaders upon examining
their freshly downloaded loot is generally this:
"Wha-?"
First of all, that's because people can't find whatever-it-was that they downloaded. (Hint: Open your hard drive. Open your America Online folder. Your
goodies are inside a folder called Online Downloads.)
Second of all, the first thing many people read when they double-click a file
they've just downloaded is this: "The application is busy or missing."
And that's because of compression. As you sit there waiting for your Santa
Claus graphic to arrive on your Mac, you're paying America Online by the
hour. Therefore, almost everything on America Online (or any online service
or BBS, for that matter) arrives in a compact, encoded format that takes less
time to transfer.
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Full size: 480K

l

II

Armadillo'w'orks:

Com'I"''' 275K

~

Armadillo'w'orks: .sit

Which is terrific, except for one thing: how are you supposed to expand your
downloaded file back into usable form?

Expand-o-matic
Any file whose format is indicated by the suffix .sit has been "stuffed" using a
program called Stufflt. As an added convenience, the America Online software
unstuffs these files automatically when you log off the service. (As an added
inconvenience, you wind up with a disk full of files in both forms, .sit and not,
because AOL doesn't automatically delete the .sit file after expanding it.)
If a file's name ends in .sea, it's a self-expanding archive. You don't need any little
program to unlock these babies - all you have to do is double-click the .sea
file, and it unfolds automatically into its usable, fatter form.

But even after unstuffing your downloaded prize, you may not be immediately
aware of how to open it. For example, suppose you've just downloaded what's
described as a "numbingly gorgeous full-color 24-bit photo of the Letterman
show's Paul Shaffer having soup." There it sits on your hard drive, and you've
even unstuffed it from its original .sit condition. Yet when you double-click the
icon, you get the dreaded message:

The document "Shaffer Soup.PI CT" could
not be opened, because the application
program that created it could not be
found.

(~)

Wha-?

In this case, you've got yourself the Classic PICT File Dilemma: you've downloaded a graphic, but don't have a graphics program with which to open it. The
solution is simple: you first have to launch a graphics program, like Claris Works,
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Photoshop, America Online itself, or even Word. Once that program is running,
then you can use the Open command. Navigate until you spot the file you're
trying to open:

Select a Document:
~I
CJ-Ca-b-in-et-..,,.~I

[l

messages

D Paint files
D Programs
D Projects
---.i

Cl Shaffer Soup.PI CT
D system Folder

<SI TeachleHt

At last, the prize is yours. If it's a file whose name ends with .gif or .JPEG, you
can open it using the Open command in America Online's File menu. Or you can
use a super-graphics-opening shareware program, such as GraphicsConverter;
see "How to find - and get - free software," earlier in this chapter.

Whafs the Internet anyway?
As legend would have it, the Internet began as a
gigantic communications network for the U.S.
military. The idea was to spread out the communications network all over the country, so that if
an enemy bomb destroyed one city, the army's
electronic messages could still reach their
destination.

Germany, bouncing down to South Africa, returning to Toronto, and finally reaching the
house next door. In fact, when you get an e-mail
message from the Internet, it's sometimes fun to
read all the lines of computer code atthe top that
tell you where this message went in its attempt
to reach your computer.

The messages were able to do that because of a
special language, called TCP/IP, which helps
each message find its own way among the millions of computers on the Internet. If one path is
blocked, the message is smart enough to go
around it.

There's no central location for the Internet; ifs
everywhere and nowhere. Nobody can control
it; nobody knows everything that's on it. Nobody
even knows how many computers are connected to it. It's impossible to measure, and impossible to control - which is why American
teenagers love it, and some governments try to
ban it!

As a result, I might send an e-mail message to
my next-door neighbor- but it might reach him
only after traveling from my Macintosh to

_ _ _ _ _ _ Chapter 10: Faking Your Way onto America Online and the Internet

The Internet (l}.ikes)
First, a word of warning about this mother of all computer networks - it's
confusing as all get-out. It represents the absolute opposite of Macintosh-style
friendliness. You can't make a move without hearing- and being forced to use
yourself-terms like TCP/JP, FTP, and ftp.ucs.ubc.ca. While this was supposed
to be a user-friendly book, all bets are off when discussing this arcane, anarchic
rat's nest of tangled computers and cables.

Two UlalJ.S to hit the Confusion Superhi9hu!a1J.
There are two ways to sign onto the Internet.

f/ia AOL
The first way is easy, but limited: it's to connect through an online service like
America Online. Here's what the Internet looks like when you're on America
Online: easy icons.

CJ About Internet Connection

D De i I y High I i ght
D Coming Alt reel i ans
t:::J We I come to the Web!
t:::J HEW : Int er net St ore

~

Search Hewsgroups--OejaHews

_.

But remember that on America Online, after your five free hours, you're paying
by the hour. If you get really addicted to using the Internet, then, your monthly
bill can be very high. I have friends who pay $400 each month in America Online
bills and haven't seen their children since 1988.

2~3
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Via an ISP
The second way to connect to the Internet is through an ISP - another juicy
acronym for your social-climbing pleasure. This one stands for "Internet service
provider," a company that will rent you a connection to the Internet. There are
hundreds of ISP's in the U.S. (the big ones are called things like Netcom, PSI, and
AT&T), and dozens more appear every day. Some are good and can help you set
up your connection. Some aren't so good - if you call for help, they'll say,
"Macintosh? What's that?"
But when you subscribe to the Internet through an ISP, you pay a flat amount
like $15 each month - for unlimited time. All Internet addicts do it that way.
Trouble is, connecting to the Internet this way is complicated and technical.
You're expected configure, or even provide, your own Internet software. And
when things go wrong- as they do a lot on this outdated, overstressed
network from the 60s - troubleshooting can be like hunting for a contact lens
in the dark.
If you opt to get connected using the ISP-connection method, I humbly release

you to the care of much fatter books than this one.

What there is to do on the lntemet
The most useful of the features with which the Internet can suck away your
time are called e-mail, Newsgroups, Mailing lists, FTP, arid the World Wide Web.
For the purposes of this discussion, we'll assume you're connecting using
America Online.
E~mail

Remember reading about e-mail on AOL earlier in this chapter? Internet mail messages you send beyond the sheltered shores of America Online itself works exactly the same way. The only difference is that, when sending a
message to someone on the Internet, the address will be longer and more
complicated. Whereas AOL addresses look like Harvey 23, an Internet address
might look like cc293fil@univ_amx.intermp.com. You have to type all of that,
complete with@ symbols and periods, into the ''To:" box of your e-mail.
And by the way, you have an Internet address, too. To figure out what it is - for
the purposes of your business card for your cocktail-party bragging - just add
@aol.com to the end of your regular Ame:r:ica Online screen name. So, if you're
known to the AOL community as HotMama, your Internet address is
HotMama@aol.com. If your potential correspondents have AOL accounts, they
can use either form. But if they're out there on the Internet, they should use the
longer format to send e-mail to you.
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News9roups
The next important Internet feature is called newsgroups. These are electronic
public bulletin boards. I post a message; everybody else on the Internet can
read it and post a response for all to see. Then somebody else responds to that
message, and so on.
There are about 20,000 different newsgroups, ongoing discussions on every
topic- chemists who like bowling, left-handed oboists, Mickey Mouse fans
who live in Bali - anything.
To access the newsgroups on America Online, starting from the welcome
screen, click Main Menu; Internet Connection; and then Newsgroups. If you then
click Read My Newsgroups, you'll be shown a starter list of topics; just keep
double-clicking topics that interest you until you're reading the actual messages. (To add newsgroup topics to your starter list, use the Search All
Newsgroups button.)
Once you've read a message, you can either respond to it (click the Send New
Message button) or just keep reading (click the Next Message button).
The little > symbols mean that this portion of the messag e is being quoted from
a previous message, so everyone will know what this guy is responding to.

-

Iii~

Madonna is 11 new art form

.

Send New Message

~essage I of I Subj eel 26 of 6 77
~ubjec t:

Madonna is a new art form
rom: bjlak@igs.net
P.ate: 30Jan199617:32:00 GMT
!-Aessage-JD : < bjlak-3001961238080001@bjlak .igs .net>

~

n

r-:

>I truly believe that Madonna is a new art form unto herself,
>that she has reinvented the musical form as we know it,
>that neither musk nor film will ever be the same

~')

I~
~~

Well, that's just the kind of irritating balderdash we might expect from o
brainless moron like you. Why is it that nobody under the age of 35 hos
the least idea of what good art is anymore? I think you Madonna fans
should go stick your heads into the microwave and hit Defrost.

~

Brian
"Nile are the knights who say NI!"

I <-Prior Message I
Mark Unread }

~

[ Mon~

I

[ NeHt Message - >

I

JReply to GroupJ J EM11il to Ruthor} ill JiJ

It's typical for Internet weenies to sign their names with some kind of whimsic al
quotati on. Don't ask me why; personally, it drives me crazy.
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You might notice, in the illustration above, that the writer is somewhat nastier
online than, perhaps, he might have been in your living room. That's an interesting Internet lesson - people tend to be ruder then they would in person. There
are two reasons: first, you're anonymous - nobody can see you, so it doesn't
seem to matter as much if you're a jerk. Second, millions of messages appear
here every day; some people think they need to be extra-dramatic just to be
noticed.

MailiniJ lists
A mailing list is like an e-mail-based discussion group. You're automatically
e-mailed a copy of everything other people have to say about a particular topic.
Sign up for these selectively, though; some of them fill your e-mail box with
dozens or hundreds of messages a day.
Generally, you subscribe to one of these free e-mailings by sending an e-mail to
its sign-up computer. To make it work, the receiving computer inspects what
you've put in the body of your e-mail to see if you typed out the correct code.
(What you put in the Subject line of the e-mail makes no difference.)
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For example, suppose I want to subscribe to the Humor mailing list, in which
jokes - some raunchy, some really funny- are automatically mailed to you
each day. I'm supposed to send an e-mail message to listserv@uga.cc.uga.edu
with subscribe humor David Pogue (or whatever my name is) in the body of
the message. So I'd choose Compose Mail from AOL's Mail menu, and fill out the
form like this:

~

-

To:

Untitled I
listserv@uga.cc .uga.edu

~

Address Book

Attach File

.
~

subj:

Idoesn't malier

File:
subscribe humor David Pogue

'o

1111
cc:

I

~I

D Return Receipt

~

Send Later

~

~

®

Ji

Send Now

Shortly after I send this e-mail, I'll get an e-mail back from the master Humor
computer, wherever on the planet it might be. This message will confirm my
subscription. It will also contain instructions for unsubscribing from the list,
which I'll be sure to print and save - it may be useful when I discover exactly
how hard it is to keep up with 100 e-mailed jokes per day! Talk about laughing
yourself to death.
Another mailing list that might be worth subscribing to is Information Alley,
Apple's free electronic newsletter. Twice a month, you get this excellent
letter, filled with tricks and news. Send an e-mail message to
listproc@spock.austin.apple.com with subscribe infoalley your name in the
body of the message. (What's on the subject line doesn't matter.)
Another interesting one: TV Tonight, an electronic TV guide. Send e-mail to
majordomo@netcom.com with subscribe tv2nite-l in the body of the message.

FTP (software to download)
FTP is short for file transfer protocol. (Doesn't it make you feel more technically
competent just pronouncing that?) FTP just means software to download:
games, shareware programs (written by amateur programmers; you pay by the
honor system), and so on.

2~7

248

Part 111: Toward a New, Nerdier You _ _ _ _ _ _ _ _ _ _ _ _ _ __
If you're accessing the Internet through AOL, all this may seem a little silly,

since it's way easier to just get whatever-you're-looking-for directly from AOL's
incredibly complete software collection (see "How to find - and get - free
software," earlier in this chapter).
If you want to do it the Internet way, though, here's what you do. Click, in

sequence, the following (starting from the AOL welcome screen): Main Menu;
Internet Connection; FTP; Go To FTP. At this point, you'll be staring at the
names of several obscurely named computers around the country; double-click
the one you want to access. (The first and fourth names in the figure below are
the most popular repositories of Macintosh software.)
Rnon mous FTP

File Transfer Protocol (FTP)
Select a FTP site from the Favorite Sites
menu or click Other Site to connect to a
site of your choice.
favorite Sites

sumex-a i RI': st an ford. edu: /Info-mac·
ftp.uwp.edu:/pub/music
rtfm.mit . edu:/pub
mac.archive.umich.edu
ftp.nevada.edu:/pub/guitar
members. ao I , com
ftp.aol .com
Connect

I

Other Site

J

~

:+

[D

To see what they've got, just keep double-clicking deeper into the folders you'll
see displayed, exactly as though you're looking through the folders on your
own hard drive. Once you locate a program you want to download, just doubleclick, and it begins transferring to your Mac.

The World Wide Web
The most popular part of the Internet is the World Wide Web. Lord knows, you
can't help hearing about this thing. Fourth graders who run around urging
schoolmates to "check out their Web pages." Web "addresses" are showing up
everywhere - on business cards, in newspaper ads, even in TV commercials.
(Have you noticed http:// www.sonycom or http://www.ford.com flashing by at
the end of recent movie ads and car commercials? Those are Web addresses.)
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The Web has become incredibly popular for one simple reason: It isn't like the
rest of the Internet. It looks friendly and familiar to actual humans. When you
connect to the Web, you don't encounter streams of computer code. Instead,
information is displayed attractively, with nice typesetting, color pictures, and
interactive buttons, like the following Apple Computer Home Page.
Navigating the Web requires little more than clicking on buttons and those
underlined blue phrases, which you can sort of see in the Apple Home Page.
You're automatically transported from one "page" (screen) to another, without
having to type in a single Internet address. One page may be a glorified advertisement; another may contain critical information about a bill in Congress;
another might have been created by a nine-year-old in Dallas, documenting
what she had for lunch.
The actual physical locations of the pages you're reading may be all over the
world - just by clicking those little buttons, you can jump seamlessly from a
page on a computer in Show Low, Arizona to another in Florence, Italy. You can
weave your way across the globe, jumping from link to link, to track down the
information you want - that's why it's called the World Wide Web.
All of this amazing on-line multimedia stuff, unfortunately, stresses your modem
nearly to the breaking point. Even with a 28.8 Kbps modem, the fastest standard
modem there is, you still wait about ten seconds, or more, for each Web page to
float onto your screen. (If you connect through America Online, the wait is even
longer.) Don't even try connecting to the Web with a 9600 bps (or slower) modem.

Connectin9 flia America Online
Connecting to the Web through America Online is the easiest way to get going,
although it isn't that easy. For example, you can't do it at all unless your Mac
has at least 8 megs of memory (check your Cheat Sheet at the front of this
book- or check the About This Macintosh command in your S menu). Also,
as of mid-1996, you still need a separate program, which works together with
the America Online program, to access the Web. The sidebar "Getting to
Webness" provides full instructions.

Where to 901 what to do on the Web
Except that it's rather slow, you'll have an absolute blast exploring the Web.
Critical to your enjoyment, however, is the quality of Web addresses you
manage to acquire. A Web address (known by the geeks as a URL), is the string
of computer codes you type into the top line of your Web window, as shown in
the examples below.
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And where do you find good Web addresses? From friends, from articles, on
television, and so on. Look for "http" at the beginning of the address - a
guaranteed sign that the address points to a Web page. (Most Web addresses
also include www.)
Of course, once you are exploring, you'll probably never need to type one of
those addresses manually. You'll simply move around by clicking the buttons
on the Web pages before you.

WatJ.s to search for a particular topic
As a starting point, may I suggest the following Web addresses? Each of these
Web pages offers a vast searchable index of other Web pages. If you're on the
Web, and don't know where to look for, say, information about waterproof
cameras, you can use any of the following Find commands:

Web pa<Jes that search at/ the other Web pa<Jes
v http : // www. yahoo. co m

I

vhttp: // altavi s ta.digit a l . com

v http: I / www. exc ite. com

_ _ _ _ _ _ Chapter 10: Faking Your Way onto America Online and the Internet

Getting to Webness
Here's how to get to the World Wide Web from
America Online:
·
1. From the Go To menu, choose Keyword. Type
Upgrade, and press Return. You'll be told you
are entering a "free area," meaning you
won't have to pay for this. Click Enter.
2. At the next screen, click the Download Now
button; then click Continue.
3. You need two items to make all this work.
First, you need America Online version 2.6 or
later: Unless you got your America Online
subscription before mid-1995, you probably
already have this version. (You can find out
by choosing About America Online from your
• menu while you're online.)
You also need the AOL Web Browser-the
program that actually lets you surf the Web.
Both ofthese components are available from
the screen now staring you in the face.

4. Click the Web browser (if you already have
AOL 2.6), or AOL 2.6 with the browser (if you
have an earlier version). Then click Download Now.
5. A window appears, asking where you want
to put the downloaded file. My suggestion:
click the Desktop button, and then click
Save.
When the downloading is over, choose Quit
from the File menu. Quit and sign off of AOL.
6. Double-click whatever you just downloaded:
either "Install AOL v2.6 with Browser" or
"Install AOL Browserv1 .0."
7. When the installation is over, sign onto
AOL using the AOL 2.6 program. Once
online, switch to the Web by choosing
Browser from your Windows menu waiting a moment - then choosing Web
from your Services menu. You should, at last,
be viewing a real World Wide Web page.
And this is the easiest way to connect!

"
I

http ://www. l ycos.com

""'http: //we bcraw l er . co m
""'http : I / www . guid e. i nfo s eek. com

Fun or useful Web places
""'http: //gag m e . w w a . co m /~ b o ba / pi c k.

Identifies, and lets you visit, the best Web page of the day.

""' htt p ://turnpike.net/met ro/ mirsky/Worst.ht ml
The worst Web page of the day.

""'Ht tp : //www.app l e.co m
Apple's beautifully-designed page.
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http: I /www. ups. com
UPS. Track your packages, and so on.

Y6

http: I /www. fed ex. com
FedEx. Track your packages, and so on.

Y6

http://www2.netscape.com/fishcam/fishcam.html
The famous Fishcam. Updated every few minutes: a close-up view of
somebody's fish tank. Live. Weird. Useless.

Y6http://mistral.enst.fr
The gateway to the Web Museum, an incredible complex of art museums.
Features the Louvre, where you can actually view and read about hundreds of paintings hanging there.
Y6

http://www.star.niu.edu/jeff/tv/tv.cgi
Shows you what's on TV right now.

Y6

http: I/pathfinder. com
The electronic editions of popular magazines like People, Time, Money,
Fortune, and more. Lots of graphics - nice, if you're willing to wait for the
pictures to arrive.

Top 10 Best and Worst Aspects
of the Internet
No question: the Internet is changing everything. If you're not on it now, you
probably will be within a few years. Here's what's to look forward to:
1. Best: everyone is anonymous, so everyone is equal. It doesn't matter what
you look, sound, or smell like -you're judged purely by what you say.

2. Worst: everyone is anonymous, so everyone is equal. You can pretend to
be someone you're not - or a gender you're not - for the purposes of
misleading other Internet surfers.
3. Best: the cost. $15 or $20 a month for unlimited access (via an Internet
company), or about $2.50 per hour via an America Online-type service.
4. Worst: the cost. $15 a month is a lot, especially when you consider the
required equipment. And America Online gets expensive if you spend a lot
of time online.
5. Best: the Internet connects you to everyone. You're only an e-mail or a
Web-page away from anyone else on the planet.
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6. Worst: the Internet disconnects you from everyone. You become a hermit
holed up in your room, as family, friends, and relationships pack up and leave.
7. Best: the Internet is drawing people away from TY. Statistics show that as
more people discover the Web, they spend less time in front of the boob tube.
8. Worst: the Internet is drawing people away from TV. The TV industry is
going crazy wondering what to do.
9. Best: the Internet is complete freedom of speech for everyone. No government agency looks over your shoulder; the Net is completely unsupervised
and uncontrolled.
10. Worse: the Internet is complete freedom of speech for everyone. Including
pornographers, neo-Nazi groups, and others you may not want your
10-year-old getting chummy with.
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Chapter 11

Putting the Mouse to the Metal
Jn This Chapter
Iii>- Uncovering the forbidden secrets of the Option key
~

Duplicating, finding, and splitting the personality of icons
Iii>- Vandalizing your own Mac, without spray paint or a sledge hammer
~ Utilities with no monthly bill

~is chapter is about honing the basic skills you already have. It's about

I

~ecoming more efficient in the way you work - shortcuts, hidden secrets,
and slick tricks to astonish your friends. And it's about turning the basic Mac
that millions of people have into one that's unmistakably yours.
Maybe it'd be better if I avoided the term that's about to apply to you ... power
user. Maybe those words will strike fear once again into your soul. But even if
you started out as a Mac virgin, either leery or outright petrified about the alien
technology before you, by now you've almost completely mastered the Mac.
The only tidbits left to explore are the ones normally classified as - yes -

power-user secrets!

The EfficienclJ. Nut's Guide to the Option Kev.
Yeah, yeah, everybody knows that you can close a window by clicking its close
box. But you didn't fork over good money for this book to learn something
that's on page 1 of the Mac manual.
No, these tips are much choicer. They show you how to unlock the power of
that most overlooked of keys, the Option key. It's been placed closer to you
than any letter key on the keyboard - and that's no accident.
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Closin9 all windows at once
Suppose you've opened a gaggle of folders and their windows are lying open all
over the screen. And suppose that the niggling neatness ethic instilled in you by
your mother compels you to clean up a bit.
You could, of course, click the close box of each window, one at a time. But it's
far faster to click only one window's close box while pressing the Option key.
Barn, barn, barn - they all close automatically, one after another.

Windows and folders: use IJ.OUr tunnel tlision
When you're trying to find a document icon that's inside a folder inside a folder
inside a folder, it's hard to avoid having COWS (Cluttered, Overlapping Windows
Syndrome). By the time you finally arrive at the darned icon, your screen is
filled with windows.
If you press Option while double-clicking each nested folder, though, the Mac
will neatly close the previous window before opening the next one. Criminythis computer even cleans up after you!

In the figure below, you could press Option while double-clicking the Oregon
folder (left); the USA folder that contains it would automatically close as the
new window opened (right):

USll
4 items

29.7 MB in disk

LJ LJ D
Ohio

<131

Connecticut

J_ •..•..••.••••.

New York

• ··--~L

•

8.3 MB avanable

..•.

Portland

J2]!1

OK. So here we are in the Oregon folder. What if we want to backtrack and go
back to the USA folder (or the World folder)? A little-known trick lets you jump
to the folder that contains it: press the 88 key and click the window's title!
In the preceding figure, you 88-click the word Oregon at the top of the window.
Now you slide down the pop-up menu that lists the nested folders from innermost to outermost. Let go when you reach the folder you want (following left);
the Mac opens the folder you selected (following right):
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~·

LJ

liiJ

World

5 items

29 .B MB in disk

B.2 MB av ail ab le

~

LJ LJ LJ LJ ~
~

Portland

Afr lea

Europe

USA

Antarctica

~II

And, logically enough, if you press 38 and Option as you choose the new folder
name, you'll simultaneously close the original nested window.

Multitaskin9 methods
As you discovered early on, the Mac lets you run more than one program

simultaneously. (Remember when you tried some tricks with both the Note Pad
and the Calculator open on the screen at once?) You can switch from one
program to another by choosing the program's name from the Application
menu at the top right of your screen, marked by the f1i1 icon (or the icon of
whichever program is currently in front) .
We haven't yet examined the other commands in this menu, such as Hide
Others and Show All. These are anti-COWS commands that help keep your
screen neat and clean. For example, suppose you're trying to use the Calculator,
but so many other programs are running that your eyes cross:

s

File

Edit

Finale 2.5 manual
IPalatino

Appendix 1: CotTOctions in the Finale 2.0 manuals
Appendix 2: For Macininsh llfx owners

4 .2

Read Me Fi

••ry

If you' re new in Finale, i I's
important Iha t yo
following the instructions in this booklet . The·
Startup Guide, also in your Finale package, no
You will still find
·
·
to setting up your
Tsunami
about registering
~
Cl 3- 15 ? (Show invisibles(
As you disc 0
CJ Ad response
.

~ 0

l> CJ
Note Pad and I 1\- 0

s1multaneousl

from One prog

menu a I the lo

t>

Backup
Cleveland

872K

trip

7BK

Desktop Critic

2 ,300K

CJ Downloads
1\- l!lill DWP stuff

266K
2,980K

) You can switch
the Application
on
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By choosing Hide Others from the Application menu, all windows that belong to
other programs disappear, leaving the frontmost window all by itself:

s

File

Edit

The other programs are still running, and they do still exist. But their windows
are now hidden. You can verify this by checking the Application menu, where
you'll see that their icons appear dimmed.
Hide Calculator
Hide Others
Show Rll

_,, 1!11 Calculator
IQ finder
Note Pad

bJ

~ Scrapbook

•

word 5

So how does the Option key play into all this? When you switch from one
program to another, you can make the program you're leaving hide itself
automatically. Just press Option while choosing the new program's name (or
clicking in its window). That way you always keep nonessential programs hidden.

Makin9 an instant document coplJ.
Normally, when you drag an icon from one folder to another on the same disk, of
course, you simply move that icon. But if you press Option while dragging an
icon to a new folder (or to the Desktop - the gray background), the Mac places
a copy of the file in the new folder and leaves the original where it was, as
shown here:
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lilj

Mocintosh HD
6 items

475 .5 MB in disk

LJ LJ
~ LJ

i'ipple Extras Applications

SimpleText

37 .8 MB available

~

System Folder

USA Folder

<>l

,

~-~ ~ ~
.
.
~
~ .. -·-c)wsuit Summary

.......~

·---------------------0--------·
1¢11

J

Alphabetize them icons!
For the neat freak, there's nothing worse than a mass of messy icons cluttering
a window (next page, top), If you choose Clean Up Window from the Special
menu, the Mac will align each icon to an invisible grid so that at least they're
neatly arranged (upcoming figure, lower left), But (1) that won't alphabetize
them, and (2) that won't maximize space in the window by eliminating gaps.
If you press Option while choosing Clean Up Window, though, it changes to say

Clean Up by Name. And the effect is totally different- the Mac (1) alphabetizes
your icons, and (2) moves them so that they take up as little window space as
possible (upcoming figure, lower right).

FunnlJ little hidden Option kelJ stunts
Those wily Apple guys! The sneaky programmers! The funsters in Apple Land
have buried all kinds of amusing little_surprises in the control panels and other
places (of System 7). Try these:

v The weird little Map control panel lets you find any major city by latitude
and longitude, and tells you the time zone difference. If you Option-<loubleclick the Map control panel, the map will appear at double size.

v Speaking of the weird little Map: if you press Option and repeatedly click
the Find button, you'll get to view every city or location in the Map's secret
database! Around the world in 80 clicks.

v Open the Monitors control panel (choose Control Panels from the S menu
and double-click Monitors). You use this panel to switch from color to
black and white (if you have a color monitor). If you hold the mouse down
on the little "7.0" (or "7.5") in the upper-right corner, you'll see a list of the
programmers. Press Option while you do so, and watch the smiley face you'll find out what they really think of you.
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Folder before cleaning up
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Clean Up using the Option key

v

When you're in the Finder, the first item under the .S menu normally says
About This Macintosh. Choose it to view some critical specifications about
your machine - how much memory it has, for example. But if you press
Option while choosing it, the command changes to say About the Finder
and shows you a pleasant Silicon Valley scene. Wait long enough, and
you'll eventually see some scrolling credits.

v

Open the Memory control panel. See the part called Virtual Memory?
(Some older Macs don't have this section.) Click the On button. Then, while
pressing (what else?) the Option key, click the pop-up menu on the right
side and keep the button pressed. And move the pointer to the right so that
the submenus pop out. Wow - it's more fun than reading the phone book!

Buried Treasures
Did you enjoy those obscure, mostly useless Option key tricks? Then you'll
really love these equally scintillating techniques, not one of which requires the
Option key.
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Make an alias of a file
The File menu has a command called Make Alias. Although you might expect
this command to generate names like One-Eyed Jake or Bubba Wilcox, the term
alias in the Macintosh world represents something slightly different - a
duplicate of a file's icon (but not a duplicate of the file itself). You can identify
the alias icon because its name is in italics, as shown here. (The original file is
located on the left.)

Microsoft 'w'ord

Microsoft W«d a-1kls

What's neat about aliases is that, when you double-click an alias icon, the Mac
opens the original file. If you're a true '90s kinda person, you might think of the
alias as a beeper - when you call the alias, the actual file responds.
So who on earth would need a feature like this? Well, there's more to the story.
An alias, for one thing, only requires a tiny amount of disk space (a couple of K)so it's not the same as making an actual copy of the original file. (And you can
make as many aliases of a file as you want.) Therefore, making an alias of
something you use frequently is an excellent time-saver - it keeps the alias icon
readily accessible, even if the real file is buried four folders deep somewhere.
Another very common trick: Place an alias of a program, or a document, into
your ti menu, where you don't have to open any folders to get at it.
Here's the drill:
I. Click the real icon once.

2. Choose Make Alias from the File menu.
3. Open your System Folder. Drag the alias into the folder called Apple
Menu Items (within the System Folder).

s

stem Folder

23 items

Ea

Control Panels

Prefer ences Startup Items

4. Now look in your ti menu.

Ser apbook File

Iii
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Sure enough - there's your file! Choose it from the S menu to open the
original file.

Hbout This Mac into sh •••

~ Hlarm Clock
Calculator
~l:hooser
~Control Panels
Key Caps

Iii!

Iii

I,

~Note Pad
~Scrapbook

And yet, because you used an alias, the real file can be anywhere on your hard
disk or on a different disk. You can move the real file from folder to folder or
even rename it, and the alias still opens it properly.

Creatin<J. the L.L. Mac cata/09
Every now and then, you might find it useful to create a list of files or folders on
your disk. But it's hardly worth your time to go to the Finder, look at the first
file's name, switch to your word processor and type it, and then repeat with the
second file. Here's a much faster way:

1. Select the files whose names you want to copy. (You might want to use
the Select All command in the Edit menu, at which point you can press
the Shift key and click "off' the items you don't want.)
2. Choose Copy from the Edit menu (upcoming figure, left).
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Label

l[fi fi ·

Note Pad

AlEIS kEI
CBliforniEI
Connecticut
Flori dB
HB w aii
MichigBn
Mi ssouri
Nevada
New Vork
Ohio
Oregon
~

• 1$$6.Aii@Hij

t> • 1$iliflEIMI

~nsylvBniB
3

3. Launch your word processor (or even the Note Pad under the ti menu)
and choose Paste from the Edit menu. Presto: a neatly typed list of file
names (above, right)!

(P.S. -The list can't be a terrifically long one; the Mac copies only 256 characters
of text at a time, but you can always repeat the process.)

Hafle it IJOUr ulalJ -

at Icon Kin9

You don't have to accept those boring old icons for files, programs, and folders.
If you want anything done around the Mac, heaven knows, you've got to do it
yourself.
I. Go into ClarisWorks (the painting window) or Kid Pix or some other

program that lets you paint stuff. Make a funny little picture. And I
mean little - remember, you're drawing a replacement icon for some
hapless file. Llke this guy here, for example:

2. Copy your creation to the Clipboard.
3. Go to the Finder, and click the file whose icon you want to replace.
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5. See the folder icon in the upper left? Click that sucker - and then
paste away!
-

~

Macs for Dummies

d

Click!
Kind: folder

Macs for Dummies

Kind: folder

From now on, that little picture is the new icon for the file (or folder, or disk). To
restore the original icon, repeat the Get Info business, but this time, after you
click the icon, press the Clear key.

Takin9 a picture of the screen
In this book, you've probably noticed a number of pictures that illustrate
objects on the Mac screen. Now I'll show you how to take your own snapshots
of the screen.
It involves pressing three keys simultaneously: Command (38), Shift, and 3. You
hear a satisfying kachunk! camera-shutter sound. After a moment, a new file
appears in your hard disk window, called Picture 1. (If you take another shot,
it'll be called Picture 2, and so on.)
If you double-click this Picture file, it will open in SimpleText (which came with
your Mac). Once SimpleText opens, you'll see that you've successfully captured
your screen image.

Unfortunately, you don't have much control over this photo-session business:
the 38-Shift-3 keystroke captures the entire screen. Once you're viewing the
snapshot in SimpleText, though, you can select a smaller portion of it. Just drag
diagonally across the part you want.
Once you've got a shimmering rectangle, choose Copy from the Edit menu. That
selected area is now on your invisible Clipboard. Open up the Scrapbook or
your word processor or ClarisWorks or some other program. And then Paste
(Edit menu). Your newly pasted screen shot appears.

Just salJ. no
There's a wonderful keyboard shortcut that means no in Mac language. It could
mean No, I changed my mind about printing (or copying or launching a program);
stop right now. It could mean No, I didn't mean to bring up this dialog box; make it
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go away. Or: No, I don't want to broadcast my personal diary over worldwide
e-mail! Best of all, it can mean Stop asking for that disk! I've already taken it out
of your slot! Be gone!

And that magic keystroke is 3€-period.
When you begin to print your Transcripts of Congress, 1952-1992, and you
discover - after only two pages have printed - that you accidentally spelled it
"Transcripts of Congrotesque" on every page, 3€-period will prevent the
remaining 14 million pages from printing. Because the Mac has probably
already sent the next couple of pages to the printer, the response won't be
immediate but will be light-years quicker than waiting for Congress.
Or let's say you double-click an icon by mistake. If you press 3€-period right
away, you can halt the launching and return to the Finder. And if the Mac keeps
saying, "Please insert the disk: Purple Puppychow" (or whatever your floppy
disk was called), you can tell it to shut up by doing that 3€-period thing over
and over again until the Mac settles down with a whimper. Show it who's boss.

Colorizin9 and Other Acts of Vandalism
The great thing about the Mac is that it's not some stamped-out clone made in
Korea. It's one of a kind - or it will be after we get through with it. These tips
illustrate some of the ways you can make the Mac match your personality,
sensibility, or decor.

Color-codin9 IJ.OUr icons
Here's a pretty neat colorization feature that hardly anyone uses but is still
worth knowing about: color-coding. All you do is select an icon or a whole
passel of them (below, left), and choose a color from the Label menu.
Control Panels

-

25 i tems

Conflict Catcher™

ii

Flle Sharing Monitor

228 MB in disk

./None
•
-

Essential
Hot
I

11

•

•
cool
-Personal
•
Project 1
•Project 2
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Two questions then: (1) How do you change the colors and labels into something more useful, and (2) What's the point?
Well, most people never bother with labeling their icons. You could argue,
though, that it makes life more convenient since you can sort by label (you
could see all your In Progress files grouped together in a window). You can also
use the Find command to search for a file that has a certain label. You might
give one label to everything related to, say, a certain book project - "Saddam
Hussein: The Sensitive Side" - and then when it's time to back up your work,
use the Find command to round up all files with the Hussein label, so you can
copy them all at once. (Or, when the project is over, you could happily delete
them all at once.)
Anyway, if you do want to use this feature, you'll probably want to change the
labels Apple suggests (Essential, Hot, In Progress, and so oh) to something
more useful. To do that, choose Control Panels from the S menu. When the
Control Panels window appears, double-click Labels.
-Iii

Labels:

~

Labels

To change the wording of a label (remember, you're actually changing the
wording of the Label menu), just double-click a label and type in something new.
To change the color - if your monitor is thus equipped - click the color
swatch; a dialog box appears where you can select a new color by clicking.

Blue lantJ.UtttJ.e
Here's one more treat for color monitor owners: you can make highlighted text
turn some color other than drab black. In other words, when you select some
text in your word processor, it usually looks like this:
Tenderly,

1!1111 she daubed his fevered
forehead with a rag soaked in
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To change the highlightin_g so that it looks more like, well, a highlighter, choose
Control Panels from the • menu. When the Control Panels window appears,
double-dick Color. This control panel appears:
Color
Highlight color:

I • Block &

White ...,..,

1mzm1
Window color:

Standard

.....

,

By choosing a new color from the upper pop-up menu, you can make your
highlighted text any color you want, like this:
o vil e mi xtu re of

oc
Pond ' s

skin creom.

Let your innate fashion sense be your guide.

Views
Open the Views control panel. This baby is the control freak's best friend - it
can change almost every aspect of the way the Finder displays icons.
Uiews

F-lii
Fon\ fo r views :

.... I an~

I Geneua

r.... 1con

DDDD

@Straight grid

Do Do 0

D

Always s nap t o gr id

Staggered grid

:···· Lis t

<$1

~

®

0

~
0

0 Calculate folder s ;zes
l8J Show disk info in header

l8J Show size
l8J Show kind
D Show label
l8J Show date
D Show version
0 Show comments
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Using the font and size controls at the top of the window, you get to choose
what text style you want the Mac to use for all icons in the Finder. If your vision
is going - or you're trying to demonstrate the Mac to a crowd - make the font
huge. If you want to make your icons as high as possible per square inch, pick a
tiny, compact type style. One possibility is shown in this figure:
i§jD

11 items
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~
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The Icon Views controls let you specify how icons should arrange themselves
when you drag them around. If you select "Always snap to grid," icons will
smartly jump into position whenever you drag them and let go, according to
your Icon Views setting: "Straight grid" places them into neat rows, and "Staggered grid" offsets every other icon so that their names won't overlap when
they're placed side by side.
The List Views control governs how icons appear when you're viewing them in
a list format .
All those checkboxes on the right side ("Show size," "Show kind," and so on)
control which pieces of information show up when you're in a list view. "Calculate folder sizes" is neat because it lets you see how much disk space each
folder takes up. (If this checkbox isn't selected, then all you get is an unhelpful
"-" in the Size column of a list view. On the other hand, turning on this option
slows down your Mac considerably.)
Finally, "Show disk info in header" puts a separate information strip at the top of
each window, which shows you how full your disk is.

U RA recordin9 studio
With many Macs, you get an Apple microphone, or you can buy one for about
$20. It's not exactly the same one Madonna licks in her videos, but it's good
enough for what we're about to do. And that is to change the little beep/ding
sound the Mac makes (when you make a mistake) into some other sound, like
"Oops!" or a game-show buzzer or a burp or something.
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Here's how it works:

1. From the S menu, choose Control Panels.
2. Double-dick the Sound icon. (On some Macs, it's called Monitors &
Sound.)
You should see something like this:
Sound

i§IE!

~lert

'.21>. . . . ....... . . . . . . . . .,

Sounds

Droplet
Indigo
· Quack

Simple Beep
Sosumi
Wild Eep

Alert Uolume

[ Aemoue J

Add ...

If your Sound control panel window looks like that, click the Alert Sounds

pop-up menu, choose Sound In, and make sure "Built-in" (meaning the
microphone) is selected.
Then, from the same pop-up menu, choose Alert Sounds again.

3. Click the Add button.
(If your Mac has no microphone or CD-ROM player attached, the Add
button is dimmed). Now you see this;

[!]~@][I]
Record

Stop

Pause

Play

<1
:OD

0

seconds

:10

(Cancel J

([

<,iwt~

~

4. To record, just click Record and speak into the microphone.
Be ready to click Stop when you're done, or else you'll accidentally include
a bunch of silence and fumbling at the end of your sound.
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You can play back your new sound in a plethora of ways. You could, mnemonically enough, click the Play button. Then again, you could click Save and give
the sound a title, so that you'll be able to preserve it for your grandchildren.
When you return to the list of sounds in the Sound control panel, click your new
sound's name to play it. If you leave it selected in the list, though, you've just
selected it to be your new error beep.

How to adjust IJ.OUr Mac~ speaker tlolume
While we're on the subject of sound, now would be as good a time as any to
show you how to adjust your Mac's sound volume.
Adjusting the volume level for your error beeps is obvious: when the Sound
control panel opens, you're generally staring right at the proper volume slider
(where it says Alert Sounds).
For all other sounds, however - such as your games, CD-RO Ms, and so on there's a separate, hidden volume slider. To get at it, choose Volumes from the
pop-up menu (below, left). You'll be shown a new window, where the overall
Mac speaker's volume slider appears (below, right). Adjust away!
Sound
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A sound-playing fact for the detail-obsessed
Here's a way to play a sound that doesn't even
involve opening a control panel. If you're a
double-clicking kinda person, open your System
Folder and then double-click the System file. It

opens into a window showing all your fonts and
all your sounds. Just double-click any sound's
icon to hear it played.
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Utilities with No Monthl1J Bill
Even as you've been taking your first tremulous steps on this most wondrous of
computers, thousands of hackers, in a grand effort to make this insanely great
computer even greater, have been slaving away late at night, for weeks at a
time, subsisting primarily on three-cheese pizza and Jolt cola ("Twice the
caffeine! And all the sugar!").
You'd be amazed at the things they come up with. Today you can buy programs
that make your hard disk hold more, automatically type out your return
address on cue, or - most important of all - send a squadron of aerodynamic
toasters flapping across your screen. These are called utility programs; here's an
overview.

.Compression pro9rams
Run a large file through a compression program, and it emerges from the other
end at about half its original size. (Too bad you can't run the government
through one.) Multiply that size-reduction process by all your files, and all of a
sudden your hard disk can hold twice as much. It's almost like getting a second
hard drive free.
Three of the best-known file-compression programs are the shareware program
Compact Pro, Stufflt, and DiskDoubler. The latter two programs add a new menu
to your menu bar in the Finder, containing Compress and Expand commands.
To shrink a file, just click it and then choose Compress.

Screen sarlers
If you've ever seen the ghost of a cash machine's welcoming screen perma-

nently etched in the display, you'll understand the reason for screen savers. By
automatically blanking the screen after a few minutes of disuse, these programs
ensure that your Mac monitor won't suffer the same burn-in syndrome if you
accidentally leave the computer on for the whole week you're in Acapulco. To
signal you that the computer is still on, however, a screen saver must bounce
some moving image around the screen. That's where the fun comes in.
The programmers of these utilities figure: if you've got to display some "I'm still
on!" signal on the monitor, it might as well be entertaining. That's why today's
screen savers let you choose from dozens of different patterns or animations to
fill your screen while you're ignoring the Mac: wild, psychedelic lava-lampish
images, sharks swimming back and forth, fireworks, swirling lines, slithering
worms, and so on. The most popular commercial screen saver is After Dark,
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whose riding mower gradually eats up whatever document you were working
on. You get your regular screen back by touching the mouse or keyboard.
Do you really need one of these? Nah. You'd have to leave your Mac turned on
for years, untouched, to get screen bum-in. On the one-piece Macs, you can just
tum down the screen brightness; on other models, you can either use the
Energy Saver control panel to black out your screen after half an hour - or
even just tum the monitor off when you're not using it (that's perfectly safe).
But frankly, screen savers are really, really neat, and sort of de rigeur among the
computing elite.

Anti-flirus so~ware
A computer virus, as you may have read, is a program written by some jerk
from a dysfunctional family who seeks to bolster his own self-worth by gumming up other people's Macs. There have been a dozen or so Macintosh
viruses - little self-duplicating programs that attach themselves to innocent
software, whereupon they duplicate some more, until every disk that passes
through your floppy-disk drive is infected. You can't get a computer virus
unless you (1) swap disks with friends or (2) use a modem to connect to other
Macs over the phone.
No widespread Mac virus has ever destroyed files; they usually just make funny
beeps or display some dumb message. But playing on virus paranoia, many
companies offer anti-virus programs for sale, charging you money for an update
every time a new virus is discovered. Virex, S.A.M., and Gatekeeper are a few.
If you're really worried about viruses, get Disinfectant, which is free. It watches
over your Mac, tells you if you've contracted a virus, and wipes it out for you.
(Disinfectant comes from the usual sources of noncommercial software: your
local user group has it, and you can get it from America Online. Or just send a
disk to the author; I've provided his address in Appendix B.)

Top Ten Free or Almost-Free
UtilitlJ Pro9rams
Airborne appliances may be charming, but they cost money. Your other Mac
utilities don't have to be. Here are ten good ones, all of them shareware. (In
case you missed it, you get shareware from a user group, electronic bulletin
board, or online service like America Online.)
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1. Disinfectant- as described earlier.

2. Folder Icon Maker- a simple, effective program that will help you visually
keep track of what's inside your folders. To use Folder Icon Maker, just
drag an application or document onto the Folder Icon Maker icon. A new
folder will be created with a miniature version of the application's icon
pasted onto it!
3. Compact Pro or Stufflt Classic - File-compression programs. Not as
convenient - and not as fast - as DiskDoubler, but then again much
cheaper.
4. SuperClock - Puts a little digital clock at the upper right of your screen, in
the typeface of your choice, so you'll always know exactly how late you
are. (Built into System 7.5.)
5. Program Switcher- Getting tired of mousing up to the Application menu to
switch between programs? Program Switcher lets you switch between
running programs via a simple keystroke.
6. SCSI Probe - You power up the Mac, but your hard-drive icon doesn't
appear. If you have SCSI Probe (or the nearly identical SCSI Info), you can
find out the make, model, capacity, and SCSI address of every SCSI device
attached to your Mac, and more. It has a Mount button that can often bring
a SCSI device on line if it's acting flaky. (SCSI is like that.)
7. Scraplt Pro - It's the Mother of All Scrapbooks. It stores and indexes
anything you can copy to the clipboard, import, or drag & drop; sounds,
PICTures, text, QuickTime movies, and lots more.
8. Remember? - It's a desk-accessory calendar thingie. You type your
appointments into its clean, colorful calendar, and it actually reminds you
of each upcoming event.
9. TechTool - TechTool is an important Mac utility that does five things
beautifully: (1) Checks your system files for damage; (2) and (3) Zaps your
parameter RAM (PRAM) or rebuilds the desktop (see Chapter 18 for what
that's about); (4) Shows system and hard drive info about your particular
Mac; and (5) Shows when your Mac was made and how many total hours
of usage it has had.
10. Typelt4Me - a typing saver. It expands abbreviations as you type. As you
go about your daily life, you teach Typelt4Me. You make up your own
abbreviations for words you use a lot: you might use Mc for Macintosh, be
for because, aol for America Online, and so on.
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Chapter 12

More Stuff to Buy and Plug In
••••••••••••••••••••••••••••••••••••••••••••••••
In This Chapter
.,._ Preserving your favorite belch sound forever
.... Why a scanner is like an inside-out printer
.,._ Hooking your Mac to the telephone line
.... Making your Mac musical or cinematic

••••••••••••••••••••••••••••••••••••••••••••••••

f t's~etprobably
taken you at least a day to reach this part of the book, and I'll
lpiffle!"
you're already chomping at the bit. "FileMaker - fiddlesticks! Printers you're no doubt exclaiming. "Give me something I, the Reader, can sink
my teeth into!"
OK, 0 Reader. In this section, you'll find out about several impressive and hightech gadgets you can spend money on - yes, it's Credit Card Workout #4.
These devices give the Mac eyes and ears, hook it to a national network, and
turn it into an orchestra. You're not obligated to purchase any of them, of
course. But knowing about some of the amazing things your computer can do
will help you understand why a Mac is such a big deal.

Scanners
You've actually seen scanners
before. They're usually known by
their technical name: copying
machines. Yup. When you put a
piece of paper on the ol' Xerox
machine, the scanner part (glass,
bright light, funny hum) takes a
picture of your document. Then
the printer part prints the copy.
Well, if you strip out the printer
part, what's left is a scanner.
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If the point of a printer is to take something on the screen and reproduce it on
paper, then a scanner is the opposite - its function is to scan an image on
paper and throw it up on the Mac screen. After the image has been scanned and

converted into bits and bytes that the Mac understands (meaning that it's been
digitized), you can manipulate it any way you want. Erase unwanted parts, make

the background darker, give Uncle Ed a mustache, shorten your brother's neck,
whatever. The more dignified use for a scanner is grabbing real-world images that
you then paste into your own documents, particularly in the realm of page layout
and graphic design. Got a potato-industry newsletter to crank out? Scan in a
photo of some fine-lookin' spuds, and you've got yourself a graphic for page one.

0 SalJ. Can U OCRJ
Unfortunately, when you scan a page of text, the Mac doesn't see English words.
It sees lots of itty-bitty dots in funny patterns. When the image pops up on your
screen after being scanned, you can't correct a typo - because it's not really
text anymore, just a picture of text. (Analogy time: If you take a Polaroid of a
handwritten grocery list, you can't then erase Charmin 8-Roll Pack from the
photo because it's no longer handwriting - just a picture of some writing.)
To convert that picture of text into a true text document, you need a piece of
highly brainy software designed for optical character recognition, which is so
unhelpful a term that people abbreviate it OCR out of sheer disgust. Using OCR,
you can save yourself massive amounts of retyping; you can just roll the
magazine article, book page, or other text document through your scanner, and
wait while your OCR program examines each letter to decide its identity. The
result is a text document that's about 98 percent correctly typed.
So how much is all this gonna cost you? A serious black-and-white scanner, one
with a big plate of glass like a copier, is around $600. Add another $400 for color.
An OCR program costs between $200 and $800, depending on its sophistication.

Modems
A modem is a phone hookup - a
box that sits between the Mac and
a phone jack.
After your Mac is connected
by phone to another computer,
all kinds of neat things can happen.
You can have a conversation
with somebody at the other end everything each person types
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appears on both people's screens. You can transfer a file from your hard disk to
· somebody else's even if the person lives in Tulsa or Zurich. You can drop
written messages into people's electronic mailqoxes, which they'll read the next
time they check in. (Such messages are called e-mail, from the exclamation
"Eeee-hah! I don't have to send it through the mail!') You can make plane
reservations, order disks, check your stocks, send cartoon renderings of your
face worldwide, and get all kinds of other info by using an online service.
(Examples of online services: America Online and CompuServe.)
In fact, if you have a PowerBook (a laptop Mac) with a modem, you can do
something really neat. Suppose you 're out in the Alaskan tundra and you realize
you left those critical third-quarter sales reports on your regular office Mac in
Chagrin Falls, Ohio. If the Ohio Mac also has a modem, you can actually dial in
to your office, turn on the Ohio Mac automatically, get the documents you need,
turn off the Ohio Mac - all by long-distance remote control. To do this, you
need a program called Apple Remote Access.
For more scoop on modems, online services, and the Internet, see Chapter 10.

Fax/modems
While we're talking about buying modems, you might also want to consider a
fax/modem. Today, almost every modem is a fax/modem, meaning that instead
of just being a modem, it can also turn your Mac into a big gray fax machine. A
fax/modem can receive any kind of fax; the incoming document appears on
your Mac screen, where you can read it, print it on your printer, or throw it away.
To send a fax, you prepare the document (that you want to send) on your Mac.
For most people; that means typing it up in a word processor. This, of course, is
the one major disadvantage to owning a fax/modem instead of a real fax machine:
you can only send documents that are on the Mac. You can't fax someone, for
example, an article from MAD magazine, because it doesn't exist on your Mac
screen. (Unless you go to the trouble of buying a scanner and scanning it in.)

CD-ROM
Nothing spices up a good discussion like a baffling computer equipment
acronym, y'know?
Fortunately, you already know half of this one: CD stands for Compact Disc, just
like the ones that let you play Ella Fitzgerald on your stereo. Instead of holding
music, though, a CD-ROM disc holds computer information - tons of it. (Don't
even worry about what ROM stands for. It'd leave you more confused than you
may be already.)
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The Pod
Much though it sounds like a movie from the
makers of It Came From Beyond the Black
Swamp, the "pod" usually refers to Apple's
GeoPort Telecom Adapter. If you have a Power
Mac or a 4-digit Performa, your modem jack is
special: it can talk to The Pod.

If so, your Pod can act as a modem- and cost a
lot less than a real one (about$90). As I write this,
the Pod's top modem-impersonation speed is
only 14.4 miles per hour (Kbps) instead of the
top-of-the-line 28.8 miles per hour. But with
new software, which Apple's supposedly
working on, your exiting Pod will be capable of
the faster speed.
But there's more to the Pod than pretending to
be a fax/modem: it also lets you use Mega Phone,
an answering-machine/speakerphone program.
Most of today's Macs come with a 30-day trial
version of this cool program. Cool, except that it
requires you to leave your Mac on all the time,
just as you would a real answering machine and real ones don't have system crashes.

If you have a CD-ROM player - a

$300 gizmo that plugs into the back
(or is built into the front) of your
Mac - you can play CD-ROM discs.
They contain pictures, sound,
movies, graphics, and text ...
enough to keep you busy for days.
Typical examples: One CD-ROM
contains an encyclopedia, complete
with color pictures, some of which
are movies that show the motion of,
say, the Venezuelan Sun Gekko.
Another is a dictionary where you
actually hear a guy read the pronunciation of each word. Another CD-ROM is a
video game - an interactive one, like a TV show where you control where the
main character goes next.
You can get a built-in CD-ROM player as an option on most Mac models. And
there are more and more good CD-ROM discs worth sticking into them. A
CD-ROM isn't a necessity-yet - but it'll become more and more valuable as
we approach the millennium. And because more and more programs come out
of the box on one CD-ROM disc instead of 45 floppies, a CD-ROM drive can save
you time and hassle.
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Speakers
Oh, yes indeedy: the Mac is more than high-tech - it's hi-fi. Most recent models
churn out gorgeous stereo signals from their back-panel speaker jacks. When
you listen to the Mac's tinny two-inch built-in speaker, though, you don't hear it.
If you get a pair of miniature speakers designed for the purpose, you're in for a
tintinnabulating treat. If you play Mac games, particularly CD-ROM discs, you

won't believe what you've been missing; the sounds are suddenly much richer
and deeper. And, of course, in stereo.
If you don't do much more with sound than listen to your Mac's startup chord,

don't bother buying speakers. And if you do want speakers, not just any old
speakers will work. They must be self-powered, and they must be shielded; the
magnets inside normal stereo speakers are enough to distort the image on your
monitor like the Sunday comics on Silly Putty. In other words, buy speakers
designed for the purpose; Apple, Yamaha, and Bose make a whole line of Macready speakers.
Of course, you can also plug your Mac into your existing stereo system. You just
have to (a) get the right cables, and (b) learn to live with the cord trailing
across the floor and into the back of your amplifier.
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Music and MIDI
Oh, groan ... another abbreviated computer term! All right, let's get it over with.
MIDI, pronounced like the short skirt, stands for Musical Instrument Digital

Interface. What it means is "hookup to a synthesizer." What it does is let your
Mac record and play back your musical performances using a synthesizer
attached to it. When you record, the Mac makes a metronome sound - a
steady click track - and you play to the beat. Then, when you play back the
music, your keyboard plays exactly what you recorded, complete with feeling,
expression, and fudged notes; you'd think that Liberace's ghost was playing the
instrument, except that the keys don't move up and down.
The advantage of recording music in this way (yup, there's a term for this,
too - it's sequencing) is that once you've captured your brilliant performance
by recording it into the Mac, you can edit it. You can take out those fudged
notes. You can transpose the piece into a different key. You can speed it up or
slow it down without affecting the pitch. Why? Because this isn't a tape recording; it's a digital recording. Your musical MIDI information is a stream of computer numbers that describe each note you play; the Mac might instruct the
keyboard, for example, to "Play middle C with this much volume. And hold the
note for one-tenth of a second."
All you need is a little box that connects your Mac to the synthesizer. It's called
a MIDI interface, and it shouldn't cost more than about $50. You also need a
program that can record and play back the music, called a sequencing program.
Some easy-to-use and inexpensive ones are EZ Vision, MusicShop, and
Freestyle. And, of course, you need to get your hands on a synthesizer. Check
out a music store and get jammin'.
Another popular use of the Mac is
to make it write out your music for
you in standard sheet music
notation. Several notation programs (Finale, Finale Allegro,
Encore) actually write down every
note you play, let you edit it, add
lyrics or chord symbols, and then
print it out as gorgeous sheet
music. These programs can even
play back your music; you can
correct any wayward notes before
committing them to paper. Presto,
you're Mozart.
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A Camcorder
"Say what?'' you're saying. "This crazy author is suggesting I plug my camcorder
into my computer? What's next, plugging my microwave into the vacuum?"
It's true. The hottest new use of a Macintosh is as a movie-making machine. You
can actually plug your VCR or camcorder into the computer and watch in awe
as your home movies pop up on the Mac screen. After you've captured your
videos onto the Mac (or, more correctly, digitized them), with full color and
sound, you can edit them, play them backward, edit out the embarrassing
parts, or whatever. The technology and the movies are called QuickTime.
Just about any Mac can play QuickTime movies. You need special gear, though,
to make them. Chapter 14 has the details.

SIJ.Quests & Zip Disks & Tapes, Oh MIJ.f
There's only one thing wrong with hard disks: like closets, garages, and landfills,
they fill up. No matter how much of a neatness nerd you are, even if you
promptly throw away anything you're finished working on, you'll gradually
watch your "MB available" count go down, down, down over the months, until
your hard disk is completely full. (Thousands of experienced Mac users all over
the world are sagely nodding their heads in sorrowful acknowledgment.)
So what are you supposed to do? Go back to writing on Post-It notes? Well, you
could buy another hard disk, of course. The one inside your computer is called
an internal hard drive. If you buy another, you could plug it into the back of your
Mac and have access to its contents as well. (This, as you may have guessed,
would be called an external hard drive.) But that's an expensive proposition,
and the darnedest thing of all is that that hard drive will fill up, too.
For thousands of storage-starved people, the solution is to get a removablecartridge system. This device looks just like an external hard drive, except when
the spinning platters get full, you can just pull them out of the machine (they're
sealed into a plastic cartridge) and put in a new, blank, virgin cartridge. Since a
100-megabyte Zip disk, for example, only costs about $15 - compared with a new
hard disk at $300 -you can see why a removable cartridge is an attractive idea
A removable-cartridge system solves another chronic problem, too: how to
back up your data. To back up is to make a spare copy of your important files,
so if something should happen to your main hard disk (or you do something to
it) and all your files get erased, you haven't lost your life's work.
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There are two primary makers of removablecartridge systems: SyQuest and Iomega. Each
makes cartridges - and the machines that
play them - in various capacities; SyQuest
drives cost from $300 to $500, and they take
cartridges ranging from 44 to lOOOMB apiece.
Even more popular are the amazing Zip disks.
These things look like slightly porky floppy
disks that have been hitting the Ben & Jerry's
a bit too often. As mentioned earlier, each
holds 100 MB and costs about $15; the Zip
drive, the player, costs $200. These Zip disks
are fantastically convenient, sturdy, and easy
to work with. (The same company makes
an even fatter version called the Jaz drive;
each $50 disk holds 1,000MB, and the drive
costs $500.)

Di9itizin9 Tablets
So you say you're an artist. Why, of course you are, dear - after all, you own
a Macintosh!
So you say you're finding it a tad
difficult to draw using a mouse
that's about as precise and conveniently shaped as a chalkboard
eraser? Then a digitizing tablet is
just the tiCket for you. As you can
see in the photo, it's simply a pad
that connects to your Mac; it comes
with a pen (usually cordless) that
lets you manipulate your on-screen
cursor just by drawing (dragging
your pen around on the pad).
Especially when used with programs that respond to the pressure of the pen by
drawing fatter lines, like Photoshop and Painter, a tablet is the closest you can
come to making your Mac act like natural painting tools.
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Di9ital Cameras
Ordinarily, the concept of paying $750 for a camera that lacks any way to insert
film would seem spectacularly brain-dead. Yet that's exactly the point of digital
cameras, like the Apple QuickTake ($750) or the Casio QV-10 ($700). They store
between 50 and 100 photos without film - actually, in RAM, now that you know
what that is - and when you get home, you can dump them into your
Macintosh, thereby freeing your camera's RAM for another round of happy-golucky shooting.
For people who need instant, no-cost developing (doctors, real-estate hounds,
fraternity party animals, etc.), these cameras are a godsend. As a matter of fact,
just to prove the point, I took all the photos in this chapter using the little Casio
jobber. The results aren't pro quality-you'll have to pay $1,000 or more for
digital cameras that take Time-magazine-quality photos - but they're great for,
say, illustrating computer books.

Networks
You already know what a network is. It's the television company that broadcasts
stuff like Baywatch so you'll have something to look at when you're burned out
from computer work.
In the computer world, though, a network is defined as more than one Mac
hooked together. In some offices, hundreds of Macs are all interconnected. Some
advantages of being networked: You can send e-mail to other people, which
pops up on their screens; you can have access to each others' files and programs; and you can save money by buying just one printer (or scanner or
modem) for use with a whole bunch of Macs.
The goal of this book is to get you going with your own Mac. If you really, truly,
honestly want to read about connecting Macs together (normally the domain of
gurus, computer whizzes, and paid consultants), read MORE Macs For Dummies.

Plu99in9 the Stuff In
Suppose you win the lottery. You buy every Mac add-on there is. Only two
things left to do: give half your winnings to the IRS and figure out where to plug
the stuff in: In Appendix A, you'll find a pretty good diagram of the jacks in the
back of your Mac. Here's where everything goes:
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~

Scanners, CD-ROM players, external hard drives, SyQuest drives, Zip drives,
tape-backup devices: The SCSI port. It's the wide one with screws on each
side. So how are you supposed to plug in so many different things if there's
only one port? Simple - by daisy-chaining them, one to another. Daisychaining is an act of utter bravery, however, and should not be undertaken
until after you've read the "Scuzzy SCSI" section in Chapter 18 and had a.nice
cool drink. Until then, plug one machine only into the SCSI jack of your Mac.

~

Apple microphone: There's a special jack, a miniplug, just for this. Marked
with a microphone icon.

~Modems,

GeoPort pod, MIDI interfaces (music), label printers, digital camera,
digitizing tablet These all go into the modem port. It's the little round
jobber marked by a telephone icon. So how are you supposed to plug more
than one of these into your Mac? (No, there's no such thing as daisychaining modem-port devices.)

You have two choices, both of which involve using only one device at a
time. First, you can just unplug one device before using the next. Second,
you can get an A/B switch box that acts like a Y-splitter; you plug both
modem port pluggables into this box and then tum a knob to select which
one you want the Mac to pay attention to. (You can even buy an A/B/C/D
box that accommodates four devices if you've really gone crazy with this
kind of peripheral.)
~Camcorder,

VCR: There's a built-in jack for this on certain models (see
Chapter 14), marked by a little movie-camera icon.

~

Printer, network: You've probably figured out, all by yourself, that the
printer gets connected to the printer port (another small, round jack, next
to the modem port, and marked by a printer icon). But it's good to know
that this is where you plug in the cabling for a network, too, if you have
one. (So then where does the printer go if your printer port is used up by a
network connection? Easy- it gets hooked into the network so that
anyone can use it. See your resident guru for details.)
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Top Ten Non-CostfIJ. Mac Add-Ons
Not every add-on has to cost a million bucks, as the following list demonstrates.
1. A mouse pad. It's a foam rubber mat that protects the desk and the mouse

from each other, gives your mouse better traction, and keeps cookie
crumbs out of the mouse mechanism. It often carries the same kinds of
promotional graphics as T-shirts and bumper stickers.
2. An A/B box. Your Mac has only one modem jack, but the world is filled
with appliances that may be attached there. This little box lets you tum a
knob to switch between, say, your modem and your StyleWriter.
3. A glare filter. I think they make the screen too dim, but lots of people use
them and think they make the screen easier to look at.
4. Disk boxes. They hold between 10 and 100 floppy disks, and come in every
possible material from plastic to polished teak. (Actually, I've found that
one of those colorful plastic Thermos-brand lunch boxes from Woolworth's
makes the very best disk box. It holds 100 floppies perfectly, has a handle,
and snaps securely shut. Just remember not to get it mixed up with your
kid's colorful plastic Thermos-brand lunch box - peanut butter and jelly
can impair the performance of your disk drives.)
5. A carrying case. For PowerBooks - and the older, one-piece Macs like the
Classic or SE - these rugged, padded protective bags are extremely
helpful in transporting your machine. Even if it's in one of these cases,
don't ever check your computer as baggage on a plane (unless it's in the
original cardboard box with its Styrofoam protectors).
6. A trackball. People who don't like computer mice often take great dE;!light in
replacing their Mac mouse with a trackball. A trackball looks like an eight
ball set into a six-inch square base; you move the pointer on the screen by
rolling the ball in place with your fingers. (PowerBook models have a builtin trackball or trackpad below the keyboard.)
7. A surge suppressor. This thing looks like an ordinary multiple-outlet
extension cord from the hardware store, but it's supposed to have an
additional benefit - circuitry that can absorb an electrical voltage surge,
and thus protect your Mac from a wayward bolt of lightning. Not many
people realize that the Mac already has a built-in surge suppressor, however. Furthermore, a surge suppressor's value has long been debated.
(They're not designed to protect you from acts of God, though. I've known
people with surge suppressors whose Macs got fried by lightning, as well
as people without surge suppressors whose houses were struck by lightning without affecting the Mac.) Let your paranoia be your guide.
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8. A one-switch multiple-outlet box. In other words, an extension-cord thing
that lets you plug in your Mac, hard drive, printer, and so on, so that they
all turn on when you flip a single switch. Such devices usually have a surge
suppressor built-in, by the way. My favorite is the PowerKey, which is
designed especially for the Mac, has four surge-protected outlets, and lets
you turn the Mac on by pressing the big triangle key on your keyboard
(even if you have a back-panel power-switch model, like an LC or a Quadra
605 or 630, whose big triangle keys usually do nothing).
9. A paper clip. Man, talk about low cost. Nonetheless, the true Mac
cognoscenti keep a straightened paper clip next to their machines - it's
the only way to remove a floppy disk that's stuck in the disk drive. (See the
sidebar in Chapter 2, "Dweebs' Corner: Alternative disk tips.'')
10. Spare printer cartridges. Have an extra ribbon, cartridge, or drum for your
printer (depending on what it is) at all times. Murphy's Law, or whatever
law governs computers, states that the printer cartridge you're using now
will not wear out until you're halfway through a large printing project
that's due shortly and all the stores are closed.

Chapter14

The Mac Sings, Shows Movies, and
Prepares Mixed Drinks
In This Chapter
~

Make your Mac talk
Iii'- Make your Mac sing
lilo- Make your Mac listen

.. Make your Mac show movies

~r a 10-year-old, the Macintosh is amazingly talented. While you may not

r~ow it yet, this computer is capable of reading aloud, singing, taking

spoken orders, making movies, and much more. (Up there in the title, I exaggerated slightly about its ability to make cocktails - but l wouldn't be surprised if
that feature made it into the next version of the operating system.) In this
chapter, you'll get to see some of these cool talents in action on your very
own screen.

It Speaks!
It has been said that we spend the first year of a child's life trying to get it to
talk, and the next 18 years trying to get it to shut up. Well, with the Mac, getting
it to talk is fantastically easy. Getting the software it needs to talk might be
slightly more difficult.
It's called PlainTalk English Text-to-Speech. If your Mac has System 7.5, or is
relatively new, you probably have it sitting around on your hard drive. Use your
Find command, as described in Chapter 3, and search for text-to-speech. You'll
probably find it, in the form of an Installer, sitting in your Apple Extras folder.
Double-click the Installer, and you're on your way.
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If you didn't find any such thing, you'll probably have to go scavenging for it.
First search the CD-ROM that came with your Mac, if there was one. If that
attempt doesn't uncover the thing, you'll probably have to go online for it; the
English-text-to-Speech installer can be found, among other places, on America
Online. (See "How to get free stuff from America Online.")

Anyway, once everything is happily installed, you'll find a new extension in your
Extensions folder called Speech Manager, and somewhere in your System Folder
you might find a folder called Voices. Restart the Mac and get ready for talking.

Makin9 it talk
You may well have wondered about the presence of a certain icon on your hard
drive called SimpleText. (In fact, if you're like most people, you've wondered
about the presence of 54 icons called SimpleText; according to ancient Mac
lore, this little program quietly replicates itself when you're not looking.)
Anyway, SimpleText is a baby word processor. Apple installs it on every Mac it
makes so that you, the purchaser, will have some program with which to read
important text files, such as Read Me First documents, even if you haven't
bought a genuine word processor program. SimpleText isn't a bad little program, at that - it lets you open more than one document at a time; it lets you
format your writing with different fonts and styles; it uses the fantastic feature
known as Macintosh Drag-and-Drop (which lets you move text just by highlighting it and then dragging it anywhere else in your document, or even into
another SimpleText window - try it!).
Oh, yeah - and SimpleText talks.
Find one of your copies of SimpleText (use your Find command). Type up some. thing you've always wanted to have said to you, such as, "You are such a god!
Holy smokes, everything you do is perfection. I'd give anything to be more like you."
Then move that mouse on up to your Sound menu, and choose Speak All. Aren't
computers great?
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Pick IJ.OUr floice
Now, for added hilarity, go back to the Sound menu. See if you have a Voices
command - and see if it offers a choice of different character names. If your
Mac came with the Text-to-Speech feature already installed on the hard drive,
you may only have one name listed. If you go get the complete installer from
America Online, as described earlier, or if you have Text-to-Speech on a CD-ROM
that came with your Mac, you'll probably have as many as 18 different voices to
choose from. They're great: male, female, kids, deep voices, shaky voices,
whispered voices. You'll spend hours, I predict, making up funny sentences for
each character voice to say.
Of course, Apple didn't create a talking Mac just for you to fool around making
up silly sentences. This technology has some actual, useful uses. For example,
there's no better way to proofread something important than to listen to it
being read to you. And PlainTalk is also a great way to help someone learn to
read: typing something onto the screen, having the Mac pronounce it, and then
making fun of its accent.

It Sin9s!
While it may be a little humbling that your Mac may be more talented than you
are, it does indeed sing. It has a somewhat limited repertoire - in fact, it only
knows four songs - but it can use any lyrics you want, and it never even stops
to take a breath.
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To make your Mac sing, you simply need to get it talking, as described earlier.
Then choose one of these voices from the'voices menu:
""" Pipe Organ: Sings to the tune of the Alfred Hitchcock theme.
""" Good News: Sings to the tune of "Pomp & Circumstance," otherwise

known as the graduation march.
""" Bad News: Sings to the tune of the funeral march.
""" Cellos: Sings to the tune of "In the Hall of the Mountain King," from Peer
Gynt, by Edvard Grieg. Such culture!
Incidentally, don't use any punctuation when writing the lyrics for the Mac's
songfest - punctuation marks make the Mac start over from the beginning of
the melody. Sample lyrics for the Good News graduation-march melody, for
example, might look like this:
You just won the jackpot good luck and God bless
Too bad you owe half to good old IRS

It Takes Orders!
If you have a desktop (not laptop) Mac with a four-digit model number, like a

Power Mac, you can actually give spoken orders to your Mac. And - most of
the time, by golly- it will respond! It will do whatever you tell it to do.
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What IJ.OU need to make it listen
As with the text-to-speech feature, this take-an-order feature requires special
software. Once again, it's probably already on your hard drive, probably in the
Apple Extras folder. And once again, if not, you can get it from America Online,
exactly as described earlier. This time, the software is known as PlainTalk
Speech Recognition.

This feature also requires a microphone, of course. Some Mac models have
a microphone built right into the monitor; others require the $20 Plain
Talk microphone.
Anyway, once your software and microphone are in place, and you've restarted
the machine, you're ready to start talking. (You'll see a little floating window
that says Ready if everything's working OK; if not, open your Control Panels,
open Speech, and turn it On.) Unless you've been fooling around in the Speech
control panel (which you get when you install the Speech Recognition stuff),
your Mac uses a "push-to-talk" system - the Mac doesn't listen to you at all
until you're pressing a particular key. It comes preset to have the Esc key on
your keyboard serve as the push-to-talk key.

What IJ.OU can salJ. to the Mac
So what, exactly, can you do when speech recognition is turned on?
Well, the Mac can't take dictation, writing down what you say; for that you need
much more expensive software, like the $2,500 PowerSecretary program. Nor
can it execute menu commands when you speak them ("Shut down," "Restart,"
"18 point," and so on), although a few, such as "Close window" and "Empty the
Trash," do work.
No, what PlainTalk does is open things - things whose icons (or aliases) you've
put into the Speakable Items folder, which you can open by choosing it from
your S menu. (The real Speakable Items folder is inside the Apple Menu Items
folder in your System Folder.)
You can launch programs and documents with the greatest of ease: just say
"open ClarisWorks," "open Monitors," and so on. If there's anything you'd like to
be able to open by voice, just put it - or, better yet, an alias of it - into your
Speakable Items folder. (See Chapter 12 for details on aliases.)
Other than opening things, you can do a few other stunts that should raise the
eyebrows of the local neighborhood kids. For example, you'll get some fun
responses from your Mac if you say any of the following:
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V' "What day is it?"

I

V'

"What time is it?"

V' "Tell me a joke."

V' "Is file sharing on?"

I

V'

"Find original of this."

V' "View window by small icon."

It PlalJ.S Mollies!
As hinted back in Chapter 12, your Mac is quite handy with movies, too. It can
make them, record them, and show them.

The cornerstone to all of this is the QuickTime extension, which I'll bet is sitting
in your System Folder at this very moment (in your Extensions folder) . If it isn't,
maybe you have an old System Folder - System 7.0 or something; you need
System 7.1 or later to make this work. If, for some strange reason, you don't
have the QuickTime icon in your Extensions folder, grab your original system
disks or CD-ROM and install it from there. Or, better yet, you can get QuickTime
from America Online; better, because it's probably a newer version than
what you have. (See "How to get free stuff from America Online," earlier in
this chapter.)

Pla1J.in9 moflies
Now, getting movies to play on your screen is simple: just double-click a movie
icon to open it. It'll probably launch good old SimpleText and appear as a
smallish rectangle, as shown here.

Click here to start or
stop playback

Drag this doodad to
jump around in the
movie

Click to move one "frame"
of the movie forward or
backward

_ _ _ _ Chapter 14: The Mac Sings, Shows Movies, and Prepares Mixed Drinks
To play the flick, click the little "play" triangle to make it play back. You'll
quickly discover a few disappointing facts about digital movies: they play back
kind of jerky, they are small (playing in a small window), and they're generally
short. That's because QuickTime movie files take up obscene amounts of harddrive space for each minute of footage.
The bigger challenge, therefore, is simply getting a movie you want to watch.
Several sources spring to mind: you can download movies from the Internet or
America Online (see Chapter 10), although these enormous files take enormous
amounts of time to transfer to you by modem. You can get movies from any of
about 13 million CD-ROM discs; some of them are nothing but collections of fun
little movies on every possible topic. And, of course, you can make your own.

Makin9 mollies
Many more Mac fans play movies than make them. That's partly because
making movies requires special equipment, special software, and endless
patience, while playing them requires only the QuickTime extension and
nothing better to do at the moment.
You can get the necessary circuitry for recording QuickTime movies in any of
three ways:
~

Get it built into certain Mac models (such as the Power Mac 8200, 8500,
630-series with the optional Apple Video card, AV-style Macs, etc.).

~

Add it, in the form of a NuBus, PDS, or PCI card (a digitizing card), to a Mac
with slots - an expensive and technical procedure that's even more
deserving of a .. .For Dummies book than this one.

~

Buy a Connectix QuickCam. It's the very cheapest way to start making
movies: a little mechanical eyeball that sits on top of your Mac. The $99
version records only in black and white, and the movies it makes are
pretty jerky. But hey: Jurassic Park wasn't Spielberg's first movie, you know
what I'm sayin'?

You'll also need some movie-editing software, like Adobe Premiere. And you
need a lot of hard-disk space: every minute of digitized movie on your Mac
consumes about 15 megs of disk space. For additional details, and even a lesson
in Adobe Premiere, you'll have to consult this book's sequel.
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In this part ...

n 1984, you could have any Mac you wanted, as long as it
was the beige, hard-disk-free, 128K original Mac.

A hundred Mac models later, the line has begun to differentiate itself into peculiar breeds of Mac. A Performa is exactly
like a regular Mac, only different. A PowerBook is exactly
like a regular Mac, only smaller. And a Power Macintosh is
exactly like a regular Mac, only more powerful.

Chapter15

Yo: It's da Perfonna (and System 7.5)
••••••••••••••••••••••••••••••••••••••••••••••••
In This Chapter
~What's

a Performa

~Why

it's called that
make a Performa behave like a regular Mac
~ At ease with At Ease

1JP- How to

A

pple Computer has never seemed totally content simply to manufacture
the greatest computer the world has ever known. No, they feel lonely over
there in those rarefied computer stores. They wanna make it big. They want
Apple products cropping up in department stores, mail-order catalogs, discount
marts ... it wouldn't surprise me one iota if, a year from now or so, we started
seeing a chain of Apple casual-wear shops in America's finer malls.
Anyway, Performas (this chapter) represent one direction the company's plan
for world domination is taking. PowerBooks are another (next chapter).
Now, before you turn the page, ye Non-Performa owner, read this paragraph. It
turns out that the easified features of the Performa were such a hit (in the early
'90s) that Apple stuck them all into everyone :S Macs -when it invented System
7.5. If, in Chapter 1 when you were supposed to figure out what kind of Mac you
have, you learned that you have System 7.5, you'll find lots of cool information
in this chapter. I'll clearly mark the portions of interest to you.
In any case, I'll be concise in this chapter for two reasons. First, the Performas
are almost identical to non-Performas. And second, as my cousin Anne always
says, no computer book should weigh more than the machine it describes.

Principles of Performer
Your Mac is a Performa if (a) it says Performa on the front; (b) you bought it as
an everything-included package for one price (monitor, keyboard, modem,
software already installed); and (c) when you say your Mac's name, you sound
like Sylvester Stallone trying to say "performer."

2 98

Part IV: Special Macs for Special People

The Deal
The first thing that makes a Performa a Performa is how you buy it: as a
complete bundle. You save hassle (because you get the complete setup for
one fixed price), money (because you get a bunch of ready-to-use software
programs already installed), and headaches (because you get a year of on-site
service - some guy will actually come to your house to fix the computer for
free if something goes wrongO. (When, oh when, will electricians and plumbers
adopt that policy?)

The Launcher (S1Jstem 7.5, too!)
One of the first things that set the Performa apart from mere mortal Macs was
the Launcher.
What the Launcher is: a control panel, just like the ones described in Chapter 3.
What it does is display a window containing jumbo icons for your programs. (I
mentioned it briefly in Chapter 3.)

As you know, you normally double-click an icon to launch a program. But
anything in this window opens when you click it once. (This is progress.)
You can move, resize, or close the Launcher window just as you would any
window (Chapter 1). Once closed, it will reappear if you double-click the little
Launcher icon on the desktop (see the next illustration).
So who decides which icons appear in the Launcher? You do. Inside your
System Folder is a folder called Launcher Items. Any file or folder icon you put
in Launcher Items shows up in the Launcher window. (Actually, more typically,
you wouldn't put the icon itself into this folder; you'd put an alias of that item.
See Chapter 11 for info on aliases.)

The Documents folder (S1Jstem 7.5, too!)
For many people, the purchase of a Mac is a primal attempt to get their lives,
so full of traffic and turbulent relationships and scraps of paper, into some kind
of order.

_ _ _ _ _ _ __ ___ Chapter 15: Yo: It's da Performa (and System 7.5)

Super-hot power-nerd hot-rod Launcher ,tricks
In recent versions of the Launcher - such as
System 7.5.1 and later -you can install an icon
just by dragging it onto the Launcher window. In
earlier Launchers, though, you have to open your
System Folder, find the Launcher Items folder,
and open it

Once inside the Launcher Items window, you'll
notice something else remarkable. Let's assume
you bought your Performa after the middle of
1993, and therefore you have topic buttons
across the top of the Launcher window, as
shown in the previous illustration.

There is a better way.

Here's the secret to those topic buttons: any
folder inside the Launcher Items window
whose name is preceded by a bullet symbol (•)
will magically become a topic button in the
Launcher window!

Hold down the Option key on your keyboard.
With steely nerve, move the cursor over one of
the topic buttons at the top of the Launcher window, as shown here. Note that your cursor
changes shape ... to become a little tiny folder:

If you click now, the Launcher Items window will
snap smartly into view. You just saved yourself
several layers of folder-burrowing to find this
window. Now you can add or remove icons as
suits your fancy.

I realize that's an ocean of words to navigate, but
try it and you'll see what I mean. Create a new
folder inside the Launcher Items folder. When
you name the folder, make the first symbol by
pressing the Option key and typing the 8 key.
Option-8 makes the• symbol.
Now have a look at your Launcher window. See
the buttons 'across the top? My God, you're a
programmer!

launcher Iterns
7ite-ms

228 .7 MB in disk

Q
•Vap-0-Rub

~

•Mylanta

o

•NyQuil
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Little do they know what awaits them on the typical Mac: their important
documents get every bit as lost as their paper-based counterparts once did.
Even the great Mac gurus of our time have, at one time or another, saved some
document created on the Mac - and then found themselves unable to find it
again because it got arbitrarily stashed in some hidden folder somewhere.
Enter the Documents folder. See its icon in the picture below? As you work
with your Mac and create different documents, the Performa housekeeps for
you by storing them all in this folder automatically. Every time you use a
program's Open or Save command, you're automatically shown the Documents
folder's contents.

In theory, you'll never lose anything again; everything you do will always be in
one place. (That feature makes backing up your work simple, too; you just copy
that one folder, and you know you're covered.)

Self-hidin9 pro9rams (S1Jstem 7.5, too!)
The third major Performa ease-of-use innovation is self-hiding windows. For
example, the following figure shows what life is like on a regular Mac.
There's actually a significant problem with this setup. As shown in the following
figure, a beginner - and we were all beginners once - might, in reaching for
the scroll bar, accidentally click outside the word processor window. Immediately, the desktop (Finder) jumps to the front, showing files and folders, and the
word processor window gets shoved to the back, apparently vanishing, causing
(in the beginner) distress, unhappiness, and occasionally hair loss.

_ _ _ _ _ _ _ _ _ _ _ Chapter 15: Yo: It's da Perfonna (and System 7.5)
You double-click a document to launch it . . .

. . . but if you ever accidentally click outside the document's window,
as is about to happen here, you'll be back in the Finder, and your word
processor will appear to have disappeared.
The Hairdresser Knock s But Once

]ii

He stared at-her fur a long, tense moment. The blood still dripped from his
elbow.
"It's not that simple, Jennifer," he said finally.
She looked at him with pity. Somewhere, in the diste.nce. a cat meowed.
"You still have to find the car-rental agreement." He fingered the revolver.
Jennifer wanted to laugh. to cry, to run. She wanted again the early days of
happiness, where life was free and so was parki~She wanted to cook, to

:~:s~!:~~~~:~J~;~~Z;~~o~~~~ Ul~ahxi~ ~~Pdfd
5

!:~h~~i:~d~td~~o;~ed~!s~;inF:e~.~c~~t~;~~s, to terrorize

Here's how the self-hiding windows feature makes things better (on Performas
and System 7.5 Macs). When you open a document, the world of the Finder
(icons, windows) disappears. (The following illustration makes this clear.) Now,
if you click outside the word processor window, absolutely nothing happens. In
fact, you can't return to the desktop without choosing Finder from the application menu in the upper-right corner of your screen, like this:

'1t's I10! tbat simple, Jennifer," he sa.ld finally.
She looked al him with pity. Somewbere, ln the dlste.n:e, a cat meowed.

"You still have to find the car-rental agreement." He fingered

lhrl revolver.

fenniferwe.nted to la.ugh. to cry, to run. She wanted a.ge.in the euly da.ys of
happiness, where life wa.s free a.nd so wu pa.rki~She wanted lo cook, to

di:s~:~~~rlti~~:;fJ~~~~~ Sheo~~~~ an~e.fu1~~r;;P~~d

buses. She longed lo collect obscu~rench dictlona.ries, to lerroriz:e
neighborhood childnm.. to dress up In men's clotb.lng. tol

Tumin9 it all off
If any of the Performa features kind of bug you, it's a simple matter to turn one

or all of them off.
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Recent f'erformas (S9stem 7.5, too!J
If you acquired your Performa after the end of 1994, it probably has System 7.5,
just like all other new Macs. You can tum off the three Performa features - the
Launcher, automatic window-hiding, and the Documents folder-magnet - the
same way you do on any System 7.5 Mac. That is, choose Control Panels from
your S menu; double-click the icon called General Controls. There, as in the
following illustration, you'll find the three on/off switches.
Automatic window hiding
Launcher window appears at startup

....

-..

-----~

When optning or savtng II dooun'flnt, Ukt IM to

0

Foldlr whtoh oontms tht applioltion.
@)Last folder und tn thl appHoltion.
QDoo.nnentsfoldr.

Documents folder on desktop

Mature f'erformas
If your Performa was born in 1993 or 1994, it probably doesn't have System 7.5.
Instead, it has a special control panel called Performa. Choose Control Panels
from your S menu and take a look.
·
If you have a Performa control panel, open it. Sure enough, you'll see the on/off
switches (checkboxes) for the three Performa features.

Antil(ue l'erformas
And if your Performa began life in the first part of 1993 or earlier, then you have,
nestled in your Control Panels folder, a control panel called Launcher. It's
responsible for creating all that Performa behavior: the Launcher window, the
Documents folder, and the window hiding when you switch programs.
To kill off these antics, thus de-Performatizing your Mac, choose Control Panels
from your S menu. Drag the Launcher control panel clear out of the System
Folder - onto the desktop, for example.
Now restart the Mac. From now on: no Documents folder, no program hiding.
You can still use the Launcher window; double-click that Launcher control
panel, wherever it is now (not in the System Folder), and the Launcher window
will appear like always.

_ _ _ _ _ _ _ _ _ _ _ Chapter 15: Vo: It's da Performa (and System 7.5)
P.S.: You can also neuter only some of the features on your vintage Performa For
example, you can kill off only the Documents-folder feature by simply renaming
the Documents folder on your desktop. You can also prevent the Launcher window
from appearing every morning; open your System Folder, open the Startup Items
folder, and drag the Launcher alias outta there. From now on, the Launcher
window won't appear until you double-dick the Launcher icon on your desktop.

Apple&ckup
Apple saved itself a precious $7 by failing to give you System disks with your
Performa. Instead, the System comes preinstalled on your hard drive.
If your Performa has a CD-ROM drive, you're in good shape; you can always use
it to reinstall your System Folder if you get into trouble (see Chapter 18). Your
Performa CD-ROM disk should contain all your free software (ClarisWorks,
Quicken, and so on), too.
If your Performa didn't come with a CD-ROM, you're supposed to back up the
system software onto your own floppy disks, using the Apple Backup program.

Three extremely important points:
1. Do it! Call up Mac Connection (see Appendix B) and order a box of high-

density disks. Use them to back up your System Folder as soon as possible.
2. If your System Folder gets trashed before you've made a backup, call
1-800-SOS-APPL. Give them the bad news. If you are persuasive, Apple will
Fed Ex you a free set of System disks.
3. Apple Backup stinks as a real backup program - it can only back up your
System Folder or your entire computer. See Chapter 4 for the actual way to
back up your work.

All About At Ease
In addition to some cool work software like ClarisWorks, America Online, and so
on, your Performa also comes with a fascinating piece of system software: At
Ease. (You can also buy it for use on any Mac for $60.)
Remember all that talk of folders, windows, and disks that you slogged through
in the beginning chapters of this book? It must've made your head spin at first.
Now imagine that you're a six-year-old, and you'll understand why Apple
invented At Ease. It's a sweet little program that covers up all that stuff you've
spent so much time and effort learning: folders, the Trash can, dragging icons
around, and list views. In fact, the entire Finder (the desktop) gets hidden when
At Ease is running.
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At Ease users: Read this or weep
To remove At Ease tot good, do not just drag the
· At Ease files to the Trash. You'll mess up your
Mac so badly it won't start up. Instead, launch
the At Ease Setup program. (Or, if you have

version 1, open the control panel.) Click the
Off button!

Now you can safely drag the At Ease stuff to
the Trash.

When you turn on an At Ease-ified Mac, you're greeted by a screen like this:
Hello there, Jonnthenf
Selec~our

I
I

name:
>;'·~

i

0

Jennifer
Timmy

[Shut Down)

' - - - - - - - - - -b'0r'-"-'

stort

You double-click your name, enter a password (if you wanted one), and wind up
at a screen like this:

This screen shows all the programs you've set up for this individual; click the
name "tab" (Jonathan, in this picture) to view all the documents that person has
created since At Ease was installed. Exactly as with the Launcher, you can open
any icon with a single mouse click, not a double-click. You hear a cool clicky
sound when you click.
When you launch a program, the At Ease window itself disappears, only to
reappear when you quit that program.

Chapter16

The PowerBook Survival Guide
In This Chapter
Ill>- Make your battery (and your sanity) last longer
Ill>- Why you should never really tum the thing off
Ill>- Surviving hotel rooms and airplanes

I

t's a little bit mind-blowing that a tiny PowerBook Duo 2300 has more
computer horsepower than any Macintosh Quadra ever made. Apple made
almost no compromises: the speed, storage capacity, memory, and back-panel
jacks on a PowerBook are almost exactly the same as those on regular Macs but they're crammed into a book-size case that weighs four or six pounds and
conceals dirt. You can get PowerBooks with grayscale or color screens, often
for less money than you'd pay for a regular Mac (hereafter called a desktop Mac).

In fact, working on a PowerBook is so much like working on a desktop Mac that
a separate chapter is almost unnecessary. Almost. But a few weirdnesses remain,
largely pertaining to this diminutive Mac's screen, battery, and portable nature.

PowerBook Care and Feedin9
Sleep is 9ood. We like sleep.
Do you have a PowerBook? Don't tell me you shut it down at the end of each day!
Yes, alas, thousands of people shut their PowerBooks off unnecessarily each
day or - horrors! - even more than once a day. Don't do it!
Instead, put your PowerBook to sleep - that is, choose Sleep from the Special
menu when you finish using the machine. The thing instantly blinks off. (Other
ways to make a PowerBook sleep: If you have the Control Strip, click the Sleep
Now icon; if you have SuperClock! in your menu bar, Control-click the battery
icon; if you have a Duo, a PowerBook 190, or a PowerBook whose number starts
with a 5, just close the lid!)
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Sleep mode is almost like Off mode. You're not using the battery; nothing
_ ~ moves; all is calm; all is dark. But the advantages of letting a sleeping
I · ·- PowerBook lie are considerable. For example, when you want to use it again,
you can just touch any key to wake it up. And when the thing wakes up, it
doesn't go through the usual 45-minute "Welcome to Macintosh" startup
process - instead, it takes you right back to whatever you were doing. If you
were typing up a letter, you wake up to your half-finished letter, still on-screen.
Great time savings.

"

You don't have to shut your PowerBook down for travel, either. The only time
you need the Shut Down command is when you'll be storing the PowerBook for
more than a couple of weeks. (You also have to shut it down whenever you plan
to attach any major equipment to it, such as a scanner or a monitor. Most
smaller attachments - printers, modems, microphone, speakers, a keyboard, a
mouse, and so on - can be attached when the machine is sleeping.)

BatterlJ. positifles and ne9atifles
Of course, it's perfectly possible to work for years on your PowerBook with its
power cord firmly attached to the wall outlet, happily ignoring its capacity for
running on battery power. Plenty of people do just that - people who bought a
PowerBook for its compact size, not because they travel on airplanes a lot.

. . : ~*~ .\lVh~n ypu pu~ yo!lt ,
·.. doesn't go right·· off~t(>
dreamlarid.?"lnstead;it gives .YPP>a.· gaofY ·niesf ~"""""""""""""""""""""""""-~
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.
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And that's perfectly OK. In fact, keeping your PowerBook plugged in whenever
possible is a great idea.
But if you do plan to use your PowerBook in the back seats of taxis, in hot-air
balloons, and on Grand Canyon promontories, you'll be running on battery
power. It's a strange feeling, running a Mac on battery juice; in no other circumstance do you hear time's hoofbeats so loudly at your back. (My editor just
winced.) Every time you move the mouse or type something, you worry that
you just unnecessarily sped closer to your battery charge's demise.
At the end of this chapter, you'll find out how to milk the most minutes from
each charge. Frankly, though, if you find yourself going crazy worrying over
your battery, the $90 for a second battery might be a worthwhile expenditure.
Aside from making it last longer, here are some fun and interesting battery facts
to help you better understand your little square gray electrovoltaic friend:
,,.,, Just so you know: your battery is recharging whenever the PowerBook is
plugged in.
,,.,, No laptop computer battery ever lasts even close to the number of hours
advertised. Not Macs, not IBMs, not any. You'll be lucky to get one hour
out of the standard "three-hour" battery. It's a fact of life. Or advertising.
Or something.
,,.,, You've heard, no doubt, about the memory effect. That's the biological
syndrome that makes you remember the plane tickets on the kitchen
counter exactly 15 minutes into the drive to the airport.
When applied to PowerBook batteri~, however, the memory effect is a bit
more technical. As with camcorder batteries, it results from repeatedly
using only half of a battery's charge, then charging it full again. Eventually,
the poor little battery forgets where its actual empty point is, and comes to
believe that the halfway point is its completely-empty place - and
thereafter only holds half as much charge.
Curing a memory-effected battery is simple. To restore the battery to its
good-as-new, virginal, strong-as-ever condition, deliberately let it run down
to the ground. That's right - just keep your PowerBook on, not letting it
sleep; click OK every time a message appears, telling you that the battery
is running down. When it is truly depleted, charge it completely full.
,,.,, Even when your PowerBook is sleeping or completely off, your battery is
still slowly being drained. That's why you may return to your PowerBook,
which had had a full battery, after a couple weeks away, only to find the
battery half empty. Now you know.
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VI" If you bought your PowerBook in the last couple years, it has a funny little

floating doodad called the control strip. It looks like this:

Hide entire strip

AppleTalk

Battery

File sharing

Sound

Sleep
Power savings

End tab

You'll note, no doubt, the little battery gas-tank gauge. While wildly
inaccurate, this little gauge is the best indicator you've got as to how much
longer you can work on this battery charge.
This Control Strip, incidentally, has some other neat controls, as illustrated
in the preceding figure.
VI" Running out of battery juice at 39,000 feet with six hours to go before Paris

may be inconvenient, but it really doesn't endanger whatever you've been
working on. You get three warnings - increasingly urgent messages on the
screen - stretching over a 15-minute period. And then the PowerBook
goes to sleep. (It actually says, "Good night!" Isn't that adorable?)
Even if you hadn't saved your work, whatever is in memory is safely
preserved. Just plug your PowerBook in at the next opportunity, wake it
up, save your masterpiece, and get out to see the Eiffel Tower.
VI" PowerBook batteries are good for about 500 chargings. That, as well as

common sense, should be your cue to use the PowerBook plugged into the
wall whenever possible; You'll know when it's time to retire a battery when
it just won't hold a charge anymore. At that point, unless you've got some
psychotic grudge against the neighborhood raccoons, don't chuck this
lethal chunk of toxic chemicals into the garbage. Instead, return it to an
Apple dealer, who will send it back to Apple's battery-recycling program.

Trackball ickiness
A PowerBook works great with a mouse - when you're home at your desk.
Finding a place to lay down your mouse pad can be a challenge, however, when
you're using your PowerBook in a telephone booth or while whitewater rafting.
That's why the first generation of PowerBooks came with a trackball - that
little miniature billiard ball centered below the keyboard.
The trouble with the trackball is that every little glob of grease, fleck of lint, and
tuft of cat hair that ever encounters your fingers gets rolled down into the
trackball mechanism. The result, as any PowerBook 100-something owner can
tell you, is jerky, sticky cursor movement.

_____________ Chapter 16: The PowerBook Survival Guide

Cleaning the trackball is an essential skill. Rotate the collar around the trackball
firmly counterclockwise until you can remove it. Dump the ball into your hand
and set it someplace where it won't wind up rolling down into the metropolitan
drainage system. Place a piece of Scotch tape inside the hole, directly over the
little rollers inside the cavity. Use the index finger from your other hand and
gently press the tape against the roller. Now, just pull up on the tape. The tape
lifts the gunk off just like magic. Repeat this procedure, with a new piece of tape,
if necessary, on the other roller. Scotch tape also works great for cleaning that
saturated-fat film festival sitting invisibly on the trackball itself.
Incidentally- now you have some idea why later PowerBook models come
with a trackpad, the flat plastic square across which you can run your grubby
fingers from now until doomsday without introducing crud into your $3,000
computer's insides.

One Ula~ant~ that1s worth ertendin9
Just a word of advice about Apple's extended-warranty program, known as
AppleCare. In general, as with those ridiculous $600-a-year service contracts
they try to sell you with your $250 television, I don't believe that these contracts ever pay off. Macs in general are built like bricks.
It's different with PowerBooks. You carry them around, you put them to sleep
and wake them up, attach and unattach equipment constantly, shove them into
overhead racks, and set down your orange-juice glass on them. With this kind of
treatment, you would be more prone to failure, too. In short, I am firmly in favor
of getting AppleCare for a PowerBook.
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Halle Laptop, Mi9ht Traflel
OK. You've figured out how to work your laptop. Now you want to show it off somewhere other than your living room. Who can blame you? A few pointers,
if I may.

X-ralJ. machines anti IJ.OU
Airport X-ray machines can't hurt your PowerBook.
Airport X-ray machines can't hurt your PowerBook.

Airport X-ray machines can't hurt your PowerBook.
OK?

Desperate for a filf
Now look, I don't want to get angry letters from spouses and significant others,
blaming me for converting their beloveds into hermitic power nerds. What I'm
about to tell you should be socked away in the back of your mind and used only
in emergencies.
The tip is about airplanes and airports. You know that PowerBooks and airplanes were made for each other. What you may not know is what t~ do when
the dreaded "Your screen has been dimmed" message pops up, warning you
that you have only a few minutes of battery power remaining, while you're in
the middle of a brainstorm.
First of all, I happen to know that you can find power outlets at every gate of
every airport (and at every bus and train station, too). The outlets are there,
actually, for the benefit of the cleaning staff's vacuum cleaners; as such, the
outlets are sometimes concealed on the side of a pillar. l also happen to know
that the outlets are never convenient to a seat, so if your Mac habit is stronger
than your pride, you're going to have to sit on the floor.
What's more, l know what to do when you run out of juice on the plane. That's
right - I'm going to call to your attention the electric-razor outlet in the
bathroom of almost every plane in America. You feel like an absolute idiot, of
course, wedged in there on that toilet with your adapter cord snaking up to the
plug above the doll-size sink while your laptop recharges.
Well, that's what I've been told, anyway. Naturally, I would never do anything
that pathetic.
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Cursing the cursor
The screens on some of the less expensive
PowerBook models have a frustrating behavior
that's well known to their owners: the cursor
tends to get lost Because of the ever-so-slightlyblurry nature of those particular screens, moving the mouse too quickly makes .the pointer
submarine (fade out momentarily).
Here are two solutions. One is free, and the other
is, too.
First, get into the habit of designating a lost-andfound center for your pointer - the upper-left
corner of the screen. Whenever you can't find
Before

the pointer, roll your trackball or touchpad furiously to move the cursor up and le~ Sooner or
later, your cursor, wherever it may have been,
will bump up into the top-left corner of the
screen. (Reunited, and it feels so good.)
The second solution is software. From a user
group or an online information service (America
Online, for example), you can get a pointer-fattening program such as FixCursor. When you're
word processing, life's a lot easier with a fat
cursor, as you can see from this before-andafter shot
After

Roland puffed out his chest heroic8lly as
the beast's heed tumbled 10 the lll8Ible
flo or, snakes hissing and writhing.
"That's for YOU , Beast !" he cried as the
1hunder clapped.

Roland puffed out his ches t heroic8lly as
the beast's heed tumbled 10 the lll8Ible
floor, snakes hissing and writhing .
"That's for YOU , Beast!" he cried as the
1hunder clapped .

He would regret 1hose woros .

He would regret 1hose woros.

I

I

JnSUt-Printer
OK, so you bought the PowerBook. But what do you print on? Painful experience has demonstrated that few airlines accept a 45-pound laser printer as
carry-on.
There are portable printers, of course; they're generally expensive, fragile, and
slow. But I've got a better idea.
Get a fax/modem for your PowerBook. (You have to get it installed by a dealer
in older PowerBooks; newer ones, like the 190 and 5000 series, have a little slot
in the side into which you can stick a MasterCard-sized "PC card" modem.)
Thus equipped, just fax whatever-it-is that you want to print to yourself. For
example, fax it from the PowerBook, while sitting in your hotel room, to the
same hotel's front desk. Ingenious, eh?
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Mano a Mano with the Duo
If you bought a PowerBook Duo, you must've turned this four-pound beauty
over and over in your hands, mystified about where you're supposed to plug
stuff in. There's no place to hook up a monitor; there's no SCSI connector for
plugging in another hard drive; there isn't even a floppy-disk drive!

Then again, you don't need any of those items when you're sitting on an
airplane typing, and that's exactly the point of the Duo. When you want to travel
light, you can leave all the extra computer paraphernalia at home and carry
only a lean, mean typing machine.

The Duo trio
The Duo has one great big wide jack on the back. Any of three categories of
things can be attached to it:
Ill' A floppy-disk-drive adapter. Not a dock, mind you -

just a three-inch, darkgray, semicircular adapter, into which you can plug the external floppydisk drive and a keyboard and/or mouse. The adapter and the disk drive
probably cost $200 total.

Ill'

A MiniDock. This thing (about $400) looks like a three-ring hole punch. It
clips onto the whole back of the Duo to provide a complete array of backpanel jacks. You can use the MiniDock to hook up a big-screen color
monitor, keyboard, mouse, scanner, CD-ROM - anything (including the
floppy drive, of course). Clip the Duo to a MiniDock, and presto: you can
work merrily away as though the Duo weren't a laptop at all. Pretty cool.
Flip one lever, and the Duo itself is free of all that wiring and gear, ready to
nestle into your briefcase or carry-on bag.

Ill' The Duo Dock. This is the one that everybody's heard of -

a big,
computer-size housing that contains expansion slots, a floppy drive,
and every connector you can think of. When you come home from your
trip with the Duo, you slide the laptop into an opening in the front of the
Dock. The closed Duo gets slurped into the Dock like a videocassette.
You've just handed all your data- and the Duo's brain -to the machine
on your desk.

There are only two reasons to get the great big Duo Dock. First, get one if you
plan to use its NuBus slots inside. (Of course, that implies that you even know
what those slots are.) Second, the Dock can display a richer palette of colors on
whatever full-size screen is plugged into it. If you're into photo retouching and
digital art, well, OK, get a Dock.
In other words, you can get information into, and out of, a PowerBook Duo in
three ways:
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Y6 Use a floppy-disk drive.
Y6 Attach the Duo to a regular Mac, using the big, fat SCSI jack (and a special

cable purchased for that purpose).
Y6 Connect the Duo to another Mac, using the hidden printer jack described
next (in other words, network the machines).

The one real jack
Oh, by the way, there is one normal jack on the Duo itself. (You have to flip
down one of the Duo's little legs to see it.) You can use this jack to plug in either
a printer or a modem - precisely the two items that you'd need most on
the road.
So how does the Duo know which personality (modem port or printer port) its
sole jack is going to take at any given moment? The secret control is the
Chooser, which you can find in your ti menu. Open it. You'll see, in the lowerright, the controls to make Apple Talk active or inactive.
When AppleTalk is active, you can (a) use a laser printer or ( b) connect to a
network. For all other purposes, including (1) printing on a StyleWriter, (2)
connecting MIDI, digital cameras, a modem, or any other modem-port
attachables described in Chapter 12, tum AppleTalk off.

Top Ten Tips for Maximizin9 &tterlJ Power
Many new PowerBook owners are devastated to find that instead of getting
"two to three" hours of life out of each freshly charged battery, they get only 90
minutes or so. These excellent tricks solve that problem in a hurry.
1. The backlighting for the screen uses up half the power. The more you tum
backlighting down, the longer your battery will last.

2. I've actually heard PowerBook owners asking the airline gate agent for a
seat not merely next to a window but on a particular side of the plane. Now
I know why: they want to be where the sun will be shining. Bright sunlight
· is enough to illuminate a PowerBook screen, so you can turn the backlighting off.
3. Remember reading about the memory effect earlier in this chapter? Or did
you forget? (Get it?)
Anyway, as observed earlier, this fairly rare event can easily explain a lowcapacity PowerBook battery. Do the empty/recharge routine once a month.
4. Another enormous battery-drainer is your hard drive. Keeping several
metal platters spinning at 3,600 rpm would drain anyone's battery.
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It might seem silly to suggest that you try to avoid making your hard drive
spin, but actually it's possible. First, visit your PowerBook control panel
and set the slider to Better Conservation. This setting makes your hard
drive stop spinning sooner when it isn't really needed. Second, avoid
Microsoft programs, which make your hard drive spin constantly.
Finally, if you have the Control Strip, as described earlier, you can actually
force your hard drive to stop spinning - on cue. To do so, place the
cursor on the hard-disk icon, and choose Spin Down Hard Disk, as
shown here.

Suppose, for example, that you've been merrily typing away into
ClarisWorks for 20 minutes. The hard drive has been peacefully still. But
now you want to save your work. The drive spins into action, and your file
is saved.
Now, as far as you're concerned, the drive's work is done. But if left to its
own devices, the drive would continue to spin needlessly for another 15
minutes (or whatever period you've specified using the PowerBook
control panel). That's 15 minutes of hard-drive juice you can save yourself
by shutting the thing up, via the Control Strip, soon thereafter.
5. Every little appliance you attach to the PowerBook takes little sips from
each battery charge. That especially includes external monitors, keyboards, and mouse. And the speaker - if you're really fanatical about
saving juice, turn off the PowerBook's speaker (use the Sound control
panel or the Control Strip's volume control, and set the thing to zero).
6. Turn off Apple Talk - an incredible power drain that saps a half-hour of life
from your battery. To do so, choose Chooser from the S menu. In the
lower-right corner, make sure that AppleTalk Inactive is selected.
7. If you're not going to use the machine, even for five minutes, put it to
sleep. (Choose Sleep from the Special menu, or use the little Zzzzzzz icon
on the Control Strip.)
8. If you have any PowerBook model numbered 160 or higher, open the
PowerBook control panel and click the Options button. You may have two
extra battery-saving options: Processor Cycling and Processor Speed. These
options slow the Mac's brain, but they do eke out a few more precious
minutes of battery juice per charge.
9. If your PowerBook has a built-in modem, quit your modem program
promptly when you finish telecommunicating. Otherwise, as long as that
program is open, the Mac is sending juice to the modem.
10. Virtual memory uses lots of battery juice. It's great when you're plugged in,
but avoid it when you're on battery power. (To turn off virtual memory,
choose Control Panels from the S menu; double-click Memory; and click
the virtual memory Off switch.)

Chapter 17

The Power Mac PowerChapter
Jn This Chapter
l\ll> What a Power Mac is
~ How to tell if yours is a Power Mac
~Weird things about Power Mac software
~ Nursing your Power Mac's inner child

A

Power Mac looks exactly the same as the Computer Formerly Known As
Macintosh. It costs exactly the same. It works exactly the same. You can
plug exactly the same things into it. In fact, the only difference between a Power
Mac and a Wimpy Mac is that it's a completely different computer.

By that I mean that the actual chip inside - the processor, as it were - even as
it weren't - has been replaced. The new one is capable of far faster speeds
than its predecessor processor. It's as though, in the middle of the night,
someone snuck into your garage and replaced the engine in your Honda Civic
with one that runs on nitroglycerin instead of gasoline.
This additional speed means two things to You, the Computer Owner: (1) speed
and (2) new features made possible by speed. You get to read all about these
new features in this chapter.
And, by the way, not every Power Mac is actually called a Power Mac. The
Power Mac Performas aren't called Power Macs. Neither are the Power Mac
·' PowerBooks, which would be way too awkward to talk about if they were called
"Power Mac PowerBooks." In fact, there's only one quick way to know if your
particular computer houses the terrifying raw power of the Power Mac processor chip: by the number of digits in its name. If four numbers are in your model
name - the 5300, 6115, 7200, whatever -we're talking Power Mac.

~
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Get to Know Your Chip
Let's continue, if we may, with that Honda-on-nitroglycerin metaphor. You can
probably figure out that feeding your Honda regular gasoline wouldn't give you
much of a speed boost; only when given its preferred Nitro Hi-Hi-Hi-Test fuel
would you be ready for the Indy 500.
In the same way, when you're using your old software, which was originally
written for the Wimpy Mac, your Power Mac doesn't run one iota faster! In fact,
traditional software on a Power Mac is likely to run slower than it would on a
run-of-the-mill Mac. (It's nice that those older programs run at all on a Power
Mac, however.)
Therefore, when you get a Power Mac, you need to adjust your shopping habits
so that you buy largely software with "accelerated for Power Macintosh"
stamped on the box. A few other synonyms for that unwieldy phrase:

,I.

PowerPC native (PowerPC is the official name of that new processor chip
described above)

"""' Power Mac version
"""'Fat binary

This last term, fat binary, may conjure up the image of an overweight programmer. However, it actually refers to a program that contains, within its single
icon, both the Power Mac and Wimpy Mac versions. If a program is fat binary,
you can run it on either kind of Mac. (A PowerPC native program, on the other
hand, won't run at all on a Wimpy Mac.)
Now, those of you who paid several thousand dollars for your top-of-the-line
Quadras and PowerBooks probably don't appreciate my constantly referring to
them as Wimpy Macs. Therefore, let me lay on you the official technoid term for
non-Power Mac Macs: they're known as 680x0 machines, named after the
processor chip inside them. You'd never guess it, but 680x0 is pronounced
"sixty-eight thousand."

Weird Thin9s about Power Mac So~ware
Two things will strike you as peculiar about "accelerated-for-PowerPC" programs. First, they require an obscene amount of memory to run. You won't fully
appreciate the nuances of managing memory until you've read Chapter 18. But
even now you can probably appreciate that Microsoft Excel requiring 11 megs
of memory (as it does on a Power Mac) is less desirable than Microsoft Excel
requiring 4 megs of memory (as it does on a 680x0 Mac).
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The second weird thing is that Power Mac programs also take up far more disk
space than their 680x0 counterparts. That's why Power Macs come with bigger
hard drives than regular Macs.
You can't do anything about the disk-space problem. You can, however, do
something about the memory problem. Here's how you strip Power Mac
programs' memory appetite back to decent levels. (I confess that the following
material is about 100 times more technical than you probably like, but steel
yourself - it'll be worth it.)

1. From your .t menu, choose Control Panels.
2. In the window that appears, double-click the icon called Memory.

3. Turn on Virtual Memory, as shown here:

••
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Cacheo Siu

Alwai,is On

.............................. .......... .

I

~

Mod•rn M.morv Manager
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Oo"
S•ltot Hard Disk:

!=cabinet

4. Now, using the little up-and-down arrows, change the number to represent one higher than your machine's actual RAM.
So if your Power Mac has 16 megs of RAM, change the virtual memory
number to 17. If you can't remember how much RAM your Mac has,
choose About This Macintosh from your .t menu and check out the BuiltIn Memory figure (ignore everything after the comma).
5. Restart your Macintosh.
When your Mac reawakens, several fascinating things will have taken place.
Your Mac will now be using virtual memory, which is described further in the
next chapter, but which, for now, you can think of as a way to use hard-drive
space as extra memory. As a result, you'll also notice that your hard drive is
suddenly fuller than it was, to the tune of whatever number you chose in
step 4 above.
And that's OK, because the third thing you'll notice is that your Power Mac
programs at last require non-freaked-out amounts of memory. That out-ofcontrol Excel program will now run in only 5 megs of RAM instead of 11, which
means far fewer "out of memory" messages brightening up your day.
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Finally, just to answer the inevitable question: the documents you create with
Power Mac-native and 680x0 versions of programs are the same and can be
freely exchanged among Macs of all denominations. Only the programs come in
different versions.

Top Ten Unit(ue Pou/er Mac Features
In addition to being fast - at least when it's running PowerPC-native programs the Power Mac also possesses a few personality quirks and multimedia goodies
made possible by its high horsepower. (Some of these features work only on
desktop Power Macs, not Power Mac PowerBooks. And a few work on the old
Quadra AV models.)
1. Speech Recognition - Yes, that's right, these machines take spoken
orders. All you need is an Apple microphone, some free software (which
you probably already have), and the instructions provided in Chapter 14.

2. MegaPhone - Your Power Mac would take the prize in the Multimedia
Talent Show with this act: it can actually function as an answering machine, fax machine, and speakerphone. The software for these stunts is
called MegaPhone, and it works great. For example, unlike a real speakerphone, MegaPhone lets you talk without cutting off the sound of the other
person's voice. Furthermore, each answering-machine message gets saved
onto your hard drive as an individual double-clickable icon, which makes
saving, sorting, or trashing messages really easy.

However, MegaPhone requires a GeoPort pod, described next; an Apple
microphone; and a Power Mac that you're willing to leave on all day and
all night.
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3. GeoPort - See Chapter 10 for details on this imitation modem, known by
insiders and sci-ti fans as The Pod. Your Power Mac has a specially
formulated modem jack in the back that can accommodate the pod,
making possible all kinds of nifty telephone-related fanciness, described in
item 2 and in Chapter 12.
4. CD-quality sound -A Power Mac has souped-up sound circuitry that can
record and play back at incredible quality. This feature may not mean
much to you now, but just you wait: one of these days, your boss is going
to lean into your office and bark, "l need a compact disc of birdsong
recordings - NOW!"
5. Get Info message - Highlight a Power Mac application's icon and choose
Get Info from the File menu. At the bottom of the Get Info window, you'll
see a message about turning on virtual memory (and how much real
memory you'll save as a result). In other words, the Mac is trying to tell
you to follow the ingenious memory-saving steps outlined earlier in "Weird
Things about Power Mac Software."
_ ....,,, Microsoft wonUilfil
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6. SoftWmdows - SoftWindows is a program that lets your Power Mac run
Windows, which, if you hadn't heard, is the Microsoft program that makes
an IBM-type computer more closely resemble a Macintosh. The effect isn't
nearly as smooth nor as easy to use as a real Mac, but some people require
programs that are available only for Windows and not for the Mac. Using
SoftWindows (which requires a Power Mac) is one solution; although it's
slowish, it lets your Mac be either a Mac or a PC clone.
7. Special RAM chips - Bandy these terms around at your next cocktail
party. Whereas a traditional Mac's memory chips are installed on little
circuit boards called SIMMs, the Power Mac requires a special new format
called DIMMs.
There now. Wasn't that refreshing?
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8. PCI slots - Yes, the terminology's flying thick and fast now.
All Power Macs released in 1995 and later have special connector slots
inside that accommodate something called PC/ cards - circuit boards that
add certain new features to your Mac, like super-fast graphics display,
high-powered networking, or professional movie-making smarts. All
previous Macs had similar slots. But they were called NuBus slots, took
only NuBus cards, cost more, and were slower.
You are perfectly forgiven if you couldn't care in the least about slots. Join
the club.
9. Video input jack-A few of the fancier Power Macs, such as the 7500 and
8500, have a jack on the back into which you can plug your camcorder or
VCR. The point of this exercise is, of course, to let you create digital
QuickTime movies from your own home-movie footage. See Chapter 12
for details.
IO. Copland - By this time next year, trust me: you'll know all about Copland.
It will probably actually be called System 8; it's the successor to whatever
system folder you're currently using - System 7.5 or whatever.
This new operating system, which will run only on Power Macs, will offer a
list of new features and improvements longer than this book. Chief among
them, however, are speed and stability (it will crash less). It will also look
a lot cooler, and should finally shut up your friends who claim that
Windows 95 on an IBM-type computer is "just as a good as a Mac."
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Jn this part ...
I

J fow it's time to take the bull by the horns, the sword

V~y the hilt, the fish by the gms, and really take oft.
First, I bestow unto you Chapter 18, the Mother of All
Troubleshooting Sections. And then you'll find out where to
go from there, with your trusty Mac ever by your side.

Chapter18

When Bad Things Happen
to Good Machines
In This Chapter
f.9- The top ten problems that beginners encounter and how to solve them
f;li- The next ten after that
~ The next ten after that
~ A bunch of others

Introduction to Computer Hell
As a new computer owner, you probably aren't cheered up very much by the

fact that this troubleshooting guide is the fattest part of the book.
But let's face it: computers are appliances. As such, they have minds of their
own. And like other expensive appliances (cars, homes, pacemakers), they tend
to get cranky at the worst possible times.
Fortunately, several million Mac users have been this way before, and they've
already uncovered the most-common glitches. You'll find those glitches and
their solutions explained here. Again fortunately, most computer problems cost
you nothing but time.
Some computer glitches, however, also cost you some data (that is, your work).
Well, you've been told to floss if you want to keep your teeth; I'm telling you to
back up your work if you want to keep your data, job, and sanity. Saving your
work frequently and making backup copies minimize the number of midnight
sobbing sessions you'll have when your important projects vanish into what's
left of the ozone.
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Shootin9 IJ.OUr own troubles
What I'd really like to teach you is how to be your own Mac guru - how to
ferret out the cause of a problem yourself.
There are only a certain number of ways that a person can set up a Mac. The
variables are what model it is; how much memory it has; what printer it's
connected to; what's in its System Folder; what order you take steps in; what
program you're using; and how everything's wired together. When something
doesn't work, the object is to try changing one of those variables and repeating
whatever-it-is-that-dido 't-work.

A mild example
Example: Walter, a New Jersey tollbooth operator, tries to print out a picture he
made of a Maserati flying off the highway at high speed - but nothing comes
out of the printer. Flicking his earlobe, he wonders whether it's the printer that's
not working or the program.
To find out, he goes to his word processor, types TESTING TESTING, and prints
that. It works. Now he knows that the printer works fine; the problem is related
to the graphics program. Next, he successfully prints a different document from
the same drawing program. Therefore, he learns that the problem is with his
Maserati document, not the drawing program in general.
Do you see the point? He never learned what, technologically speaking, the
problem was. But he figured out where the problem was, and that's the first step
to working around it and getting on with your life.
Here, then, is a chapter full of typical snafus that typical Mac users encounter. If
you never need to refer to this section, the gods smile on you - but read it
anyway, to find out how lucky you really are.

About the cookbook
It turns out that about 90 percent of the things that go wrong with your Mac can

be solved using the same handful of troubleshooting steps. To save you reading
and me writing, I've consolidated them all at the end of this chapter. As you
read through this chapter's symptom-by-symptom listings, I'll refer you to one
or another of those steps.

_________ Chapter 18: When Bad Things Happen to Good Machines

The most common cause of troubles that need shooting
Get used to the computeristic-sounding word

extension.
An extension is a little file in your Extensions
folder (which is inside your System Folder). Each
extension adds a specific new feature to the
Macintosh: a screen saver, fax capability, and so
on. You know those little icons that march across
your screen when you turn on the Macintosh?
Those are your extensions.
An extension runs all the time; it's like a program
that you can't quit. It gets launched when the
Mac turns on, and it's running in the background
during your entire work day.

But the people who wrote the After Dark screensaver program, for example, have never even
met the programmers who wrote the FaxPlus
faxing extension, let alone figured out how to
make their two little programs coexist. Suppose
you have both After Dark and FaxPlus in your
Extensions folder. Also suppose that each little
extension program, in the background, simultaneously reaches for the same morsel of electronic memory.
"Sorry, a system error occurred."
In other words, extension conflicts (the technical term) are among the most-common causes
of problems on the Mac. You'll find the solution in
this chapter.

The Mac Freezes or Crashes
There are two scary conditions that are enough to make even semipro Mac
jockeys swallow hard. The first of these conditions, a system crash, occurs
when the following message appears on the screen:

Sorry, a system error occurred.
"Finder"

unimplemented trop

Your current work session is over, amigo; you have to restart the computer.
(Safest way to restart is to press the Restart switch, as described in "The
Restart switch" at the end of the chapter.) Anything that you've typed or drawn
since the last time you saved your work is gone.
A System freeze is different - and, as horrific computer nightmares go, it's
preferable. You get no message on the screen; instead, the mouse cursor freezes
in place. You can't move the cursor, and nothing that you type changes anything. The Mac, as far as you can tell, has silicon lockjaw.
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Escapin<J. a Sv.stem freeze ri9ht now
First resort: Try the amazing "Force Quit" keystroke, 88-0ption-Esc (see "The
amazing 'Force Quit' keystroke" at the end of this chapter). That should get you
out of the locked program, at least.
La.st resort: If the Magical Force-Quit Keystroke doesn't work- and sometimes
it doesn't -you have to restart the Mac. This time, see "The Restart switch" at
the end of this chapter.

Escapin9 repeated Sv.stem
freezes and crashes
Ninety percent of the time, freezes and crashes are related either to memory or
to extension conflicts.

First resort: Increase the amount of memory allotted to the program that you
were using, as described in "Giving more memory to a program" at the end of
this chapter. Give the program 150K more, for example.
Second resort: Something, or several somethings, are clashing in your System
Folder. See "Solving an extension conflict" at the end of this chapter. If you're in
a hurry to get your work done and can't take the time, just restart your Mac
while pressing the Shift key. That turns all extensions off.
Third resort: Maybe one of your programs is either (a) buggy or (b) out-ofdate. The first problem is likely if you're using Microsoft programs; the second
problem is likely if you have recently upgraded something -your Mac or your
System Folder version, for example. You can't do anything but contact the
software company and hope for the best.
Fourth resort: You may have a SCSI conflict on your hands, especially if more
than one external gizmo is plugged into your Mac. See "Solving SCSI nightmares" at the end of this chapter.
Fifth resort: If nothing so far has stopped the crashes, some weird memoryrelated thing may be going on under the hood. Some programs are allergic to
virtual memory, for example; so your second step should be to turn off Virtual
Memory (open your Memory control panel, and click the Off button). Or, if you
have a Power Mac, try turning virtual memory on. And if you're advanced
enough to know what 32-bit addressing is, go to the Memory control panel and
turn it off, if your Mac lets you. A lot of older programs break out in puffy hives
when that is on. (But a lot if newer programs shriek if it's off.)
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Last resort: If the crashes still haven't stopped, something in your System
Folder may be gummed up. You're in for a 20-minute, but very effective, ritual
known as a clean reinstall of your System Folder. For instructions, see "Performing a 'clean system reinstall"' at the end of this chapter.

Error Messa9es
Let's start the troubleshooting session in earnest with a few good old American
error messages. Yes, kids, these are the '90s equivalent of "DOES NOT COMPUTE." These are messages, appearing in an alert box like the fictional one
shown here, that indicate that something's wrong.

R serious and mysterious problem has
deueloped, deep inside your computer where
you'll neuer get at it.

([

OK

JJ

''Application not found"
First resort: Not everything in the Mac world is meant to be a plaything for
you; the Mac reserves a few files for its own use. If a thing came with your Macthe Scrapbook file, the Clipboard file, and so on -you at least get something
when you double-click its icon. The Clipboard file opens into a window where
you can see the most-recent stuff that you copied; the Note Pad file automatically launches the Note Pad desk accessory; and extensions or control panels at
least identify themselves (by means of a message on the screen, such as
"System Extension: This file adds functionality to yqur Macintosh'').
But if you double-click an icon that belongs to non-Apple software - any icon in
the Preferences folder, for example, or various other support-file icons for nonApple stuff -you'll just get a beep and an unhelpful error message.
That's what's going on most of the time. (Review Chapter 8 for more information on double-clicking things in the System Folder.)

Second resort: Every now and then, you'll double-click a file that you created
and still get the "Application not found" message. Refer to Chapter 3, where you
learned about programs and the documents that they produce (like parents
and children). In this case, you're trying to open a document (child), but the
Mac can't find its parent (the program used to create it).
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So if you double-dick a ClarisWorks document, but the ClarisWorks program
itself isn't on your hard disk, the Mac shrugs and asks, in effect, "Yo - how am I
s 'posed to open this?" To remedy the situation, reinstall the missing program
on the hard disk.
Third resort: Sometimes, you get the "Application not found" message even if
you're sure that the document's parent program is on the disk. (You doubleclick a ClarisWorks document, for example, and you're told that the application ClarisWorks - can't be found, even though it's sitting right there on the disk in
plain sight!)

In a situation like this, the Mac's genealogical gnomes have become confused:
the computer has lost track of which program is associated with which kinds of
documents. Don't ask me how such confusions happen; just rejoice that the
problem is easy to fix. In the words of Mac gurus everywhere, "You gotta rebuild
the Desktop."
For instructions, see "Rebuilding the Desktop file" at the end of this chapter.

La.st resort: There's one more circumstance under which you'll get this
message: if you try to open a generic text or graphics file that's not associated
with any particular program.
(Sigh.) Yes, I know, this contradicts everything you've learned about programs
and documents being like parents and children. But suppose that someone who
isn't sure which brand of word processor you own wants to give you a memo
that she wrote. The smart thing would be for her to give you the memo in textonly format: a generic, no-frills, raw-typing format. Text-only format is a text file
or, as the weenies say, an ASCII (pronounced ASKie) text file. No matter which
program was used to create this file, any word processor (even on non-Mac
computers, for that matter) can open it.
A text file, however, isn't double-clickable. (Actually, the Mac generally offers to ·
open a text file with SimpleText, but just pretend that I have a point here.) To
read the file, launch your word processor first, and then choose the Open
command from the File menu (below, left).
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The usual list box appears, and you'll see the text file listed there (previous
illustration, right). Double-click to open it.
The same applies to generic graphics documents. These files, in technicalsounding formats like PICT, JPEG, and GIF, can be opened by almost any
program (America Online, for example, can open all three). Yet if you try to
double-click a generic graphics file, you'll be told, "Application not found."
Once again, the solution is to launch your graphics program first (America
Online or ClarisWorks or Photoshop, for example) and then open the file via
the Open command.

'~n error of Twe

1occurred11 or
"Bad F-Line lnstruction 11
These messages, the equivalent of a 1950s-movie computer saying "Does not
compute," convey nothing. They simply mean that something has gone terribly
wrong inside and that you have to start over.
Tum the Mac off and then on again, or use the Restart switch (see "The Restart
switch" at the end of this chapter).

As you've probably guessed, this message means that anything you typed and did not save - is gone forever. Reality bites.
If you get a lot of these messages, however, it's time to wonder why. The Mac is

not supposed to crash a lot!
Without question, the problem is your extensions. As you read at the beginning
of this chapter, having the wrong mix of extension files inside your System
Folder is an invitation to conflicts and problems. At the end of this chapter,
you'll find a section called "Solving an extension conflict," which shows you
how to determine which ones are responsible for ruining your life. And if you're
getting a lot of these error messages, you may need to perform a clean install of
your System Folder; see "Performing a 'clean system reinstall"' at the end of this
chapter.

"SorrlJ., a S1J.stem error has occurred11
See "The Mac Freezes or Crashes" at the beginning of this chapter.
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''Math coprocessor not installed"
The "no co-processor" message is almost never accurate - almost every Mac
made today has a math co-processor chip (a floating point unit, FPU, described
in Appendix A), yet this message sometimes crops up anyway.
The "no co-processor" message can appear whether your Mac has an FPU or not.
It's just another generic system freeze message, which you should handle the
way you'd handle any other system freeze; see "The Mac Freezes or Crashes" at
the beginning of this chapter.

"You do not hafle enou9h access priflile9es11
First resort: Wow, does this message make people mad. "Not enough access
privileges!?" they scream. "It's my damed computer!"
Right you are. If you have a Performa or System 7.5, however, your darned
computer has a useful feature that can actually save your Mac from the marauding
actions of children or ignoramuses. This feature is called Protect System Folder.
Choose Control Panels from your S menu. Open the control panel called
General Controls (on a Performa, it may be called Performa). There, you'll see
the on/off switch for this System Folder protection business. You'll see a similar
checkbox for protecting your Applications folder, if you have one.
How, you may well ask, does this feature protect anything? All it does is prevent
you from moving any of the icons in your System Folder. You can't throw them
in the Trash; you can't put them in folders; you can't, in fact, do anything that
would mess up your Mac.
If you try, you'll be told -yessirree - "You do not have enough access privileges." If you really do want to move something out of your System Folder or
Applications folder, open the control panel again and tum off the Protect feature.

Last resort: If you don't have a Performa or System 7.5, there's only one possibility: you are, or have been, connected to another Macintosh (in the lingo,
networked). Which means that in theory, you have remote-control invasion
rights to somebody else's computer. Which means that in theory, the somebody
else probably protected his stuff from over-the-network pillaging. Which
ultimately means that sure enough, you don't have enough "access privileges"
(or permission) to root through that other Mac via network.

''Not enou9h memorlJ to open ClarisWorks11
See "Out of Memory," later in this chapter.
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''Application has uneJtpectedllJ. t(uit11
You're probably out of memory. Again, see "Out of Memory."
Even if your Mac has plenty of memory, however, the individual program that
just "unexpectedly quit" may not have enough memory allotted to it. To find out
how to give your program a more generous helping of memory, see the section
at the end of this chapter called "Giving more memory to a program."

"The disk is full"
This means that the disk is full.
You'll have to make some more room. From the Application menu (at the topright comer of your screen), choose Finder. Root through your files, find some
things to throw away, and drag them to the Trash can. Don't forget to empty the
trash (by choosing the Empty Trash command from the Special menu). See
Chapter 8 for some good ideas for stuff to throw away.

Can 1t emptlJ. trash 11

11

First resort: A locked file is probably in the Trash can. Press Option while
choosing Empty Trash from the Special menu.
Second resort: You may be trying to throw away a document that you're still
working on. Or maybe the Mac just thinks that you're still working on it. Be sure
that the file isn't open on the screen. Sometimes, you even have to quit the
program you were using before that document is considered to be trashable.
Third resort: Maybe the Mac has become confused about the trashability of
some file in the Trash. Restart the Mac and try again.
La.st resort: About once in every Mac user's life, the Mac gets so confused that
it simply will not empty the Trash, even if you've tried all the logical things.
In this case, it's your System Folder that's having the psychotic break. The trick
is to start up from some other System Folder - the handiest of which comes on
your all~important Disk Tools (or Utilities) disk. (Or, if your Mac came with a
system-startup CD-ROM disc, use that.) This special startup disk comes with
every Mac ever made, so you can't claim helplessness on this point.
Turn off the computer. Put Disk Tools (or Utilities) into the disk drive. Then turn
the Mac on. When the computer is running, you should at last be able to empty
the Trash.
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'~n error occurred while

writing to the disk11

Something went wrong while you were trying to save a document - probably
your disk was full, or it's a flaky floppy disk. (See "Floppy-Disk Flukes," later in
this chapter, for more information on flaky floppies.)

"Microso~ Word prefers

20!J8K of memorlJ..

2000K is aflailable 11
Once again, you're out of memory. The Mac will give you the chance to launch
the program anyway - but it'll run slowly and may crash if you get too ambitious with your work. See "Giving more memory to a program," at the end of the
chapter, for a more lucid explanation.

Numbered error messages
This may strike you as hard to believe, but the numbers in some error messages (Type 11, Type 3, Error 49, and so on) are no help at all. They're valuable
only to programmers, and even then not very. For example, a Type 1 error
means "bus error," a Type 3 is "illegal instruction," and Type 20 is "stack ran
into heap." Realllllllly helpful.
Of the 200 Mac error messages, only one lets you remedy the situation: -39,
which means that something's wrong with the disk (or the file you're trying to
work with is corrupted somehow). All the others are caused by the usual
problems: some program didn't have enough memory, or you had an extension
conflict, or your System folder needs re-installing.

Out of Memoru
As a service to you, the Tremulous Novice, I've gone this entire book without
even a word about memory management, which is a whole new ball of wax. I
hoped that you'd never need to think about it. Memory really becomes an issue
only when you get the message "There is not enough memory to open Word"
(or whatever program you're trying to open), and that's why you're reading
about memory in a troubleshooting chapter.

Your Mac has a fixed amount of memory. Think of the Mac as a station wagon.
You can pack it with camping gear, or you can pack it with your kid's birthdayparty friends, but probably not with both. Even if you manage to cram in the
kids and the gear, if you then try to cram in the dog, somebody in the family is
going to say, "There is not enough room to take Bowser."
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That's what the Mac is trying to tell you.
Each program that you open consumes a chunk of the Mac's limited memory.
You're entitled to run as many programs as you want simultaneously- the
Note Pad, the Calculator, your word processor, and so on - provided that they
all fit into the amount of memory your Mac has. If you try to open one too many
programs, you'll get that message about the dog. (You know what I mean.)

First resort: Quit protJ.rams
If you're told that you're out of memory, the easiest way out of the situation is
to quit one of the programs you're already running. (You quit a program by
choosing Quit from the File menu.) So if you're running Word and you try to
open ClarisWorks, and you're told that there's not enough unused (free)
memory, you'll just have to quit Word first.
YLA/4'.

Often, you may have programs running and not even know it. Remember that
-"' just because a program has no windows open doesn't mean it isn't running.
.~ When you're done working on something, did you just close the window, or did
you actually choose Quit from the File menu? If you didn't actually Quit, then the
program is still running, and still using up memory.
To get rid of that program, choose its name from the Application menu (in the
upper-right comer of the screen - to the right of the question-mark menu).
Then choose Quit from the File menu.
·

Second resort: Make the Mac iJ.itle hack
Quitting programs, of course, isn't a very convenient solution - especially if
having multiple programs open is part of what you're trying to do, such as
copying numbers from the Calculator to Word. Therefore, your next attempt to
solve the problem should be to make the Mac itself use less memory.
Yes, indeed, the Mac's own behind-the-scenes operations use memory like a
silicon hog- at minimum, System 7.5 grabs 2.5MB of your memory. H your Mac
has only 4MB to begin with, you can see why running out of memory can
happen easily.
Here are some tricks to make the Mac use less memory:

I

Y' Use fewer extensions. The little auto-loading programs whose icons

appear across the bottom of the screen when you start the Mac. Each
extension that didn't come with your Mac (screen savers, fax software,
virus checkers, and so on) eats up another nibble of your memory.
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Dark (3001<); Adobe Type Manager/ATM (SOOK or more); QuickDraw GX
(1500K or more).
And how do you tum off extensions? See "Solving an extension conflict," at
the end of the chapter.

me Sharing. Those of you who are advanced enough to be using
this complicated feature know who you are. March right up to that Control
Panels command in the S menu, young man or woman, choose Sharing
Setup, and click the Stop button. You'll immediately get back one-fifth of a
megabyte of memory.

1"" Turn off

And while you're shutting things off, open the Chooser (by choosing its
name from the S menu), and select AppleTalk Inactive, if it's not already
selected. Hyou have a laser printer, you've just killed your ability to print,
but if you have a StyleWriter you've reclaimed another one-fifth of a meg
of memory.
1"" Check your Disk Cache. This little gimmick is something that you can

blissfully ignor~ for most of your computing days ... until you start
running out of memory.
Suppose that you're innocently word processing, and you make some text
boldface. Because the word-processing program resides on your hard disk,
the Mac consults the disk to find out how it's supposed to create bold
type. This disk-reading business takes, say, one second. Hyou use boldface
a lot, those one-second disk searches are going to cumulatively slow both
you and your Mac.
Therefore, the Mac reserves a piece of memory, called the Disk Cache, just
for such frequent pieces of information. Now when you make text boldface,
the Mac consults the disk (taking one second), but it stores the "how-tomake-bold" information in the Disk Cache. The second time that you need
to create bold text, the Mac already knows how to do it; your text becomes
bold in 1/ioo second (because memory delivers information to the Mac's
brain 100 times faster than the disk does). Cumulatively, all the little tidbits
of information that the Mac stores in the Disk Cache give you quite a speed
boost.
The larger this piece of memory is, the faster your Mac will go. But there's
the rub: If you make this Disk Cache memory too big, you'll use memory
that you could be using to run programs.
Even if I've totally lost you, here's what to do when you're strapped
for memory. From the i menu, choose Control Panels, and double-click
Memory. Clicking the arrow, as shown below, makes the Disk
Cache smaller.
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This has been a long explanation for a small reclamation of memory, I know,
but it feels good to know what's going on behind the scenes, doesn't it?

Third resort: De(ra9ment lJ.OUr RAM
Sometimes, the Mac will appall you. Here it is, the equivalent of a whole roomful
of 1950s-style computers, yet it can't even add.
Here's the scenario. Your Mac has 5MB of memory, let's say. You know your
System uses l.SMB. And you're running Excel, which, in this fantasy, takes 2MB.
Then you try to launch ClarisWorks, which we'll suppose needs l .5MB of
memory. You get the out-of-memory message. How can this be? After all, the
System (1.5) and Excel (2) together use only 3.5 of your 5MB. There ought to be
l.5MB left over, right? What's going on?
Memory fragmentation is going on, if you must know. It works like this. At noon,

you start the Mac. Your memory usage looks like this:
Total Memory: 5 megs

free memory

System (1 .5)

Then, at 12:05, you open the Calculator. For this example, let's say that its
memory requirement is half a megabyte.
When you then launch Excel, your Mac's memory map looks like this:
Total Memory: 5 megs

System (1.5)
Calculator (.5)

(free)
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At 12:15, you close the Calculator. Your memory map looks like this:
Total Memory: 5 megs

(free)

System (1.5)

free (.5)

If you look at this last drawing, you'll see that you can't launch Claris Works
(which needs l.5MB) now because there isn't l.5MB of contiguous memory left!

Because of the sequence, you've inadvertently chopped your remaining
memory into two smaller chunks, neither of which alone can accommodate
ClarisWorks.
The solution to the I-know-I-have-enough-memory-to-launch-this problem is to
quit all your programs so that only the Finder is running and then launch all the
programs that are supposed to fit in your Mac's memory. This time, it will work.

Fourth resort: Get RAM Doubler
Here's a fascinating possibility for the RAM-shy Mac fan: buy a $50 program
called RAM Doubler.
RAM Doubler uses several potent, deeply technical tricks to make your Mac
behave as though it has twice as much memory as it really does. Most people
who try it love it. The rest get their money back!
The only fundamental understanding of RAM Doubler that you need is this: it
lets you run more small programs at the same time. It doesn't let you run one big
program that requires more real memory than you have.
So Billy Bob, who has a 4-meg PowerBook and who wants to run ClarisWorks
and Kid Pix at the same time, is made in the shade. He no longer has to quit Kid
Pix just to free enough memory to launch Claris Works. RAM Doubler lets him
keep both programs going.
Jenny Sue, however, wants very much to run Photoshop or Myst on her 4-meg
LC. She's out of luck. Those programs require about 5 megs of memory apiece.
RAM Doubler's double-memory tactics don't let you run any big programs that
you couldn't run before.
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Fifth resort: Use f/irtual memorlJ.
Here's another rather technical but interesting possibility for avoiding out-ofmemory problems. Fortunately, this solution lets you run programs whose
combined memory requirements add up to much more than your Mac should
be able to handle. Unfortunately, it requires you to learn a new term. Ponder
this trade-off for a moment; then read on, if you dare.
The new term is virtual memory. (Virtual means fake, as in "virtual reality.")
Under this scheme (unique to System 7 and later), the Mac attempts to use the
hard disk as emergency memory.
Suppose your Mac has 4MB of memory, but you want to run both LimerickWriter (which requires 2MB) and BrailleMeister (which also requires 2MB).
Because your System requires l.SMB by itself, you can see that 2 + 2 + 1.5 is
goi':1g to equal more than your 4MB.
If you were using virtual memory, though, the Mac would allow you to run both

programs simultaneously. Where would it get the extra 1.SMB of memory that it
needs to fit everything in? It would use an empty hunk of hard.<fisk space.
Read this slowly: When you're in LimerickWriter, the Mac stashes the excess
1.SMB worth of BrailleMeister information on the hard disk. Then, when you
bring the BrailleMeister window to the front, the Mac quickly feeds that l .SMB
worth of information back into actual memory, displacing the same amount of
LimerickWriter instructions (which, needless to say, it writes back onto the
hard disk). Each time you switch programs, the Mac juggles the overflow.
This switch doesn't take place instantaneously; that's a lot of information for
the Mac to shuttle back and forth between memory and the hard disk. (Maybe
it's time to reread Chapter 11/z, which describes memory and hard disks in
pulse-quickening detail.) In fact, you may have quite a lag when you switch from
one program to another. But a little waiting sure beats not being able to run
those two important programs at the same time.
For some mysterious technical reason, the amount of hard-disk space that the
Mac needs to perform this stunt isn't just the amount of pretend memory you
want to add to your real memory. That is, if your Mac has SMB of memory, and
you'd like your Mac to think that it has 8MB, you can't just set aside the difference (3MB) in hard-disk space. Golly, no. You have to allow a chunk of disk
space that's the size of all the memory, real and imagined - in this case, 8MB.
OK. All that having been said (and read), let's get to the actual process of using
virtual memory. Follow these steps:
I. From the .t menu, choose Control Panels; then double-click Memory.

The control panel appears, like this:

33 7

338

PartV: Becoming Your Own Guru _ _ _ __ _ __ _ _ _ __ _ __
Memo!Jl
Di sk Cache
Always On

Cache Size

Sel ect Hard Disk :
Virtua 1 Memory

1~ DOCU

@on

Available on disk: 10 M
Av ailable built- in memory : SM

Qoff

After r est•rt

ITQE[J

~

[ Use Oefoult s J
v7 .0 .I

See the Virtual Memory area? If not, your Mac isn't equipped for this
feature. (Some of the older ones aren't, including the original Classic and
the original LC.)
2. From the pop-up menu, specify the hard disk that you want the Mac to
use as its temporary fake-memory dumping ground.
If you have only one drive - the one inside your Mac - skip this step.

3. Using the little up- and down- arrows, specify how big you want that
virtual-memory file (on your hard disk) to be.
Remember: there has to be a chunk of empty hard-disk space that's big
enough to hold the total of your real memory and the extra, phony
memory that you'd like to have.
Don't create total memory more than double your real memory. If you
have 4MB of RAM, your total memory (including virtual) shouldn't exceed
8MB; things will get so slow as to be unworkable.
Oh, yeah: if you're going to set virtual memory higher than 8MB, you also
need to turn on the 32-bit addressing switch (if your Mac displays one in
the Memory control panel).
The Mac may tell you that your disk does not have enough room. Maybe
it's time to go on a cleaning binge.
4. When you're done with your virtual-memory setup, restart the Mac.

Last resort: Buv more
After a certain point, knocking yourself out to solve out-of-memory problems
reaches a point of diminishing returns. You get so worn out from workarounds
that they're not worth doing.
At that point (or much sooner), just spring for the $25 per megabyte and buy
more memory. You can get it from any mail-order company (such as Mac
Connection). You can install memory yourself, fairly easily, in some models.
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But installing memory in other models - like PowerBooks - is trickier and
requires some funky tools. Anyway, when you call a mail-order-company to buy
memory, tell them what Mac you have and find out what you'll need. Sometimes, the company will send you a how-to video, which is very handy- and
when you're done with it, you can use it to record Seinfeld.
Installing memory yourself can be easy as pie or hard as nails, depending on
your Mac model. For the fewest headaches, get someone (like your favorite
computer store) to install it for you.
Having lots of memory to kick around in is a joy. Your Mac runs faster, has fewer
crashes and glitches, and acts like a new machine. It's a situation that I heartily
recommend.

Startup Problems
Problems that you encounter when you tum on the Mac are especially disheartening when you're a new Mac user. It does wonders for your self-esteem to think
that you can't even turn the thing on without problems.

·No din91 no picture
First resort: Chances are very, very, very good that your Mac simply isn't getting
electricity. It's probably not plugged in. Or it's plugged into a power strip that has
an On/Off switch that's currently set to Off. Or (if it's a PowerBook) the battery
is completely dead; plug in the adapter for ten minutes before trying again.

Second resort: If you have a two-piece Mac, you normally turn the machine on
by pressing the triangle key on the keyboard. Maybe the keyboard isn't plugged
in. Check that.

Third resort: Here's another PowerBook possibility. It may be that the internal
circuitry known as the power manager has gotten drunk again. Unplug the
PowerBook and take its battery out. Let it sit like that for ten minutes. Then put
it together and try again.
Last resort: If none of those steps solved the problem, your Mac is as dead as
Elvis. Get it in for repair. But that's virtually never the actual problem.

Din91 no picture
If you hear the startup chime (or ding) but the monitor doesn't light up,
something's wrong with the monitor.
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dial is on the edge of the monitor. On a Classic, you have to use the Brightness
control panel.

Second resort: I don't mean to insult your intelligence - but is it possible that
you have a screen-saver program installed? (You know, like After Dark ... flying
toasters, all that?) Some Macs, like the 7200 and 7500, have a built-in screen
saver that kicks in after a few minutes.
To find out if a screen saver program is the cause of the current blackness, press
a key or click the mouse button. If the screen picture doesn't appear, read on.

Third resort: If you have a two-piece Mac, the monitor has to be (1) plugged
into the Mac, (2) plugged into a power source, and (3) turned on. (Not everybody realizes that the monitor has an On/Off switch.) Often, the monitor is
plugged into the AC outlet on the Mac itself; that's OK.
Last resort: Does your monitor require a graphics card? Some old models do.
(Of course, if your Mac needs a graphics card, you would have discovered this
problem the day you got your system.)

Picture, no din9
Every Mac makes a sound when it's turned on. In fact, even if you've set the
volume level of your Mac's speaker to zero (by using the Sound control panel),
you still get a sound when you start the Mac.

First resort: Look at the little speaker jack in the back of the Mac. If some kind
of plug is in it - some kid's Walkman headphones, a cord connected to a
stereo, or a pretzel stick - no sound can come out of the Mac speaker.

Last resort: There's a remote possibility that somebody, mucking around inside
your two-piece Mac, unplugged the speaker-wire cable. Find that person, yell
firmly into his or her nearer ear, and insist that the cable (inside the Mac) be
reconnected.

Four musical notes (or crash sound)
If you hear an arpeggio, a lick of the Twilight Zone theme, a drum or flute solo,

or a car-crash sound, something's seriously wrong inside the Mac (Apple's
sense of humor at work).
Fortunately, 50 percent of the time, you hear this sound just after installing new
memory. It means that one of the memory chips is loose or defective - something that you (or whoever installed the memory for you) can fix relatively
easily. And 40 percent of the time, it's a SCSI problem. Read on.
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First resort: If you've just installed or otherwise messed around with the
memory chips in your computer, that's certainly the problem. Reopen the Mac.
Carefully remove each memory chip and reinstall it, checking the little centipede legs to make sure that they're not bent. (Come to think of it, get someone
who knows what he or she's doing to do this.)
Second resort: The other common source of funny startup notes is a SCSI
problem of some kind. (Yes, I know that we haven't defined this in a while; for
instructions, see "Solving SCSI nightmares," later in this chapter.) For a quick fix,
just unplug any external hard drive or scanner from the SCSI jack (the very wide
one) in the back of the Mac, and try starting up again.
Last resort: If it's truly not a memory-chip or SCSI problem, call your Apple
dealer. This baby's sick.

A l{uestion mark blinks on the screen
The blinking question mark is the Mac's international symbol for "I've looked
everywhere, and I can't find a System Folder anywhere."
The blinking question mark means that your hard drive's not working right or that it's working fine, but your System Folder got screwed up somehow. In
either case, here's what to do.

First resort: After ten seconds of panic, turn the Mac off and try starting again,
or just press the Restart switch (see "The Restart switch," at the end of the chapter).
Second resort: Find a floppy disk with a System Folder on it. The best bet is the
white System disks (or the startup CD) that came with your Mac. The floppy
called Disk Tools or Utilities usually does the trick. Put it into the disk drive, and
turn the Mac on.
After you're running, find the program called Disk First Aid. Run it and use the
Repair button. About 40 percent of the time, Disk First Aid can repair your hard
drive.

Third resort: If the hard-drive icon still doesn't appear, read "Solving SCSI
nightmares," later in this chapter.
Fourth resort: Try zapping the PRAM (pronounced PEA-ram). See "Zapping the
PRAM," at the end of the chapter.
Last resort: If nothing has worked, and you still can't make your hard-drive
icon appear on the screen, your hard drive is sick. Call your local dealer or Mac
guru, and do not freak out - chances are very good that all of your files are still
intact. (Just because the platters aren't spinning doesn't mean that they've
been wiped out, just as your Walkman tapes don't get erased when the
Walkman runs out of batteries.)
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grab anything useful off the disk and may even help heal what's wrong with it.

Some crazlJ. pro9ram launches itself
eflerlJ. time IJ.OU start up
In the words of Mac programmers everywhere, "It's a feature, not a bug."
Inside the System Folder, there's a folder called Startup Items. Look inside it.
Somebody put a program or document in there.
Anything in the Startup Items folder automatically opens when you tum on the
Mac. This feature is supposed to be a time-saver for people who work on the
same documents every day.

Printin9 Problems
"Printer could not be opened" or
"Printer could not be found"
Fi.rst resort: These messages appear when you try to print something without
turning on the printer first (or letting it warm up fully). Tum it on, wait a whole
minute, and then try again.
Second resort: Of course, it may be that you haven't performed the critical
step of selecting the printer's icon in the Chooser desk accessory. (Even if you
did, the Mac sometimes gets a little feebleminded and forgets what you selected
in the Chooser. Just repeat the procedure.) See Chapter 5 for step-by-step
instructions.
La.st resort: Maybe a cable came loose. Track the cable from your Mac's printer
port all the way to the printer. (Important: make sure that it's really the printer
port, because the modem port looks exactly like it.) If it all seems to be firmly
connected, try replacing (1) the cable or (2) the little connectors.

Stlj.leWriter: Blank pa9es come out
It's your cartridge.
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First resort: Choose Print from the File menu. Click the Options button. See
where it says "Clean ink cartridge before printing"? Click that.

=S=ty=le=W=n=·t=e=r=ll=P=r=in=t=O=pt=io=n=s==========1.2
D~lean ink cartridge before printing
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Now try to print something normally. The StyleWriter will, in effect, blow its
nose before trying to print, just in case your cartridge nozzle has dried up and
clogged.

Last resort: If that didn't work, your cartridge is probably empty. Buy a new one.
To replace the old cartridge, pull open the front panel of the StyleWriter. Locate
the existing cartridge - a little black square thing. Lift the blue lever to release
the old cartridge, slip in the new one (after taking off the protective nozzle
strip!), and lower the blue lever to lock it in.

Stlj.leWriter: Paper jams
Some people gape in shock to hear that other people have endless paper
problems with a StyleWriter. Either yours works like a charm, or it doesn't.

First resort: The problem is your paper. Don't try to feed single sheets; put at
least 20 pages or so into the feeder. If it's a humid day, fan the paper stack to
separate the pages. Then resquare the pages and put them into the feeder.
Don't expect terrific results with stiff, textured, wedding-y envelopes, by the way.

Last resort: The problem is your feeder tray. On the left side is a sliding plastic
thingy. You definitely want to slide this paper-edge-aligner right up to the edge
of the paper stack. If it's too far away, the pages will tilt as they're pulled into
the StyleWriter. If it's too close, the StyleWriter will have a struggle pulling pages
through.

A million copies keep pourin9 out
This big-time hazard for novices has to do with background printing (see
Chapter 5). When you print something, nothing happens for a minute or two.
(The Mac is storing the printout behind the scenes so that it can return control
of the Mac to you.)
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PartV: Becoming Your Own Guru - - - - - - - - - - - - - - Trouble is, your first time at bat, you probably don't know what the delay is; all you
know is that the printer isn't printing. So you figure that you'll just try again. You
choose Print from the File menu again. Still, nothing happens. So you print again.
The thing is, the Mac is duly storing all your printing requests; at some moment,
when you least expect it, all those copies will start to print! To stop them,
choose Print Monitor from the Application menu (the tiny icon at the far right
end of your menu bar); select each document; and click Cancel Printing.

"Font not found, usin9 Courier'
This problem is unique to laser printers. Your document contains a Postscript
laser font (see Chapter 4 for excruciatingly detailed definitions), but the Mac
can't find the printer font file for the font that you're using. Find the printer font
(the file with the abbreviated name, such as FrankGothBol) and install it in your
System Folder.

Nothin9 comes out of the printer
Sometimes, the Mac fakes you out: it goes through the motions of printing, but
nothing ever comes out of the printer.

First resort: Go to the ti menu. Select Chooser. Click the icon for the printer
that you're using, and make sure that your actual printer's name shows up in
the list on the right side of the Chooser window. (This process is explained
more patiently in Chapter 5.)

Second resort: Is there paper in the paper tray, and is the tray pushed all the
way in?

Third resort: If you're using a laser printer: Alas, your document is probably
overwhelming the printer's feeble memory, and the printer is giving up. You can
try using fewer different fonts in the document. Try printing only a page at a
time. Or try using fewer downloadable fonts - that is, fonts that aren't built into
the printer (see #3 in "Top Ten Free Fun Font Factoids" in Chapter 5).
Fourth resort: If you're printing something complicated on your laser printer,
there may be a messed-up graphic. Programs such as FreeHand and Illustrator
are known for generating very complex, sometimes unprintable graphics. For
example, here's a graphic from FreeHand that won't print out:
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If you're printing a document that includes both text and graphics, try removing
your graphics and printing the same document. If it prints without the graphics,
you know where the problem is. Call the graphics-program company and
complain abrasively.

La.st resort: If your laser printer truly has run out of memory, you can usually
pay to have it upgraded with more memory. In the computer world, as always, a
little cash can surmount almost any problem.

PrintMonitor won 1t 90 aUlalJ.
If you're using the generally wonderful Background Printing option, described

in Chapter 5, you sometimes encounter the bizarro PrintMonitor program.
What's so baffling is that you never remember launching this program by
double-clicking. But there it is, listed in your Application menu. And sometimes,
it beeps at you, demanding some intervention on your part (such as when the
printer runs out of paper).
Anyway, you can't make PrintMonitor quit on cue. To make it really go away,
cancel any printing jobs that it's still working on (by clicking the Cancel
button), and then go to another program. Eventually, PrintMonitor should
disappear from your Application menu.

That stupid startup pa9e
Every time you tum on your laser printer, it prints a dumb startup page with its
own logo. This is an annoying problem, but easily fixed. See #8 in "Top Ten Free
Fun Font Factoids" in Chapter 5.

Finder Foul-ups
The Finder, you'll recall, is your home base. It's the Desktop. It's the Trash can
and icons and all that stuff. It's where you manage your files, rename them,
copy them - and sometimes have problems with them.

The Find command doesn 1t find a file
The Find command is pretty literal. Suppose you're looking for a letter called
Mr. Ted Smith. You use the Find command, and where it says "Find what,"

you type Mr. Smith, Mr.Ted Smith (see the missing space?), MrTed Smith
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(no period), or Mr. William Smith. In any of these circumstances, the Find
command will draw a blank. Try searching for smi, Mr, or any portion of the
letters that you're certain of. (Capitalization doesn 't matter.)
Of course, the problem may not be what you type in the "Find what" box. You
may have misspelled the name of the file itself - say, 1997 Salries - and no
matter how many times you search for the word salaries, the Finder will always
come up empty-handed.

You can't rename a file
The file is probably locked. Click it, choose Get Info from the File menu, and
deselect the Locked checkbox.

You can't rename a disk
First resort: I'm gonna take a wild shot at this one. Despite your supposedly
novice status, I'll bet you're using the Mac's networking feature. I'll bet you're
plugged into another Mac. Right?
It's true: if you're using this feature (known as file sharing), you're not allowed
to change your hard drive's name. You'd wreak havoc with the other people on
the network, who are trying to keep straight who you are. If you really want to
bother, open your Sharing Setup control panel and turn off file sharing. Now you
can rename your disk.
La.st resort: In System 7, you can't rename those really old, single-sided, 400K
disks. Period.

You dra9 a file into a window,
and the file disappears
You have to watch your tip, if you'll excuse the expression. When you drag an
icon, the cursor arrow's tip actually marks where the icon is going, not the icon
itself. What probably happened is that you accidentally released the icon when
the arrow tip was on top of a folder within the window, as shown here:
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All IJ.our icons show up blank
If you get zapped by the "generic icons" problem, where every document looks
like a boring blank sheet of paper, your invisible Desktop file has become
corrupted. See "Rebuilding the Desktop file," at the end of the chapter.

Flopp1J.-Disk Flukes
Floppy disks are cheap and handy and make excellent coasters. But when they
start giving you attitude, read on.

"File could not be copied"
This one's a pain, isn't it?

First resort: If you were copying a whole group of files, try dragging the
troublesome file by itself.

Second resort: Make a duplicate of the file (click it and then choose Duplicate
from the File menu). Now try copying the duplicate.

Third resort: If the unruly file is a document, launch the program that created
it. (If it's a Word file, for example, launch Word.) Now choose the Open command from the File menu, and try to open the file. If it opens, use the Save As
command to save it to a different disk.
Fourth resort: Eject the disk. Open and close the sliding shutter a couple
times. Manually rotate the round hub. Try again.

Fifth resort: Try inserting the obnoxious floppy into somebody else's Mac.
Leist resort: With a little expenditure, you can almost certainly retrieve the file.
The rescue programs are called things like 9i 1 Utilities and Norton Utilities.
These programs are listed in Appendix B, "The Resource Resource."

Mac keeps askinlJ. for a disk IJ.OU 1fle ejected
First resort: You probably ejected the disk by using the Eject Disk command in
the Special menu. In general, that's a no-no, precisely because the Mac will
continually ask for it.
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eject a disk by choosing the Put Away command from the File menu (or by
dragging the disk icon to the Trash can).

Last resort: Sometimes, even if you use Put Away, a ghost of the disk's icon
remains on the screen; the Mac keeps asking for it, and pressing 88-period
doesn't solve anything. In this case, you probably opened a file on that disk, and
it's still open. As long as something on that disk is open, the Mac won't forget
about the disk; it would be like canceling the space program while some
astronauts were in the middle of a mission.
Choose the program in question from the Application menu, and make sure that
you close all documents. Now you should be able to drag the disk icon to the
Trash can.

You can't 9et a flopplJ. disk out
First resort: Press 88-Shift-1. That should pop out the disk, even if you can't see
its icon.
Last resort: Use the paper-clip trick described in the sidebar "Dweebs' Corner:
Alternative disk tips" in Chapter 2.

"This disk is unreadable. Do
IJ.OU want to initialize it1 11
If it's a brand-new disk fresh out of the box, there is no problem. All brand-new
floppies are initially unreadable unless they have already been initialized. Go
ahead and click Erase, and follow the disk-naming process that the Mac takes
you through. But if it's a disk that you've used before, you certainly don't want
to destroy it.

First resort: Click Eject. No, you do not want to initialize (erase) the disk.
Second resort: Remember that there are three different kinds of floppy disks:
single-sided (400K), double-sided (SOOK), and high-density (1,400K). If you have
an older Mac (made before 1990), it may not have a high-density disk drive, and
you may be trying to insert a high-density disk that it can't read.
Actually, the situation is even more complicated than that. Another typical
problem: you insert a new SOOK disk into a high-density disk drive, go through
the usual "Initialize?" routine, and then discover that the disk won't work in
somebody else's old SOOK disk drive! Strange but true.
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In any of these cases, again, the main thing is that you do not give the Mac
permission to erase the disk. Just take the disk to a more modem Mac, rescue
the files, and bring them home on a kind of disk that your Mac can read.

Third resort: If it's a disk that you know contains data, and you have a disk
drive of the right type, something may actually be wrong with the disk. Eject it,
shake it around a little,.and try it a couple more times.
Fourth resort: Something may be wrong with your disk drive - not the disk
itself. To find out, insert the disk into another Mac's drive.
Hthere turns out to be a problem with your drive, the culprit is often dust and
crud. Some of my technoid friends say that it's dangerous (staticwise) to use a
vacuum or blower in the disk-drive slot, but I've actually rescued a disk drive or
two this way (and have never damaged one).

Fifth resort: Buy a recovery program, such as Norton Utilities.
Sixth resort: You're not trying to insert an IBM PC disk into your Mac, are you?
Hyou are (having read in the ads that any Mac can read a PC disk), give it up it's not that simple. You're going to need some special software, such as PC
Exchange (which comes with System 7.5) if you want your Mac to read PC disks.

Last resort: If the problem is not your disk drive, the disk is really broken.
Don't even erase it and reuse it: throw it away!
One occasional source of zapped floppies, by the way, is magnetic damage.
Just like an audiotape, a disk stores information by magnetizing tiny particles of
metal stuff. Hthe disk gets magnetized by accident, the metal particles get rearranged in some random pattern that the Mac correctly deems to be unreadable.
I know that this sounds crazy, but somebody has to put it into print: don't put
refrigerator magnets on your Mac. That hard disk inside the machine is, after
all, a disk, and magnets do to disks what gravity does to a watermelon dropped
at 39,000 feet.

Your flopplJ. disks don't hold the amount
that the1J.1re supposed to
It's true-you can't fit SOOK of information on an SOOK disk or 1.4MB on a
1.4MB disk.
The missing storage capacity is filled by an invisible file, present on every disk,
called the Desktop file. This file, which is the Mac's accounting department, is
described in more detail in "Error Messages," earlier in this chapter.
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up a lot more than that, you may have a bloated Desktop file; see "Rebuilding
the Desktop file," at the end of this chapter, for instructions on trimming it.

E11er1J.thin9's Slow
Of course, if your Mac has seemed too slow since the day it arrived, maybe you
just bought a model that's too slow for your demanding tastes. There's nothing
for it except to upgrade to a faster model - or, if it's a Power Mac, to make sure
you're using Power Mac-specific programs. See Chapter 17 for details.
But if the Mac has begun acting slower since you've owned it, something may
indeed be wrong.

First resort: After several months of using a Mac, it actually does slow down.
The problem is a bloated desktop file; the solution is described in "Rebuilding
the desktop file" at the end of this chapter.
Second resort: Choose Control Panels from your ti menu. Open the one called
Memory. Is virtual memory turned on? If so, you've accounted for at least some
of the sluggishnE75s·
Third resort: While still in your Control Panels window, open the one called
Views. Is "Calculate folder sizes" turned on? If so, turn it off; it's slowing down
the works.
Third resort: Just to be secure, read "Solving SCSI nightmares" at the end of
this chapter. A SCSI problem can also make your Mac act like it's on Sominex.
Last resort: If your hard drive is rather full, perhaps it needs to be defragmented.
See "Defragmenting your hard drive" at the end of the chapter.

Hardware Headaches
These aren't the most common glitches that you're likely to encounter, but
they're just as frustrating.

Mouse or trackball is jerklJ. or stick!J.
This problem is very common. Like children, mops, and mimes, a mouse does
its work by rolling around on the ground. It's bound to get dirty.
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To clean it, turn it upside down in your hand. Very firmly rotate the round collar
counterclockwise so that you can remove the trackball. (The idea is the same
on a PowerBook.) Dump the rubber or plastic ball into your hand, wash it off
under the faucet, and let it air-dry completely.
In the meantime, go to work inside the socket where the ball usually is. With
tweezers or something, pull out any obvious dust bunnies and hairballs. The
main thing, though, is those three little rollers inside the cavity: you'll probably
see stripes of accumulated gunk around them. With patience, a scissors blade
(or a wad of sticky-side-out Scotch tape), and a good light, lift off that stuff,
preferably making an effort not to let it fall inside the cavity. Keep turning the
mouse right side up and tapping it on the table to dislodge stuff.
When you put everything back together, both you and your mouse will be
much happier.

Douhle-clickiniJ doesn't Ulork
You're probably double-clicking too slowly, or you're moving the mouse a little
bit during the double-click process.

Cursor freezes on the screen
This is a System freeze or System hang. Read all about it in the "System Crashes
and Freezes" section, earlier in this chapter.
Then again, your mouse (or keyboard) cable may have come loose. Plug
everything in firmly.

NothiniJ appears when IJ.OU tlJ.pe
Frrst resort: Well, obviously, you can't just type at any time and expect to see
text appear. You have to be either in a word processing program or in a textediting area (for example, in a dialog box or in the little text-editing rectangle
that appears when you're renaming an icon).
Second resort: Check the cable between the keyboard and the Mac. Make sure
that it's very firmly plugged in at both ends. And make sure it's plugged into the
correct jack~ the one marked with a strange-looking, mangled F shape.
Incidentally, the keyboard and mouse cables are especially sensitive to being
plugged and unplugged while the computer is on. Be religious about shutting off
the Mac before plugging and unplugging the cables. (That's especially true of
SCSI cables. The same is not true of modem and printer cables, though.)
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The PowerBook or Duo modem
(or printer) won t work
1

This note applies only if you have certain PowerBooks, such as a Duo,
PowerBook 190, or a PowerBook 500- or 5000-something. These particular
laptops don't have a printer jack and a modem jack on the back, like all other
Macs; instead, they have one combo printer/modem jack.
If your laptop is equipped with a built-in modem, you wouldn't think there'd be

much problem. After all, your modem is built in, so you can use that single
back-panel jack for your printer. Soon you'll discover a bizarre and unfortunate
gotcha, however: you can't use a StyleWriter printer and your modem at the
same time! Each time you want to switch your Mac from one function to
another, you have to
1"

1

Open your PowerBook Setup control panel.

1" Choose Normal if you want to print, or Compatible if you want to use

the modem!

While we're on the topic of StyleWriters: when you visit your Chooser (in the
menu) and click the appropriate StyleWriter icon, you'll note that you're asked
to make a choice between two serial ports. One looks like a telephone, and the
other looks like a little printer:
Connect to :
,Q, <Serial Port>

Bf<5e::::ruI Port>

.

0

Which brings up a fascinating question. Your PowerBook only has one jack, so
which port do you select on the screen: the modem (telephone) or printer port?
I'll save you five minutes of experimentation right here: select the modem port.

Your monitor shimmers
Of course, I don't mean that your monitor itself jiggles; I mean the picture.
First resort: Your screen's being subjected to some kind of electrical interference, such as a lamp, a fan, or an air conditioner running on the same circuit.
Try a different plug, a different monitor location, or a different career.
Second resort: You're chewing something crunchy. Stop it.
La.st resort: You live in an earthquake zone. Move to the Midwest.
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There's a thin horizontal line all the
UltUJ. across IJ.OUr color monitor
Believe it or not, all Apple 13-inch color monitors show this faint line (it's about
a third of the way up the screen); the 16- and 20-inch models actually have two
of these lines. It's a shadow cast by a wire inside. Just grit your teeth and
remind yourself, "It's a Sony." (Sony make5 these monitors.)

The Problem-Solt1in9 Cookbook
OK- now you've read about everything that can possibly go wrong. This
section contains everything you can possibly do to fix the problem. Remember,
you'll almost never find out what caused the problem to begin with; just be
happy that the following techniques are magical in their ability to cure things.

Rebuildin9 the desktop file
The Desktop is a very important file on your disk. How come you've never seen
it? Because the Desktop file is invisible. (Yes, Mac icons can be invisible.
Remember that fact if you ever get involved in antiterrorist espionage activity.)
The file is something that the Mac maintains for its own use.
The Mac stores two kinds of information in the Desktop file: the actual pictures
used as icons for all your files; and information about the parent-child (program-document) relationships that you're having trouble with.
H the Desktop file becomes confused, two disturbing symptoms will let you

know: the "generic icon" problem, where all your icons show up blank white,
and the "Application not found" message that appears when you try to doubleclick something.
Another Desktop-related problem: over time, this invisible file gets bigger and
bigger; remember, it's having to store the pictures of every little icon that
crosses your Mac's path. And just because you throw some icon away after
using it doesn't mean that its image gets cleared from the Desktop file - it
doesn't. And the bigger your Desktop file gets, the slower your Mac becomes in
its efforts to open windows, display icons, and start up in the morning.
Resetting your Desktop file, therefore, has two delightful benefits. First, it cures
the generic-icon syndrome and the "application not found" problem (because it
re-learns the relationships between files and their pictures). Second, it makes
your Mac faster (because it purges all the unnecessary leftover icon images
from its invisible database).
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Rebuilding the Desktop file involves forcing it to unlearn the misconceptions
that are giving you trouble, and then to relearn the correct relationships
between documents and the programs that gave birth to them. Here's how you
do it. Turn the computer on. As it starts gearing up, press and hold the Option
and 3C keys. Don't let go. Keep them down until the Mac explicitly asks you
whether you want to "rebuild the Desktop." (Obviously, you should click OK.)
After that's done, your document double-clicking will work, your icons will
return, and your Mac, having been cleansed of all obsolete icons, will run faster
and more smoothly.

Zappin9 the PRAM
The PRAM is a tiny piece of battery-sustained memory. In this little area of
memory, the Mac stores several pieces of information even when the computer
is turned off: the clock time, your various control panel settings, choice of
desktop pattern, and so on. But when the PRAM memory itself gets corrupted, a
whole category of goofy problems can result.
First, turn off (or restart) your Mac. Then turn it on again, but hold down four
keys at the same time - 3C, Option, P, and R- and don't let go until you hear
the startup chime. (Afterward, you may have to reset your Mac's clock, desktop
pattern, and mouse settings by choosing Control Panels from your S menu and
opening the control panels called Date & Time, General, Desktop Patterns,
and Mouse.)

The amazin9 "Force Quit11 ke1J.stroke
Here's this amazing keystroke for escaping a frozen program: 3C-Option-Esc.
(This is about the only time that you'll ever use the Esc key.)
If it works, you'll get a dialog box that says, "Force [this program] to quit?" Click
Force Quit, and you exit the program that you were working in.

So what's the big whoop? Well, if you had several programs running, this
technique dumps only the one that you were working in - the one that
crashed. You now have a chance to enter each of the other programs that are
still running and save your work (if you haven't done so). Then, to be on the
safe side, restart the Mac.

The Restart switch
Every Mac has a restart switch. Sometimes, you'll find two buttons side by side
somewhere on the Mac's casing - and the one with a left-pointing triangle is
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the Restart switch. Sometimes, as on older PowerBooks, there are two little
back-panel holes that you're supposed to stick a pin into.
All the other models - especially recent ones - have a secret Restart switch;
you press Control, the SE: key, and the On button (or power key) at the same time.
In every case, pressing Restart is the same as turning your Mac off and then on
again, except that it doesn't suddenly send a wall of electricity thudding into
the machine's delicate electronics. Therefore, Restart is gentler to your Mac.
Keep the Restart switch in mind when you have a System freeze or crash.

Soli1in9 an extension conflict
OK, here it is - the long-awaited extension-conflict discussion.
See, each extension (a self-loading background program, such as a screen saver,
that you install in your System Folder) was written by a programmer who had
no clue what other extensions you'd be using. As a result, two extensions may
fight, resulting in that polite disclaimer "Sorry, a System error has occurred."
These things are easy to fix, once you know the secret. Shut off your Mac, and
then turn it on again. But as the Mac is starting up, hold down the Shift key, and
keep it down until (1) you see the message "Extensions off" or (2) you arrive at
the Desktop, whichever you notice first.
Your Mac probably won't give you trouble anymore - but now, of course,
you're running without any of your cute little extension programs. No screen
saver, no fax software, and so on.
If the point of this exercise is to pinpoint which extensions aren't getting along,
you have three choices. One is free but takes a lot of time. Another is easier but
only works if you have System 7.5-point-something. The third way costs $50 or
so but works automatically.
~

The hard way: Burrow into your System Folder to find the Extensions
folder, where these little guys live. Drag a few of their icons out of that
folder onto the Desktop; that's how you prevent selected extensions from
loading. You don't have to throw the extensions away; just take them out
of the System Folder and then restart the computer. (Use the Restart
command in the Special menu.)

If the Mac doesn't crash this time, you can pretty much bet that one of the
extensions you removed was the guilty party. If the Mac does crash again,
repeat the whole process, but this time take some more extension icons
out of the System Folder.

355

356

Part V: Becoming Your Own Guru _______ _________
Through trial and error, you eventually should be able to figure out which
pair of extensions don't get along. Sometimes, just renaming one so that it
alphabetically precedes its enemy is enough to solve the problem.
V'

The System 7.5 way: Use the same method given under "The hard way."
But instead of burrowing into your System Folder to tum off extensions,
try this. While the Mac is starting up, press and hold the space bar down.
Eventually, if you have System 7.5 or later, you'll be shown a complete list
of your extensions, like this:
B!i!®·

EHtenslon s Mana er

Sets:
v3D.2

UH this control ran.I to ttrn
off prob,.m•tic txttnsions so
you will b• ab1t to boo t !Jour
M~intosh cornctly .

I

Custom

Ext• nsions
V Conflict ExttnSK!n,...
V Dtsinfectant IN IT
./

... 1

•

Now Toolbox

RAM Doubler
V 7 .~.2 PrTiting fix
'w'wni09 : lncorn·ct ust of
V Applt CD-ROM
this control p1ntl mai,i c<1uH
./ Appl• Gulde
pr ob'k>ms Yith your M•cintosh . ./ AppltScript™

V Applt Shar eo
V CEToolbox
../Oiosktop PrinterEx t•nsion
V Duktop Prlnttr Spooltr
./ Dtsktop PrintMonitor
./ DiskDoubler 1M Findt r M•nu

Undo

./ Entr9y Sanr Exttnsion
./ FiltSharingExtension

He lp

./ FindFile Ex t t ns1on

./ FindtrSeriptir19 Extension
./ For.ti2!! Filt,t,ccHs

+

You can turn off selected extensions just by clicking their names. Figuring
out which specific extensions are causing your headaches is still trial and
error, but at least it's easier to switch them on an off.
V'

The easy way: Buy a program called Conflict Catcher. This program does
many useful things for managing your extensions, but its main virtue is
catching conflicts. It can figure out, all by itself, which extension (or
extensions) caused your Mac's problems. All you have to do is sit there,
restarting the Mac over and over, each time telling Conflict Catcher
whether or not the problem has been solved yet. By the time the process
is over, the program will emblazon the name of the errant extensions on
your screen; you then can dismember, disembowel, or trash them as you
see fit.
Conflict Catcher also lets you rearrange the order in which your extensions
load, simply by dragging their names around in a list. Oddly enough,
switching the order of your extensions often solves extension conflicts,
too.
(Tip: a free three-day demo version is available on America Online. It
lasts just long enough for you to figure out which extensions were driving
you crazy.)
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Solflin9 SCSI ni9htmares
I've tried to shield you as much as possible from the term SCSI and all that it
entails. But because it's a common source of trouble, it's time to put on the
overalls and get dirty.
If there's nothing attached to your SCSI jack in the back of the Mac (for example,
a scanner or a Zip drive), you have no SCSI problems, and you should skip this
entire section. You don't know how lucky you are.

What'sSCSIJ
They pronounce it "scuzzy," for some reason. Here on the East Coast, we used
to pronounce it "sexy," which l prefer, but the Valley girls and boys held sway.
Anyway, SCSI stands for Small Computer System Interface (orSerial Interface, or
Standard Interface, depending on where you look it up; it's such a messed-up
technology that nobody can even get the name right). SCSI describes the widest
connector on the back of your Mac: the SCSI port. It also describes the fattest
cable of any Mac appliance: the SCSI cable. It describes the kind of hard drives,
scanners, Zip drives, CD players, and other gadgets that you attach to this jack:
SCSI devices. It also describes the type of information that flows from those
devices through those cables to that jack along the SCSI chain.
But frankly, the term that you hear most often is SCSI problems.
Examples: some SCSI appliance (a scanner, a CD-ROM, a Zip drive, whatever)
doesn't work right. Or your whole Mac is acting slow and weird. Or your Mac
won't start up at all.
What's especially frustrating to people who write computer books is that you
can't pin SCSI down. Even if you obey the "rules" (which I'll give you anyway),
things still go wrong.
The only good thing to say about SCSI problems is that once you figure out the
problem with your setup, that problem is gone for good.

The rules of SCSI
Rule #1: Somewhere in this book, I've mentioned that you can string multiple
SCSI devices together - or daisy-chain them, which is how you can use both an
external drive and a scanner (for example), even though the Mac has only one
SCSI jack. When the Mac attempts to talk to various devices along this SCSI
train, it must be careful not to say "start scanning!" to the hard drive or "start
spinning!" to the scanner. In other words, it has to address its messages carefully.
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and 7. Usually, a little number wheel that looks like a one-digit odometer is on
the back or the bottom of your SCSI device. Each SCSI device connected to your
Mac must have a different SCSI number (address) so that the Mac can speak to
each appliance individually.
The Mac, which is part of the chain, has a SCSI number, which is always 7. If you
have an internal hard drive, it has a SCSI number, too - and that number is
always 0. (If your Mac has a built-in CD-ROM player, its address is always 3.) So
for your external drives, scanners, and so on, you can choose numbers from 1
to 6; just make sure that no two devices have the same number, or you're
cruisin' for a bruisin'.
Rule #2: I wish I didn't have to mention SCSI Rule #2: The last device on the
chain has to be terminated.

When I say terminated, I mean taken out and shot.
The second meaning for terminated is a little bit more complicated.
As the Mac sends its little instructions to the various SCSI devices attached to
it, it shoves those instructions out the door with such force that they sometimes go all the way to the end of the cable and bounce back toward the Mac.
Sometimes, the instructions make it all the way back, in which case you get
nutty problems like a hard-drive icon showing up twice on the screen.

To soak up any messages that were pushed with too much oomph, you're
supposed to put an electronic shock absorber at the beginning and the end of
the line of devices. This absorber is called a terminator, Arnold Schwarzenegger
notwithstanding.
If your Mac has an internal hard drive, as most Macs do, you don't have to
worry about the beginning terminator: your SCSI chain is already terminated
inside. And if you also have only one SCSI device outside your Mac, you don't
need a terminator on the outside end. (I'm perfectly aware that this contradicts
Rule #2, but it doesn't contradict Rule #3, which is that these rules don't always
apply. Including Rule #3.)

After you have two or more SCSI things attached to the back of your Mac,
though, it's time to start thinking about termination. You add termination by
attaching a three-inch stopper plug (called, obviously, a terminator) to the
empty SCSI jack of the last device on the chain. Some devices, however - such
as Zip drives - have a terminator switch on the back or bottom. You can just
flip this switch between the terminated and unterminated positions.
Worst of all, some devices may or may not be internally terminated, meaning
that you can't tell whether or not they're already terminated. Rule #4 is that
you don't want a device in the middle of the chain to be terminated! The only
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way to find out whether a device is internally terminated (if that information is
not in the owner's manual) is to call the cheap, lazy company that made it. If it
is internally terminated, that device must go at the end of the SCSI chain. (Is this
the most pathetic technology ever, or what?)
Rule #5: If your SCSI setup isn't working, try rearranging the physical order of
the devices in your SCSI chain. It makes no sense, but sometimes rearranging
makes things work when nothing else does. Anyway, at this point, you're
entitled to be a little irrational.
Rule #6: Your SCSI cables can make or break the entire operation. If everything
else seems hunky-dory, it's conceivable that the trouble is their combined
lengths. They're not supposed to add up to more than 20 feet or so, and (like
speeches and Willie Nelson songs) the shorter the better.

Oh, and while we're talking about SCSI cables, you should know this: they go
bad. It's true. One rich guy I know threw out an 800MB hard drive because he
thought that it had died permanently. Upon rescuing it from the dumpster, an
enterprising Mac buddy discovered that the drive was fine; the cable had been
crimped by a piece of furniture. After he spent $30 on a new SCSI cable, the
drive was as good as new. It's probably worth replacing, or at least switching,
the cables if you're still having SCSI problems.
Another guy I know solved his SCSI woes by switching his cable from one SCSI
jack on his CD-ROM player to the other (of the two identical SCSI jacks). It
makes absolutely no sense, but that's what happened.
Rule #7: OK, you've made sure that every device has its own address. If you
have more than one external SCSI device, you've terminated the last one. But
things still aren't working right.

In this case, try taking o/fthe terminator. I'm perfectly serious. SCSI Rule #8 is: if
a rule isn't working, try breaking it.
Someday, we'll laugh and tell our grandchildren, "Why, when I was your age, we
used to have to add terminator plugs to our external devices!" Until that golden
day, though, we have to put up with this cranky and unpredictable technology.
Good luck to you.

Git1in9 more memorlJ to a pro9ram
When you tum on your Mac, about 2 or 3 megabytes of its available RAM
(memory) gets used up by your System Folder's contents -your operating
system. Then, every time you launch a program, a little bit of the leftover free
RAM gets used up.
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Here's how to find out where your memory is going at any particular moment: go
to the Finder. From the S menu, choose About This Macintosh. This helpful dialog
box appears, showing several important numbers about your use of memory:
This is how much memory your Mac has. (If you want
to convert this number to megs, mentally replace
the comma with a decimal point.)
-ii

iilj

Abou~ Thi s Macintosh

This is the largest
chunk of memory you
have left, into which
Total Memory:
~largest Unused Block~1-- you can open more
20K
~ DeskDraw
I
~ programs. (There may
be smal le r chunks
20K
~ DeskPaint
I
available, too.)
1,024K
~ FileMaker Pro 1 .. .
~
Sy stem Software 7 .0 . 1 •
© App le Computer , Inc. 1983-1 99 1

~ Macintosh llcx

~

Sy stem Software

3 ,678K

•

\'lord5

1,024K

~

~

~

In the bottom part of the box, you can see what's already taking up memory and
how much memory each program is taking up (see those bars?).
You may find it useful, however, to change the amount of memory that each of
your programs uses. If you're experiencing a lot of system crashes, for example,
the program may need a bigger memory allotment. If memory is at a premium,
you may be able to give a program less memory, freeing some for other purposes.
Here's how:
Y' Quit the program whose memory appetite you want to change, and then

·

click its icon.

Y' From the File menu, choose Get Info. This box appears:
§Iii

ClarisWorks Info

I&ill

Clar is\'lorks

Kind : application program
Size : 608K on disk (614 ,908 by tes used)

Yhere : Cabinet : Programs : ClarisWorks
2 .0 :
Cr-eoated : Fri , Mar 19, 1993 , 1 :00 AM

Modified : Sun , Oct 2, 1994 , 3 :53 PM
Version : Claris'w'orks 2.0v 1
March 1993

Comments :

This is the amount of memory
suggested by the programmers ...
... but you can change the
program's actual memory
appetite by editing this number.
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V' Change the number in the Preferred size box (in older systems, it's called

I

the Current size). This number is the amount of memory that the program
will actually consume when you run it. Unless System crashes make your
life more interesting, don't set the Preferred (Current) size much below the
Suggested size, though.

Per(ormin9 a "clean SIJ.stem reinstall11
This procedure is just a wee bit technical. But it's amazing how many problems
it solves. Font problems, crash problems, freeze problems, glitch problems,
weird things you can't even describe very well - all of them go away when you
do a clean install.
As the gears of your System Folder grind away day after day, little corruptions

and rough edges can develop. The following procedure replaces your old,
possibly corroded System Folder with a brand-spanking-new one. It's nearly
guaranteed to wipe out any erratic, bizarre crashes or freezes that you've been
having; after all, it restores the Mac to the exact condition it was in the day it
left the factory.
This process will, however, require your System installation disks: your pile of .
white Apple floppy disks, a startup CD-ROM disc, or your Apple Backup disks
(for Performas). If you don't have those disks ready, get them. (If you're really
stuck, you can always buy a replacement set of System disks, in the form of
System 7.1 or 7.5.)
If you have System 7.5: Insert the first Installer disk (or your system CD).

Double-click the Installer icon. At the main installation screen -where you'd
normally click the Install button - press ~-Shift-K, of all things. You'll be asked
which you want: a brand-new System Folder, or just an updated existing System
Folder. You want the whole new one. Click your choice, click OK, click Install,
and then follow the directions.
If you have earlier System versions: Open your System Folder. See the Finder
icon? The purpose here is to separate it, folder-wise, from the System suitcase

icon. Drag the Finder out onto the desktop, for example, as shown here:
S stem Folder
38 items

t:il
Fonts

Clipboard

41 6.8 MB in disk

96 .5 MB av ail ab le

~LIJJ~.

Control Panels

System Apple Menu Items

Ex®.I Laun~ems

UQJ

Startup Items
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You're doing beautifully. Now close the System Folder window, press Return,
and rename the System Folder. (Call it "Old System" or something like that.)

OLD SYSTEM

Finally, take the Install Me First disk (or your Performa Apple Backup disk, or
startup CD), and insert it. Double-click the icon called Installer; then follow the
directions on the screen, feeding floppy disks into the drive as requested.
Regardless of your System version: The result of all this is a virgin, clean
System Folder, free of any corruptions. But all your customized fonts, control
panels, preferences, and so on are stranded back in your Old System Folder!
Ideally, you should install each of these items from their original, store-bought
floppy disks. If that's too much hassle, copy them, item by item, from your Old
System Folder to your new System Folder. (Key folders to compare with their
newer counterparts: the Preferences; Extensions; Control Panels; Apple Menu
Items; and Fonts folders.) Do so with care, however, so that you don't simply
reinstate whatever problems you were having.

De(ra9mentin9 IJ.OUr hard drifle
Over time, you create and throw away a lot of files.
Your hard drive, if you'll indulge me, is like a closet maintained by a guy who's
always in a hurry. When guests are coming over, he cleans up the living room
and throws everything into the closet, although not particularly neatly. Every
now and then, when he gets time, he unpacks the closet and repacks it neatly,
putting everything in a tidy, organized place.
The hard drive, too, is in a hurry. When you ask it to save a file, it doesn't wait
around: it shoves that file wherever it can find space. Sometimes, that even
means sticking the file in two places, splitting it as necessary. Over time, more
and more files are stored on your hard disk in pieces. It's no big deal: when you
need that file again, the hard drive remembers where all the pieces are and is
perfectly able to bring the file back to the screen.
But all this hunting for pieces slows the drive down. And like our busy closet
keeper, you'll find it very satisfying, every six months or so, to reorganize the
files on your disk so that they're each in one piece, neatly placed end to end on
the hard-drive surface.
You can defragmentyour drive (which is the term for it) in two ways. First, you
can copy everything onto other disks, erase the hard drive, and copy the files
back onto it. Second, you can buy a program just for defragmenting your drive.
These programs are called things like Norton Utilities and DiskExpress.

Chapter19

Beyond Point-and-Click:
Where to Go from Here
In This Chapter
~Facing the future,

credit card in hand

...,_Where to turn when things go wrong
~

Now get outside for some fresh air

A New Leash on Life: Up9radin9
As I warned you in Chapter l, your Mac's life span is limited - not in terms of
usefulness, but in terms of cutting-edgeness. As new models roll out of Silicon
Valley, you'll find that your top-of-the-line Mac model becomes bottom-of-theheap insultingly quickly.

The advice I'm about to give you may be difficult to follow, but it's something I
firmly believe: If the Mac does what you need it to do, you don't have to keep up
with technology. The impulse to keep your Mac current for its own sake will be
strong, but I promise you that your personal worth does not ride on the processor speed of your Mac.
A woman I know uses a 1984 Mac with 1/s of a meg of memory. She owns one
program - the very first version of MacWrite. She's in heaven.
Now then. If some software that requires a more powerful Mac comes out, and
you require that program, that's a different story. At that point, you, too, will
face the Upgrade Paradox.

The up9rade paradoJt
Here's the thing about upgrading your Mac: it's a psychological trap. Your

thinking goes like this: "I've got so much invested in this thing, I'll just pay for a
little bit of enhancement. That way, I retain my investment."
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new Macs plummeted. Without your noticing, the price of a new, faster Mac has
sunk so far, it costs less than accelerating your old one! Throw in the money
you'd make by selling your current Mac, and the upgrade makes even less sense.

It's very true. Painful, at first, to accept, but delightful in practice. Here's
an example.
Suppose you have a Quadra 650. You've heard that, for $1,000, you can buy an
upgrade that turns your Mac into a Power Macintosh 7200!
Only trouble is, at this writing, a new Power Mac 7200 costs about $1, 100, about
$800 of which you'd recoup by selling your Quadra. (There are plenty of places
to sell your Mac: the classifieds, user groups, bulletin boards at the library or
the gym, and any of a number of national computer brokerages. These last
advertise in Macworld and MacUser magazines.)
Do the math. If you upgraded your Quadra, you'd have spent $1,000. But if you
sold your Quadra and bought a brand new Power Macintosh 7200, you'd have
spent $300. Not only would you save $700, but you'd wind up with a new,

updated machine with a new, one-year warranty.
Two great things about this reasoning: (1) It makes getting a cool new computer
easier to justify to your spouse, and (2) it's actually true.

Nud9e9rades
Now, despite the astounding genius of Pogue's New Upgrade Math, some Mac
add-ons are worth adding. For example, if your hard drive has become full, and
you're spending ten minutes a day weeding through old stuff to throw out, it's
time to get another hard drive (or a removable Zip disk drive; see Chapter 12).
And if you're getting out-of-memory messages all the time, and you've tried all
the tricks in Chapter 18 for making do with what you have, it's OK to consider
installing more memory chips (known as SIMMs).
Those don't quite qualify for the term upgrades, really, but they do make using
your Mac a happier experience for not much money.
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Where to Tum in Times of Trouble
You do own the world's most forgiving, self-explanatory computer. But things
will go wrong. ·
Fortunately, Apple has gone from providing an absolutely wretched service plan
to an absolutely spectacular one. Any time during the first year you own your Mac,
they'll send somebody to you to fix the thing if it breaks. In your house. For free.
And if it's a PowerBook, they'll send an overnight-package person to your door
to pick up the laptop, pay for the overnight freight to Texas, fix it there, and
overnight it right back to you. For free.
The magic phone number to get this kind of help, cleverly enough, is 800-SOSAPPL. Get it?
Another tip: If you have a fax machine, you can use AppleFax, a great free
service; call 800-505-0171 by telephone, listen to the instructions, punch in
your own fax number when you're asked for it, put in a fresh roll of fax paper,
and stand back.
Otherwise, as I've no doubt etched permanently into your brain by now, your
next resort should be a local user group, if you're lucky enough to live in a
pseudo-metropolitan area. A user group, of course, doesn't exist to answer your
personal questions; you still have to do some phoning and hobnobbing and
research. But a user group is a source of sources. You can call up and find out
who will know the answer to your question.
The other great source of help is an electronic meeting place like America
Online, where you may get your question answered instantly- and if not, you
can post your question on a bulletin board for somebody to answer overnight.
As a matter of fact, I'm there, ready to receive your praise or, if it must be, your
wrath, for stuff I've gotten you into. My e-mail address there is Pogue.

As for your continuing education - after you spend a month's salary on a
computer, I'll bet you can afford $20 more for a subscription to Macworld or
MacUser magazine. As noted in Chapter 9, huge chunks of these rags will go
right over your head. But in every single issue, you'll find at least one really
useful item. You can learn all kinds of things just by reading the ads. And if
you're not in touch with the computer nerd world at least by that tenuous
thread -via magazine - then you might miss stuff like free offers, recall
notices, warnings, and other consumer-oriented jazz.
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Buy a book- clothe an author
The publisher of this book has decided that, by gum, there's a market for this stuff; 89 he persuaded
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favorites, Mac FAOs [Freque'1f/y Asked Questions]. It's an answer book ... a "whatam I supposed
.to do now?'~·tmok ... a ''how come my Mac always ... ?".book. It contains nothing butquestions and
answers- 500 of each. Some examples:
·
~. Is it better to leave my Mac on all the time, or
· · shutlt off every night?
·

"". It says. ".Not enough memory.'' Should I
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~ What's aType 1 error?

v
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~
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·
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What now?

·
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Satle .Chan9es Before Closin9l
If you do decide to pursue this Macintosh thing, I've listed the phone numbers of
major user groups, dial-up services, and magazines in Appendix B, the Resource
Resource, along with contact information for the products I've mentioned.

But wait a minute - the point of this book wasn't to convert you into a full-time
Mac rabbit. It was to get you off the ground. To give you just enough background so you'll know why the computer's beeping at you. To show you the
basics and help you figure out what the beanie heads are talking about.
Don't let them intimidate you. So what if you don't know the lingo or have the
circuitry memorized? If you can tum the thing on, get something written up
and printed, and get out in time to enjoy the sunshine, you qualify as a real
Mac user.
Any dummy knows that.

Top Ten Topics Not Cotlered in This Book
Here's a who's who of topics I don't think any new Mac user needs to bother
with. If you have the slightest interest in any of them, the shelves are full of
geekier books than this one.
1. Programming.

2. Networking.
3. Any add-on that costs over $1,000.
4. Color separations.

5. Multimedia.
6. Hard-disk partitioning. Too many syllables.
7. Publish and Subscribe.
8. How data is stored on a disk. (If you never need to know something, why
bring it up?)

9. Security.
10. The terms ROM, interleave, user-centric, initiate, V.32 bis, TCP/IP, userdefinable, DRAM, implement, CDEV, nanosecond, kemillg, VRAM, magnetooptical, token-ring, Ethernet, directory, or AlffOEXEC.BAT.
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Appendix A

How to Buy (and Set Up)
aMacintosh

G

etting started with a Mac really involves three steps: deciding which
model to get, figuring out where to buy it, and setting it up. This delightful
appendix will guide you through all three steps with as few stress headaches
as possible.

The OnllJ Four Specs That Matter
(Besides the Price)
You'll hear all kinds of numbers and specifications tossed around when you go
Mac-shopping. But the only four that matter are (1) how big its hard drive is,
(2) how much memory it has, (3) what processor chip is inside, and (4) how
fast that processor runs.
I" Hard-disk space. The first number that matters is the size of the hard disk
inside the Mac. The size is measured in megabytes. (If you're at a cocktail
party, you can say megs for short.) Larger disks are more expensive.

How much do you need? Well, the stuff that you'll be creating- letters,
manuscripts, whatever - is pretty small. A 500-page book might take up
lMB (MB is short for megabytes) of your hard disk. But today's software
programs, such as word processing programs, are huge. Count on each
program's taking up a couple of megabytes by itself. (Count on anything
from Microsoft Corporation taking up 2SMB all by itself.)
Whether you understand any of this or not, believe it: a hard disk fills up
quickly. You can't even buy a hard drive smaller than about 200MB
these days. They've even started measuring hard-drive sizes in gigs 1000-megabyte increments.
The first question you might ask in the computer store, then, is, "Yo does this Mac have a 200-, 250-, or 500-meg hard disk?" No salesperson
will take you for a ride.
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Y' Memory. When you press Play on a VCR, the machine reads the

videocassette's contents and throws the video information onto the TV
screen. When the TV is off, you can't watch your movie, but you sleep well
knowing that it's still safely stored on the tape.
Similarly, your Macintosh reads what's on the hard disk and throws an
electronic copy of it up on your computer screen. There, you can look at it,
make changes, whatever. While it's on the screen, it's in memory. (Details
on this stuff are in Chapter 11/2.)
What's confusing about memory is that it's measured in the same units as
hard-drive space: megabytes. But memory is much more expensive than
disk space, so you get a lot less of it. Whereas hard drives typically are
250MB or SOOMB, a Mac usually comes with 4MB, 8MB, or 16MB of
memory. The more memory you have, the more you can do with your
computer simultaneously (type in one window, draw in another, and so
on). In general, you need 4MB of memory to do even one thing at a time
and 8MB to have a couple of programs going. If you have a Power
Macintosh, double those numbers.
Intelligent Computer Question Number Two, then, is "How much RAM do I
get in this Mac? Five megs? Forget it! I can't even breathe in five megs."
By the way, newspaper ads often give you both of these critical numbers
(memory and disk space). You may read, for example, "PowerBook 4540
8/120." In your newfound savvy, you know that this model-540 computer
has 8MB of memory and a 120MB hard drive for permanent storage. (On
the other hand, they sometimes use a preceding pair of slashed numbers
to indicate speed, too; more on this in a moment.)
Y' Processor model number. The third important number is the name of the

primary processor chip. (As endless Newsweek articles and specials on
"Nova" have no doubt informed you, a chip is a rat's nest of tiny circuits
etched into a piece of silicon the size of a postage stamp.) The heart of a
Macintosh is a chip, a,bout an inch square, that's actually manufactured in
the millions by a completely different company. (It's Motorola; that's why
Apple stock goes down when there are negative headlines about Motorola.)
Before the Power Macintosh line, several models of processor chips were
used in Macs: 68000, 68020, 68030, and 68040. You don't have a choice for a
specific model of Mac. The Quadra 630, for example, has a 68040 chip, and
that's all there is to it. The higher the model number of this chip, the faster
the Mac.
Power Macintosh models, on the other hand, use a newer kind of Motorola
"brain" chip: the famous PowerPC chip. These chips have all kinds of
names - 601, 603, 604, 620 - but in this case, higher numbers don't mean
faster Macs. To gauge the speed of a certain Power Macintosh, ignore its
chip model number, and instead focus on the following item.

_ _ _ _ _ _ _ _ _ _ Appendix A: How to Buy (and Set Up) a Macintosh
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Clock speed. This is the other variable that accounts for the performance
differences among Mac models. A chip's clock speed is something like
blood pressure; it's how fast the data moves through the machine's
circuits. The range of speeds, measured (get this) in megahertz, is 16 (on a
Mac Classic) to 32 or more (the latest Power Macs).

That explains why the Classic II, the Hsi, and the Ilci (for example) run at
different speeds, even though they use the same Motorola 68030 chip.
Until the Power Mac series, you didn't really know how fast a Mac was
unless you looked at the fine print. It's not so tough with the Power Macs,
though: the clock speed is part of the Mac's name, appearing after the
slash. So a Power Mac 8100/100, for example, is faster than an 8100/80.
(See? 100 is higher than 80, so it's faster.)

Macintosh as a Second Lan9ua9e
To make newcomers feel as much like outsiders as possible, the computer
stores and newspaper ads run all this information together in a cryptic little
line. This is pretty important information for comparison shoppers, so I thought
that a translation might be in order. Let's see how much of that tech talk you
were able to absorb.

The newspaper--ad test
Stay calm. Don't let your eyes glaze over. You do know what this means. Take it
morsel by morsel.

memory size/hard drive size

main processing chip
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model name always includes the speed measurement. Here, then, the model
number is the 7200. This number is pure marketing, concocted by some ad
agency in California. It has nothing to do with the Mac's relative speed or
anything. Just ignore it.
After the slash, you'll find the speed of its chip, which here is 100 MHz (megahertz, which you can think of as miles-per-hour). The clock speeds of nonPower Mac models range from 16 MHz to 40 MHz; for Power Mac models,
speeds range from 66 to 150, so this one, at 100, is pretty decent.
Next, you see how much memory and hard-drive space you get in this computer (16/500). Both features are measured in megabytes. The memory comes
before the slash, and the hard drive size after it.
Finally, there's the chip number. The central processing chips in the Power Mac
or four-digit Performa lines are the 601, 603, 604, and so on, and there's nothing
particular you can learn from this information - a higher number doesn't mean
faster speed. (The 601 is faster than the 603, for example).
The critical point here is: you can't compare speed ratings among different chips.
Don't get all excited about a Power Mac with a 100 MHz chip inside - if it's a
603+ chip (the one in PowerBooks), it's actually slower than an 80 MHz chip in
an old Power Mac 7100 (which has a 601 chip).
By the same token, don't let your friends gloat about the high MHz ratings of
their PC-clone "Pentium" computers; the MHz rating means absolutely nothing
except when comparing against other Pentium chips. For example, your Power
Macintosh, rated at 110 Mhz, may well be faster than an IBM computer that has
a so-called Pentium chip that runs at 150. You can compare 604 chips, or
Pentium chips, but you can't compare MHz ratings between a 604 and a
Pentium. (Pause for breath.) Get it?

What's an FPU 2U1
When shopping for older, non-Power Macs, you sometimes run across the term

FPU, too. This is a bonus chip, also called a math coprocessor. It pretty much
does what it sounds like: it helps the Mac do math. Only the most expensive
Mac models, destined for the desks of scientists and accountants, come with an
FPU. For programs used by ordinary mortals - word processing programs,
drawing programs, checkbook software, and most games - an FPU does
absolutely nothing and isn't worth paying extra for.

Final exam
OK, let's see how fluent in Applespeak you've become.
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In the grocery: "Nice to see you! Say, you ought to come over to my house. My
husband just got a Macintosh PowerBook 190c 4/200, It's neato."

Translation: Well, you'll find out from the following discussion that a PowerBook
with a c in its name has a color screen. So her husband got a color laptop
computer with 4MB of RAM (not really enough) and a 200MB hard drive - the
4/200 configuration. (He'll probably fill up that baby's hard drive with stuff in
about six minutes.)
On a bulletin board: "FOR SALE: Macintosh Plus. Color monitor, 2 expansion
slots. $3,000. Call Sid."
Translation: This guy has no idea what he's talking about. The Plus is black-andwhite, it has no expansion slots; and that's about 20 times too much to pay for
that used machine!
If you understand that much, the worst is over. You're ready to begin your
assault on the computer marketplace- informed, armed, and ready for anything.

The Product Line
Look, it's hopeless to try to keep up with Apple in a Mac book. Since the
Macintosh first appeared on the scene, there have been JOO different models.
Apple is still making something like 130 models - at this writing. Each one is
available in several configurations.
For heaven's sake, Apple introduces a half-dozen new models twice a year/Who
can keep them straight, let alone get them printed in a book that stays current?
Still, I think you should have some idea of what's happening on the Mac shelf
when you walk into the computer store. One reason it's especially futile to keep
track of the Macs in this world is that Apple often gives the same machine
several different names! I mean, the Quadra 605, the Macintosh LC 475, and the
Performa 476 are identical Macs.
Why on earth would Apple do something so silly? Because Apple thinks that
people buy computers in three distinct ways. Kids, of course, buy them through
their schools; the Macs for sale there are all called LC-something.
Businesspeople buy computers at computer stores; their machines are all
called Quadra-something, Power Macintosh-something, or PowerBooksomething. And Mr. and Mrs. Family buy their computers at Sears and electronics stores; their Macs are all called Performa-something. So Apple figures it may
as well sell the same models in as many different ways as possible!
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Of course, this strategy is something new for Apple. Before the company came
up with this scheme, there were a zillion other now-defunct model lines.
Remember the olden days of 1993? Remember those crazy Mac II-series machines? And how about those nutty Classics? And oh, yeah - that wacky
Centris line?
Anyway, here are some representative model names, past and present, along
with information on what you might use them for. Remember that for a little
difiero, you can upgrade almost any Mac at any time to make it faster. Also
remember that within each family, higher numbers usually indicate faster, more
recent models.

Black-and-white one-piece
Macintosh Plus
Macintosh SE and SE/ 30
Macintosh Classic and Classic JI
Macintosh Portable
Performa 200

These one-piece models, which
Apple calls compact Macs, are about
two feet tall. All you do is plug in the
keyboard and the power cord, and
you're off and running.
The screen is built in; you can see a five-inch-tall slice of a page all the way
across. Today, these discontinued models cost $50 to about $300 (used).
They're quite old, and quite slow; almost none of today's software runs on
them.

What the1/re 9ood for
Word processing (but not with Microsoft Word 6); mail-merge operations (form
letters) ; typing-instruction programs; Rolodex and calendar programs; simple
database files ; HyperCard stacks, such as kids' programs; and checkbook programs.

Color one-piece
Color Classic
Color Classic II (overseas only)
LC 500 series
Performa 500 series
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These machines are bigger, heavier,
and more expensive (in the $1,000to-$1,800 range) than the black-andwhite compact Macs. On the other
hand, they're easy to expand; and
they have built-in, gorgeous color
screens. Also, they're relatively fast
because they're based on the 68030
or 68040 chip - particularly the
later 500 models like the LC580. The
LC 500-line Macs also have built-in
stereo speakers and a built-in CD-ROM
player (see Chapter 12). Their screens
measure 14 inches diagonally; the
Color Classic's screen is 10 inches.

What the1/re 9ood for
Everything listed for the preceding models, plus color games; kids' programs
(especially CD-ROM discs); dialing America Online and the Internet; basic color
painting and drawing; and playback of QuickTime digital movies, complete with
sound and video, in a small window.

The LC series
Macintosh LC
Macintosh LC II (Performa 405, 410, 430)
Macintosh LC III (Performa 450, 460, 466, 467)
Macintosh LC 475 (Performa 475, 476)
Macintosh LC 630 (Performa 630, 636, 638)

Except for the 500 line, the LC (for low-cost color) Macs are two-piece Macs. In
other words, you have to buy two pieces of equipment: the computer itself and
a separate screen (the monitor). When computer nerds want to show off, they
call the main box a CPU Got that? You have two pieces to buy - a monitor and
a CPU. (CPU stands for Central Processing Unit. Now that makes everything clear,
doesn't it?)
You're not going to be able to transport this baby without the original shipping
cartons (and a luggage cart). But buying a separate monitor grants you the
power of choice: large or small, black-and-white or color, tall or wide. (If we're
talking Performa, I take that back; every Performa comes with a monitor.)
The two-piece Macs, which Apple calls modular, are also easy to expand. The lid
pops right off, just like the lid of a shoebox. Of course, the inside of the computer looks nothing like the inside of a shoebox. There are a lot of wires and
chips and stuff, but they're very neatly arranged, and whatever you want to
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install (more memory, an accelerator card, whatever) slips into a very obvious
place. Each LC has one slot- a rectangular socket into which you can plug a
special-feature circuit board, such as an accelerator or a video card. These
days, Apple even sells an inexpensive TV/video card for that slot, which lets
you watch TV as you seek inspiration for your thesis.
Today, Apple thinks of LCs as its educational line. An LC is no longer considered
to be a cheapo wimp machine, either. The LC 475, for example, is the exact
same computer as the Quadra 605, a respectably horsepowered machine.
(Read about the LC 630 later in this chapter.)
Techie note: The LC models' speeds vary widely within the family, ranging from
the LC (with an '020 chip) to the LC 580 (with an '040 chip); speeds run from 16 to .
33 MHz. Prices for new and used LC computers range from $600 to $1,800 or so.

What thelJ're 9ood for
Everything listed for the previous models, plus page layout and graphic design
· (because you can attach a big screen, except on the 630 models, which max out
at 15-inch monitors); music recording from a synthesizer; basic spreadsheets.
(The LC 475 and higher-number models, of course, have the necessary horsepower for more challenging tasks. See "What they're good for" following the
Mac II-series discussion.)

Mac II series
Macintosh II, llx, llfx, !lex:, llsi, !lei
Macintosh llvi (overseas only)
Macintosh llvx (Performa 600)

All these models have been discontinued. These, too, are modular
Macs; the screen is separate.
Furthermore, most of these Macs
have multiple expansion slots. The
prices for used II-series Macs range
between $500 and $1,000.
Techie details: All but the '020-based Mac II contain a 68030 chip running at
speeds between 16 and 40 MHz. You can get a built-in CD-ROM player on the
IIvx/Performa 600.

What thelJ're 9ood for
Everything listed for the previous models, plus complex spreadsheets, pro-level
page layout, medium and complex databases, music notation (sheet music),
QuickTime digital movie recording (with the addition of a $400 expansion card)
and editing, and electronic mail (sent to other Macs in the office).
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The Quadra series
Macintosh Quadra 605
Macintosh Quadra 610 (Centris 610)
Macintosh Quadra 650 (Centris 650)
Macintosh Quadra 700, 800, 900, 950
Macintosh Quadra 630 (LC 630,
Performa 630-638)
The name Quadra comes from the
chip on which these Macs are based:
the '040, which, when it debuted,
made everybody's hair stand on end
with its blistering speed. Only a couple of years later, this speed had become
status quo, even for the PowerBooks. Then the Power Macintosh appeared,
making even the '040 processor seem poky.
Anyway, the Quadras introduced one other notable feature: you can get other
Mac devices, such as CD-ROM players and removable SyQuest cartridge drives,
built right in. A Quadra 610 or 650 Mac can house one such device; Quadras 800
and higher are huge Macs, with enough room for two such built-in gadgets.
Most Quadra models also come with a feature called Ethernet,· much as it may
sound like the webbing of choice for anesthesiologists, Ethernet is actually a
fast and fancy system of wiring the Macs in an office together (for sending
electronic messages back and forth, sharing files, and so on).
Prices for new and used Quadras range from $700 to about $3,000 for the
top-0f-the-line, feature-packed 950, which is ready for use as the backbone of a
whole office.

What thetJ're 9ood for
Everything listed for the previous models, plus color photo retouching and
Photoshop (a professional painting program) art; 3-D graphics "rendering" (onscreen model making); morphing (making QuickTime movies that melt one
image magically into another, as in Michael Jackson's "Black and White" video);
high-level statistical analysis; programming; and use as an office server (a
central Mac whose files can be accessed by every desktop Mac in the office).
The 630 has a couple of special properties; for example, you can watch TV on it
and even record your own digital movies (if you buy optional accessory cards).
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The AV series
Macintosh Quadra 660AV (Centris 660AV)
Macintosh Quadra 840AV
AV stands for audiovisual, and that describes these discontinued Macs perfectly.
They can actually speak anything that you type for them and take spoken

orders from you; see Chapter 14 for details. All of the special AV features of
these models later wound up in most Power Macintosh models.

What the1J, 1re 9ood for
Everything listed for the previous models, plus a few specialized tasks that only
AV Macs (or, today, Power Macs) can perform: hooking up a VCR to record what
you see on the screen; hooking up a cable and watching TV on your monitor;
making QuickTime movies from a videotape or the TV without buying any extra
equipment; and, with the purchase of a $100 adapter, serving as a full-fledged
fax/modem (see Chapter 10).

Pou/erBooks
PowerBook 100, 140, 170
PowerBook 145, 145b, 150, 160,
165, 180
PowerBook 520, 540
PowerBook 165c, 180c, 520c, 540c
PowerBook Duo 210, 230, 250, 270c,
280, 280c
PowerBook 190
PowerBook 5300
PowerBook Duo 2300

PowerBooks are portable, laptop
Macs. They're dark gray, two inches
thick, weigh less than seven pounds,
and are every bit as powerful as most of the models that you've read about so
far. A PowerBook opens like a book when you're using it; one side has the
keyboard, and the other has the screen. You can plug a PowerBook in or use the
battery, which lasts about two hours_per charge. (See Chapter 16 for additional
PowerBook scoop.)
Typing on a PowerBook is slightly less comfortable than on a desktop Mac, and
you can expand one only with considerable hassle and expense. But a
PowerBook is indispensable for anyone who travels. And a PowerBook is
definitely the Mac to have if you're trying to catch the eye of an attractive
stranger across the airplane aisle.
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What on earth could account for all the different models and prices? First,
there's screen quality. Every PowerBook screen uses one of two technologies:
active-matrix or passive-matrix. As is true of employees, agents, and brokers,
active is better than passive. Active screens (models 180, 540, 270, and so on)
are crisp and bright. Passive screens (160, 520, 230, and so on) are slightly
murkier, slower to update the display (such as when you move the cursor), and
a lot cheaper (to the tune of nearly $1,000).
Color also costs you. Those models whose names end inc (180c, 520c, 540c,
and so on) show gorgeous full color. Most other PowerBooks can show, at best,
different shades of gray, like a newspaper photo. Color screens also cost a lot more,
drain your battery twice as fast, and weigh more than their paleface cousins do.
The biggest differences among PowerBook models, though, have to do with the
families they belong to. The Duos, for example, are much smaller and lighter than

regular PowerBooks. That's because you can leave a lot of the electronics - the
floppy-disk drive and the back-panel jacks - at home on your desk and take
just the computer itself on your travels.

RecentPowerBooks
The 520 and 540 (and the color versions of each) are much faster than the
100-series models. (Nerd note: It's because the 500s have an '040 chip inside.)
They have stereo speakers. They also offer a separate module socket into
which you can insert a second battery. Finally, in place of the standard gray
track/ping-pong ball, these special PowerBooks feature a trackpad that's a
couple inches square. The trackpad lets you control the pointer just by dragging your finger - no doubt a response to the efforts of the powerful LongFingernailed Computer Users' lobby.
The next wave of PowerBooks was the 1995 line: the 5300 (essentially a Power
Mac PowerBook) and the identical-looking PowerBook 190. They feature bigger,
brighter screens and still faster speeds. The Duo 2300 is the Power Mac version
of the famous mini-laptop.

What theq're fJOOd for
Everything listed for the Quadra or Power Macs - and you can do any of those
things while sitting comfortably in a plane, train, or La-Z-Boy recliner.

Power Macintosh
Power Macintosh 6100, 7100, 8100
Power Macintosh 7200, 7500, 7600, 8500, 9500
Performa 6110, 6112, 6115, 6117, 6118
Performa 6200, LC 6200
Performa 6300, LC 6300
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These Macs, called the Power
Macintosh series, look, feel, and
smell like the Macs that came before
them (see Chapter 17). They work
fine with all existing normal Mac
programs. But if you buy (or upgrade to) special PowerPC versions
of your programs - the so-called
"native" programs (doesn't that have
a wild, jungly sound?) - these Macs
really scream. Native programs run
several times faster than on the
fastest of yesteryear's Quadras.
In the last two years, almost every
existing Mac model was quietly snuffed out to make room for a new PowerPCbased model. As the 1990s progress, Apple will crank out models built on faster
and faster PowerPC chips.
If you already own a Quadra, a Centris, a recent LC or Performa model, or a

PowerBook 500-something Mac, you can even upgrade your computer to have a
PowerPC chip by forking over between $700 and $2,000 to some smiling Appledealer technician. However, doing so is almost always more expensive, overall,
than just selling your old Mac and buying a new Power Mac.

What thet/re 9ood for
Everything listed for the previous models - but faster. The Power Macs also
have the hi-fi sound-recording features, the GeoPort, and speech-recognition
options of the AV Macs (described earlier). Some models also let you hook up
your TV to the Mac for recording and playback. Oh, joy.

8u1Jin9 a Monitor
If you've decided to become the proud owner of a two-piece Mac, you have to

decide what kind of screen (monitor) to get.

Black-and-white, 1Jra1Jscale, color
For writing, finances, spreadsheets, music, databases, calendars, Rolodexes,
and 90 percent of the other day-to-day Mac tasks, black-and-white is all you'll
ever need. Black-and-white screens are also the fastest; you almost never have
to wait for the computer to "paint" the screen from top to bottom, as you do
when you're working in color.
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Trouble is, they don't even make black and white screens anymore. Like color
TVs, color Macs have grown to dominate the market.
The next step up is a grayscale monitor. It doesn't just have black and white; it
also displays many different shades of gray. Particularly in larger sizes, these
Macs are less expensive than color monitors, but they can still give your icons a
nice 3-D look. But these, too, are growing rare.
Color monitors are the most expensive, and they make everything appear on
the screen slightly slower. Some things absolutely demand a color monitor:
games, color graphics, presentations and some business charts, most CD-ROMs,
digital movies (QuickTime movies), and so on. Certain programs make clever
use of color. For example, a drafting program may display light-blue graphpaper lines behind the black lines that you draw.
When you're choosing a monitor, remember that a color monitor is also a
grayscale monitor and a black-and-white monitor. (The Monitors control panel
lets you switch from one mode to another.)

How bi9 is IJOUr fliew?
Your biggest buying headache, however, will be deciding what size monitor to
get. Monitors are measured diagonally, and they're measured stupidly - that is,
from edge to edge of the glass, not the picture area. (The outer inch of glass is
always left black.) A recent lawsuit has made a few companies vow to start
measuring their monitors accurately, which will result in even more confusion,
not to mention weird monitor sizes like 15-point-37-inches.
In any case, the common monitor sizes are 14, 15, 16, 17, 20, and 21 inches. (You
may also hear "the old Apple 13-inch monitor" mentioned now and then·. It's
exactly the same size as the current Apple 14-inch monitor; it got its name
before the marketing people switched to rose-colored measuring tapes.)
By far the most common size is 14 inches (below). It's the most common
because it's the least expensive. The screen is just shy of nine inches wide and
seven inches tall.

~
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Although most monitors are wider than they are tall (landscape orientation),
some 15-inch screens come in portrait orientation. The point here is that you
can see an entire 81/z-inch x 11-inch page (below).

The remaining monitor sizes are called two-page displays because, obviously,
they show two pages side by side (below). Some monitors - such as Apple's
15-, 17-, and 20-inchers - come with the fancy high-tech adjective multisync at
no extra charge. This simply means that you can zoom in or out, magnifying or
shrinking everything on the screen. Of course, when you're zoomed out, everything's smaller - but the advantage is that you can see a larger area. For example,
you can zoom out the 17-inch screen and see two entire pages side by side.

For writing, virtually any size screen will do. Even if you can see only half a page
at a time, you can always scroll the display up (or down) to see what you wrote
on the preceding (or following) page. If you plan to do any graphic design that is, page layout of brochures or newsletters -you'll probably want at least
a full-page display. And if you're going to do professional page-design work,
such as laying out a book, get a two-page display.

Gettin9 it on paper
In the olden days (in other words, last year), seeing color on the screen would
have been the end of the color story. You got to see great, rich, stunning color
on the screen, but everything that you printed came out in black and white.
Color printers cost way too much for any individual to buy.
Recently, though, the prices of color printers have plummeted. Now you can
buy a high-quality color printer for $4,000 or one that prints sort of grainy for
$400. I wouldn't advise getting a color printer for everyday correspondence. But
if you're ever hired to design rough sketches for a movie poster or something,
keep those cheapie color printers in mind.
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A bit about color bits
(Note: I'm providing the following discussion so that you'll understand the
chatter in your favorite computer magazines. Unless you retouch photos for a
living, there's no reason to know this stuff.)

The technobullies of the world have foisted several different kinds of color upon
us: 8-bit, 16-bit, and 24-bit color.
All you need to know is that when you set your monitor to 16-bit or 24-bit color,
images are slower to appear on the screen and much more realistic. Realistic is
a term that matters only if you plan to work with photos or movies on the
screen. H not, 24-bit is for the pros; it's overkill for everyone else.
Which degree of colorness you have depends on your Mac, not the monitor. All
of today's Macs provide 8-bit color: they can show 256 different colors on the
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screen. All you have to do is plug your monitor into the built-in jack. If you one
day decide that you can't live without photorealistic colors on your screen, you
can buy and install more VRAM (video memory) to get 16-bit or 24-bit color;
you don't need a new monitor.

Where to BulJ Your Mac
I'm going to assume that you're not in Donald Trump's tax bracket. I'm going to
assume that you're looking for ways to get the most Mac for the least lira.

The Apple school discount
In Apple's younger, healthier days, Apple gave discounts of 40 percent to
students and teachers; it's not nearly as much of a giveaway today, but there
are still deals to be had. If you're affiliated with a college, find out whether the
school's bookstore is a member of this delightful program.

Mail order
The next-least-expensive way to get a new Mac is probably through a mail-order
company. These outfits take out big ads in the Macintosh magazines, such as
Macworld and MacUser. Of course, you can't exactly browse the merchandise,
so it's assumed that you already know what you want when you call one of
these places.
If everything goes smoothly, mail order can be a nifty deal: You save hundreds

by avoiding sales tax, you get a pretty good price, and you don't have to haul
anything home in the car. The trouble with mail order, though, is that life can
get pretty ugly if things don't go right. What if the thing is broken when it
arrives? Suddenly, you've got the burden of packing it up, shipping it back, and
persuading the company to replace the equipment (if they'll even consider it).
Mail order is for gamblers. You can score big, but you can also get shafted, and
you won't have anywhere to turn for help.

Computer stores
A computer store is likely to have higher prices. You'll have to pay sales tax. But
you also get a human being to blame when things get fouled up.
Unfortunately, buying a computer at a store is still a crapshoot: good dealers
are relatively rare, and lousy dealers are everywhere.
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So how are you supposed to know good dealers (and their repair guys) from
bad? There's only one way: ask around. Depending on where you live, though,
getting the word-of-mouth report may be easier said than done. If you're at a
loss as to whom you should ask, start by finding the nearest Macintosh user
group; call Apple's user-group-listing hotline at 800-538-9696.

Mac user 9roups
Speaking of user groups: lately, Apple has been unloading unsold Macs to the
nation's network of Mac user groups, for quick (and often amazingly inexpensive) sale. It may be worth joining a user group just to take advantage of this
program, called the User Group Store.

Consumer stores
The Performa series of Macs aren't just sold at computer stores; they're also on
the shelves of non-computer stores, such as Sears, Silo, Price Club, and officesupply stores. There they are, right next to the blenders and microwaves.
Because the usual clerks can't be expected to know anything about computers,
Apple covers you with toll-free phone numbers: one to call with questions and
one to call if something breaks.
The Performas are essentially the same machines as Macs that are sold under
other names. You're spared the hassle of choosing a keyboard and monitor;
both devices are included in the total price. It's about the same price that you'd
pay for a non-Performa system, except that you get free software. If you aren't
too grossed out by the word Performa, the Performas are a good deal (see
Chapter 15 for details).

Used Macs
Finally, you can buy a used Mac. Once again, the luck of the draw determines
how satisfied you'll be. To a certain extent, you can tell how much abuse a Mac
has taken by looking at it. But a visual exam won't tell you about the funny
noise that the hard drive makes only after it's been on for 20 minutes, or about
the monitor that's been in for repairs three times already, or about the ball of
cat hair wedged inside the disk drive.
In other words, there are three rules for buying used equipment:

I "" First, determine whether you're willing to forgo the comfy Apple warranty
I for the sake of saving money.
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savings meaningful, particularly on discontinued Mac models. Some naive
sellers who don't understand the Inviolable Rule of Instant Obsolescence
think they can recoup the full purchase price when they sell their used
Macs. Don't fall for it - be sure to compare the asking price with a
computer store's new-Mac price.
1" Finally, test the Mac as much as possible before you buy it. Above all, test the

disk drive (by inserting a floppy disk and copying a file onto it), the printer
port (by printing something), and the mouse (by rolling it around on the desk).

Credit cards
It doesn't thrill me to break the news to you, but you're going to be spending a
lot of money even after you buy your Mac. We haven't even discussed buying a
keyboard yet. You're also going to need software. As hobby costs go, computing
isn't exactly crocheting.
As long as you're committed to this plunge, a word of solemn advice: put

everything on a credit card, especially when you're buying by mail order.
Thousands of Mac users have avoided getting ripped off by the occasional flyby-night operation because they charged it. (As you probably know, the creditcard company doesn't pay your bill if you're disputing the charge. This is an
incredible layer of protection between you and companies that send you the
wrong item, a broken item, and so on.)

I Took Off the Shrink Wrap! Now Whatl
Setting up the Mac should take less than 20 minutes; all you have to do is plug
in a few cables. (See Chapter 5 for instructions on plugging in your printer.)

EriJ.o ... ertJ.onomics
First, figure out where you're going to put the most expensive appliance that
you've ever bought. In my opinion, the principal principle is this: when you're
seated at your desk and you're in typing position, your elbows can't be lower
than your wrists. Otherwise, if you plan to do a lot of work at the computer, you
may wind up with a nasty and painful ailment like Carpal Tunnel Syndrome,
which never goes away until you stop using the computer.
The next ergonomic lesson is one learned from the painful experience of
thousands of home-office users: don't put the monitor in front of a sunny
window. It turns out that your pupils shrink to accommodate the bright window
light. But because you're trying to focus on the relatively dim Mac screen, your
optic system gets confused and strained, and it's hello, headache.
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GettinlJ. plUIJ.IJ.ed
Your manuals, of course, are the best source of instructions for setting up the
Mac. But here are the basics.
Everything plugs into the back of the Mac. Take a look: a whole assortment of
plugs is back there. The plugs are labeled with little symbolic pictures called
icons. (Get used to icons; they're the cornerstone of the Mac's graphical
nature.) The "The back of the Mac, Jack" sidebar shows the back of a typical
Mac and what you can plug into it.
If your new Mac is a laptop (PowerBook), there's nothing to set up. Plug it in
and flip back to Chapter 1.
If your Mac isn't a PowerBook, study the diagram in the sidebar. Using it as your
guide, plug the power cord into the power jack and the keyboard into the ADB jack.
Then plug the mouse into the other side of the keyboard. Do whatever feels good.

SwitchinlJ. the Mac on
Quick! Flip to Chapter 1!

Top Ten Thin9s That You Get Free
with Your Mac
Enjoy this list - this is the last time in your entire computing career that you'll
·get anything free.
1. A mouse.
2. A floppy-disk drive built into the machine.
3. A Disk Tools floppy disk that can start up your Mac when the hard drive is
having problems.
4. A one-year warranty that covers parts and labor at any Apple
dealership - or at your house or office.
5. A set of white System software disks, or a startup CD-ROM disc (except
Performa models).
6. A power cord.
7. A coupon for a free mouse pad or a subscription to Macworld magazine.
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The back of the Mac, Jack
Power for
the Mac

Monitor
power

Microphone
Speaker

Printer
Modem

If you have a one-piece Mac, your installation is
complete. Flip back to Chapter 1.
If you have a two-piece Mac, plug the monitor's
two cables into the monitor-power and videooutjacks, as shown in the diagram. You're all set.

out

S-video in
Monitor

If you bought an old, use'd Mac that requires a
video card, you have to open the cover and install it. Call whoever sold it to you for help.
You're ready for business. For instructions on
hooking up your printer, see Chapter 5.

8. Instruction manuals.
9. A guided-tour program (such as Macintosh Basics).
10. A registration card. Fill it out and send it in.

AppendixB

The Resource Resource
Ma9azines
Mac Home Journal
415-957-1911
Macworld
800-234-1038
MacUser
800-627-2247
Mac Week
609-461-2100

User Groups
Apple User-Group Info Line
800-538-9696 ext. 500
Boston Computer Society
BCS/Mac
617-864-1700
BMUG (Berkeley)
310-549-2684
Los Angeles Macintosh
Users' Group
310-278-5264
New York Macintosh
Users' Group
212-473-1600

Products
Mentioned in
This Book
Adobe Type Manager
(ATM)
Adobe Systems
415-961-4400
800-833-6687
After Dark
Berkeley Systems, Inc.
510-540-5535
America Online
America Online, Inc.
800-827-6364
ClarisWorks
ClarisDraw
Claris Corp.
408-727-8227
408-987-3932 (FAX)
CompuServe
800-848-8199
Conflict Catcher
Casady & Greene
408-484-9228
800-359-4920

DeskWriter
Hewlett-Packard
415-857-1501
800-752-0900
Disinfectant
Freeware: John Norstad,
author. Available from any
online modem service, or
send a self-addressed
stamped sturdy envelope
and an SOOK disk to the
following address. People
outside the U.S. may send an
international postal reply
coupon instead of U.S.
stamps (available from any
post office).
John Norstad
Academic Computing and
Network Services
Northwestern University
2129 Sheridan Road
Evanston, IL 60208
DiskDoubler
Symantec Corp.
408-253-3570
800-441-7234
Encarta

Microsoft
206-882-8080
Excel
Microsoft Corp.
206-882-8080
800-426-9400
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HyperCard
Apple Computer
408-996-1010
800-776-2333

PageMaker
Adobe Systems
415-961-4400
800-833-6687

KldPi:x

Photoshop
Adobe Systems
415-961-4400
800-833-6687

WriteNow
WordStar International, Inc.
800-523-3520

QuarkXPress
Quark, Inc.
303-934-2211
800-356-9363 .

Zip disks
Iomega Corporation
801-778-1000
800-456-5522

Broderbund Software
800-521-6263
Last Resort
Working Software
408-423-5696
800-229-9675

living Books
Broderbund Software
800-521-6263
MacConnection
800-800-4444
MacDraw
see ClarisDraw
MacWarehouse
800-255-6227

QuickCam
Connectix Corp.
800-950-5880
415-571-5100
Quicken
Intuit
415-322-0573
800-624-8742

Mac Zone
800-248-0800

RAM Doubler
Connectix
415-571-5100
800-950-5880

Myst
Broderbund Software
415-382-4400
800-521-6263

Street Atlas USA
Delorme Mapping
207-865-4171
800-452-5931

Norton Utilities
Symantec Corp.
408-253-3570
800-441-7234

SyQuest
SyQuest Technologies
510-226-4000
800-245-2278

Now Up-to-Date
Now Utilities
Now Contact
Now Software
503-274-2800

Word
Microsoft Corp.
206-882-8080
800-426-9400

WordPerfect for the
Macintosh
Corel Corporation
800-772-6735
613-728-8200
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accelerator - An expensive circuit board that you can
install to make your Mac faster and slightly less
obsolete.
access privileges - Permission to do something on the
Mac. Appears only in the context of "You can't do that
because you don't have access privileges." Pertains
either to File Sharing (you haven't been allowed access
to a certain networked folder) or Performas or System
7.5 (somebody turned on "System Folder protection" in
your Performa or General control panel).
active window - The window in front . Usually, only
one window can be active; you can recognize it by the
stripes across the title bar, like this:

;;iii _ _
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5 items

29 MB in disk
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Apple menu - The menu at the far left end of your
menu bar, marked by the S symbol - a piece of black
or multicolor fruit . In the S menu, you'll find a list of
your desk accessories (miniprograms, such as the
Calculator), as well as any files, folders, documents,
control panels, and even disks (or their aliases) that
you care to see there. To add something to the S
menu, drop its icon into the Apple Menu Items folder
within your System Folder.
AppleShare - Some kind of trade_marked name for the
way that interconnected Macs communicate with one
another.
AppleTalk - Another trademarked name, also having
to do with Macs talking to one another. You may need
to know this term if you have a laser printer because
Apple Talk is the language that it speaks to your Mac.
To print, you must make sure that AppleTalk is active.
Choose the Chooser from the S menu, and you'll see
where you turn Apple Talk on or off.

System Folder

application - Nerd word for program.
ADB-An acronym (for Apple Desktop Bus) that
describes the cables and jacks used by the keyboard
and mouse, as in "Can you believe that dimwit!? He
plugged his printer into the ADB port!"
alert box - A message that appears on the screen.
Unfortunately, as in most relationships, the Mac tends
to communicate only when something is wrong.

The resale ualue of your computer system
has just sunk to 253 of what you paid for it.

(QD]
alias - A duplicate of a file's icon (not of the file
itself). Serves as a double-clickable pointer, or
reference, to the original file, folder, or disk. A feature
of System 7 or later. Indicated by an italicized icon name.

Application menu - The rightmost menu In the menu
bar (if you have System 7), marked by an icon. This
menu lists whichever programs you have open and
displays a check mark next to the frontmost program.
You can switch from one program to another by
choosing names from the Application menu.
ASCU - The most interesting thing about this term
(which means text file) is its weird pronunciation:
ASKie. Good name for a Labrador, don't you think?
ATM - Short for Adobe Type Manager, a piece of
software that makes certain fonts look really great on
the screen (and in nonlaser printouts).
background printing - A feature that returns control
of the Mac to you immediately after you use the Print
command; the Mac will print your document, taking its
own sweet time, always giving priority to what you're
doing on the screen. The alternative, known as
background printing is off, takes less time to print but
takes over the Mac, preventing you from working and
displaying a "now printing" message until the printing
is over.
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back up - To make a copy of a file for use in case
some horrible freak accident befalls your original copy
(such as your throwing it ou.).
Balloon Help - A feature of System 7 and later. See
the little question mark in the upper-right corner of
your screen? It's a menu. Choose Show Balloons from
it; then point to various elements of your little Macscreen world. Cartoon balloons pop out to identify
what you're pointing at.
baud rate - The speed of a modem (see modem).
Directly related to the price.
BBS- An electronic bulletin-board system. That's
where a Mac in somebody's house is connected to a
phone line or two so that you can dial in with a modem
(see modem) and post messages for other people to
see. You can also read other people's messages. A BBS
is a good place to advertise that you're selling your
used Mac stuff and to get dates.
beta test - Means test, but adding a Greek word makes
it sound more Important. Used exclusively when
applied to software: When a program is still so buggy
and new that a company does n't dare sell it, the
company gives it away (to people who are called beta
testers) in hopes of being told what the bugs are.
binary- Capable of counting only up to 2: how a
computer thinks. Or anything that can only be in one
of two conditions, such as a Morse<ode signal, a light
switch, or a public restroom.
bit- You'd think that it's the past tense of byte (see
that entry). Actually, it's a tiny piece of computer
information that's not even big enough to bother with.
bitmap - A particular arrangement of black dots on
your white screen. To your eye, a particular bitmap
may look like the letter A (bitmapped text) or a coffee
mug (a bitmapped graphic); to the computer, it's just a
bunch of dots whose exact positions it has to
memorize.
boot - (1) (v.) To start the computer. (2) (n.) Western
footwear.

byte -A piece of computer information made up
of bits.
cache - A trick, involving a special piece of memory,
that makes a Mac faster. You can adjust the everyday
cache in the Memory control panel; if you're willing to
pay for speed, you may be able to buy for your model a
cache card, which uses high-speed memory to pull off
the same speed enhancement.
Caps Lock - A key on your keyboard that makes
every letter that you type come out as a capital; it
doesn't affect numbers. Press it to get the capitals;
press it again to return to normal.
CD-ROM - A computer compact disc that requires a
special S300 player. CD-ROMs can show pictures, play
music or voices, display short animations and movies,
and display reams and reams of text.
character - (I) A single typed letter, number, space,
or symbol. (2) The scoundrel who got you into this
Macintosh habit.
Chooser - A desk accessory, therefore listed in the
tt menu, that lets you specify what kind of printer you
have. Failure to use this thing when you set up your
Mac is the #1 reason why beginners can't print.
click- The cornerstone of the Macintosh religion: to
po int the cursor at an on-screen object and then press
a nd release the mouse button.
clip art - Ready-made graphics - cutesy little
snowmen, city skylines, Santa Clauses, whatever - to
dress up newsletters, party invitations, and threatening legal notices.
Clipboard - The invisible holding area where the Mac
stashes any text or graphics that you copy by using the
Copy command. The contents of the Clipboard get
vaporized when you turn off the Mac (or copy
something new).
clock speed - The speed of your computer, measured
in megahertz, and determined by the studliness of the
main processor chip inside.

bps - Bits per second. The technically proper way to
measure the speed of a modem (instead of baud, which
everybody still says out of force of habit). ·

close box - The little square in the upper-left corner
of a window (as opposed to the little square who sold
you the Macintosh), which, when clicked, closes the
window.

bug - A programming error in a piece of software,
caused by a programmer too wired on Jolt and pizza,
that makes the program do odd or tragic things when
you're working to beat a deadline.

Close box

bus - A form of public transportati on. Any other
questions? No, really, it's a connection between a ny
two components inside your computer.
button - You'll have to deal with two kinds of buttons:
the big square one on the mouse, and the many oval or
round ones on the screen that offer you options.
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command- Something that you'd like the Mac to do,
such as Print or Save or Make Me Rich. See also menu.
Command key- The one on your keyboard, right
next to the spacebar, that has a 3ll (Command) symbol
on it. When you press this key, the letter keys on your
keyboard perform commands Instead of typing letters for example, K-P = Print, 31l-S = Save, 31l-Q = Quit, and
31l-Z =Undo.
Control key - A keyboard key that generally does
absolutely nothing.
control panel - A window full of settings that pertain
to some aspect of the Mac's operation. There's a
control panel for the mouse, another for the keyboard,
another for the monitor, and so on. To view the
selection of control panels, choose (what else?)
Control Panels from the 9 menu.
Copland - The code name for 1997's new version of
the System Folder (which will probably be called
System 8). For +digit Mac models only. Will make the
Mac faster and more stable, with lots of neat flexible
features.
copy- The command that places a copy of something
(whatever text or graphics were first selected) in the
invisible Macintosh Clipboard. Accomplishes nothing
unless you then click somewhere and paste.
CPU - What it stands for Is central processing unit.
What it means is the actual computer - in the case of
two-piece Macs, the box that contains the real brains.
As distinguished from things like the monitor, the
printer, and the keyboard.
crash- A very ugly moment in every Mac user's life
when the Mac abruptly malfunctions, usually with
scary-looking sounds and visuals. Requires restarting.
CIU - The CRT Is the screen. If you must know, It
stands for cathode ray tube.
cursor - The pointer on the screen whose position
you control by moving the mouse across the desk.
DA - Short for desk accessory.
daisy chaining - The act of stringing together a
bunch of different add-on appliances, such as a CD
player, a hard disk, and a scanner. Involves plugging
one Into the back of the next, very much like an
elephant conga line.
data- Isn't he that white-makeup guy on Star Trek:
The Next Generation?
database - An electronic list of Information - for
example, a mailing list - that can be sorted very
quickly or searched for a specific name.
default - (1) The factory settings. For example, the
default setting for your typing in a word processor Is
single-spaced, one-inch margins. (2) De blame for
hooking you on de Mac hobby.

defragment - To restore, In one continuous chunk,
something that's all broken up and scrambled. Usually
refers to the Information in memory or on a hard disk,
but can also be applied to hamburger meat.
Delete key- In the typewriter days, this key was
named Backspace. In my opinion, it still should be
called that.
deselect - To unhighlight some selected text or
graphic. (You usually do It by clicking someplace else.)
desktop - (1) The top of your desk, where the Mac
sits, as In "I don't want a laptop; I want a desktop
computer." (2) (Capitalized) The home-base environment, where you see the Trash can, Icons, and all that
stuff. Also known as the Finder. (3) The actual (usually
gray) background of that home-base view. You can drag
an Icon out of Its window and onto this gray tablecloth,
and announce to your coworker that you've just placed
an Icon on the Desktop.
desktop file - A file the Mac maintains for its own use,
In which It stores Information such as what your icons
should look like and which kinds of documents can be
opened by which programs. This file Is invisible, but
when it becomes damaged or bloated and starts
causing problems, it's not quite invisible enough for
most people.
desktop publishing - The act of cranking out nicelooking printouts from your Mac instead of paying to
have the work typeset. Despite the fact that the
PowerBook ls equally adept at creating beautiful
printouts, the term laptop publishing still hasn't quite
caught on.
dialog box - The message box that the Mac puts on
the screen when It needs more Information from you
(for example, the one that appears when you print,
asking how many copies you want).
digitize - Computerese for digest. To convert sound,
pictures, video, or any other kind of real-world sensory
experience Into the Mac's own numerical digestive
tract.
digitizing board - A circuit board that converts video
or TV pictures Into Illes on your Mac.
DIMMs - The memory chips for certain Power Macs
made in 1995 or later (see SlMMs).
disk- Oh, come on; you know this word.
disk cache - A secret feature for making your Mac
faster at the expense of memory. The Mac memorizes a
few things that you do a lot and keeps them in a wad of
memory called the disk cache, where they'll be
Immediately accessible. You set the size of the disk
cache (the amount of memory reserved) In the
Memory control panel.
disk drive - The machinery that actually reads what's
on a disk. If we're talking hard disk, the disk and the
drive are built into a single unit. If we're talking floppy,
the disk drive is the slot in the face of the Mac into
which you insert a floppy disk.
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Examples: a memo (using a word processing program),
a logo (using a graphics program), or a spreadsheet
(using a spreadsheet program).

Ethernet -A system (wiring, connectors, software) of
connecting Macs together in an office network. Faster
than the free, built-in system (LocalTalk) that comes
with every Mac.

documentation - A five-syllable way of saying user's

expansion slot - The connector socket for an add-0n
circuit board inside most Mac models. Used to add
circuit boards for fancy new features like networking,
pro graphics, and so on.

guide.

DOS - Synonym for IBM-style computers, meaning the
computers of the world that aren't lucky enough to be
Macs. Stands for Disk Operating System.
dot-mabix - A kind of low-quality printer, such as the
ImageWriter, and the printouts that it makes.
dots per inch -A gauge of visual clarity, both on
printouts and on the screen. The Mac's crystal-dear
screen became famous for having a very high
resolution - 72 dots per inch, or 72 dpi. A laser printer
is much sharper, though, capable of printing at 300 or
600 dpi.
download - To transfer a file from one computer to
another over phone lines. If you're on the receiving
end, you download the file. If you're on the sending
end, you upload the file. If you're the phone company,
you love the file.
downloadable font - Every laser printer comes with
a basic set of typefaces built into it. You're welcome to
use fonts that aren't in that built-in set, but the Mac
has to send them to the printer (the printer downloads
them) before the printer can start spitting out pages.
dpi - Dots per inch.

extended keyboard - A slightly more expensive
keyboard than the "standard" one. The extended
keyboard has a row of function keys (Fl, F2, and so on)
across the top, which don't do anything, and a little
bank of keys that say Page Up, Page Down, and
other stuff.
extension - Miniprogram that you install by dropping
it in your System Folder (whereupon the Mac puts it in
the Extensions folder). From that moment on, the
extension will run itself when you tum on the Mac and
will be on all the time. Examples: virus protectors and
screen savers.
fax/modem - Like a modem (see modem), but also
lets you send or receive faxes from your Mac screen.
field - Computerese for blank, such as a blank in a
form.
file - The generic word for one of the little icons in
your Macintosh. There are two kinds of files: programs,
which you purchase to get work done, and documents,
which are created by programs. See also program and
document.

drag- (1) To position the cursor on something, hold
down the mouse button, and move the mouse while
the button is still down. (2) What it is when your disk
drive breaks the day after the warranty expires.

F1Ie Sharing- A built-in feature of System 7, wherein
you can make any file, folder, or disk available for other
people to go rooting through (as long as they're
connected to your Mac by network wiring).

drawing program - A graphics program (such as
MacDraw or ClarisDraw) that creates circles, squares,
and lines. The Mac stores each object that you draw as
an object unto itself, rather than storing the status of
each screen dot. See also painting program and bitmap.

Finder - The "home-base" view when you're working
on your Mac. It's the environment where you see the
Trash, your icons, and how little space you've got left
on your disk. Also known as the Desktop or "that place
with all the little pictures."

driver - A smallish file on your disk that tells the Mac
how it's supposed to relate to a specific piece of
equipment (such as a printer or a scanner) that it's
never heard of before. A translator.

FICEY - One of those cool techno-sounding words that
nobody's ever pinned down to one meaning. Can refer
to (1) the row of keys across the top of some keyboards: the function keys, labeled Fl, F2, and so on. Or
(2) a special built-in keyboard shortcut involving the 3C
and Shift keys plus a number. The 3C-Shift-3 function
key, for example, takes a snapshot of the screen, and
:!fl-Shift-I ejects a floppy disk.

E-mail - Electronic mail; messages that you read and
write on the Mac screen without ever printing them.
May also be short for Earth-mail, because no paper
(and no rain-forest acreage) is involved.
Enter key-A key (obviously) with the word Enter on
it. It almost always does the same thing as the Return key.
EPS file - A type of graphics file. Characterized by
extremely sharp, smooth printing on a laser printer; a
large file size on the disk; and, often, difficulty in
printing.

flat-file database - A shopping list, Rolodex, or phone
book; a simple collection of information. On a Mac, you
can do things to your database like search or sort; flat·
file means that the database doesn't have fancy
interconnections to other lists, as a "relational"
database does.
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floppy disk-The hard 31/2-inch-square thing that you
put into your disk-drive slot. Comes in three capacities:
400K (single-sided), SOOK (double-sided), and l,400K
(quadruple-sided, or high-density).
folder - In the Mac world, a little filing-folder Icon into
which you can drop other icons (such as your work)
for organizational purposes. When you double-click a
folder, it opens into a window. Also the name of the
high-speed machine that creases and envelope-stuffs
the junk mail that you're going to start getting from
computer companies.
font- (1) Apple's usage: a single typeface. (2)
Everyone else's usage: a typeface family or package.
FPU - See math coprocessor.
fragmentation - When something gets broken up into
little pieces. Usually refers to the files on your hard
disk (which, over time, get stored In little pieces all
over the disk, making it slower) or to the memory In
your computer (see defragmenf). Also can apply to
your window after you throw the computer through It
in frustration.
freeze - When your cursor becomes Immovable on

your screen, you can't type anything, your Mac locks
up, and you get furious because you lose everything
you've typed In the past ten minutes.
function key- See FKEY.
GIF - A kind of graphics file, most often used on
America Online and the Internet. Requires a special
program, such as the America Online program, to open
and view it.
gig- Short for gigabyte, which Is 1,024 megabytes, or
a very big hard drive.

graysc:ale - A form of color image or color monitor on
which all the colors are different shades of gray, like all
the images in this book.

grow box - Slang for resize box (see that entry).
hang- (I) Freeze (see freeze). (2) Knack, as in "Hey,
I'm actually getting the hang of this. I'm no dummy!"

hard copy - A synonym for printout. A term used
primarily by the kind of people who have car phones
and say, "Let's interface on this.•
hard disk - A hard drive.
hard drive - A hard disk. That is, the spinning
platters, usually inside your Mac but also available In
an external form, that serve as a giant floppy disk
where your computer files get stored.
hardware - The parts of your computer experience
that you can feel, touch, and pay for. Contrast with
software.

header - Something that appears at the top of every
page of a document, such as "Chapter 4: The Milkman's
Plight" or "Final Disconnection Notice."
highlight - To select, usually by clicking or dragging
with the mouse. In the Mac world, text and icons
usually indicate that they're selected, or highlighted,
by turning black.
icon - A teensy picture used as a symbol for a file, a
folder, or a disk.

initialize - To prepare a new disk for use on your
computer. Entails erasing it completely.
Insertion point - In word processing, the short,
blinking vertical line that's always somewhere in your
text. It Indicates where your next typing (or backspacing) will begin.

+

The insertion point is right before this !word.

internet - The worldwide network of computers
joined by phone lines. Incorporates the World Wide
Web, e-mail, and other features (see Chapter 10).
Jaggles - Ragged or tiny stairstepped edges on
lettering or graphics, appearing either on the screen or
in your printouts. Usually solved by switching to a
TrueType font or by getting Adobe Type Manager
working. See also ATM.
JPEG - Another graphics-file format found
most often on America Online and the Internet (see
GIF). This one has higher quality.
K - Short for kilobyte, a unit of size measurement for
computer Information. A floppy disk usually holds
SOOK or l,400K of data. All the typing In this book fills
about l ,SOOK. A full-screen color picture Is around
l,OOOK of information. When your hard disk gets
erased accidentally, it's got OK (that's not OK).
kerning - In type-intensive Mac work, such as
creating a newspaper headline, the act of squishing
two letters slightly closer together to make better use
of space so that you can flt the phrase AN ALIEN
FATHERED MY TWO-HEADED BABY on one line.
label - A System 7 text tag or color tag, used to
identify icons by category.
landscape - Used to describe the sideways orientation of a piece of paper. Also the natural environment
outdoors that you gradually forget about as you
become addicted to the Mac.

laser printer - An expensive printer that creates
awesome-looking printouts.
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computer all day long, moving icons around, because
he hasn't figured out how to launch a program yet."

modem - A phone attachment for your Mac that lets
you send files and messages to other computer users
all over the world, and prevent anyone else in the
house from using the phone.

LCD - The technology that creates the flat screen on
the PowerBook laptop computer, marked by the
tendency for the pointer to fade out if it's moved too
quickly. Stands for either Liquid Crystal Display or Lost
the Cursor, Dammit.

modifier keys - Keys that mess up what the letter
keys do. Famous example: the Shift key. Other
examples: 00 (Command), Option, Control, and
Caps Lock.

leading - (LEDding): The vertical distance between
lines of text in a document. Single-spaced and doublespaced are measurements of leading. Example: "His
term paper was 33 pages short, so he increased the
leading and hoped that the professor wouldn't notice."

monitor - What you should do to your blood
pressure when you find out how much computer
screens (monitors) cost and weigh.

LocalTalk - The hardware portion of a Macintosh
network: the connectors and cables that plug one Mac
into another.

mount - A term used mainly in error messages: to
bring a disk's icon onto the Desktop so that its
contents may be viewed or opened.

logic board - The main circuit board inside your Mac.
Often at fault when your Mac refuses to tum on.

mouse button - The square or rounded plastic button
at the far end of the top of the mouse.

MacOS - The System software (the behind-the-scenes
operating software) that makes a computer act like a
Mac. As distinguished from DOS or Windows.

multimedia - Something involving more than one
medium, I guess. On the Mac, anything that gives you
something to look at and listen to, such as a CD-ROM
game.

macro - A predefined series of actions that the Mac
performs automatically when you press a single keysuch as launching your word processor, typing Help!
I'm being inhabited by a Mac poltergeist!, and
printing it - all by itself. Requires a special macro
program such as QuicKeys or Tempo.
mail merge - Creating personalized form letters with

a word processing program. Considered to be perfectly
polite unless somebody catches you.
math coprocessor - The kid whose algebra homework you used to copy. (Just kidding.) Actually, a
specialized chip inside certain high-level Macs that
kicks in to handle certain very intense numbercrunching tasks - data analysis and stuff. Does
nothing for word processing and other normal tasks.
Also called an FPU (floating-point unit).
MB - Short for megabyte.
megabyte -A unit of disk-storage space or memory
measurement (see K). Used to measure hard disks,
memory, and other large storage devices. There are
about l,OOOK in a megabyte.
memory - The electronic holding area that exists
only when the Mac Is turned on; where your document
lives while you're working on it. Expensive and limited
in each Mac.
menu - A list of commands, neatly organized by
topic, that drops down from the top of the Mac screen
when you click the menu's title.
menu bar - The white strip, containing menu titles,
that's always at the top of the Mac screen. Not to be
confused with bar menu, which is a wine list.

motherboard - See logic board.

native software - Specially written programs that run
nice and fast on a Power Macintosh.
network - What you create when you connect Macs
to each other. A network lets you send messages or
transfer files from one Mac to another without getting
up and running down the ~all with a floppy disk in
your hand (a networking system fondly called
SneakerNet).
Newton - A small hand-held computer made by
Apple. Has no keyboard; you write on it with an inkless
pen. Can exchange names, addresses, and notes with
your Mac.
NuBus - The special kind of expansion slot (see
expansion slot) found in any Mac II-style computer and
most Quadra-style computers. Contrast with PDS, the
slot in a Macintosh LC, or PC/, the slot in the most

recent Power Macs. (And no, there was never an
OldBus.)
NumLock - A goofy key, named by numskulls, on the
keyboard. Pretty much does nothing except in
Microsoft Word, where it switches the functions of the
keys in the number pad.
OCR - Short for optical character recognition. You run
an article that you tore out of Entertainment Weekly
through a scanner, and the Mac translates it into a
word processing document on your screen, so you can
edit it and remove all references to Cher.
oniine - Hooked up, as in "Let's get this relationship
online." In Mac lore, it means hooked up to another
computer, such as America Online.
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painting program - (1) A program with the word
Paint in the title (for example, MacPaint or UltraPaint)

that creates artwork by turning Individual white dots
black on the screen. (2) An adult-education course for
would-be watercolorers.
partition - To use special formatting software that

tricks the Mac into thinking that your hard disk is
actually two (or more) disks, each with its own icon on
the screen. Like subdividing a movie theater into a
duplex, but less expensive.
paste - To place some text or graphics (that you
previously copied or cut) in a document.
PC - Stands for personal computer, but really means
any non-Macintosh (i.e., inferior) computer; an
IBM clone.
PO -A 1995-era new style of NuBus slot in certain

Mac models (see NuBus).

means high-quality type and graphics, and all of it
means heaping revenue for Adobe, the company that
invented it.
PowerBook - A Mac laptop and the first of many

Apple trademarks to contain the word Power.
Power Macintosh - A Mac whose primary brain is the

PowerPC chip.
PowerPC chip - The very fast main processor chip

inside a Power Macintosh.
PowerTalk - A special feature of System 7.5, designed
for very sophisticated network setups in offices.
Provides a desktop mailbox icon for electronic
messages sent to you by your officemates (and may
someday also be able to receive your messages from
services such as America Online). Absolutely
impossible to figure out.
PRAM - Parameter RAM: the little piece of memory

expansion slot (see that entry) in a Mac LC. Incompatible with NuBus (see that entry, too).

maintained by your Mac's battery. Helps explain why
the Mac always knows the date and time even when it's
been turned off.

peripheral- (1) Any add-on: a printer, scanner, CO..

printer font - The printer half of a PostScript font

ROM dr,ive, dust cover, and so on. (2) The kind of
vision by which you'll see your spouse leave you
forever because you're too consumed by the Mac.

(the other half is the screen font). Must be in your
System Folder, and you must have one printer font for
each style (bold, italic, and so on). An eternal
nuisance.

PDS- Stands for processor direct slot and is the kind of

Performa - A Macintosh sold as a complete package
(monitor, keyboard, software, modem, Mac) for one
price in one box.

PrlntMonltor - A program that launches itself,

PICT - A confusing-sounding acronym for the most
common kind of picture file, as in "Just paste that
image of Sculley's head into your word processor,
Frank; it's only a PICT file, for heaven's sake."

unbidden, whenever you try to print something when
background printing is turned on (see background
printing). Print Monitor is also the program that tries to
notify you when something goes wrong with the
printer, such as when a piece of paper gets horribly
mangled inside.

pixel - One single dot out of the thousands that make

program - A piece of software, created by a

up the screen image. Supposedly derived from picture
element, which still doesn't explain how the x got there.
pofHip menu -Any menu that doesn't appear at the
top of the screen. Usually marked by a down-pointing
black triangle. Doesn't actually pop up; usually

drops down.
Paper: I US Letter
Layout:I

1

I

Up.,.. I

port - A jack or connection socket in the back of

your Mac.
portrait - A right-side-up piece of paper; the opposite

of landscape (see that entry). Also a right-side-up
monitor that can display a full page (as in "a portrait
display monitor").
PostScript - A technology, a printer, a trademark, a

kind of font, a computer code language for displaying
or printing text or graphics, a way of life. All of it

programmer, that you buy to make your Mac do
something specific: graphics, music, word processing,
number crunching, or whatever.
Publish and Subscribe - A fancy new version of copyand-paste that's part of System 7. Lets you paste
information (such as a graphic) from one document
into another (such as a memo) in such a way that
when you make a change in the original (the graphic),
the copy (the memo) is changed automatically.
QulckDraw - A behind-the-scenes technology used to

draw all the familiar pictures on your screen, such as
lettering, windows, and icons.
QulckDraw GX - A very sophisticated feature for
System 7.5 and later. Permits certain "GX-savvy"
programs to manipulate type on the screen in neat
ways. Also puts an icon on your Desktop for each
printer you own, so you can specify which printer to
use by dragging your document icon onto it. Not really
worth the trouble.
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QuickTime - The technology (and the little software
extension) that permits you to make and view digital
movies on your Mac screen: Does nothing by itself;
requires QuickTime recording, playing, and editing
programs.

resolution - (1) A number, measured in dots per inch,
that indicates how crisply a printer or a monitor can
display an Image. (2) A New Year's vow, such as "I will
spend five minutes away from the computer each day
for family, exercise, and social activity."

QuickTime VR - A special kind of QuickTime movie
that lets you change the camera angle of a still photo
by dragging your cursor around inside the picture.
Increasingly common on the World Wide Web.

restart switch - A little plastic switch, marked by a
left-pointing triangle, on the case molding of most
Macs that, when pressed, turns the Mac off and on
again. For use when the computer's "frozen."

quit - To exit or close a program, removing it from
memory. Or to exit or close your job, having gotten
sick of working in front of a computer all day.

RISC - Stands for reduced instruction-set computing
and means a very fast processor chip, such as the
PowerPC chip inside a Power Macintosh.

radio button - What you see in groups of two or more
when the Mac is forcing you to choose among mutually
exclusive options, such as these:

ROM -A mediation mantra that you can use when
contemplating the ROM chips, where the Mac's
instructions to itself are permanently etched.

R System error has occurred. Whot result
would you like?

0 loud, static buzzing

® Quietly blink to block
0 R two-minute fireworks display
RAM - Term for memory (see memory) designed to
intimidate non-computer users.
RAM disk - A way to trick the Mac into thinking that
It has an extra floppy disk inserted. The RAM disk is
actually a chunk of memory set aside to resemble a
disk (complete with an icon on the screen). A built-in
option on most Macs and PowerBooks.
reboot -

Restart.

rebuilding the Desktop - One of several desperate
methods that you can use in the event that something
screwy goes wrong with the Mac. Involves holding down
the ag and Option keys while the Mac is starting up.
record (n.) - Other than Its obvious definitions, the
computer word record refers to one "card" In a
database, such as one person's address information.
Contrast with field, which is one blank (such as a ZIP
code) within a record.

sans serif-A font, such as Helvetica or Geneva, with
no little "hats" and "feet" at the tip of each letter. See
Chapter4.
scanner - A machine that takes a picture of a piece of
paper (like a Xerox machine) and then displays the
image on your Mac screen for editing.
Scrapbook- A desk accessory, found in your
ti menu, used for permanent storage of graphics, text,
and sounds. (Not the same as the Clipboard, which
isn't permanent and holds only one thing at a time .) To
get something into the Scrapbook, copy it from a
document, open the Scrapbook, and paste It. To get
something out of the Scrapbook, use the scroll bar
until you see what you want, and then copy it (or cut it).
screen saver -A program (such as After Dark) that
darkens your screen after you haven't worked for
several minutes. Designed to protect an unchanging
image from burning into the screen, but more often
used as a status symbol.
scroll bar- The strips along the left and right sides of
a Mac window. When a scroll bar's arrows, gray
portion, or little white (or gray) square are clicked or
dragged, a different part of the window's contents
heaves Into view (scrolls).
§Iii~

resize box - The small square in the lower-right
corner of a window that, when dragged , changes the
size and shape of your window.

Control Panels
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SCSI - Stands for Small Computer [something]
Interface. The second Smay stand for standard, system,
or serial, depending on whom you ask. Used only in the
following five terms.
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SCSI address - Refers to a number that you must give
each SCSI device (see SCSI device) that's plugged into
your Mac, using a little switch or thumbwheel on the
back. The address can be between 0 and 7, except that
the Mac is always 7 and the internal hard disk is always
0. If two SCSI devices have the same SCSI address,
you're in big trouble.

stationery - A System 7 feature. Click a document
Icon, choose Get Info from the File menu, and select
Stationery Pad. Thereafter, when you double-click that
Icon, it won't open; instead, an exact copy of it opens.
This saves you the hassle of pasting the same logo into
every memo that you write because you can paste It
Into your Stationery Pad document just once.

SCSI cable -A fat cable with a 25- or 50-pin connector
at the end, used to Join SCSI devices. The total length
of all your SCSI cables can't be more than about 20 feet,
or you 're in big trouble.

StyleWriter - A quiet, low-cost, high-quality, slowspeed Apple inkjet printer.

SCSI device - A scanner, CD player, external hard
drive, or other piece of eqµlpment that you attach to
the wide SCSI port in the back of your Mac.

submenu - In some menus, you're forced to choose
among an additional set of options, which are marked
in the menu by a right-pointing triangle. When your
pointer Is on the main menu command, the submenu
pops out, like this:

SCSI terminator - A plug that is supposed to go Into
the last SCSI device attached to your Mac. If you don't
use one, you're in big trouble; although sometimes
you're in big trouble if you do use one. See Chapter 12.

Ruant Garde
Helvetica

serif (n., adj.) - A term used to describe a font that
has little ledges, like little "hats" and "feet," at the tip of
each letter, such as Times or this font.

Monaco
New York

shareware - Programs that are distributed for free,
via an electronic bulletin board or on a floppy disk,
from user groups. The programmer requests that you
send $10 or $20 to him or her, but only if you really like
the program.
SIMM - Stands for Single In-line Memory Module,
which I suggest that you immediately forget. It refers to
the little epoxy mini-circuit board that you install Into
your Mac when you decide you need more memory.
SimpleText -An extremely basic word processor that
comes free with every Mac.
sleep - A command, and a condition, that applies to
PowerBooks and recent Power Mac models. Sort of like
Off, except that the Mac remembers everything that
you had running on the screen. When you want to use
the computer again, you Just touch a key; the whole
computer wakes up, the screen lights up, and you're In
business again. Used to conserve power.
slot-An expansion slot (see that entry).
software - The real reason you got a computer.
Software Is computer code, the stuff on disks:
programs (that let you create documents) and
documents themselves. Software tells the hardware
what to do.
spreadsheet - A program that's like an electronic
ledger book; you can type columns of numbers in a
spreadsheet program and have them added automatically.
startup disk- A startup disk is a floppy or hard disk
that contains a System Folder. The startup disk is the
one that you've designated to be In control (in the
event that you have more than one to choose among).
The Startup Disk control panel is what you use to
specify the startup disk.

Images

Times
Zapf Dingbats

System 6 -An older version of the Mac's controlling
software. Faster, but harder to use, than System 7.
Requires !MB of memory or less.
System 7 - The more recent version of the Mac's
cont.·olling software. More attractive, easier to use,
more powerful, and slower than System 6. Requires at
least 2MB of memory and, because it's a lot of
software, a hard disk (it doesn't fit on a floppy).
Generically, refers to any flavor of System 7: version 7.0,
7.1, 7.5, or whatever.
System 7.1 - The first version of the Mac System
software that's not free; you have to buy it. Adds two
features to System 7: a Fonts folder, which contains all
manner of font files (TrueType, screen fonts, and
printer fonts); and WorldScript, which enables you to
convert all Mac screen elements to a different
language, such as Japanese. (WorldScript requires
special drop-in language modules.)
System 7.5- Yet another version of the System
Folder, which, again, you must purchase unless your
Mac came with it. Under the hood, System 7.5 is much
the same as System 7.1. But it comes with about 50
new control panels and extensions that perform stunts
such as giving submenus to your 9 menu to providing
a floating "control strip" for your PowerBook.
System crash - When something goes so wrong Inside
your Mac that a bomb appears on the screen with the
message "Sorry, a System error has occurred" - or
not. Sometimes, the whole screen Just freaks, fills with
static, and makes buzzing noises, like a TV station
that's going off the air.
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System disk-A startup disk (see that entry).
System file - The most important individual file
inside a System Folder. Contains the Mac's instructions
to itself, and stores your fonts, sounds, and other
important customization information. A Mac without a
System file is like a broke politician: it can't run.
System Folder - The all-important folder that the Mac
requires to run. Contains all kinds of other stuff that's
also defined in this glossary: the System file , the
Finder, fonts , desk accessories, printer fonts, and so
on. Always identified by this special folder icon:

(}]
Sys tem Folder

volume - A disk of any kind: floppy, hard , cartridge,
or anything represented on your Desktop by its own
icon.
VRAM - Stands for video RAM Memory chips inside
your Mac that are dedicated to storing the screen
picture from moment to moment. The more VRAM you
have, the more colorful your picture (and the more you
paid for your Mac).
window - A square view of Mac information. In the
Finder, a window is a table of contents for a folder or a
disk. In a program, a window displays your document.
word wrap-A word processing program's ability to
place a word on the next line as soon as the current
line becomes full.

telecommute - To work in T-shirt and slippers in a
messy apartment, spending not one penQy on
transportation, and sending work to the office over the
phone lines. Requires a modem and an ability to be
alone for days on end without going insane.

WYSIWYG - Short for what you see is what you get one supposed reason for the Mac's superi-0rity over
other computers. Theoretically means that your
printout will precisely match what you see on the
screen (but isn't always true).

terminator - See SCSI terminator. Or see an Arnold
Schwarzenegger movie.

Zip disk - A slightly thickened floppy disk that holds
lOOMB (as much as a hard drive) and costs $15. To be
used in Zip drives, sold by Iomega.

third party - (1) A company other than Apple, as in
"You didn't get a mouse pad with your Mac? Well, of
course not; you buy that from a third party." ( You, by
the way, are the second party.) (2) The New Year's Eve
get-together at which you get the drunkest.

zoom box - The tiny square in the upper-right corner
of a window (in the title bar) that, when clicked, makes
the window jump to full size.

Zoom box

TIFF - Stands for tagged image file format and is the
kind of graphics-file format created by a scanner.
title bar - The strip at the top of a window where the
window's name appears. Shows thin horizontal stripes
if the window is active (in front of all the others).
toner - The powder that serves as the "ink" for a
laser printer. Runs out at critical moments.
trackball - An alternative to the mouse. Looks like an
8-ball set in a pedestal; you roll it to move the pointer.
TrueType - A special font format from Apple that
ensures high-quality type at any size, both on the
screen and on any printer. Rival to PostScript but costs
much less (nothing, in fact; it comes with System 7).
upload - To send a file to another computer via
modem. See also download.
user group - A local computer club; usually meets
once a month. Serves as a local source of information
and as a place to unload your obsolete equipment to
unsuspecting newcomers.
video card - A circuit board that most Mac II-series
Macs need to display anything at all on the monitor.
virtual memory - A chunk of hard-disk space that the
Mac sets aside, if you want, to serve as emergency
memory.
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A/ROSE extension, Extensions folder, 202
Abaton Interfax extensions, Extensions folder, 202
About This Macintosh command
operating system Information, 19
Option key and, 260
accelerators, defined, 391
accent marks, special characters, 172
access privileges, defined, 391
active windows, defined, 391
ADB (Apple Desktop Bus), 391
add-ons. See peripherals
addresses
SCSI, 402
World Wide Web, 248, 249-252
Adobe Type Manager (ATM), 105
Alarm Clock, Apple Menu Items folder, 191
alert boxes, defined, 391
aliases, 261-262, 391
alphabetizing icons, Option key, 259
America Online, 227-242
ArtValve utility, 235
artwork downloads, 234-235
chatrooms,236-238
compressed files, 240-242
connecting to, 227-230
e-mail, 229, 235-236
favorite places, 232-234
free software from, 289
hangups,220
icons, 230-231
· Instant Messages, 238-239
Internet access, 243
keywords,231-232
obtaining, 227
screen names, 228
self-expanding archives, 241
software downloads, 239-242
Stufflt file expander, 241-242
World Wide Web, 249, 251, 254
Apple Backup program, Performa, 303
Apple CD Speed Switch, Control Panels folder, 193
Apple CD-ROM extensions, Extensions folder: 202
Apple Computer, toll-free number, 221, 365 '
Apple Gulde extensions, Extensions folder, 202
Apple menu
available RAM, 29
Control Panels, 57-60
customizing, 52
described, 391
desk accessories, 51-57
operating systems, 19

shutting the Mac down, 15
System 7.5, 189
Apple Menu Items folder, System Folder, 191-193
Apple Menu Options, Control Panels folder, 194
AppleCare warranty, PowerBooks, 309
AppleCD Audio Player, Apple Menu Items folder, 191
AppleFax, help service, 365
AppleScript extensions, Extensions folder, 202
AppleScript Lib extension, Extensions folder, 205
AppleShare extensions, Extensions folder, 202
AppleTalk
Control Panels folder, 194
descrlbed,391-392
PowerBooks and, 306
printers and, 97
Application menu, 54-57, 392
"Application not found" error message, 327-329
Arc tool, painting programs, 123-124
ASCII, defined, 392
Assistant Toolbox extension, Extensions folder: 202
assistants, ClarlsWorks, 183
'
At Ease Setup control panel, Control Panels folder:
194
'
At Ease system software, Performa, 303-304
ATM (Adobe Type Manager), 105, 392
Control Panels folder, 194
Audio Player, Apple Menu Items folder, 191
Auto Power On/Off, Control Panels folder, 194
AutoRemounter, Control Panels folder, 194
AutoVlsion extension, Extensions folder: 203
AV series, product line, 378
'
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background printing, 98, 392
backing up files, 84, 86, 392
Balloon Help, described, 392
Basic Color Monitor extension, Extensions folder:
203
'
Basics program, 22
batteries, PowerBook, 306-308, 313-314
Battery desk accessory, Apple Menu Items folder:
191
'
baud rate, defined, 392
BBSs, defined, 392
beta tests, defined, 392
binary, defined, 392
bitmapped fonts, 102
bitmapped graphics, painting programs, 116,
120-124
bitmaps, defined, 392
bits, defined, 392
black record syndrome, ClarisWorks, 175
blinking question mark, troubleshooting errors
341-342
'
books, Macintosh, 366
boot, defined, 392
bps, defined, 392
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browser, World Wide Web, 254
bugs, defined, 392
bus, defined, 392
Button & Button Disabler control panels, Control
Panels folder, 194
buttons
defined, 392
labels and, 221-222
mouse,399
radio, 401
buying
memory, 338-339
software, 48-49
buying Macs, 369-388
clock speed, 371
credit cards, 386
FPU math coprocessors, 372
hard-disk space, 369
memory, 370
monitors, 380-384
newspaper ads, 371-373
processor model numbers, 370
product line, 373-380
where to buy, 384-386
bytes, defined, 393
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cables, SCSI, 359, 402
Cache Switch, Control Panels folder, 194
caches,defined,393
CAD, defined, 393
Calculation fields, FileMaker Pro, 163
Calculator, 51, 54-55
cameras, digital, 283
Caps Lock, described, 393
Caps Lock extension, Extensions folder, 203
CD Audio Player, Apple Menu Items folder, 191
CD Speed Switch, Control Panels folder, 193
CD-ROMs, 277-279, 393
characters
defined,393
formatting, 70-72
formatting Microsoft Word 5.1, 128-129
Fractional Character Widths option, 112
special, 172
viewing invisible, 70
charts, Excel, 158-159
Chooser
described, 393
printers and, 95-98
ClarisWorks, 167-184
black record syndrome, 175
data entry, 171-174
databases, 169-174
form letters, 168, 174-178
launching, 167-168
letterhead, 178-181
mail merge, 168-178
mailing labels, 184
module overview, 168
Painting window, 181-182
slide shows, 182-183
talking software, 290

"Use Assistant or Stationery" checkbox, 183
View buttons, 180
"clean system reinstalls," troubleshooting errors,
361-362
clicking the mouse, 14
defined,393
double-clicking, 20
clip art, defined, 393
Clipboard
copy and paste, 53-54
cutting text to, 88
described, 393
System Folder and, 208
Clipping extension, Extensions folder, 203
clock speed, defined, 393
close box, 18, 393
CloseView control panel, Control Panels folder, 194
closing
all windows at once, 256
files, 78
programs, 84
Color control panel, Control Panels folder, 194
Color Picker extension, Extensions folder, 204
color printers, 93-94, 382
color separation, defined, 393
Color SW extensions, Extensions folder, 204
ColorSync extension, Extensions folder, 204
ColorSync System Profile control panel, Control
Panels folder, 195
Command key, 35, 393
commands
defined,393
"grayed out," 14
highlighted, 14
verbal, 290-292
compressed files
America Online, 240-242
.sit files, 214-215
compression
defined,396
utility programs, 271
Conflict Catcher, extension conflicts, 356
Control Panels, 57-60
described, 393-394
top ten explanations, 59-60
Control Panels (Disabled) folder, System Folder, 208
Control Panels folder, System Folder, 193-201
Control Strip
Control Panels folder, 195
PowerBook, 308, 309
Copland, defined, 394
copy and paste, 53-57
letterheads, 181
copying
data to floppy disks, 42
data to hard disks, 42-43
defined,394
documents with Option key, 258
floppy disks, 45
CPU Energy Saver control panel, Control Panels
folder, 195
CPUs, defined, 394
crashing, defined, 394
CRT, defined, 394
curly quotes, 89

Index
cursors
defined, 13,394
I-beam, 65
PowerBook, 311
troubleshooting errors, 351
cutting text to Clipboard, 88
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daisy-chaining peripherals
defined,394
SCSI, 284, 357-359
DAL extension, Extensions folder, 204
DAs. See desk accessories
data
copying to floppy disks, 25-26, 42
copying to hard disks, 42-43
data entry
ClarisWorks, 171-174
FileMaker Pro, 161-162
data types, FileMaker Pro, 161
databases
ClarisWorks, 169-174
defined,394
FileMaker Pro, 159-165
flat-file, 396
relational, 401
Date & Time control panel, 59, 195
date-stamping, Microsoft Word 5.1, 131
default, defined, 394
defragmenting
defined,394
hard drives, 362
RAM,335-336
D.elete key, described, 394
deleting
See also Trash
text, 66-67
deselecting
defined,394
text, 68, 72
desk accessories, 51-57
Calculator, 51, 54-55
Note Pad, 51-52, 56
Desktop
See also Finder
defined, 11, 394
moving icons around on, 15-16
rebuilding, 353-354, 401
saving documents on, 83
Desktop file, defined, 394
Desktop Patterns control panel, 60, 195
desktop publishing, defined, 394
diacritical marks, special characters, 172
dialog boxes, 74
described, 394
Tab key and, 99-100
digital cameras, 283
digitizing
defined,395
tablets, 282
DIMMs, defined, 395
disk caches, defined, 395

disks
See also floppy disks; hard disks
renaming, 44
top ten tips, 44-46
Display Enabler extension, Extensions folder, 204
Document Layout palette, QuarkXPress, 153
documents
See also files
backing up, 84, 86
closing, 78
copying via Option key, 258
defined,395
finding, 84-87
locking, 45
naming, 74
navigating via scroll bars, 88
relationship to programs, 80-81
retrieving, 81-82
saving, 73-78, 82-83
selecting all text in, 88
Documents folder, Performa, 298-300
Dogcow, 111
DOS, defined, 395
dot matrix, defined, 395
dots per inch (dpi), defined, 395
double-clicking, 20
defined,395
selecting words by, 87
downloadable fonts, 109, 395
downloading files
America Online, 239-242
defined, 395
FTP (file transfer protocol), 247-248
Drag and Drop extension, Extensions folder, 204
dragging the mouse, 14, 395
dragging text, Microsoft Word 5.1, 130-131
drawing programs, 116-120
concepts, 117-118
described, 395
frequent pattern changers, 118
handles, 117
object-oriented graphics, 116
painting comparison, 116
pop-up controls, 118
selecting and grouping multiple objects, 119
Shift key, 118
text and, 119-120
tools, 117-118
drivers
defined, 395
Extensions folder, 218
printer, 96-97
Duos, PowerBook, 312-313
dye-sublimation printers, 94
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e-mail
America Online, 229, 235-236
defined,395
Internet, 244
Easy Access control panel, Control Panels folder, 195
editing
desktop publishing, 150
word processing, 66-68
ejecting floppy disks, 43, 44

403

404

Macs For Dummies, 4th E d i t i o n - - - - - - - - - - - - - - - - Ellipse tool, painting programs, 123-124
EM extension, Extensions folder, 204
Enter key, described, 395
EPS files, described, 396
Eraser tool, painting programs, 123
ergonomics, setting up work environment, 386
error messages, 327-332
See also troubleshooting errors
"An error occurred while writing to the disk," 332
"An error of Type 1 occurred," 329
"Application has unexpectedly quit," 331
"Application not found," 327-329
"Bad F-Line Instruction," 329
"Can't empty Trash," 331
"The disk is full," 331
"Math coprocessor not installed," 330
"Microsoft Word prefers 2048K of memory," 332
numbered, 332
"Sorry, a System error has occurred," 329
uselessness of, 218-219
"You do not have enough access privileges," 330
Ethernet, defined, 396
etiquette, Internet, 246
Excel, 153-159
calculating cells, 156-158
charts, 158-159
Fill Right command, 157
formatting numbers and text, 154-155
navigating cells, 155
starting, 154
expanding
.sit files, 214-215
windows,46
expansion slots, defined, 396
Express Modem control panel, Control Panels
folder, 196
extended keyboards, defined, 396
extensions
conflict resolution, 355-356
defined,396
troubleshooting errors, 325
Extensions (Disabled) folder, System Folder, 208
Extensions folder
drivers, 218
System Folder, 202-207
Extensions Manager control panel, Control Panels
folder, 196
External CD Sound extension, Extensions folder, 204
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Fax Extender extension, Extensions folder, 204
Fax extension, Extensions folder, 204
fax/modems, 212-213
defined, 396
as printers, 311
fields
defined,396
FileMaker Pro, 160
file compression, defined, 396
File Sharing, defined, 396
File Sharing Monitor control panel, Control Panels
folder, 196
FileMaker Pro, 159-165
automatic saves, 160
Calculation fields, 163
data entry, 161-162

data types, 161
fields, 160
Find command, 164
layout design, 162-164
records, 160
Sort command, 164-165
starting files, 160-161
views, 159
files
See also documents
aliases of, 261-262
backing up, 84, 86
closing, 78
defined,396
duplicating, 45
finding, 84-87
lists of, 262-263
Find command, FileMaker Pro, 164
Find File desk accessory, 84-87
Apple Menu Items folder, 192
Find File extension, Extensions folder, 205
Finder
See also Desktop
described, 396
System Folder and, 209
troubleshooting errors, 345-347
Finder Help extension, Extensions folder, 204
Finder Scripting Extension, Extensions folder, 202
FKEY, defined, 396
flat-file databases, defined, 396
floppy disks, 40-44
copying, 45
copying data onto, 42
defined,396
ejecting, 43, 44
initializing, 40-41
inserting, 40-41
locking, 41
Put Away command, 43
storing data with, 25-26
top ten tips, 44-46
troubleshooting errors, 347-350
folders, 33-34
defined,396
lists of, 262-263
naming, 34
nested, 256-257
font toolbar, Microsoft Word 6, 133
Font/DA Mover, described, 396
fonts, 100-112
ATM (Adobe Type Manager), 105
avoiding jagged printouts, 100-104
bitmapped, 102
built-in, 106-107, 109
defined,396
downloadable, 109
Fractional Character Widths option, 112
identifying, 104-107
installing, 107
organizing utilities, 110-111
Postscript, 102-104
printer, 400
QuickDraw GX, 101
removing, 107-108
serif & sans serif, 112
top ten facts, 109-112
TrueType, 104

Index
Fonts folder, System Folder, 207
footers and headers, 89, 131
Foreign File Access extensions, Extensions folder,
202
form letters, ClarisWorks, 168, 174-178
formatting
characters, 70-72
numbers and text in Excel, 154-155
paragraphs, 72-73
word processing, 69-73
Fractional Character Widths option, 112
fragmentation, defined, 397
freezing, defined, 397
FTP (file transfer protocol), 247-248
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General Controls control panel, Control Panels
folder, 196
GeoPort extension, Extensions folder, 204
G!Fs, defined, 397
·
gigs, defined, 397
graphics
bitmapped, 116
letterhead, 178-181
object-oriented, 116
Graphics Accelerator extension, Extensions
folder, 205
"grayed out" commands, 14
grayscale, defined, 397
grouping multiple objects, 119
grow boxes, defined, 397
GX, QuickDraw, 101, 206, 400
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Hand grabber tool, painting programs, 124
handles, drawing programs, 117
hanging, defined, 397
hard copies, defined, 397
hard disks, 26-27
copying data on, 42-43
defined,397
defragmenting, 362
icon, 16
top ten differences between memory and, 31-32
top ten tips, 44-46
hardware
defined,397
troubleshooting errors, 350-353
headers, defined, 397
headers and footers, 89, 131
help
Apple Computer toll-free number, 221, 365
Balloon, 392
Finder Help extension, 204
where to go for, 364-365
Hide Others option, windows, 257-258
highlighted commands, 14
highlighted text, colorizing, 266-267
highlighting
defined,397
text, 53, 66-68
horizontal scroll bar, 18
HyperCard, defined, 397
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I-beam cursors, 65
IBM PCs, expense of, 219-220
icons
aliases,261-262
alphabetizing, 259
America Online, 230-231
color-coding, 265-266
creating, 263-264
darkened,37
defined,397
hard disk, 16
moving around on Desktop, 15-16
printer, 101
renaming, 44
replacing with list views, 21, 22
selecting, 17
in this book, 4-5
Views control panel, 267-268
Ilci/Ilsi Monitors extension, Extensions folder, 205
ImageWriters, 92
defined,397
plugging in, 94
initializing
defined,397
floppy disks, 40-41
inserting floppy disks, 40-41
insertion points, 64-65
defined,397
moving, 65
installing
"clean system reinstalls," 361-362
programs, 215-216
System 7 fonts, 107
Internet, 242-254
acronyms,246
America Online and, 243
defined,397
e-mail, 244
etiquette, 246
ITP (file transfer protocol), 247-248
history of, 242
ISPs (Internet Service Providers), 244
mailing lists, 246-24 7
newsgroups, 245-246
top ten best and worst aspects of, 252-253
World Wide Web, 248-252
invisible characters, viewing, 70
Iomega, removable-cartridge systems, 281-282
ISPs (Internet Service Providers), 244

•]•

jaggies
avoiding, 100-104
defined,397
Jigsaw Puzzle, Apple Menu Items folder, 192
JPEG, defined, 397
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K, defined, 397
kerning, defined, 398
Key Caps, Apple Menu Items folder, 192
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keyboard shortcuts, 34-38, 56-57
formatting characters, 72
keyboards,extended,396
keys, modifier, 35
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labels
buttons and, 221-222
defined, 398
mailing (ClarisWorks), 184
Labels control panel, Control Panels folder, 197
landscape, defined, 398
laptops. See PowerBooks
laser printers, 93
defined,398
plugging in, 94-95
LaserWriter extension, Extensions folder, 205
Lasso tool, painting programs, 121-122
Launcher
buttons, 62
Control Panels folder, 197
Performa, 298, 299
Launcher Items folder, System Folder, 207
launching, defined, 398
LC series, product line, 375-376
LCD, defined, 398
leading, defined, 398
letterhead, ClarisWorks, 178-181
line spacing, Microsoft Word 6, 134
Line tool, painting programs, 123
Linking Tool, QuarkXPress, 152
list views, 21, 22
expanding and collapsing, 44
lists of files and folders, 262-263
LocalTalk
connectors, 95
defined, 398
locking
documents, 45
floppy disks, 41
logic boards, defined, 398

•M•

Mac FAQs (Frequently Asked Questions), 366
Mac II series, product line, 376
MacinTalk Pro extension, Extensions folder, 205
Macintosh
Basics program, 22
books, 366
buying and setting up, 369-388
evolution of, 1
how it works, 25-31
obsolescence of, 6
operating systems, 19-20
Performa, 297-304
plug ins, 387, 388
Power Macs, 315-320
power switch locations, 10
PowerBooks, 305-314
product line, 373-380
reasons to use, 5
resources,389-390

shutting down, 14-15
spoken commands, 290-292
Startup Slide Show, 11
System Folder, 185-210
top ten free things, 387-388
top ten similarities between you and, 23-24
turning off, 12
turning on, 9-10
upgrading, 363-364
user groups, 108
VCR analogy, 47
your inability to damage, 18
Macintosh Easy Open Setup control panel, Control
Panels folder, 197
Macintosh Guide, System 7.5, 188
MacLink Plus Setup control panel, Control Panels
folder, 197
MacOS, defined, 398
MacroMaker, described, 398
macros, defined, 398
MacTCP control panel, Control Panels folder, 197
Macworld Mac & Power Mac SECRETS, 366
magazines, 389
complexity of, 220-221
Magnifying glass tool, painting programs, 124
mail merge
ClarisWorks, 168-178
defined,398
mail. See e-mail
Mailbox extension, Extensions folder, 205
mailing labels, ClarisWorks, 184
mailing lists, Internet, 246-247
Map control panel
Control Panels folder, 197
Option key, 259
margins, Microsoft Word 5.1, 126
Marquee and Lasso tools, painting programs,
121-122
Master Pages
PageMake~ 147-148
QuarkXPress, 152-153
math coprocessors, defined, 398
MBs (megabytes), 28, 398
Measurement Palette, QuarkXPress, 153
megabytes (MBs), 28
memory, 27-28
See also RAM
buying, 338-339
defined,398
defragmenting, 335-336
freeing for programs, 359-361
MB (megabytes), 28
Power Macs, 317-318
PRAM,354
RAM, 28-29
top ten differences between hard disks and, 31-32
troubleshooting errors, 332-339
virtual, 317-318, 337-338
Memory control panel
Control Panels folder, 198
Option key and, 260
memory effect, PowerBooks, 307
menu bar
deflned,398
overview, 13-14

Index
menus
defined,398
pop-up, 76
pulling down, 14
submenus, 214
triangles in, 36
Microsoft Dialog Library extension, Extensions
folder, 205
Microsoft OLE extension, Extensions folder, 205
Microsoft Word 5.1, 124-132
character formatting, 128-129
date-stamping, 131
dragging text, 130-131
headers and footers, 131
interface, 126-127
margins, 126
Microsoft Word 6 comparison, 133
page numbers, 131
paragraph formatting, 129
Ribbon, 128-129
Ruler, 129
selection bar, 130
spell checker, 131-132
Summary Information box deselection, 132
Toolbar, 127-128
views, 125-126
Microsoft Word 6, 132-137
font toolbar, 133
killing "Choose a template" box, 133
killing superfluous commands, 136-137
killing toolbars, 134
line spacing, 134
Microsoft Word 5.1comparison,133
size of, 132-133
style sheets, 135-136
MIDI and music, 280
Mode32 folder, System Folder, 210
modems, 226-227, 276-277
baud rate, 392
defined,225,398
Express Modem control panel, 196
faxing, 212-213, 277
noises from, 229
plugging in, 226-227
Pods, 278
speed of, 226
modifier keys, 35, 398
monitors, 380-384
color types, 383-384
defined,398
sizes of, 381-382
technical overview, 383
troubleshooting errors, 352-353
types of, 380-381
Monitors & Sound control panel, Control Panels
folder, 198
Monitors control panel
Control Panels folder, 198, 199
Option key and, 259
MORE Macs For Dummies, 366
mounting, defined, 399
mouse
button, 399
clicking, 14, 221-222
double-clicking, 20

dragging, 14
Macintosh Basics program, 22
overview, 12-13
troubleshooting errors, 350-351
Mouse control panel, Control Panels folder, 198
mouse pad, described, 399
multimedia, defined, 399
multiple objects, selecting and grouping, 119
multiple windows, 20-21
multitasking methods, Option key, 257-258
music and MIDI, 280
My Speech Macros extension, Extensions folder, 205
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naming
disks and icons, 44
documents, 74
folders, 34
native software, defined, 399
nested folders, Option key and, 256-257
Network control panel, Control Panels folder, 198
networking, AppleTalk, 97, 306
networks, 283, 399
newsgroups, Internet, 245-246
Newton, described, 399
Note Pad, 5f-52, 56
Note Pad file, System Folder, 209
NuBus, described, 399
Numbers control panel, Control Panels folder, 198
NumLock, described, 399
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object handles, 117
object-oriented graphics, drawing programs,
116-120
ObjectSupportLib extension, Extensions folder, 205
OCR (optical character recognition)
defined,399
scanners and, 276
online,defined,399
Open File box, 75-78
Open Transport control panels, Control Panels
folder, 198-199
opening
ClarisWorks, 167-168
documents, 81-82
objects. See double-clicking
operating systems, 19-20, 187-190
Option key, 255-260
About This Macintosh command, 260
alphabetizing icons, 259
closing all windows at once, 256
copying documents, 258
Map control panel, 259
Memory control panel, 260
Monitors control panel, 259
multitasking methods, 257-258
nested folders and, 256-257
stopping commands with, 264-265
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page numbers, Microsoft Word 5.1, 131
Page Setup dialog box, 109-110
page-layout programs
PageMaker, 147-150
QuarkXPress, 150-153
PageMaker, 147-150
adding text, 148-149
editing, 150
Master Pages, 147-148
painting programs, 120-124
bitmapped graphics, 116
defined,399
drawing comparison, 116
Eraser tool, 123
Hand grabber tool, 124
Line tool, 123
Magnifying glass tool, 124
Marquee and Lasso tools, 121-122
Pencil tool, 122
Rectangle, Ellipse, Polygon, and Arc tools, 123-124
Spray can tool, 123
Text tool, 122-123
tools, 121-124
Painting window, ClarisWorks, 181-182
paragraph formatting, 72-73
Microsoft Word 5.1, 129
partitions, defined, 399
paste
See also copy and paste
defined,399
patches, Extensions folder, 203
PC Exchange control panel, Control Panels folder
199
,
PC Setup control panel, Control Panels folder 199
PC!, defined, 399
'
PCs
defined, 399
expense of, 219-220
PDS, defined, 399
Pencil tool, painting programs, 122
Performa, 297-304
Apple Backup program, 303
At Ease system software, 303-304
described, 399
Documents folder, 298-300
Launcher, 298, 299
self-hiding windows, 300-301
peripherals
daisy-chaining SCSI, 284, 357-359
defined,399
plugging in, 283-284
top ten non-costly, 285-286
phone lines, modems and, 226-227
PhoneNet connectors, plugging in laser printers 95
PICT, defined, 399
'
pixels, defined, 400
PlainTalk
Speech Recognition, 291-292
Text-to-Speech, 287-289
plug ins, Macintosh, 387, 388
plugging in
laser printers, 94-95
peripherals, 283-284

Pods, modem, 278
Polygon tool, painting programs, 123-124
pop-up controls, drawing programs, 118
pop-up menus, 76
defined,400
finding files via, 87
portrait, defined, 400
ports
defined,400
SCSI, 402
Postscript
defined,400
fonts, 102-104
laser printers, 93, 94-95
Power Macintosh Card control panel, Control
Panels folder, 200
Power Macs, 315-320
defined,400
processor chips, 315-316
product line, 379-380
software, 316-318
top ten features, 318-320
virtual memory, 317-318
power switch locations, 10
PowerBook & PowerBook Display control panels,
Control Panels folder, 199
PowerBook Monitors extension, Extensions folder:
205
•
PowerBook Setup control panel, Control Panels
folder, 199
PowerBooks, 305-314
AppleCare warranty, 309
AppleTalk and, 306
batteries, 306-308, 313-314
Control Strip, 308, 309
cursors, 311
defined,400
Duos, 312-313
fax/modems as printers, 311
memory effect, 307
product line, 378-379
Sleep mode, 305-306
trackballs and trackpads, 13, 308-309
traveling with, 310-311
troubleshooting errors, 352
PowerPC chips, defined, 400
PowerTalk control panels, Control Panels folder, 200
PowerTalk extension, Extensions folder, 205
PowerTalk Manager extension, Extensions folder
205
,
PRAM memory
defined,400
troubleshooting errors, 354
Preferences folder, System Folder, 207-208
Printer Descriptions extension, Extensions folder:
206
,
printer drivers, Chooser and, 96-97
printer fonts, defined, 400
Printer Share extension, Extensions folder 206
printers, 91-100
'
AppleTalk, 97
built-in fonts, 106-107, 109
Chooser, 95-98
color, 93-94, 382
drivers, 96-97

Index
dye-sublimation, 94
how to print with, 94-100
icons, 101
lmageWriter, 92
laser, 93
plugging in, 94-95
startup pages, 111
StyleWriter, 92-93
troubleshooting errors, 342-345
printing, 98-104
background, 98
canceling, 100
Fractional Character Widths option, 112
jagged printouts, 100-104
Page Setup dialog box, 109-110
QuickDraw GX, 101
PrintMonitor, described, 400
PrintMonitor Documents folder, System Folder,
209, 210
PrintMonitor extension
Extensions folder, 206
troubleshooting errors, 345
product line, 373-380
AV series, 378
black-and-white one-pieces, 374
color one-pieces, 374-375
LC series, 375-376
Mac II series, 376
Power Macs, 379-380
PowerBooks, 378-379
Quadra series, 377-378
programs
See also software
defined,400
determining which you're in, 79
installing, 215-216
quitting, 84
relationship to documents, 80-81
Publish and Subscribe, defined, 400
purchasing. See buying
Put Away command, ejecting floppy disks, 43
Puzzle, Apple Menu Itei;ns folder, 192

-
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Quadra series, product line, 377-378
QuarkXPress, 150-153
Document Layout palette, 153
Linking Tool, 152
Master Pages, 152-153
Measurement Palette, 153
Tool palette, 151
question mark, blinking, 341-342
QuickDraw GX
described, 400
printing and, 101
QuickDraw GX extension, Extensions folder, 206
Quicken, 137-146
categories, 137-138, 141-142, 144
entering transactions, 140-141
extra items in bank account, 145-146
preprinted checks, 146
reconciliation, 144-145
register window, 138-140
Split window example, 142-144

Splits icon, 141
Tab key, 139
Write Checks option, 143-144
QuickTime extensions, Extensions folder, 206
QuickTime movies, 281, 292-293, 400
QuickTime VR, defined, 400
quitting
defined,400
programs, 84
quote marks, curly, 89
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radio buttons, defined, 401
RAM, 28-29
See also memory
defined,401
defragmenting, 335-336
disks, 401
RAM Doubler extension, Extensions folder, 206, 336
Read Me First files, ignoring, 217
rebooting, defined, 12, 401
rebuilding the Desktop, 353-354, 401
Record Button extension, Extensions folder, 206
records
defined,401
FileMaker Pro, 160
Rectangle tool, painting programs, 123-124
relational databases, defined, 401
removable cartridges, defined, 401
removable-cartridge systems, 281-282
ResEdit,defined,401
Resize box, defined, 401
resolution
bitmapped fonts, 102
defined,401
resources
Macintosh, 389-390
troubleshooting errors, 364-365
Restart switch
defined,401
troubleshooting errors, 354-355
Return key
moving down pages with, 68
word processing and, 62, 63, 69-70
Ribbon, Microsoft Word 5.1, 128-129
RISC, defined, 401
roll-up windows, System 7.5, 189
ROM, defined, 401
Ruler, Microsoft Word 5.1, 129

•S•

sans serif fonts, 112, 401
Save File box, 75-78
saving
documents, 73-78,82-83
importance of, 30-31
scanners,275-276,401
Scrapbook
Apple Menu Items folder, 192-193
described, 401
Scrapbook files, System Folder, 209
Screen control panel, Control Panels folder, 200
screen savers, 271-272, 402
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scroll bars, 18, 88, 402
scrolling, defined, 402
SCSI
addresses, 402
cables, 359, 402
daisy-chaining peripherals, 284, 357-359
described, 357, 402
devices, 402
ports, 402
rules of, 357-359
terminators, 402
troubleshooting errors, 357-359
SCSI Manager 4.3 extension, Extensions folder, 206
.sea files, self-expanding archives, 241
selecting
all text, 88
icons, 17
large amounts of text, 89, 90
multiple objects, 119
text, 53, 66-68
words,87
selection bar, Microsoft Word 5.1, 130
selection tools, Marquee and Lasso, 121-122
self-hiding windows, Performa, 300-301
Serial (Built-in) extension, Extensions folder, 206
Serial Switch control panel, Control Panels
folder, 200
serif fonts, 112, 402
Shared Library Manager extension, Extensions
folder, 204
shareware, 50, 402
Shift key
drawing programs and, 118
installations and, 216
as modifier key, 35
Shortcuts extension, Extensions folder, 206
shortcuts. See keyboard shortcuts
Shut Down, 14-15
Apple Menu Items folder, 193
defined,402
Shutdown Items folder, System Folder, 209
SIMMs, defined, 402
SimpleText
defined,402
talking software, 288
singing, 289-290
.sit files, expanding, 214-215
size box, 18
Sleep mode, PowerBook, 305-306, 402
slide shows, ClarisWorks, 182-183
slots, defined, 402
snapshots of screens, 264
software, 47-57
See also programs
Application menu, 54-57
buying, 48-49
ClarisWorks, 167-184
cost of, 49
defined,402
desk accessories, 51-57
determining which program you're in, 79
downloading via America Online, 239-242
drawing programs, 116-120

economics and usability, 219
Excel, 153-159
FileMaker Pro, 159-165
Launcher buttons, 62
Microsoft Word 5.1, 124-132
Microsoft Word 6, 132-137
native, 399
obsolescence of, 48
PageMaker, 147-150
painting programs, 120-124
PlainTalk Text-to-Speech, 287-289
Power Mac, 316-318
QuarkXPress, 150-153
QuickDraw GX, 101
Quicken, 137-146
shareware, 50
System Folder and, 218
top ten programs, 166
utility programs, 271-273
version numbers, 48
versions caveat, 212
viruses, 217-218
where to get it, 49-50
Sound control panel, 58-59, 268-270
adjusting volume, 270
Control Panels folder, 200
Sound Manager extension, Extensions folder,
206-207
Sounds & Displays control panel, Control Panels
folder, 200
Speakable Items folder, System Folder, 208
speakers, 279
special characters, 172
Speech control panel, Control Panels folder, 200
Speech Recognition, PlainTalk, 287-289, 291-292
spell checker, Microsoft Word 5.1, 131-132
Splits icon, Quicken, 141
spoolers, defined, 402
Spray Can tool, painting programs, 123
spreadsheets
defined,403
Excel, 153-159
SR Monitor extension, Extensions folder, 207
stacks, defined, 403
startup, troubleshooting errors, 339-342
Startup Disk control panel, Control Panels folder,
200
startup disks, defined, 403
Startup Items folder, System Folder, 209
startup pages, avoiding, 111
Startup Slide Show, 11
stationery
ClarisWorks, 183
defined,403
Stickies, Apple Menu Items folder, 193
storage
floppy disks, 25-26
removable-cartridge systems, 281-282
Stufflt file expander, America Online, 241-242
style sheets, Microsoft Word 6, 135-136
StyleWriter extension, Extensions folder, 205
StyleWriters, 92-93
defined,403
plugging in, 94
troubleshooting errors, 342-343

Index
submenus,214,403
SuperDrive, 403
symbols, special characters, 172
SyQuest, removable-cartridge systems, 281-282
System 6
described, 403
Trash and, 41
System 7
described, 403
installing fonts, 107
System 7.1comparison,187
System 7.5 comparison, 188-190
System 7.1
described, 403
finding files, 86-87
removing fonts, 108
System 7 comparison, 187
System 7.5
Apple menu, 189
described, 403
extension conflicts, 356
finding files, 85-86
Macintosh Guide, 188
Performa, 297-304
roll-up windows, 189
System 7 comparison, 188-190
upgrading, 190
System AV extension, Extensions folder, 207
System crashes, defined, 403
System disks, defined, 403
System Enabler file, System Folder, 209
System file
deflned,403
System Folder, 209
System Folder, 185-210
Apple Menu Items folder, 191-193
cleaning up, 190-210
Clipboard, 208
Control Panels (Disabled) folder, 208
Control Panels folder, 193-201
described, 403
drivers and, 218
Extensions (Disabled) folder, 208
Extensions folder, 202-207
Finder, 209
Fonts folder, 207
Launcher Items folder, 207
Note Pad file, 209
operating system version numbers, 187-190
operating systems, 186-187
Preferences folder, 207-208
PrintMonitor Documents folder, 209
Scrapbook file, 209
Shutdown Items folder, 209
Speakable Items folder, 208
Startup Items folder, 209
System Enabler file, 209
System file, 209
top ten pieces of crud in, 209-210
System Speech Rules extension, Extensions
folder, 207
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Tab key
in dialog boxes, 99-100
Quicken and, 139
tab stops, aligning text with, 88
tablets, digitizing, 282
talking software
ClarisWorks, 290
PlainTalk Text-to-Speech, 287-289
WordPerfect, 290
telecommunication, defined, 404
telecommuting, defined, 404
terminators, SCSI, 402
text
aligning with tab stops, 88
colorizing highlights, 266-267
cutting to Clipboard, 88
deleting, 66-67
deselecting, 68, 72
in drawing programs, 119-120
highlighting, 53, 66-68
PageMaker, 148-149
selecting, 53, 66-68
selecting all, 88
selecting large amounts of, 89, 90
Text control panel, Control Panels folder, 200
Text tool, painting programs, 122-123
Text-to-Speech, PlainTalk, 287-289
third party, defined, 404
Thread Manager extension, Extensions folder, 207
TIFF, defined, 404
title bar, 18, 404
toll-free number, Apple Computer, 221, 365
toner, defined, 404
Toolbar, Microsoft Word 5.1, 127-128
tools
drawing programs, 117-118
painting programs, 121-124
trackballs, defined, 404
trackballs and trackpads
PowerBook, 13, 308-309
troubleshooting errors, 350-351
Trackpad control panel, Control Panels folder,
200,201
Trash, 38-40
See also deleting
aliases and, 262
dragging to new location, 46
ejecting floppy disks with, 44
emptying, 39-40
System 6 and, 41
top ten tips, 44-46
"Warn before emptying" option, 45
triangles
inmenus,36
in windows, 23
troubleshooting errors, 323-362
See also error messages
blinking question mark, 341-342
"clean system reinstalls," 361-362
defragmenting hard drives, 362
error messages, 327-332
extensions, 325, 355-356
(continued)
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Finder problems, 345-347
floppy disks, 347-350
"Force Quit" keystrokes, 354
freeing memory, 359-361
freezes and crashes, 325-326
hardllVare,350-353
out of memory, 332-339
PRAM memory, 354
printing problems, 342-345
rebuilding the Desktop, 353-354
resources, 364-365
Restart S11Vitch, 354-355
SCSI, 357-359
startup problems, 339-342
system slo11Vness, 350
TrueType fonts, 104, 404
turning the Mac off, 12
turning the Mac on, 9-10
typography. See fonts
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Undo command, 57
updates, Extensions folder, 203
upgrading, 363-364
System 7.5, 190
uploading, defined, 404
user groups, 108, 389
defined,404
Users & Groups control panel, Control Panels
folder, 201
utility programs, 271-273
anti-virus, 272
compression, 271
screen savers, 271-272
top ten free or almost-free, 272-273

.

(/.

vertical scroll bar, 18
video, QuickTime movies, 281, 292-293
video cards, defined, 404
Video Guide extensions, Extensions folder, 202
Video Startup extension, Extensions folder, 207
vie-wing invisible characters, 70
vie11VS
FileMaker Pro, 159
Microsoft Word 5.1, 125-126
Vie11Vs control panel
Control Panels folder, 201
icons, 267-268
virtual memory
defined, 404
memory management, 337-338
Po11Ver Macs, 317-318
viruses, 217-218
anti-virus programs, 272
defined,404
volumes, defined, 404
VRAM,defined,404
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"Warn before emptying" option, Trash, 45
Web. See World Wide Web
"Wind011VS
closing all at once, 256
defined,404
expanding, 46
Hide Others option, 257-258
inability to rename or Trash, 222
multiple, 20-21
roll-up (System 7.5), 189
self-hiding (Performa), 300-301
top ten tips, 44-46
triangles in, 23
Windo11VShade control panel, Control Panels
folder, 201
11Vord processing, 61-90
backing up files, 84, 86
closing files, 78
closing programs, 84
curly quotes, 89
deselecting text, 68, 72
editing, 66-68
finding files, 84-87
formatting, 69-73
headers and footers, 89, 131
I-beam cursors, 65
insertion points, 64-65
Microsoft Word 5.1, 124-132
retrieving documents, 81-82
Return key and, 62, 63, 68, 69-70
saving documents, 73-78
selecting all text, 88
selecting large amounts of text, 89, 90
selecting text, 66-68
special characters, 172
top ten tips, 87-90
top three rules of, 62-64
11Vord 11Vrapping, 64
Word. See Microsoft Word 5.1; Microsoft Word 6
11Vord 11Vrapping, 64, 404
WordPerfect, talking soft11Vare, 290
11Vords, selecting by double-clicking, 87
World Wide Web, 248-252
addresses,248,249-252
America Online, 249, 251, 254
bro11Vser, 254
searching,250-251
WorldScript Po11Ver Adapter extension, Extensions
folder, 207
WYSIWYG, defined, 404
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Zip disks
defined, 404
removable-cartridge systems, 281-282
zoom box, 18, 46, 404
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